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' N TRODUCC 0N

| répido crecimiento de la industriq de la
computadora personal (PC) se aceler6 gracias a la hoja de
cilculo. A principio de los afios 80 el mundo de los negocios

se dio cuenta del poder y versatilidad de la hoja de célc'ulo, y

vio que la PC pertenecia mds a la oficina corporativa que al
hogar o al sal6n de pasatiempos.

Excel puede derivar su origen desde esas primeras hojas de célculo.
Peroel compararlas con Excel escomo comparar el aeroplano d? Orville
y Wilbur Wright que vol6 en Kitty Hawk, con el bombardere Stealth de
hoy en dfa. lgual que este dltimo avion, Excel es 4gil, poderoso y
efectivo. Es la culminaci6n de una historia orgullosa combinada con la
imaginacién y genio de los que lo desarrollaron. .

Este libro también estd disefiado para ser 4gil y efectivo; Lo hard
productivo con Excel en el més breve tiempo posible. Forja y desarrolia
sus habilidades en pasos, un conceplto y una destreza a la vez,

Si se es un usuario nuevo o principiante de Excel, encontrard que

" este libro es tanto de instruccién como de referencia. Usardel libro para
aprender Excel y podr llevar a cabo sus propios proyectos importantes
después de s6lo unas pocas lecciones. :

El libro cubre 1a versién 4.0 de Excel. Siendo que es:ta obra fue
desarrollada segin Windows 3.1, todas las lecciones se aplican igual-
mente a Windows 3.0. La tinica diferencia son algunos cambios en los

-l
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comandos de la pantalla de ayuda y en la accesibilidad a tipos de letra
TruType (del Tipo Fiel).

COmo Usar
este Libro

$i adin no ha instalade Excel en su computadora, pase direclamente al
Anéndice A. Ahi aprendersd cdmo hacer copias de respaldo de sus discos
de Excel y cémo instalar Excel en su sisterna.

Las lecciones de este libro suponen que tiene uny comprension
bisica ¢de cdmo usar ¢l mouse, asi como de los menis y lus cajas de
didlogo en las aplicaciones de Windows. Si es usuario nuevo de
Windows, lea el Apéndice B antes de empezar con las lecciones. Este
apéndice explica cdmo usar el mouse y el teclado para dar comundos a
Excel y otras aplicaciones de Windows. Trabajar con Excel ¢s muy ficil
¢ inluitivo, pero lea el Apéndice B de cualquier modo. S6lo le 1omard
Unos pocos Minulos, y hard que su trabajo con Excel marche mucho mas
facilmente. Las lecciones en si estin organizadas en una progresion
16gica basada en las habilidades que necesitard parz ser realmente
pradductivo con Excel. Todas las lecciones incluyen una serie de pasos
ficiles de seguir. A fin de aprender ¢cé6mo usar Excel, simplemente
siéntese frente a la computadora y haga lo que le instritye cada paso.
Quedard sorprendido de cudn fdcil y rdpido es.

Las lecciones de la Parte | — Aprendizaje de los Principios
Fundamentales de Excel — mucstran cdmo crear, imprimir y guardar
una hoja de trabajo simple en ¢l menor tiempo posible. No se dan todos
los detalles de la creacidn de hojas de trabajo en estas lecciones iniciales
— sino que sélo se aprenden los principios basicos para poder empezar
a aplicar Excel para realizar su propio trabajo.

La Parte 2 estd dedicada a aumentar sus habilidades. Aprenderd
cdmo leer hojas de trabajo del disco y cémo editar la informacién que ya
ha ingresado o alimentado en la hoja de trabajo. También aprenderd
modos de expeditar el trabajo; por ejemplo, ingresar datos a un grupo de
celdas y hacer que Excel automédticamente Hene una serie de clenentos
por usted. Aprenderd c6mo crear férmulas para ejecutar eperaciones
aritméticas, y cémo inscrtar y borrar hileras y columnas.

Las lecciones en la Parte 3 se enfocan al formateo — arreglo del

INTROQUCCION E

aspecto de su hoja de trabajo para méximo impacto visual, Enla Leceion
15, por ejemplo, aprenderd cémo ubicar caracteres dentro de una celda,
La Leceién 16 le muestra como formatcar ndmeros, mientras yue la
Leceion 17 cxplica cémo cambiar cl-ancho de columnas y ki aliura de
hileras. Aprenderd cémo cambiar ¢l tipo y formato de caracteres en la
Leccidn 18, y céme crear efectos con lineas, patroies y colores ¢n la
Leccién 19. En la Leecién 20 aprenderd como formatear una hoja de
trubajo entera con $6lo unos poces clicks del mouse.

Serd capaz de crear laminas y grificas de notable configuracion
después de leer las fecciones de b Parte 4. Esias lecciones le Hievan paso
a paso a través de la creacion de grificas de barras, de lincas, de sectores
y otros tipos. Aprenderd cémo cambiar el tipo, dimension y pusici(’)nrde
las graficas y ¢émo imprimir ¢lementos graticos junte con, o
independieniemente, de sus hojas de trabajo.

En la Parte 5 aprenderd una serie de desirezas pura hacer su trabajo
mas fdcil y efectivo. Aprenderd cémo buscar y qeemplazar lexto
auloimdticamente, cémo ordenar hileras y columnas ¢ cualquier orden
y como trabajar con més de una hoja de trabajo a la vez. Por ejemplo,
aprenderd como desplegar varias hojus de trabajo en pantalla al nisme
tienpo, y cémo mover y copiar informacion entre ellas,

En estas tecciones también aprenderd como verificar la ortogralia,
c6mo ajustar la distribucicn de las hojas de trabajo y ldminas en ka pigina
impresa, y cémo cambiar la torma en que Excel muestra las hojas de
trabujo. Aprenderd, por ejemplo, cémo aplicar zeom hacia adentro y
hacia afuera para cambiar la amplificacién, y cdmo ver un facsimil
gréiico de la hoja de trabajo impresa. Las lecciones finales le muestran
cHmMo insertar notas para si mismo, c6mo grabar macros pura repetir
teclevs y comandos de uso frecuente, y cémo usar Excel para ayudar a
resolver problemas de direccidn de empresas o negocios y fomar
decisiones.

Aun cuando existe una progresion natural en las lecciones, se puede
saltar hacia adelante si se necesita informacion para terminar un trabajo.

Busque en la tabla de contenido o en el indice, o bien acudadirectamente
a lu leceion que necesite. Por ejemplo, puede estar creando una hoja de
trabajo que serfa mds efectiva en forma de grafica. Eneste cuaso se puede
hacer referencia rapidamente a la Leccién 22 para encontrar como crear
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una gréfica de columna oprimiendo una sola tecla o haciendo una sola
seleccién de mend. Puede crear la gréfica, y luego regresar a una leccién
anterior para continuar.

ComO SEGUIR LAS INSTRUCCIONES DE ESTE LIBRO

Cada leccion de esta obra le lleva’ paso a paso a través de una tarea
especifica. Simplemente siga cada instruccién para dominar la técnica
explicada.

Las instrucciones para seleccionar opciones de menil se mostrardn
como sigue:

Seleccione File » Open

El sfmbolo » sirve dnicamente para separar los elementos que debe
seleccionar. Significa, en este ¢ejemplo, "Seleccione File de la barra de
Mentis, y luego seleccione Open del mend de persiana que aparezca.” No
setiene que buscar el cardcter » en la pantallani hay que oprimir ninguna
otra tecla.

Algunas opciones de menl tienen una tecla o combinaciones de
teclas— Hamadatecleos de atajo-— mostrados asu derecha, porejemplo
Shift+F12 a un iado del comando Save (Guardar). Esto significa que se
puede oprimir esa combinacin de teclas para ejecutar et comando, en
vez de usar €] mouse para abrir el mend. Cuando un comando tiene
asignada una combinacién de teclas, verd las instrucciones escritas de la
siguiente forma:

Select File » Save (Shift+F1i2)

La notacién Shift+F{2 significa que se oprime y se mantiene
oprimida ia tecla Shift, se oprime latecla F12, y luego se sueltan ambas.

Si su teclado no tiene las teclas de funcién F11 o F12, sustitiyalas
por Alt+F1 y Alt+F2, respectivamente. Por ejemplo para guardar una
hoja de trabajo, puede oprimir Shift+Alt+F2 en vez de Shift+F12. La
notacién Shift+Alr+ F2 significa oprimir y mantener oprimidas tanto la
tecia Shift como a tecla Alt, y luego oprimir la tecla de funcién F2; en
seguida, soltarlas todas.

Encontraré que es muy fécil seguir las instrucciones de este texto.
A continuacion se dap algunos consejos para que resulte adn més facil:

intropuccion | XXl

o]
»  Sies un usuario nuevo de Windows, vea en el Apéndice B
consejos sobre c6mo seguir las instrucciones del mouse, tales
!
como dar click y arrasirar. ‘

s Cuando lleve a cubo operaciones de mouse, siempre use ¢l
botén izquierdo a menos gue explicitamente se indigue;usar el
bot6n derecho.

a Cuando se le pida teclear algo desde el tecludo, lo que Elebc
teclear apareceré en letras negritas, como, por cjcmpllo:

Teclee Net Income,

m Cuando Excel le presente un mensaje en la pantalla en
respuesta a una accidn suya, 1a informacién aparecerd como
sigue: . '

Save changes to "QUARTERS.XLS"? 3
(¢ Guardar cambios a "QUARTERS.XLS"?) ‘

m Cuando esté haciendo algo realmente en la computadora, verd

una serie de pasos numerados a seguir: :
]

Lea toda la informacién de cada paso antes de llevarlo a cabo.
SI No SE TIENE MOUSE
Aun cuando el mouse no es absolutamente necesario para usar Excel, es
muy recomendable. Algunas operaciones que requeririan mucho tecleo
pueden ser cjecutadas dando click al botén del mouse 616 un.a o aos
veces. Siono tiene mouse y planea usar Excel u otra aplicacion de
Windows con cierta frecuencia, considere la compra de un mouse.

Mientras tanto, puede trabajar con Excel y otras uphclaclmncs de
Windows. Veaen ¢l Apéndice B como aprender a seleccic.aar !opcmncs
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de menud y comandes por medio del teclado. Tambicén hallard que eneste
librolamayor parte de las instrucciones para seleccionar comandos estin
seguidas por teclas de atajo. Use cualquiera de los dos métodos — techas
de atajo o mends — cl que sienta que es mds comado y convenienie.

Encontrard en las guardas de este libro una lista de teclas de atajo
usadas con frecuencia.

Excel es un programa notable. No sélo pucde ser divertida su uso,
sino lambién es un activo valiosisimo en su empresa 0 DCOCio, pas-
tiempo, hogar o en la escuela.

PARTE 1

Aprendizaje de los Principios
Fundamentales de Excel

Microsolt Excel es un progrmma rico @n funciones gque
ofrece habilidades para desarroffar planes de negocios. pmducit"
grificas profesionales, llevar a cabo wnilisis estadisticos
complejos y resolver problemas. No obstante, uprcndiéudu
unicaniente algunos conocimientos basicos on las lecciones
que siguen, inmediatamente serd cupaz de usar Bxcel paracrear
hojas de caleuto de alta calidad, Siadn no lo ha hecho, siga
cuidadosamente Jus instruccicnes del Apsndice A para instalar
Lxcel en su computadora.

Cuando Lxeel quede instalado empicee con la Leccian |
para iciciar elaprendizaje de cste poderaso programay versatil

herrumienta de negocios,
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Cémo Arrancar
Windows

como Abrir el
- Grupo Excel

Cémo Arrancar

Arranque eacel
de Excel |

ucha de la versatilidad de Excel viene de su
interaccién conel ambiente de Windows. Podra
utilizarel Clipboard de Windows para transferir

informacién entre Excel y otras aplicaciones
de Windows, tales como Word para Windows
y WordPerfect para Windows. Ademds, siendo
una aplicacién de Windows, Excel muestraen
la pantalla los datos exactamente igual que
aparecerdn al imprimirlos, incluyendo los tipos
y el estilo de los tipos asi como ldminas y

graficas multicolores.

LECCION1 3

Se llena con datos y férmulas una hoja de cdlculoen la pamlalla. La
hoja de cdlculo de Excel es una cuadricula de columnas ¢ hilelras muy
similar a una hoja de célculo contable, pero con una calculadora

financiera interconstruida,

Como Arrancar
Windows

Para poder correr Excel, primero se debe arrancar Windows. Para
hacerlo, siga los siquientes pasos: '

1. Encienda la computadora. Verd ¢l llamador C: >.

2. Teclee WIN y lucgo oprima .t para correr Windows y mostrar
la ventana Program Manager.

Si Windows no arranca, asegirese de haberloinstalado debldameme

en su sistema. Consulte su manual de Windows. ‘
i

1

Como Arrancar
Excel

Arranque Excelconeliconode programa Excel. Esté roluladolMlici"osofl
Excel y estd ubicado dentro del grupo de programas Excel. ‘Sl instalé
Excel después de instalar Windows, verd que el grupo de progrdmas
Microsoft Excel 4.0 aparecerd enlapantalla, como muesirala Flgural 1,

1an pronto como arrangue Windows. Si la ventana de grupo Excel no se
despliega, refiérase a Ia seccion "Cémo Abrir el Grupo Excel” mis
adelante en esta leccién.

) !

» Para arrancar Excel dé doble click ¢n el icono de programa
Excel. Si esta es la primera vez que corre Excel en su
computadora, verd en la pantalla Intreducing Microsoft Excel
(Presentacién del Excel de Microsoft). Se pueden seleccionar
opciones en esta pantatla para aprender més acerca de Excel.
Por ahora seleccione Exit to Microsoft Excel (Salir de |
Microsoft Excel) — podré correr el curso posteriormente
usando ¢l ment Help descrito en la Leccion 3. !

I
|
I
!
:‘
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FIGURA 1.1:
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_ Enunos momentos verd el ment principal de Excel, como muestra
la figura 1.2. Si Excel no arranca, puede ser que no csié instalado
correctamente. Refidrase al Apéndice A.

Si no est4 listo a continuar con la siguiente leccidn, oprima All-F4
para salir de Excet y regrese a Program Manager de Windows. Si
introdujo datos a la hoja de cdlculo, verd una caja de didlogn con el
mensaje

Save changes 0 "Sheet1"?
(2 Guardar cambios a "Sheet1"?)

v las opciones Yes, No, Cancel y Help (5i, No, Cancelar y Ayuda).D¢
Click en No u oprima N para salir de Excel sin guardarla hoja de cileulo.

LECCION 1 5

=

File

Edit  Funinula

Formal  Dala  Qptiuns Macro  Window  Help
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Como ABRIR EL GruUpPO EXCEL

Si la ventana de grupo Excel no estd abierta en primer plano al arrancar
Windows, use uno de los siguientes métodos pari que aparezea el icono
del programa Excel:

®  Sila ventana de grupo Excel estd abierta en ¢l plano posterior
o de fondo — esto es, detrds de ofra ventana de grupo, por
ejemiplo el grupe Main — dé Click en cualquier parte de la
ventana Excel pura que pase al plano anterior o de frente, u
oprima Ctrl+F6 hasta que la ventana Excel aparezea.

®  Sila ventana de grupo Excel es1d cerrada — un icono rotulado
Excel aparece en Iz parte inferior de la ventana de Program
Manager — dé doble Click en el icono para abrir 1a ventuna
Excel, u oprima Ctrl+F6 hasta que el icono quede
seleccionado; luego oprima .J.
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m Sino hay ventana de grupo Excel ni icono, pue@e ser que el
icono del programa Excel esté en el grupo Apphcatlgns. Esto
puede suceder si se instalé Windows 3.1 después de instalar
Excel en una versi6n previa de Windows. Abra la ventana
Applications y busque el icono del programa Excel .
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Aprendizaje de las
ventanas de Fxcel

Barras de tﬂiulo,
de meqais.
de henan;llqnta,
de tormula

y de estado

Familiarizacién |
con la Pantalla Excel

a pantalla principal de Excel contiene una
ventanade hojade trabajo dentro de la ventana
de aplicacién de Excel. Esta contiene 6arra de
Titulo, barra de Mend, barra de Herra:miema,
barra de Formula, un amplioespacio detrabajo
y la barra de Estado. Se usan los eleméntos de
la ventana de aplicacion para dar comandos a
Excely paraingresar datos a la hoja de trabajo.

- La ventana de hoja de trabajo, que tiene su propia barraid? tftulo,
ocupa ¢l drea de trabajo de la ventana de aplicaci6n. Se puede tener m4s
de una ventanade hoja de trabajo mostradas a Ja vez, También es posible,

e



FAMILIARIZACIONCON LAPANTALLA EXCEL

simultineamente, mostrar hojas de trabijo, grafica y ventanas macro
para operaciones mds avanzadas de Excel, Mostrando varias ventunas,
s¢ puede mover y copiar informacién fcilmente entre hojas de trabajo
o ver como el cambiar una hoja de trabajo afecta a una grifica o tabla.

1.a forma del sefialador del mouse depende de su localizacion en la
pantalla, Las técnicas de mouse se discuten en ¢l Apendice B — refiérase
al Apéndice si es nuevo usuario de Windows.

La pantalla principal de Excel de la Figura 2.1 se muestra con sus
partes rotuladas.
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LaBarra
de Titulo

La Barra de Titulo, arriba de la pantalla, muestra el nombre de la
aplicacién. Si se maximiza la ventana de hoja de trabajo, la barra de
Titulo incluird €] nombre de la hoja de trabajo también. '

La barra de Titulo también contiene una caja y dos botones que
ofrece Windows:

m Darclick en la caja de Control (el rectangulo estd del lado
izquierdo) abre un meni que permite salir de Excel, reducir el
programa a icono (para que se puede trabajar con otra aplica-
cién teniendo, mientras, a Excel corriendo), o bien, pasar a
otra aplicacién,

m  Darclick en el botén de restaurar (los dos tridngulos que estan
al extremo derecho) cambia el tamafio de la ventana de Excel.
Cuando se da un primer click al bot6n, la ventana se estrecha y
el bot6n se transforma en un tridngulo sencillo gue apunta
hacia arriba y que ahora se llama botdn de maximizar, el cual
permite regresar 1a ventana a su tamafio completo.

m  Dar click en el botén de minimizar (el tifngulo que apunta
hacia abajo colocado a la izquierda del botén de restaurar)
también reduce Excel a un icono. Si no se tiene mouse, use el
menii de la caja de control para minimizar la ventana de Excel.

La Barra de
Men( y la Barra
de Herramienta

La barra de Meni esté justamente abajo de 1a barra de Titulo, y muestra
los mends de los cuales se seleccionan comandos para trabajar con Excel,
Usard 12 barra de Menii constantemente para llevar a cabo operaciones
con la hoja de céiculo.

Abajo de la barra de Menti estd la barra de fHerramienta. La barra
de Herramienta sirve como utensilio de atajo para dar a Excel comandos
que se usan frecuentemente, con un soloclick del mouse, en vez de tener
que abrir un meni de la barra de Meniis. Aprenderd como usar 1a barra
de Herramienta en la Leccién 3. ' i




10

4——*—

FAMILIARIZACION CON LA PANTALLA EXCEL

LaBarra de
Formula

Seusalabarrade Férmula paraingresarinformacién alahojade trabajo.
Conforme se mueve a lo largo de la hoja de trabajo, la barra de Férmula
muestra el contenido de la celda activa. Aprenderd como usar la barra de
Férmula en 1a Leccidn 4.

La Ventana de
Hoja de Trabajo

Una hoja de trabajo contiene una serie de celdas en las cuales se
introducen datos. Las celdas estdn ordenadas en hileras numeradas y
columnas identificadas por letras. Se puede identificar cada celda por la
interseccién de su columna y su hilera, Por ejemplo, a la celda en la
esquina superior izquierda de la hoja de trabajo se hace referencia como
celda A1 porque estd en la columna A y la hilera 1. La celda que sigue
hacia la derecha es la celda B, la que estd bajola Al esla A2. Laletra
identificadora de columnas siempre precede al niimero de la hilera.
La ventanade hoja de trabajo contiene su propia barra de T{tulo que
muestra el nombre de la hoja de trabajo. E nombre preestablecido de la
hoja que es Sheet 1, serd reemplazado cuando guarde y le dé nombre i su
hoja de trabajo. La caja y botones de esta barra de Titulo, afectan tnica-
mente a la ventana de la hoja de trabajo. Por ejemplo, dar doble click a
la caja de Control de 1a hoja de trabajo cerrard dnicamente fa ventana
Worksheet (Hoja de trabajo), no la ventana de aplicacién de Excel.

La Barra de
Estado

La barra de Estado estd ubicada a lo largo de la parte inferior de la
pantalla. A su extremo izquierdo aparece un mensaje que reporta el
estado actual de Excel. Por ejemplo, la palabra Ready (Listo) indica que
Excel est4 inactivo, esperando que se inicie un trabajo. El indicador se
convierte en Enter cuando se estdn ingresando datos a una celda o se
transforma a Edit cuando se est4 editando el contenido de una celda.

Cuando se resalta un elemento de mend o se dé Click a un botén de
la barra de Herramienta, la barra de Estado indica latarea que ¢l elemento
o botdn ejecuta.

Al exiremo derecho de 1a barra de Estado se indica el estado de
ciertas teclas de funcién odel tectado, La Tabla 2. 1 explicael significade
de cada uno de los indicadores que pueden apareceren la barrade Estado.

o

{NDICADOR

NUM
FIX
OVR
SCRL
CAPS

LECCION 2 1 1 I

CESCRIPCION

La modalidad Add estd encendida para seleccionar celdas
adicionales no adyacentes '

La modalidad Extend estd encendida para seleccionar celdas
adicionales adyacentes

Num Lock (1ablera numérico} estd encendido

Fija la posicidn del punto decimal en una celda

Lamodalidad de sustituircaracteres(sobreescritura)estdencendida
Scroll Lock (cancelacién de recorrido) estd encendida

Caps Lock (todas maydsculas) estd encendida

TABLA 2.1|.
Indicadores de la

barra de Estado,

Refiérase a la barra de Estado con frecuencia al trubajar con Excel.
Sinoecsid seguro de cudl es 1a funcidn gue ejecuta determinada seleccion

de menud, resdltela en el mend de persiana y luego lea el mensaje al
I

extremo izquierdo de la barra de Estado,
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Cémo trabajar
con los mends
de Excel

Como usar la barra
- de Herramienta

Comunicacion
con Excel

e crean hojas de cdlculo y gréficas interactuando
con la pantalla de Excel. Se dan instrucciones
a Excel usando el mouse o el teclado y
respondiendo a las preguntas ¢ instrucciones
que aparezcan en la pantalla. Excel puede
incluso guiarloatravés de operaciones dificiles

utitizando una serie de llamadas y mends.

$i es un nuevo usuario de Windows, vea el Apéndice B para
aprender més acerca del trabajo con Windows y sus aplicaciones.

e
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LECCION D

El Sistema de
Mends de Excel

Normalmente el primer paso al dar un comando a Excel es seleccionar
una opcidn de la barra de Meni. Las opciones mostradas en la barra de
Menti cambian dependiendo de si lo que estd activo en el drea de trabajo
es una hoja de trabajo, una grifica o una ventana de macro.

Recuerde que las instrucciones para seleccionar opciones de mend
se mostrarin como sigue:

Seleccione File » Save(Shift+F12)

(Vea la Introduccién para una descripcién detallada de este formato.)
Para practicar el uso del sistema de meniis, exploremos el de Help.

Gomo Usar el
Sistema de
Ayuda

Si se necesita ayuda al estar trabajando con Excel se puede encontrar a
través de su amplio sistema Help (Ayuda). El sistema de ayuda despliega
ventanas que explican cada comando, cada operacién y cada procedi-
miento de Excel.

Por ejemplo suponga que deseara crear una grifica de sectores a
color usando los datos de la hoja de trabajo. Veamos como usaria el
sistema de ayuda.

1. DDé click en Help en 1a barra de Mend, u oprima Ali+H, para
desplegar el mend de persiana Help.

Este meni enumera ocho opciones: Contents (Contenido), que
despliega un indice de temas de Help; Search (Buscar), que permite
buscar ayuda sobre temas especificos; Product Support (Apoyo del
Producto), que explica cémo obtener ayuda directamente de Microsoft;
Introducing Microsoft Excel (Presentacién de Microsoft de Excel), que
muestra una serie de pantallas sobre funciones bdsica de Microsoft
Excel, Learning Microsoft Excel (Aprendizaje de Microsoft Excel), que
empieza un curso de Microsoft Excel; Lotus 1-2-3 y Microplan, que
muestran a los usarios de programas de otras hojas de célculo cémo
transferir sus habilidades a Excel; y About Microsoft Excel (Acerca de
Microsoft Excel), que reporta la version de Excel que se esti usando y la
cantidad de memoria disponible.

2. Seleccione Search paradesplegar su caja de Didlogo, que enume-
ra alfabéticamente temas de Help, como lo muestra laFigura 3.1.
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FIGURA 3.1:
La caja de didlogo

Type a word, o select ono tiom the list. Search
Then choots Show Topics.

Swhact & fapic, then choose Go To.

Se puede recorrer manualmente la lista de temas pero es més rdpido
dejar que Excel lo haga.
3. Teclee P. Cuando se teclea en 1a caja de texto, la lista se
recore hasta mostrar los temas de Help que empiezan con las
letras que se teclearon.

4. Teclee I de manera que aparezcan en la caja de lexto las letras
PI. Los temas que empiecen con esas letras son los que ahora
se enumeran. .

Si se desea ver temas que empiecen con otras letras, oprima
la tecla Retroceso para borrar los caracteres que estdn actual-
mente en la caja de texio; luego teclee las otras letras to cual
har4 que la lista se recorra autométicamente.

5. Dé doble click en pie charis (Grdfica de Sectores) en l.a lista.
Aparece una lista de temas en la parte inferior de la caja de
lista, como muestra la Figura 3.2,

6. Dé doble click en el tema Pie Chart Tool (Herramienta Gréfica
de Sectores). La caja de didlogo Search desaparece, y en su
luﬁar aparece la ventana Help explicando c6mo crear una
grafica de sectores.

LECCION 3 15
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7 FIGURA 3.2:
Search Tépicos 'dc! Helpen la
2 caja de texto inferior

Trpe a word, o 1dect one from the lst.
Then choose Show Topics.

pie charts

M
Pl math function
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Pre Chast ool >
ound notos 3
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3-0 Pie Command [Galety Menu)
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Pio Command [G allery Menu)
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7. De doble click en la caja de Control de la barra de Menis de la
ventana Help, u oprima Alt+F4 para cerrarla.

Las ventanas de ayuda de todas las aplicaciones de Windows tienen
la misma barra de Meni y los mismos botones de comaﬁd(i)s En el
Apéndice B se tiene una descripcién de los controles de la ventana Help.

Para obtener informacién acerca de una opcién de ment, de un
botén de la barra de Herramienta, o sobre alguna otra parte de lg ventana
de Excel, seleccione el dltimo botén de la derecha de la barra de
Herramienta, u oprima Shift+F1. El sefialador del mouse se transforma
en una flecha pequefia conectada a una interrogacién. Seleccione la
opcién de meni o dé click en el botén de 1a barra de Herramle'ma enla
parte de la ventana acerca de la cual se desea obtener ayuda. Sl cambia
de opini6n y decide que siempre no necesita ayuda, oprima IEsc para
transformar de regreso el sefialador del mouse a su forma n9npal. Una
vez que la ventana Help aparece, se le debe cerrar para poder regresar a
ta hoja de trabajo.

Para obtener informacién acerca del menid o la caju de dlﬁlogo en
lacual esté trabajando actualmente, oprima Fl en vezde recurriral mend
de Help. Esto hace que se despliegue ayuda sensible al contexio acerca
de 1a parte de Excel desde la cual se oprimi6 F 1. Sinembargossi S€oprime
Fl desde la ventana de hoja de trabajo aparecerd la ventana Help
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Conlents, y habr4 de seleccionar o buscar el tema del cual necesita ayuda.

Como usarla
Bara de
Hemamienta

Si tiene un mouse, puede usar la barra de Herramienta para comunicarse
con Excel. La barra de Herramienta contiene botones con iconos que
representan los comandos mas comunes de Excel. Por ejemplo, el botén
con el sfmbolo sigma (I) represenia ¢} comando AutoSum, el cual
autématicamente calcula €l total de una columna o de una hilera de
NUmMeros.

La Tabla 3.1 muestra los iconos de la barra de Herramienta y sus
aplicaciones. Para usar la barra de Herramienta, dé click en €l icono del
comando que se desee ejecutar. Si s¢ da click en un icono de barra de
Herramienta y mantiene oprimido ¢l botén del mouse, aparcceré la
descripcidn del icono en la barra de Estado. Suelte el botén del mouse
para seleccionar el comando. Si no desea seleccionar el comando,
arrastre el sefalador alejindose de 1a barrade Herramienta, y luego suelie
el botén.

La barra de Herramienta se puede mover y modificar para que
muestre barras de Herramienta adicionales para tareas especiales, tales
como dibujar grificas y crear léminas. La barra de Herramienta
prestablecida que se muestraen la pantalla se lama barra de Herramienta
Stdndard. Aprenderé como desplegar y usar otras barras de Herramienta
en la Leccion 15.

Mends de
Atajo

Dar click en el bot6n derecho del mouse despliega un mend de persiana
de comandos usados frecuentemente ilamado meni de atajo. El mend
aparece en laubicacién del sefialador del mouse, de modo que estaes una
manera ripida de seleccionar comandos sin mover el sefialador 2 1a barra
de Meniis o a la barra de Herramienta. Las opciones del menii de atajo
dependen de 1a ubicaci6n del sefialador.

Cajas de Didlogo

Muchas operaciones de Excel se controlan con cajas de didlogo. Estas
contienen opciones adicionales que se relacionan a la tarea de Excel que
se desea cjecular. Las instrucciones para usarlas estdn en el Apéndice B.

¥

NOiMBRE

Nueva hoja

Abrir

Guardar

Imprimir

Caja de estilo

Flecha abajo

AutoSum

Negritas
Itdlicas

Amplif Tipo

Reduce Tipo

Alinea 1zq

LECCION 3 E

EQUIVALENTES VIATECLADO)

Crea una nueva hoja de trabajo en blanco
(Shift+F11) .

Abre una hoja de trabajo existente (Ctrl+F12)

Guarda lahoja de trabajoque aparece en la ventana
activa (Shift+F12)

Imprime la hoja de irabajo que aparece en la
ventana activa (Ciel+Shift+F12)

Muestraelestiloenusoen laceldaactivay perniite
aplicar o definir un estilo nuevo (Cirl+$)

Abre |a caja de lista de estilos

Inserta a la celda activa la suma de las celdas en
colwmna sobre ¢lla o en hilera a su izquierda
(Ali+=)

Hace ennegritaselcontenidode unacelda (Cirl+B)
Hace en itdlicas el contenido de una celda (Curl+1)

Agranda el tipo de letra del contenide de una
celdu (Ctri+F)

Achica el tipe de letra del contenido de una celda
{Crl+F)

Alinea los caracteres de una celda con s lindero
izquierdo (Format » Alignment » Left)

TABLA 3.1:

[conos de 1a barra de
Herramienta




COMUNICACION CON EXCEL

SCRIECICN i EQUIVALENTES VIA TECLADO!

Alinea Centro

Alinea Der

Centra entre
Columnas

AutoFormat

Marco

Lindero Infer

Copiar

Pegar formato

ChartWizard

Ayuda

Alinea los caracieres al centro de una celda (For-
mat » Alignment » Center)

Alinea los caracteres de una celda con su lindero
derecho (Formal » Alignment » Right)

Centrael textosobre varias columnas seleccionadas
(Format » Alignment » Center ACross Selection)

Aplica formatos standard a la hoja de trabajo
(Format » AutoFormat)

Coloca un marco alrededor del perfmetro de la
hoja de trabajo (Ctrl+Shift+&)

Coloca una linea de lindero inferior a la celda
{Format » Border)

Inserta al clipboard una copia del contenido de la
celda (Cirl+C)

Insenta un formato de celdas al clipboard
Gulfa paso a paso cn la creacitn de una gréfica

Muestra informacién relativa al contexto (F1)

TABLA 3.1:

Iconos de la barra de
Herramienta
(Continia)

LECCION |

PRESENTACION DE
o

Movlmlent?a enla
hoja de trabajo

Cémo Ihgresar
texto y nimeros

Como Introducir Détlos
enla Hojade T rabaj(l)

hora que esta familiarizado con Excel, necesita

arrancar la primera hoja de trabajo. Ulsaremos
una hoja de trabajo mis bien basica como
ejemplo en esta primera parte del librb. En las
partes que siguen creard hojas de trabajo més
complicadas.

MOVImlemOS pn  Para ingrf:sar informacién en una celda, se requiere activarla p'ri mero. La
celdaactiva(lacelda Al de la pantalla inicial) se identifica por su marco

|a HO]H de grueso. Sus coordenadas aparecen al lado izquierde de la barra de
Trabajo Férm.ula. La anotacién A [ en labarrade Férmula, porejemplo, s'ignif"lca

que la celda A es la celda activa. Los datos gque contenga la celda se
| mostrardn en el espacio Jargo a la derecha de las coordenadas.
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Se activa una celda — estoes se le selecciona—dandoclick enella
con el sefialador del mouse, u oprimiendo las teclas de flecha hasta que
su marco aparezca resaltado. En la Tabla 4.1 se muestran las teclas para
llegar rédpidamente a determinadas celdas.

Se activa una celda con el mouse y las celdas adyacentes aparecen
resaltadas en video inverso, ello guiere decir que el mouse se movid
teniendo oprimido el bot6én. Oprima Esc o dé click de nuevoen la celda
que se quiere activar.

2434 & E5TA POSICION TABLA4.1:
! Qe ' Teclas para moverse en
Home Principio de la hilera (si Scroll Lock estd encendida, pasaa lacelda | la hoja de trabajo
de la esquina superior izquierda de la ventana)
End Si Scroll Lock estd encendida, pasa a la celda de la esquina inferor
derecha de la ventana
PgUp Al principio de la pantalla anterior
PgDn Al principio de Ia pantalia siguiente

Cirl+PgDn | Al principio de a pantalla de la izquierda

Ciri+PgDn | Al principio de la pantalla de derecha

Ctrl+Home| Celda Al

Cirl+End | Celda de 1a esquina inferior izquierda de la hoja de trabajo
End+?T Principio de la columna

End+] Fin de |a columna
End+¢~ |Principio de la hilera
End+— | Fin de la hilera

Como lng[esar Ahora se creard la hoja de c4lculo mostrada en la Figura 4.1. Lahoja de
clculo tiene el aspecto de una tabla, con un titulo y encabezados para

Datos cada columna y para cada hilera. Siga estos pasos:

LECCION 4 21

1. Seleccione la celda A3 — coloque el sefialador en la celda A3
y dé click en el botén izquierdo del mouse. Asegirese de que
la anotacién A3 aparece al lado izquierdo en la barra de
Formula.

2. Teclee Vendor. Si comete un error, simplemente oprima la
tecla de retroceso para borrarlo; luego reteclee el elemento.

Los caracteres tecleados aparecen tantoen lacelda como en la barra
de Férmula. Note también que aparecieron dos cajas en la barra de
Formula cuande empez6 a teclear. La caja de la izquierda con la X se
llama caja de cancelar. Dé click en esta caja u oprima Esc para borrar
lo que se acaba de teclear y empiece de nuevo. La caja de la derecha con
la palomaes lu caja Enter (de ingresar o alimentar datos ). Teclee enesta
¢aja u oprima J para intreducir los datos a la celda.

La linea vertical que parpadea en la barra de Férmula es el punto de
insercién, el cual indica donde va a aparecer el siguiente caricier que se

teclee.
_ . FIGURA4.1:
File Edit Foymuis Forma) Data  Options Macro  Yindow  tHelp Muestra de hoja de
trabajo
A -8 cC It'D " E {< F: G H [~1 rY
! || Bid Requesl Comperatve Anohysis
E:Vendur crPy Speed” RAM Digk. Warranty Pnce
4 |PCs-R-Us 2860 25 4 120 12150045
§ |Doorwey 7860 13 8 160 24 199999
B_jDelisie 4865 25 8 200 12 245095
7 _[2ous 4068 25 4 160 W 23805
[]
$ Al syslgms meet minimum 1dquire ments
19
n
12
13
14
15
1]
(7]
L] 3]
[ +
Ready [ T T 71

f'
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2 COMO ALIMENTAR DATOS A LAHOJA DE TRABAJO

Cuando aparece la palabra Enteren la barra de Estado indica que se
estd en la modalidad Enter. En esta modatidad muchas de las opciones

de los mends de persiana no estén dis

ponibles — sus nombres estén

palidos. Parateneraccesoa 1odas 1as opciones de mentl, déclickenlacaja
Cancel o en la caja Enter para regresar 2 la modalidad Ready.

3. Oprima | para seleccionar la celda Ad.

Al oprimir una tecla de flecha, autométicamente se introducen los
datos a la celda activa antes de que quede seleccionada la siguiente. Si
niot6 haber hecho un errorenuna celda después de haber introducido los
datos, seleccione esa celda de nuevo y reteclee el concepto. Aprenderd
como editar una celda sin reteclear en la Leccién 9.

4,

w = oo

10.

12

Teclee PCs-R-Us.

Oprima | para seleccionar la celda AS y teclee Doorway.
Oprima | para seleccionar la celda A6 y teclee Dellsie.
Oprima |, para seleccionar la celda A7y tecleq Zeus.

Oprima | para seleccionar la celda A9 y teclee All systems
meet minimum requirements. El texto completo aparece en
la barra de Férmula pero en la celda cabré s6lo una parte.

. Oprima .J. Ahora el texto aparece en la hoja de trabajo,

invadicndo celdas adyacenies. Las lineas que separan las
celdas han desaparecido para que el 1exto aparezca contenido
dentro de una sola celda larga.

Seleccione C1 y teclee Bid Request Comparative Analysis.

. Seleccione €3y tecle CPU.

Oprima ¢ para seleccionar D3 y teclee Speed.

14, Imroduch los datos a las columnas C y D:

LECCION & @

13. Llene los elementos faltantes de 1a hilera 3 con los sigﬁiémcs |
datos: }

CELDA CONTENIDQ
E3 RAM

F3 Disk |
G3  Warranty
H3  Price

Not.c que por.opcién preseleccionada, Excel alinea el texto
hacia ¢l lado izquierdo de la celda. Ahora llenemos las o
columnas Cy D. - :

| . |

CELDA CONTENIDO  CELDA  CONTENIDD

C4 386DX D4 25

CS  386DX D5 33 ‘
C6  4865X D6 15 I
Ccr 486SX D7 © a8 ;

Excel automdticamente alinea los nimeros, como en la
columna D, al lado derecho de !a celda. Sin embargo, los
elementos de la columna C se alinean hacia la izquierda | Aun
cuando los elementos de {a columna C empiezan con r;l]-mcros
Excel los trata como texto porque contienen caracteres no ,
numéricos. '
!

Ahora terminemos la tabla,
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15. Introduzca los siguientes datos en las columnas E, F, GyH:

mmmmmmmm

E4 4 F4 120 G4 12 H4 1500.95
E5 8 F5 160 G5 24 H5 1999.99
E6 8 F6 200 Gb 12 Hé6 2450.95
E7 4 F7 160 G7 18 H7 2350.50

E} niimero en la celda HT se muestra como 2_350.5, sin ]

segunda cifra decimal. Por opcitn presc!cccmnada,dE:ff:e Lsi.

quita todos 103 ceros finales a la derecha de punio ecm;xg .

se teclea 99.00, por ejemplo, Excel mostrard 99 en la ce ?.

Aprenderd como hacer que aparezcan Jos ceros finales en la

Leccidn 16. |

Alhacer movimientosen la hoja de trabajo, notard queel Cotr)llemili(;

de la celda activa aparece ala derecha de sus coordenadas en la arr::llda
Eérmula. Sin embargo los elementos que son mds largos qu:: u:)\a c @
aparecen de otro modo. Verd su contenido mosllrado en la _madc!
Foérmula Gnicamente cuando 12 celda que contiene el pnncipio
clemento es una celda activa. Veamos porqué ocurre esto.

-~

ELEMENTOS L.ARGOS EN LAS CELDAS

Los valores numéricos que tienen més fie ocho nimeros gc:icl::\i(;
izquierdo del punto decimal, y nfimeros decimales largos con mas :
ceros a la derecha del punto decimal, aumentan automdticamente

formato exponencial. Por ejemplo, si se teclea 150000000, Excel

mostrard 1.5E+08 en la celda. Esto significa que se nefw que n?(f)vcr De;
punto decimal ocho lugares hacia la derecha para mostrar lg E;Sra.. o
jgual forma, el elemento 0000123 se mosfraré cprno 1.23E- h, lir; -
cando que tendria que mover el punto decimal cinco Iu%ares :cq -
izquierda. Aprenderé en la Leccidn 17 f:émo hacer m ? anc’ a.emq
columnas, y en la Leccion 16, como camb{ar ¢l aspecto de os [;umhaciz;
Los conceptos de 1exto que son demasiado largos seexucrf cnd e
Jas celdas adyacentes en blanco. Apesardequeel lilul_o s€ mueslraE le o
de una celda alargada, 1as celdas sobre las que se encima-—— D1, ELy-

LECCION 4 @

— siguen existiendo como entidades separadas. Se puede aclivar
cualquiera de estas celdas e introducir datos en ellas. Al introducir datos
en cualquiera de estas celdas se afectard la manera en que se despliega
el titelo. Por ejemplo si se introduce informacidn en lacelda El, el téxto
de Ja C1 ya no aparacerd en las E1 y FL.

Aun cuzndo los textos no se muestren, permanecen en la memoria
de Excel. Si mas adelante se borra ¢l texto de la celda El o se ensanchan
las columnas, el resto del texto de C1 reaparecerd en la hoja de trabajo.

Para adquirir conciencia de esto, active la celda D1. Note que las
coordenadas de la celda aparecen en la barra de Férmula pero no figura
ningdn contenido. Se debe a que las celdas DI, El y FI estdn adn
realmente en blanco. El titulo de la celda C1 se muestra sobre ellas sélo
porque permanecen vacias.

Como INTRobUCIR NUMEROS coMmo TEXTO

Hasta aqui en esta leccion, se han alimentado dos Lipos de datos — texto
y nimeros. El texto se alinea a ia izquierda, y los nidmeros a la derecha
de la celda. Aprenderd mis adelante en esta leccién como cambiar el
alineamiento de datos en las celdas.

Ahora suponga que desea introducir niimeros como encabezado de
columna, por ejemplo los aiios 2000, 2001, 2002, Si desea que los anos
se alineen hacia la tzquierda, se le debe ordenar a Excel tratartos como
lexto. Para ello empiece el tecleo con comillas (). Las comillas
apareceran entaceldahastaquese seleccione lacajaEnter ose activeotra
celda.

Si se estén usando niimeros como encabezados de columnas o de
hileras, conviene introducirtos como texto. Los nimeros que se introducen
como texto no pueden usarse en operaciones arilméticas, asi es que no
es posible sumar accidentalmente a totales de columnas o renglones ni
ser usados en férmulas.

Uso de Barras
de Recorrido

Hay harras de recorrido a la derecha y en la parte inferior en la hoja de
trabajo. Se pueden utilizar para seleccionar una celda que no esté visible
en la pantalla. Las flechas en los extremos de las barras de recorrido
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desplazan la hoja de trabajo vertical y horizontaimente. Use la barra de
recorrido de la derecha para desplazar la hoja de trabajo hacia arriba y
hacia abajo por hileras. Use la barra de recorrido de abajo para desplazar
la hoja de trabajo hacia laderecha y hacia 1a izquierda por columnas. La
caja que estd dentro de cada barra de recorrido se 1lama especificamente
cajade recorrido. Sele puede arrastrar hastauna posicion descadadentro
de 1a hoja de trabajo.
Use las barras de recorrido como sigue:

@ Para recorrer hilera por hilera, dé click en las flechas que
apuntan hacia arriba o hacia abajo en los extremos de la barra
de recomrido del lado derecho.

a Para recorrer columna por columna, dé click en las flechas que
apuntan hacia derecha e izquierda que estdn en los extremos
de 1a barra de recorrido de la parte inferior

m Para recorrer pantalla por pantalla dé click arriba o abajo de la
caja de recorrido.

@ Para recorrer rdpidamente hacia una posicién determinada de
\a hoja de trabajo, arrastre 1a caja de recorrido al drea relativa
de la posicién que se desea localizar. Por ejemplo, para
mostrar una hilera que estd a la mitad de la hoja de trabajo,
arrastre 1a caja de recorrido hasta fa mitad de la barra de
recorrido derecha.

Note que este método generalmente le acerca iinicamente a
la posicion deseada. Una vez que se ha llegado al drea general,
puede ser necesario recorrer hilera por hilera o columna por
columna hasta encontrar la posicién exacta deseada.

L ECC
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PRESENTACION D2

|
Cémo imprimir la
hoja de trabajo
entera

Coémo selecclonar
1
la impresora

Impresion de
una Hoja de Trabajo

iendo una aplicacién de Windows, Excel puede
imprimirhojas de trabajoy graficasen cualqﬁier
impresora que ya esté instalada en el ambiente
de Windows. La hoja de trabajo impresa se
vera tal como aparece en la pantalla, cor‘hpleta
con sus tipos TrueType y en color, si sé lliéne

una impresora de color.

i
'

En esta Jeccién verd qué ficil es imprimir hojas dc‘lrabajo.
|

Usaremos dos méloedos para imprimir las hoj j
primir las hojas de trab.
cred en la Leccitn 4. : wode mu‘:'S”aq“e
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C6mo Imprimir
desde ia Barra
de Herramienta

Siga ¢stos pasos para imprimir {a hoja de trabajo muestra usando la barra

de Herramienta:
i. Localice el bot6n de impresién. Su icono es una impresora, ¥
estd ubicado en el cuarto lugar desde Ia izquierda en la barra
de Herramienta (refiérase a la Tabla 3.1

2. Dé click en el bot6n de imprimir en la barra de Herramienta.

Se verd una caja de didlogo que identilica la pagina que se estd
imprimigndo, el rombre de lahojade trabajo, y laimpresoraen uso. Para

cancelar la impresién, selecciane el botsn Cancel de 1a caja de diflogo.

Cuando se acaba de imprimir la hoja de trabajo, desuparece la caja de
didlogo. .
Excel imprime las hojas de trabaje incluyendoel lindero perimetral
de celdas, — es decir, las lineas alrededor del perimetro de la hoju de
trabajo son més oscuras que las lineas entre celdas. La hoja de trabajo se
define como ¢l 4rea rectangular en la cual la celda Al estden laesquina
superior izquierday la dltima celda que contiene datos estd en laesquina
inferior derecha. E nombre de 1a hoja de trabajo se imprime hasta arriba
de la pagina y el nimero de pagina se centra en la pante inferior.

Note que la hoja de trabajo en la pantalla incluye ahora una linea
vertical punteada entre las columnas H e L. (La posici6n puede cambiar
dependiendo de la impresora.) Esta linea indica la orilla derecha de
pagina. Recorra la hoja de trabajo hacta abajo y veré una linea punteada
horizontal que marca la orilla inferior de pigina.

Es muy practico imprimir desde la barra de Herramienta, pero si se
deseatener contro del proceso de impresion, se requ iere usar el comando

Print del meni File.

Como Usar el
Comando Print

£] comando Print del ment File ofrece otra manera de imprimir las hojas
de trabajo. Siga estos pasos para imprimir la hoja de trabajo usando el
meni:
1. Seleccione File » Print {(Ctrl+Shift+F12) para mostrar la
caja de didlogo Print, igual a la de la Figura 5.1.

LECCION 5 a

OPCION

Print Range

Print Qualiey

Print

Page Setup

Copies
Preview

Fast, but
ho graphics

Prntor:  Delaul Print

s o P it
P g [ comew §
s
| € Poges

- O e i 2 ettt e et

1
| shast  Comges O o |

DESCRIPCION

Ra P - \
EOd:glo a 1m.pmmr) P.or opcién preseleccionada Excel imprime

s las paglnasFie hojas de trabajo largas. Para hacerimpresiones
E;r.cm e;. s.eleccmne ¢l bot6n Pages, luego teclee la primera y la

ima pigina que desea imprimir en l: j
P 4s cajas de text

respectivamente. ’ oFromyTo
f](i?‘ahda.ld de lmpresi_én) Seleccione de entre las resoluciones
. spenibles para su impresora. (Las opciones cambian de una
1rT11;)llresora a otra.) Dependiendo de su modelo de impresora, los
pardmetros pueden afectar unicamente las ldminas y préficas

flrr;prime) Para seleccionar imprimir sélo Sheet (la hoja de
rabijo), s6lo Notes (los comentarios que es iblei

el o Both (b, yue es posible insertar en las
('Cr:u?ﬁguraciéndepégina)Desp!iegaunacajadediélogopam fijar
el aspecto general de la pdgina. Las opciones de esta caia s

describen en la Leccién 28. e
(Tantos} Parateclear el numero de ejemplares que desea imprimir.
FPICVISla) Mu.estra en pantalla un facsimil gréfico de la hoja
impresa. Preview se explica en la Leccidn 29, !

s)Rél?Jdu. pero sil'll dibujos} Imprime un ejemplar burdo para
orrador, de la hoja de trabajo, sin dibujos de ninguna clase.

FIGURA 5.1:
Lacaja de didlogo
Print

TABLA 5.1:

Opciones de ta caja
de didlogo Print
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LaTabla5.1 describe las opcionesexistentes en estacajade didlogo.

2. Seleccione OK.
Verd una caja de didlogo que muestra el estado del trabajo de
impresién. Al terminar la impresién de la hoja de trabajo desaparece la
caja de didlogo.

Como
Seleccionar
a Impresora

Si la hoja de trabajo no se imprimié o si la impresién no se asemeja a lo
que apareceen la pantalla, tal veztendrd que seleccionarimpresora desde
dentro de Excel.

Seleccionar impresora es especialmente importante cuando se tiene
mis de una conectada al sistema. Ser4 deseable usar una impresora en
blanco y negro para impresiones rdpidas de borrador de las hojas de
trabajo y una impresora de color para los ejemplares finales de las hojas
de trabajo incluyendo tablas y gréficas.

Es necesario seleccionar una impresora dnicamente la primera vez
que se usa Excel o cuando se cambie de impresora. Noes necesario seguir
estos pasos cada vez que se desee imprimir una heja de trabajo.

1. Seleccione File » Page Sctup para mostrar la caja de didlogo
Page Stup (Aprenderd a usar esta caja de didlogo en la Leccidn
28.)

2. Seleccione Printer Setup para mostrar la caja de didlogo
Printer Setup que muestra la Figura 5.2

FIGURA 5.2:
La caja de diflogo
Printer Setup

LECCION 5 S—TI
I

Se mosirard una lista de las impresoras disponibles con los puertos
seleccionados para eilas, por ejemplo !

PCL/HP Laser|et on LPT1:
Postscript printer on COM1:

{PCL/HP Laserjet en LPT1: '
Impresora Postscript en COM1:) J

1

3. Seleccione la impresora que esté conectada a su sistema, luego
OK para regresar a la caja de didlogo Page Setup.

4. Seleccione OK para regresar a la ventana de hoja de ilrabajo.

Excel s6lo puede usar impresoras que estén instaladas al ambiente
Windows. 51 la impresora ne estd en la lista de lacaja de diél(l)gé), WESET
impresora estd conectada a un puerto que no sea uno de los molslrados,
o si el puerto estd indicado como none, habré que salir de Excel ¥ usar
el Panel de Control de Windows para instalar y configurar la irﬁpresora
antes de que pueda imprimir hojas de trabajo. En el Apéndice,A!sc tiene

informaci6n acerca de configuracién de impresoras de Windows.
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LECCION

Cémo Al guardar una hoja de trabajo por primera vez, es cuando se liene
) JO por p
G d oportunidad de darle nombre. Los nombres de hojas de trabajo pueden
cb uardar la hoja uardar un tener de uno a ocho caracteres de longitud.
mo g - ; ; s acab: sur hai
de trabajo al disco Documento Quogl%agdenlos la hoja de trabajo que acaba de crear bajo el nombre
mo guardar ' ' ,
un(a;:ola ?19 trabajo por anera 1. Dé click en el botén de guardar de la barra de Herramienta (el
editada Vez tercer botén desde la izquierda, que t.iene el icono de un
Opclones al disco), o seleccione File » Suve (Shift +F12), para mostrar la
:cuardar caja de didlogo Save As, mostrada en la Figura 6.1,

El nombre SHEET1.XLS aparece en videe inverso en‘la caja
. de texto Filename. Si no se introduce un nombre nuevo, la
Almac enamlento hoja de trabajo quedard guardada como SHEET . XLS.

2. Teclee QUOTES, luego oprima .. Después de darle nombre

| de 1a HOj a de Trabaj 0 al archivo, éste aparece en la barra de Titulo.

' Cuando Excel guarda una hoja de trabajo, automdéticamente le

. . e s a la extension . XL5 a su nombre. Asi es que QUOTES queda
ificaalmacenarla agrega 4

uardar una hO_]ade trabajosign realmente guardado como QUOTES. XLS. Estohace mds facil distinguir

entre las hojas de trabajo y otro tipo de archivos en el disco. De hecho,

lirse d mds adelante al leer de disco la hoja de trabajo verd que Excel presupone
trabajo, al apagar la computadora O salirse de que el documento tiene esa extension.

en el disco. A menos que se guarde la hoja de

Excel queda perdida para siempre. Sise hacen

cambios a una hoja de trabajo despies de FIGURA 6.1-
La caja de didlogo
guardarla, es necesario guardarla de nuevo. De La i
esa manera los cambios hechos a la version = . %EZ-\ : EC'E—
: o . encel
original quedaran registrados en el disco. | £ s
1 | ga
Se debe puardar el trabajo a intervalos regulares. De esta manera w ‘ :
no se perderd mucho si por alglin problema en la computadora 0 alguna comrm et D
falla de la electricidad la computadora se apaga 0 s¢ rearraica. o 1 (oo AC
En esta leccién guardaré 1a hoja de trabajo que acaba de crear € oma o
imprimir.
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Sinosedeseaunaextension XLS teclee su propiaextensitn al darle
nombre al archivo. Sin embargo esto hard mas dificil de leer de disco ese
archivo més adelante. Lo que si debe evitares el uso de algunos nombres
de extension que estdn reservados para tipos especiales de programas;
por ejemplo, .EXE y COM se usan-para nombres de programas, BAT
representa archivos de gruposy SYS identificaarchivos de sistemas que
son utilizados por el sistema operativo.

Exce} guarda las hojas de trabajo en el directorio Excel del disco
duro. Para guardarlos en otro directorio, seleccione el nombre del drive
y del directorio en las cajas de lista Save As. También se puede guardar
el archivo en otro formato que no sea Excel — abra la caja de lista Save
File as Type y seleccione el formato deseado. Las opciones incluyen
Lotus 1-2-3 y otros programas de hoja de trabajo conocidos.

El guardar una hoja de trabajo no laquita de la pantalla, para que s¢
pueda seguir trabajando en ella.

Gomo Guardar
una Hoja de
Trabajo Editada

Después de haber guardado y dado nombre a una hoja de trabajo por
primera vez, la siguiente vez que s¢ dé click en el boton de guardar (oque
se dé el comandao File »- Save) para¢sa hojade trabajo, Excella guardard
inmediatammente, y Ja caja de didlogo Save As no apareceré.

Si se desea guardér 1a hoja de trabajo bajo un nombre nuevo,
seleccione File » Save As (F12) paramostrar esacajade dialogo. Teclee
un nuevo nombre de archivo, y luego seleccione OK.

Cémo Hacer
Hojas de
Respaldo

Cuando se guarda una hoja de trabajo editada bajo el mismo nombre gue
la versién original, la copia original s¢ borrard. Si se deseaconservaruna
copia de la versién original sin cambios en el disco, ordene a Excel que
haga copias de respaldo. Asi, al guardar la hoja de trabajo usando el
comando Save, Excel da a la copia original la extensién BAK y guarda
la nueva versién con el mismo nombre pero con la extension
preseleccionada .XLS.

LECCION 6 35

Para hacer copias de respaido, siga estos pasos:

1. S.eleccione File » Save As (F12) » Options. Verd 1a caja de
dll:ilogo Save Options (Opctones al guardar) que muéstra la
Figura 6.2. I

2. Seleccione Create Backup File (Crear archivo de respaldo)
luego seleccione QK. '

Repita estos pasos si mas tarde desea apagar esta funcién.
H

FIGURA*G.?:
La caja de didlogo
Save Oplionls

Como Proteger
las Hojas de
Trabajo

Aptcs de guardar la hoja de trabajo, use 1as otras opciones de la caja de
didlogo Save Options puradarcierta seguridad de que nadie canlﬁiarjfi su
hojas de trabajo. ‘ -

En lacajade texto Protection Password (Contrasefia de Proteccién)
teclee ur?a contrasena (de hasta 15 caracteres) la cual serd indisp'eneable
para abrir ta hoja de trabajo. Aparecen asteriscos en esta caja de lc)-uo al
teclear. Debido aque lacontrasefia en sinose muestra, es posible cometer
un error de tecleo, quedando asi asignada una contraseia incorrecta. Si
esto sucediera despdes seria imposible abrir el documento 'us‘ando. la
cont_rascﬁa deseada. De mode que al seleccionar OK apa'reccrﬁ otra caja
dedlalég(.), pidiéndole reteclear lamismacontrasefia. Las dos contlrascﬁ;s
deben coincidir antes de que Excel guarde el documento.

En 'Ia caja de texto Write Reservation Password (Confraseﬁa de
Restriccién de Cambios), teclee una contrasciia que serd necesaria al
guardar una copia editada de la hoja de trabajo. Una vez mds ‘apéarecerz’x
una scgtﬁnda caja de didlogo solicitando que se reteclee ta |misma
contrascia. !
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Utilizando combinaciones de contrasefias, puedencrearse diferentes

niveles de proteccitn. Porejemplo, siseusa unacontrasefiade Restriccion
de Cambios perono se usa contrasefiade proteccién, Jos usuarios pueden .
abrir 1a hoja de trabajo pero se les restringe la posibilidad de hacer
cambios en ella, La maxima seguridad se obtiene del uso de ambas com
o cerrar la venta-
contrasefias. na de hoja de trabajo
Cdmo arrancar una

Seleccione Read-Only Recommended (Se Recomienda Lectura
Unicamente) cuando se desea que el usuario decida acerca del tipo de
acceso. Aparecerd un mensaje recomendando que el usuario abra lahoja
de trabajo dnicamente para Jeerla, pero no seré una restriccién forzosa.

' Cémo terminar la

Terminacién :riesidn-de Windows
de una Sesion de Hoja
de Trabajo

na vez que se guardd la hoja de trabajo, se

hoja de trabajo nuava
Como salir de Excel

puede continuar trabajando en ella, arrancar
otra hoja de trabajo, o salir de Excel. Cuando
se ha terminado de trabajar Co-n Excel, debe
salirse del programa y regresar a Program
Manager de. Windows. Antes de apagar la
computadora, también debe salirse de Windows
y regresar al llamador DOS. Si se apaga la
computadora antes de salir de Excel y de

Windows, podrian dafiarse los archivos que

) ) ‘ ' mas adelante necesitara. ‘
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En esta lecci6n, aprenderd c6mo arrancar o iniciar una hoja de
trabajo nueva y cémo salir de Excel y de Windows.

Cémo Despejar
la Ventana

El cerrar una ventana borra la hoja de trabajo de la pantalla y de la
memoria de la computadora, asf que no cierre la ventana a menos que ya
haya guardado la hoja de trabajo al disco, 0 a menos que haya cambiado
de opinién y no desee guardar lo que acaba de hacer,

Siinicia una nueva hoja de trabajo antes de cerrar una ya existente,
tendrd dos ventanas de hoja de trabajo abiertas a la vez. Esto facilita
mover y copiar datos entre hojas de trabajo, pero aumenta la cantidad de
recursos de Ja computadora utilizados por Excel. (Aprenderd cémo
trabajar con varias ventanas, en la Leccién 26.) §i no requiere mds que
una hoja de trabajo abierta a la vez, cierre cada ventana de hoja de trabajo
antes de empezar con otra.

Para cerrar 1a hoja de trabajo QUOTES que cred en las lecciones
anteriores:

m D¢ doble click en la caja de control que aparece en el extremo
izquierdo de la barra de Titulo de la ventana de la hoja de
trabajo. (No use la caja de control de Excel). O bien,
seleccione File » Close (Ctrl+F4).

El espacio de trabajo de Excel se despeja dejando dnicamente las
opciones File y Help mostradas en su barra de Memi. Ahora que la hoja
de trabajo est4 cerrada, se puede iniciar una nueva..

Sitrata de cerrar una hoja de trabajo que haya sido editada o que esté
nueva sin haber sido guardada, vera una caja de didlogo con el siguiente
mensaje

Save changes to "QUOTES.XLS"?
(¢Se guardan Jos camblos a "QUOTES.XLS"?)

Seleccione Yes para guardarla, o No para cerrar la hoja de trabajo sin
guardarla.

LECCIONT @

Cémo Iniciar
una Hoja de
Trabajo

Cuando termine de trabajar en una hoja de trabajo, puede iniciar otra sin
salir de Excel. Asf se inicia una nueva hoja de trabajo:

w Dé click en el botén de hoja nueva de la barra de Hérram:enta
(el primer bot6n de la izquierda, cuyo icono se ve como una
hoja de trabajo). O bien seleccione File » Ncw(Stht+Fl 1%
luego seleccione OK en la caja de didlogo que aparece.

Aparecerd una nueva hoja de trabajo en cuya barra de T{tlulo se le
dael nombre Sheet y un ndmero consecutivo, estoes Sheel2, Sheet3, etc.

Como Salir
de Excel

Cuando termine de trabajar con Excel, salga del programa como sigue:

m D¢ doble click en la caja de control de la ventana de E lccl —
que es el rectdngulo de la izquierda en la barra de ttulo de
Excel — o bien seleccione File » Exit(Alt+F4).

Si trata de cerrar Ja ventana antes de guardar una hoja dc trabajo
editada, se le preguntar4 si desea guardarla. Seleccione Yes para guardar
los cambios, o No para cerrar |a ventana sin guardarlos. Esta es una
manera rdpida de guardar una hoja de trabajo y salir de Excel en un solo
paso. '

Cuando Excel termina aparece Ja venlana de Program Manager de
Windows. ‘

Como Salir de
Windows

Se sale de Windows desde la ventana de Program Manager. Si Program

Manager estd en forma de icono en la parte inferior del eSCnchmO dé

doble click en ¢l icono u oprima Alt-Tab para restaurarlo a ventana,
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Cuando se desee regresar a un llamador DOS, salga de Windows

siguiendo estos pasos:
|. Dé doble click a la caja de control de Program Manager u
oprima Alt+F4. Aparecerd una caja de didlogo con el mensaje.

This will end your Windows session

Aplicacion de las

2. Seleccione Yes u oprima .. {Seleccione Cancel u oprima Esc
si desea permanecer €n Windows.)

Ahora puede apagar la computadora sin arriesgarse a dafiar los , .
de respaldo de las hojas de Tecnlcas EsenCialeS

archivos. Para su seguridad haga copias
trabajo imporiantes en diskettes,
En vez de requerir que usted teclee o calcule el

contenido de una celda, Excel le sirve como socio activo al ir
construyendo su hoja de trabajo. Dandole los comandos ¢
instrucciones necesarias a Excel, puede hacerse .que ejecute
operaciones matematicas, llene encabezados de celdas
inteligentemente, y absorba la mayor parte del esfuerzo de
crear una hoja de trabajo.

En las lecciones que siguen aprenderd como Excel puede

ayudarle a desarrollar sus hojas de trabajo.
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PRESENTACION DE

Cémo abrlr una
hoja de trabajo

Como trabajar con
hojas de trabajo
protegldas

Apertura de
Hojas de Trabajo

s posible que no termine una hoja de trabajoen
‘una sola sesidon de Excel. Para continuar
trabajando en una hoja de trabajo existente —
o para editarla o imprimirla — primero se le
debe abrir, o leerla del disco en el cual fue
almacenada. Cuando se abre una hoja de
trabajo, se le carga en la memoria de la
computadora y se le muestraen una ventanade

la pantalla.

En esta leccidn, aprenderd c6mo abriruna hoja de trabajo y cémo
preparar hojas de trabajo para lectura solamente. Estas \iltimas son
aquéllas que se desea que no sean cambiadas.

>
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Como Abrir un
Documento
Existente

L -

Excel simplifica abrir la hojas de trabajo que han sido guar;dalus. Siga
€stos pasos para abrir 1a hoja de trabajo QUOTES, \

1. Arrangue Excel para Windows.

2. Cierre la ventana Sheet | — dé dobie click en su Cd_]d de
control u oprima Ctri+F4.

3. Seleccione File para mostrar el mend de persiana respectivo,

Note que el nombre QUOTES . XLS estd mencionado al |l“nul del

mend, arriba del comando Exit, después del ndmero ! subrayado. Excel .
agrega al meni File los nombres de las dltimas cuatro hu_]as de irabajo
€n que se ha trabajado, numerdndolas de | a 4.

4. Oprima 1. La hoja de trabajo QUOTES se lee de disco y se
despliega.
Al abrir una hoja de trabajo, la celda activa serd la que
estaba en tal situacién al guardar la hoja de trabajo porI tlima
vez.

5. Sino esid listo para continuar con la siguiente leccion, |[salga
de Excel — dé dobie click a la caja de control de la ventuna de
Excel u oprima Al+F4.

Como ABrIR OTrAS Hosas DE TRABAJO

El mend File puede enumerar hasta cuatro hojas de trabajo, asi que si
tiene més de cualro, no todas aparecen en el mend. Para abrir una hoja
de trabajoqueno esté enumerada en el mend, dé click en el b(:tén de abrir
(¢l segundo desde la izquierda) de la barra de Herramienta, o se]cccuone
File » Open (Cirl+F12), para mostrar la caja de dlﬁlObO Open que
muestra la Figura 8.1.

La caja de didlogo Open enumera todos los archivos quc tiencn
extension XLS localizados en el directorio Excel de! disco dluro Dé
doble click en el nombre de la hoja de trabajo que se desea .lbnlr 0 resalte
sunombre y luego seleccione OK. Si la hoja de trabajo que se desw estd
en otra ubicacién, selecctone el disco y dircetorio apropiadr.s dL iz caja
de lista Drives y Directories. Los nombres de los archivos XLS de esu
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FIGURA 8.1:
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ubicacion aparecerdn en lista.

Si guardé su hoja de trabajo con una extensi6n diferente de XLS,
seleccione All Files (*.*) en la caja de lista List Files of Type, ¢ teclee
su extension usando la forma * EXT, en la caja de texto File Name. Por
ejemplo, si se teclea * MWS se producird una lista de todos los archivos
que tengan exlensién . MWS,

L.a caja de'lista List Files of Type también inlcuye opciones para
abrir otros documentos Excel, como macros, y para abrir archivos de

formatos usados por otros programas, por ejemplo, dBASE y Lotus .

1-2-3.
Si se desea abrir un documento sélo para leerlo o imprimirlo,
" seleccione la caja de palomeo Read Only (Sélo leer) de lacaja de didlogo
Open antes de seleccionar OK. La anotacién (Read Only) aparecerd
después del nombre de 1a hoja de trabajo en la barra de Titulo. En esta
modalidad, Excel no permite guardar la hoja de trabajo bajo el mismo
nombre. Si se hacen cambios a Ia hoja de trabajo, tendré que darsele a la
versién editada un nuevo nombre al guardarta.

CoMo ABRIR DOCUMENTOS PROTEGIDOS

Al tratar de abrir un documento al que se le ha dado una contrasefia de
proteccion, aparece unacaja de didlogo pidiéndole que teclee lacontrasefia.
Si se teclea una contrasefia equivocada aparece una caja de didlogo con
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el mensaje

fncorrect Password

{Contrasefa Incorrecta)

en la pantalla. Seleccione OK para quilar el mensaje y regresar a la
ventana Excel.

Si se le dio a la hoja de trabajo una contrasefia de reservacion de
cambios, verd una caja de didlogo como la mostrada en ta Figura 8.2, Se
puede teclear la contraseia para tener acceso completo a la hoja de
trabujo o seleccionar Read Only para abrirla en la modalidad de Lectura
Solamente.

Si la hoja de trabajo fue puardada bajo la opcién Read Only
Recommended, aparecerd una caja de didlogo con el mensaje

"QUOTES.XLS" should be opened as Read-Only
unless changes to it need 1o be saved. Open as
Read-Only?

("QUOTES.XLS" debe ser abierta como Read-Only a
menos que se tengan que guardar cambios. Abrir
como Read-Only?)

y las opciones Yes, No, Cancel y Help. Seleccione No para abrir la hoja
de cdleulo con pleno acceso o seleccione Yes para abrir lu hoja de ¢dlculo
en la modalidad de lectura solamente

FIGURA 8.2:
Licuja de didlogo
PART1.XLS is tosstved by 2
oA Prsoord

Enter pazsword for waite

acceas. of open read only,

Pacsmord: li—_wrr*# Read Dnly l
Help _j
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“PRESENTACION OF

Coémao editar el
contenido de celdas

Cémo deshacer
acclones

Cémo seleccionar
varias celdas

Manipulacion
del Contenido
de las Celdas

n esta leccién aprendera cémo editar los datos

Cémo mover y coplar
celdas

Cémo borrar el
contenido
de una celda

. de una celda en vez de reteclear su contenido
completo. Tambien aprenderd cémo borrar la
informacién que estd en una celda y c6mo
mover y copiar informacién a otra ubicacidn

dentro de la hoja de trabajo.

Las técnicas que aprenderd en esla leccidn se aplican al contenido
de unacelda, més que alaceldaen si. Cuando se " mueve unacelda”, por
ejemplo, se estd moviendo el contenido de la celda a otra ubicacién.

L -

wecoons | 4]

Como Editar la
Informacion de
una Celda

Cuando se selecciona una celda y se empieza a teclear, el contenido
anterior de la celda se borra. Si se selecciona la caja Cancel o se oprime
Esc antes de teclear los datos nuevos, se restaura ¢l contenido 6riginal.

Para editar una celda en vez de reteclearta completa, se depe entrar
a modalidad Edit. Seleccione la celda, mueva el sefialador del mouse -
sobre el contentdo de la celda en la barra de Férmula, luego dé|click al
botén del mouse en el punto donde desea cambiar o insertar datos. La
palabra Edit aparecerd en la barra de Estado, y un punto de insercién que
parpadea aparecerd en la barra de Férmula. Arrastre el qenala'dor del
mouse sobre los caracteres que se desea borrar, luego oprima Ial tec Ta Del.
Para seleccionar todo el conienido de 1a celda, dé€ dobie click en ‘Ia barra
de Férmula. Para reemplazar caracteres, resilielos en la‘ barra de
Férmula, luego reteclee la nueva informacién.

También se puede entrar ala modalidad Edit seleccionando la celda
y oprimiendo F2. Luego mueva el punto de insercién con lasltelclaa -
y + a la ubicacién del cambio o insercion, Oprima Del para borrar
caracteres hacia la derecha del punto de insercién, oprima Retomo para
borrar caracteres hacia la izquierda.

Usemoslamodalidad Edit paracambiar la hoja de trabajo QUOTES.

1. Amanque Excel, cierre la ventana Sheet1, y abra la hoja' de
trabajo QUOTES.
2. Seleccione la celda HS5.

3. Arrasire ¢l seflalador del mouse — el sefialador aparecerd
como vigueta I — sobre el nimero 9 de la barra de F6rmu|a.
luego teclee 8.

4. Seleccione la caja Enter u oprima .1,

Poropcién preseleccionada la modalidad Editentra en modalidad
Insert (Insertar). Esto significa que al teclear caracteres nueves, los
existentes (a menos que estén selecionados) se moverdn hacialaderecha.
También se puede remplazar caracteres sin seleccionarlos primero.
Oprima la tecla Ins para hacer aparecer las letras OVR en la ;ba‘rra de
Estado. Ahora cada cardcter nuevo que se teclee remplazard al existente

. . I .
anteriormente. Oprima Ins una vez mds para regresar a la modalidad
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Insert. Ahora que se estd esta en la modalidad Overtype (Reemplazo de
caracteres, o sobreescritura) se debe lener cuidado de no reemplazar
accidentalmente caracteres que no se desea borrar. Sin embargo, si se da
cuenta, estando atn en modalidad Edit, que borré algo accidentalmente
oprima Esc para abandonar los cambios.

ComMo DEeSHACER CAMBIOS

Aun después de haber introducido texto nuevo en sustitucion de
otro, se puede deshacer un cambio usando el comando Edit »
Undo(Cirl+Z). Este comando cancela la dltima accién tomada. 5i se
selecciona Undo inmediatamente después de editaruna celda, se restaura
su contenido original. Una vez que se empieza a teclear en una celda
nueva, o se lleva a cabo cualquier operacién que no sea la de seleccionar
una celda, el cambio ya no se puede deshacer.

El nombre completo de laopciénmostradaencel ment Edit depende
de la accién tomada antes de abrir el mend, sin embargo la tecla de atajo
siempre es Ctri+Z. Por ejemplo, la opci6n se puede mostrar como Undo
Entry (Deshacer tecleo), Undo Font (Deshacer tipo), Undo Clear
(Deshacer borrado), o incluso como Redo Entry (Rehacer tecleo) para
cancelar el dltimo comando de deshacer.

Como
Seleccionar
Varias Celdas

Hay veces en que se desea llevar a cabo una operaci6n que afecta a mis
deuna celda. En vez de tener que copiar varias una por una, serfa mas facil
seleccionar el grupo entero de celdas y copiarlas en un solo paso.

Para seleccionar un grupo de celdas con el mouse, cotoque el
sefialador del mouse (con la forma de un signo mds (+), grande) en la
primera celda del grupo, oprima el bol6n izquierdo y manténgalo
oprimido, luego arrastre el sefialador hasta la vltima celda del grupo y
suelte el botén. Todas las celdas del grupo, excepto la primera, aparecen
en video inverso, y un marco grueso rodea el grupo entero. La Tabla 9.1
enumera otras técnicas de mouse para seleccionar celdas.

También se puede seleccionar un grupo de celdas usando el teclado.
Active la primera celda del grupo, oprima y mantenga oprimida la tecla
Shift, luego use las teclas de flecha para seleccionar la Gitima celda del
grupo. Otras teclas para seleccionar celdas se muestran en la Tabla 9.2.

—_——

PARA SELECC.

Una columna
Vurias columns.
Una hilera
Varias hileras
Hoja entera
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EJECUTE ESTAACCION

D¢ click sobre la letra de esa columna

Arrastre el sefialador sobre las letras de las columnas

Dé click sobre el nimero de esa hilera

Arrastre el sefialador hacia abajo (0 arriba) sobre sus mimeros

Dé click enel botén Select Atl (que estd sabre los encabezados
de hileras y a la izquierda de los encabezados de columnas)

Celdas no ady. | Déclick enlaprimeracelda, luego oprima Ctrl y dé click sohre
cuatquier otra celda que desee seleccionar
Girupos no ady.  { Oprima Ctrl y arrastre ¢l mouse sobre cada grupo

TABLA 9.1:
Técnicas de mouse
para seleccionar
celdas

PARA SELECCIONAR OPRIMA

[ Ctri+Shifts |

Desde [a celda activa, hasta el diltimo elemento
ingresado en ta columna o hasta el fin de la columna, lo
que ocurra primero.

Desde la celda activa, hasta el primer elemento
ingresado en Ja columna o hasta el principio de la
celumna, lo que ocurra primero.

Desde la celda activa, hasla el ultimo elemento
ingresado en la hilera o hasta el fin de la hilera, lo

que DCUITa primero.

Desde la celda activa, hasta el primer elemento
ingresado en la hilera o hasta el principio de la hilera,
lo que ocurra primero.

L.a hilera entera.

La columna entera

La hoja de trabajo entera

Ctri+Shife+ T

Ctrl+Shift+ —

Ctrl+Shifi+

Shift+Barraespacio
Cirl+Barra espacio
Crrl+Shift+Barra esp

TABLA 9.2:
Técnicas de leclado
para seleccionar
celdas
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Como Mover y
Copiar el
Contenido de.
Celdas

Si se introduce informacién a la celda equivocada, se puede mover la
informaci6n rapidamente o hacer una copia de ella hacia otra ubicacién
en vez de reteclearla. Se mueven y se copian celdas usando la técnica del
mouse llamada arrastrar y soltar (drag and drop). Esto significa que se
arrastra el contenido de la celda hasta su nueva ubicacion, luego se suelta
el botén del mouse, soltdndolo en su lugar,

Para mover unacelda, use el bot6n del mouse solamente, Moveruna
celda la borra de su ubicacion original. Para copiar una ceida, oprima y
mantenga oprimida la tecla Ctrl mientras suelta el botén del mouse.
Cuando copie unacelda, estard haciendoun duplicadode ellaen sunueva
ubicacién sin cambiar la celda original. Para ambas técnicas primero se
debe posicionar el sefialador del mouse para que se transforme en flecha.

Probemos estas técnicas ahora para cambiar la hoja de trabajo
QUOTES a fin de que aparezcacomo muestra la Figura 9. |, Empiece por
mover el texto de la celda A9 hacia abajo una hilera.

[II: Edll Formula

Formny

FIGURA 9.1:

La hoja de trabajo
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4
l

1. Seleccione la celda A9. ‘ ‘

. s |
2. Coloque ¢l sefialador del mouse en uno de os linderos de la
celda. El sefialador se transforma en flecha, indicando que
puede arrastrar y soltar la celda. :

3. Con el sefialador con forma de flecha, oprima y manieng.l
oprimida el botén izquierdo del mouse, arrastre el sefialador
hasta la celda A 10, y suelte el botén. El texla de Ia celda A9
aparecerd ahora en 1a celda A10.

Al arrastrar el sefialador, ¢l marco de la celda que t..st{l
moviende se transforma en una caja de linea punteada y
hoja de trabajo se recorre si es necesario. !

=

Si trata de mover una celda a otra ya existente ue contierie datos,
Excel desplegard el mensaje '

Overwrite non blank cells in destination?
{¢Sobreescribir en celdas ocupadas en el destino?)

y las opciones OK, Cancel y Help. Seleccione OK para reemplazar el
contenido de la celda de destino con la informacion nueva, o seleccione
Cancel para dejar la celda sin cambio.

Ahora hagamos una copia de lahilera 4 y coloquémosla en la hilera
8 de ia hoja de trabajo.

1. Coloque el sefialador del mouse (asegurdndose de que ;cnga la
forma de un signo mds (+), grande) en la celda A4, |

2. Oprima y mantenga oprimido el botén izquicrdo del mouse y
arrastre el seflalador a la celda H4.

Antes de soltar el bot6n del mouse, note que aparece ]a
notacion 1Rx8C en el extremo izquierdo de la barra de
Férmula. Esto indica que lo seleccionado cubre una hilera y 8

columnas. Al soltar el botén del mouse todas las celdas
seleccionadas excepto la primera aparecen en video imjcrio
coma indica la Figura 9.2. |

. [t
3. Apunte al marco que aparece alrededor de la hilera sclcccllona-
da, de tal manera que ¢l seflalador se transforme en flecha,
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7. Mantenga oprimida la tecla Ctrl, suelte el botdén del mouse y
suelte la tecla Cirl.

MANIPULACIQON DEL CONTENLDO DE LAS CELDAS

FIGURA 9.2:
Hilera de celdas

: ]E seleccionpda

Mictunol bwcel

Mocra  Window _Help Sisueltalatecla Cirl antes de soltar ¢l botén del mouse I hilera serd
File Edit Formuia Formsi Data  QOptlons acro indaw

movida en vez de copiada. Repita los pasos para mover las celdas de
regresoalahilerad, o seleccione Edit-Undo(Cirl+Z) ¢ intente de nuevo,
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8. Edite la celda D8 para que contenga 486DX, y edite 1a celda
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1] Bid Request Comparnive Analyss HR para que lea 2500.99,
:}lfv“w Soceq A Da chde oprm_n}' y mantener oprimida la lgclu Ctrl durante toda la
4 [Fes U B i . i 2 1598 0s operacidn de movimiento, fero no es necesario — la tecla debe estar
X o
,—~gzﬁxy 335;( 25 8 00 13 2;3253 oprimida solamente al sollar ¢ botén del mouse.
7 4885 2 “ 160 ! ‘ . . .
1 |2eus 9. Dé click en el botén de Guardar para grabar la hoja de trabajo
_’.—, T . &)
18 |t syst0mms ot ciionum requizements editada; luego salga de Excel.
“:'i*-' Para cancelar {a operacién de movimiento o de copia, seleccione
13 ] Edit » Undo Drag and Drop(Ctri+Z).
[14]
|15 ]
18
7] : CoMo Usar EL CLIPBOARD
T T T e = Se puede usar ¢} clipboard para mover y copiar celdas. El clipboard es

e = ) NI AP | DN IPRTIY (R PR .
e TP NS N ORISR | e . una firea de la memoria que almacena lemporaimente datos que se desea

4. Arrastre el sefialador hacia abajo a la hilera 8 pero no suelte el
botén del mouse todavia.

Note que el marco del blogue entero selecciona(.io se transformaen
unacajade linea punteada. Cuando se mueve 0 s¢ copia rpés deunacelda,
coloque la caja punteada de modo que empiece en la primera celdaenla
cual se desea colocar datos. Por gjemplo si ubicara la cayg punteada a
manerade que empiece enlacelda B8en vez deenla A8, lahilerade datos
empezarfa una celda hacia la derecha de donde se desea.

5. Ajuste la caja punteada para que empiece en la celda A8,

6. Oprima la tecla Ctrl. Aparece un pequefio signo més a Ia
derecha de 1a flecha, indicando que se estd en 1a modalidad de
Copia.

r—

mover o copiar. Debido a que las celdas estdn almacenadas en el
clipboard hasta que se corta o se copia otra celda, se puede pegar el
contenido del clipboard tantas veces como se le necesite.

Seleccione las celdas que desea mover o copiar, luego seleccione
Edit » Cut(Ctrl+X) para moverlas, o seleccione Edit » Copy(Ctri+C)
paracopiarlas, Las celdas seleccionadas, que aparecerdn enmarcadas por
unalinea que parpadea, se almacenardn en el clipboard. {Si se cambia de
opinién, cprima Esc para que desaparezca el marco que parpadea de
alrededor de las celdas seleccionadas y para borrar 1a informucién del
Clipboard).

Seleccione la primera celda de la ubicacién donde se deseu que
aparezca el contenido, luego oprima J. Quedar4 insertado entonces ¢l
contenido del Cliphoard.
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Un atajo de mend puede simplificar las operaciones de movimiento
y de copia del clipboard. Seleccione las celdas que desea Mover o copiar,
luego, mientras el sefialador estd atn dentro de las celdas seleccionadas,
dé click en el botén derecho del mouse para que aparezca el meni con
las siguientes opciones:

Cut Cortar Cul+X
Copy Copiar Ctri+C
Paste Pegar Control+Y
Clear... Despejar... Del
Delete... Borrar...

Insert... Insertar...

Number... Numerar...

Alignment... Alineamiento...

Font... Tipo...

Border... Lindero...

Patterns... Patrones...

Si las celdas ya no aparecen seleccionadas, es porque se movié el
sefialador antes de dar click al botén del mouse — seleccidnelas de nuevo
y cuidadosamente dé click al bot6n derecho del mouse.

Estas opciones de meni aparecen tinicamente cuando se da click at
bot6n derecho del mouse mientras que el sefalador estd dentro de la hoja
de trabajo. La opcién de menil seré diferente si el sefialador estd sobre
ntimeros de hilera, letras de columna u otra parte de la ventana Excel al
dar click al botén derecho del mouse.

Seleccione Cut para mover las celdas o Copy para copiarlas. El
meni desaparece pere las celdas seleccionadas quedan rodeadas por un
cerco que parpadea. Apunte a la primera celda de la ubicacién donde
quicra que aparezea el contenido, dé click al botén derecho del mouse
nara desplegar ¢l mend de atajo y seleccione Paste, Si copi6 las celdas,
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después oprima . o Esc para quitar el marco que parpadea de alrededor
de la selecci6n original. . ' l

Note que dar click al botén derecho del mouse seleccion I la celda
bajo el sefialador del mouse y despliega el mend de atajo todo en un solo
paso. Por lo tanto, no es necesario seleccionar primero una celda y luego
dar click al bot6n derecho del mouse, para poder cortaro copiurL'macelda

sola usando el menti de atajo.

Consejos para
Seleccionar
Celdas

1

I
Se puede empezar aseleccicnarceldasencualquicrextremode un grupo.
Para seleccionar las celdas de la Al a la FI, por ejemplo, se puede
empezarcon lacelda Al y arrastrar el mouse hacia la derechao vficeversa
empezar con la celda F1 y arrastrar el mouse hacia la izquierda.

Se puede extender la seleccion aun habiendo sehado el botén del
mouse. La primera celda del grupo seleccionado — la que no'apjurcce en
video inverso — actlia como posicién ancla. Coloque ¢l sefialador del
mouse en la dltima celda del drea adicional que se desea s_eléccionar,
hacia cualquier lado de 1a ceida ancla activa. Luego oprima y n‘mnlenga
oprimida latecla Shift y déclick. También se pucde arrastrar el sefalador
del mouse diagonalmente con la tecla Shift oprimida para extjcnder la
seleccién — suelte el boton del mouse cuando el block entero de celdas
quede seleccionado.

Si selecciond més celdas de las que queria, oprima la lcclg. Shifty
manteniéndola oprimida, asi como el botén del mouse, arrastre hacia
alrds sobre las celdas que desea deseleccionar, Para deseleccionar todas
las celdas, dé click en cualquier parte de la hoja de trabajo u oprima
Shif+Retroceso.

Para seleccionar una serie de celdas no conseculivas, mantenga
oprimida latecla Ctrl al irlas seleccionando. Descleccione una celda sola
del mismo modo.

Como Despejar
Celdas

Cuando se desee borrare! contenido de una celda, use el comando Clear.
Seleccione las celdas que desee borrar, dé click en el butén derecho del
mouse y seleccione Clear o seleccione Edit » Clear(Del}. Excel
desplegard la caja de didlogo mostrada en la Figura 9.3,
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FIGURA 9.3:
La caja de didlogo
Clear

ccionada Formulas. Estoborra

Seleccione OK paralaopcion presele
o notas

solamente los caracteres de la celda dejando cualquier formateo
adicionales.

Seleccione All (Todo) para despejarla celdadetod
formatos y notas; seleccione Bormats para regresar el contenido al
formato preseleccionado que usa Excel: o seleccione Notes para borrar
comentarios insertados previamente. También se pueden borrar los
formatos de una celda oprimiendo Ciri+Del. Aprenderd acerca de los
formatos en la Leccidn 15 y acerca de las notas en la Leccion 30.

Recuerde, cuando use el meni de atajo, asegiirese de que el
sefalador estd directamente en la celda, 0 ccldas seleccionadas, antes de
apretar el boton derecho del mouse. Si accidentalmente mueve el

sefialador, puede borrar una celda equivocada.

os los caracteres,

L EC C
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PRESENTACION OE

Coémo llenar celdas
seleccionadas

Cdmo Imprimir
celdas seleccionadas

Agilizacion de
Tareas Usando Celdas
Muiltiples |

ada vez que introdujo datos a una celda de la

hoja de trabajo muestra, tenia que usar el
mouse o las teclas de flecha para seleccionar la
siguiente celda. Puede evitar este esfuerzo
manual seleccionando un grupode celdas antes
de ingresar datos. L.uego se puede teclear una
hilera o columna entera —— o toda la hoja de
trabajo — sin retirar las manos del teclado.
Incluso se puede encender la funcién Num
Lock y usar el teclado numérico para teclear

nimeros mas rapidamente.
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En esta Jeccién aprenders cémo introducir datos a un grupo de
celdas, También aprenderd c6mo imprimir celdas seleccionadas en vez
de 1a hoja de trabajo entera.

Como Llenar un
Rango de Celdas

Para poder introducir rdpidamente datos a varias celdas consecutivas,
seleccione el grupo, empezando con la celda que quiere llenar primero.
Una vez que las celdas estdn seleccionadas, se da entrada a los datos
pasando a la siguiente celda oprimiendo .J. No tiene que usar €l mouse
o las teclas de flecha para moverse de una celda a otra.

‘Veamos como funciona esto creando el segmento de hoja de trabajo
mostradoen laFigura 10.1. (Realizaré formateo y trabajo adicional sobre
esle segmento en lecciones posteriores, para crear una hoja de trabajo

. completa). Empiece por seleccionar las celdas desde la A7 hasta la A23.

Elle Edh Fo(mula

Fo

FIGURA 10.1:

Segmento de hoja de
A trabajo
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Siga estos pasos: ‘ /
1. Armanque Excel o, si ya estd en Excel, inicie una nueva hoja de
trabajo.

2. Coloque el sefialador del mouse con un signo més de tamafio
grande en la celda A7.

3. Oprima y mantenga oprimido el bot6n izquierdo del mouse,
arrastre el sefialador a la celda A23, y suelte el botén del
mouse, La hioja de trabajo se recorrerd al arrastrar el mouse
hacia abajo pasando 1a orilla de la pantalla.

Note que la celda A7 estd aiin activa — sus coordenadas
aparecen en la barra de Férmula (Figura 10.2).

4, Teclee Sales, luego oprima .. La siguicnte celda de]I grupo
seleccionado, que es la AB, automdticamente se convierle en
celda activa.

FIGURA 1c|'>.2:
Celdas seleccionadas

|
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Si se comele un error, oprima Shift+. para regresar a la celda
incorrecta; dar click con el mouse deselecciona 1as celdas.

5. Teclee Rentals, y oprima . para seleccionar la celda AS.
6. Teclee Leases, y oprima .l para seleccionar ka celda A10.
7. Teclee Royalties, y oprima . para seleccionar la celda All.

8. Teclee Interest, y oprima J dos veces — una vez para
introducir los datos a la celda, la segunda vez para saltar una
hilera y seleccionar la celda Al3,

9. Teclee Total Income, y luego oprima J dos veces para
seleccionar la celda A5,

10. Llene la columna, luego dé click con el mouse, u oprima
Shifi+Retroceso, para deseleccionar las celdas.

CELDA CONTENIDO

AlS Salaries

Al Comissions

AlT Rentals

A8 Utilities

Al9 Supplies

A20 (Dejar en Blanco)
A2l Total Expenses
A22 {Dejar en Blanco)

A23 Net Revenues

Si oprime . después de teclear en la celda A23, la celda AT se
activa de nuevo.

L
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Ahora veamos qué sucede si se seleccionan las celdas arrastrando
ta columna hacia arriba en vez de hacia abajo.

1. Seleccione las celdas de 1a C19 a la C7 — empezando con la
celda €19 y arrastrando hacia arriba de la columna hasta la
C7. Note que la celda C19 es una celda activa, por lo tanto se
debe eclear su contenido primero.

2. Teclee 2985.5, luego oprima .. Excel pasa a la ditima celda
que se selecciond, la celda C7.

3. Teclee 73651.75, y oprima .| para seleccionar la celda C8.

4.

Llene el resto de la columna, tomando los datos de Ta Figura
10.1. Asegiirese de dejar las celdas de Tas hiferas 10, 12, 13,
14 y 17 en blanco.

También se puede seleccionar una hilera de celdas o un grupo de
celdas repartidas a través de mas de una hilera o de una columna. Veamos
come tunciona esto ahora.

1. Coloque ¢ sefalador dei mouse en la celda D7, oprima el

botén y manténgalo oprimido, arrastre el sefiulador hasta fa
celda F19, luego suéltelo.

. Introduzca los datos de la columna D tomandolos de la Figura
10.1. Cuando oprimu  después de llenar la celda 219, Excel
pusa al principio de la siguiente columna, que es la celda E7.

Alimente los dates de las columnas E y F.

Dé click en el botén de Guardar (o seleccione File » Save),
teclee QUARTERS, luego seleccione OK para puardar 1a hoja
de trabajo.

Salga de Excel si no estd listo paraa continuar cen la siguiente
leccion, '

MovIMIENTOS EN CELDAS SELECCIONADAS

Si se du click al botén del mouse $6lo en un grupo de celdas
seleccionadas, se deseleccionan, Asigue paramoverel mouse avwnacelda
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de un grupo de celdas, mantenga oprimida la tecla Cirl ¥ dé click en la

celda que desee.
Cuando estd seleccionada una sola hilera o und sola columna, O

cuando las celdas seleccionadas son no consecutivas, puede oprimir 40
Tab para pasar de celdaa celda, y Shift+-40 Shift+Tab para retroceder.
Si selecciont un grupo de celdas esparcidas ¢n més de una hilera ©
columna, puede alimentar datos hileraporhilerao columna por columna:
Oprima | pard avanzar hacia abajo de 128 columnas. Al llegar
al fin de una columna, oprimiendo Jsepasaala parte supe-

rior de Ia siguiente.

p Oprima Shift+-1 para moverse hacia arriba en las columnas.

a Oprima Tab para avanzar en las hileras. Al llegar al fin de una
hilera, oprimiendo Tab sc pasa al principio de la siguiente.

m Oprima Shift+Tab para cetroceder en 128 hileras.

m Oprima Cirl+. (punto) para moverse de una esquina a ourad en
direcci6n de 128 manecillas del reloj.

a Sise resaliaron dos grupos no consecutivos de celdas, oprima
Cirl+Tab para pasar al siguiente grupe 0 Ctr1+Shifl+Tab para

pasar al grupo anterior.
Como lmp“m'“ . Si tiene ura hoja de trabajo grande, pucde ser conveniente imprimi
secciones geleccionadas de ella para referencia. Con objeto de impnmir
Gﬂlpos de una parte de la hoja de trabajo, seleccione el grupo de cetdas que desec
Ce\das imprimir y luego Options » Set Print Area. (Fijar drea de impresion):
Apareceran jineas punteadas rodeando al drea seleccionada. Alimprimir
}a hoja de trabajo solo se imprimirén las celdas seleccionadas.

Para cambiar €l grea de impresion, seleccione oo grupo de celdas.
luego Options » Set Print Area.

Para cancelar el 4rea de impresion, seleccione la hoja de trabajo
entera, y luego Options »> Remove Print Area. (Retirar areade impresién):
Laopcion Remove Print Area aparece €1 el ment de persiana solamente
andn esté seleccionada 1oda la hoja dc trabajo.

primir

LECCION

CAmo usar AultoFlll

Cémo allmentar
una sorla‘

Ahorro de

Cémo duplicar fechas
y horas de celdas

Tiempo con
Funciones Répidas

:cel simplificael copiado de celdas y el llenado
e uné serie de datos alimentados uséndo él
asa Fill (de llenar). El asa Fill es un c1i1adro

cquert .
pequefio en la esquina inferior derecha del

ma

rco que rodea a la celda activa '

1

Definiremos un i ' ‘

‘ a serie como elem -

g na ser entos consecuti eld
secuencia logica; por ejemplo, nim i) s Celdlﬂs ias

X eros ordinales, horas, dfas

de la sem

ana, o meses del ap

afo. A ;
mostrados en la Figura 11.1. lgunos ejemplos de scriesI estdn

Como Trabaja
Excel con
AutoFil|

|

Si se tecl i
ea el prim
Fill, la rUﬂCiél?Au;: l:wilﬁrgemo de estas series, y luego se arrasira el
usted. También puede usa:fxc‘;! automdticamente llenard 1a sefie ;‘:
utoFill para ingresa . |
r series lanto en hil
n hileras

como en colum
n . .
as, y la direccién en que se efectie el re!
arrastre' no es

o
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' . . LEGCION 11 65

¥

., FIGURA 11.1: 6. Cologue el sepalador en el asa Fill en la esquing inferior
Muestras de series derecha de la celda C5. Asegirese de Gue el sefalador se

File Edit Formula Format Dals  Qpllons Macio Winduw Help

creadas con AutoFill transforma en un signo mds (+), lleno, yue indica que se estd
en la modalidad Fill.
7. Mantenga oprimido ! bo16n izquierdo del mouse y arrastre el
‘ o gl I
I S o = seflalador a la celda F5.
3 . Znd
EMunduy Tuesdoy Wednesd. Thuisday Fridey kD] 8. Suelle el bot(m del mouse.
5 Aih
xR Moy . E'xcel automéncazncntc llené las series 2nd Qur, 3rd Qir y 4th Qtr.
II cene1 st Gusss ciesd Ciosss o Si arrastrara el sefialador para llenar mas yue las otras tres celdas,
9] &mn Excel irf i : imeslres:
2] comr sonme st 15c0m0 170000 o repetiria la serie de cuatro trimestres:
11 10t
O 1o 1stQtr 2nd Qtr 3rd Qir M Qtr 1stQtr 2nd Qir 3rd QR
i3 125 4th Qtr
E 13h l
%. :;:, Para que Excel cree una serie, el primer elemento debe contener un
n I a v s =
L‘T ; dia de la semana, un mes del afio, una fecha, una hora o una combinacién
ie i ! dendmeros y caracteres. Algunas combinaciones deben tenersignificado
e i o
— - special tales como Ist Qur, Quarter 1, 1 Q, y Qir 1, las cuales se

. feconecen como la scrie quarter y se tepiten en grupos de cuatro.
Quzm 1, sin embargo, no serd reconocido como de | serie quarter,

pera sise numerard consecutivamente, al igual que elementos tales como

Period 1y Day 1,contantos nimeros como celdas se hayanseleccionado.

importiante. Por ejemplo, se puede llenar la serie Qtr tecleando Qir 4 en

la dltima celda y arrastrando hacia arriba o hacia la izquierda.
Tecleemos los titulos y texto adicional en la hoja de trabajo

QUARTERS, luego se usard AutoFill paraintroducir los encabezados de

. e e

las columnas. Co6mo Corar CeLpas
1. Amanque Excel y abra ia hoja de trabajo QUARTERS. ‘ Si Excel no reconoce un elemento como primero de una serie, copiard
2. Enlacelda Al teclee Watson and Sens, Inc. ‘ en las otras celdas lo que se haya tecleado. Se pucde aprovechar esto para
copiar los mismos datos rdpidamente a varias celdas,
3. Enlacelda C3 teclee Fiscal 1993. .
1. Seleccione la celda Cl0y teclee 1500,
4. Enlacelda A25 teciee All figures are subject to audit. .
g ) . 2. Apunie al asa Fill de la celda, arrastre el sefalador a la celda
5. Enlacelda C5, teclee Ist Qtr. F10,y suelte el botén del mouse.

3. Seleccione ka celda C17 y teclee 4500

!




AHORRO DE TIEMPO CON FUNCIONES RAPIDAS

4, Arrastre el asa Fill de la celda hasta la celda F17, y suelte el
botén del mouse.

5. D¢ click en ¢l botén de Guardar (o seleccione File » Save)
para grabar la hoja de trabajo; luego salga de Excel si no estd
listo para continuar con la siguiente leccién.

Para copiar una celda que de otra manera hubiera sido tratada como

serie, mantenga oprimida la tecla Curl al arrastrar el mouse.
La Figura 11.2 muestra la hoja de trabajo como se ve ahora.

C6mo CreAR SERIES ESPECIALES

Para crear hileras o columnas numeradas, se deben introducir los
datos en las primeras dos celdas. Por ejemplo, aunque AutoFill reconoce
1st como el principio de una serie (2nd, 3rd, y as{ sucesivamente), sdlo

FIGURA 11.2:
Hoja de trabajo con
series y encabezados
completos

(R s i - O 5 s B S BN B T R T e B 2 BN T D
AY.:]Watsan and Sons, inc. -
B M i -
'y Fiscal 1993 3
! X
f 1stCh.  ndQu. JdOu. 4w i
3 31|Seles 7166175 1243676 7825465 97654 97 :!I
=) Fentals 58503 573567 507625 6BEAZ6 i
i§7lLanses 15325 V6325 15225 16325 %
18 |Royeties 1500 1500 1500 1500 k.
31 Jintarast 12085 129756 1310%2 133676 &
KF ] A
Tatal lncome ;
1 : ¥
Sateaies 3054256 I056473 17656 3247867 b
18 JCommissions 73852 72437 7825h 97655 2
T {Rentals 4500 4500 4500 4500 i
18 [unlues 13425 139427 140105 1412087
i . v Dot LA Cta T SR DB TR 28
Raedy s b2 e LB T L T [ I | RRCg FER] gt e

Comprensidn de
los Formatos de
Fecha y Hora
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copia el nimero 1 en todas las celdas seleccionadas. ‘

. También puede ser (til crear s
ciemplo de nimeros impares o pares
hora,

Cries no consecutivas, como por
. |
» 0 series de horas de cada tercera

En c: . . .
b s nlcasgs asi, tendrd que introducir los dos primeros valores de
TiE, Seleccionar ambas celdas, y luego arrastrar el asa Fil]l Excel

automiti 4 i i
‘ miticamente detectay repite lasecuencia, Porejemplo, para numerar
hileras o columnas, empiece con ’

1 2
enlas primeras dos celdas, oincre i F
, m . .
i ente unaserie de horas cada doshoras
8:.00 AM 10:00 AM

Excel despliega fechas y horas de acuerdo con formatos prefij

ados.

9/94 Sep-94 |
1-1.94 1/1/94

Jan 5 5-Jan !
Jan 1, 1994 1-Jan-94

1/5 5-Jan

10:00 10:00 "
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SISETECLEA: EXCEL MUESTRA
13:50 13:30

Sin importar COMo aparezca en la celda, la barra de Férmula
siempre tendrd el formato 1/1/94. Sinoseteclea el afioen lacelda, elafio
en curso aparecerd en la barra de Formula.

Las horas siemnpre aparecerén en la barra de Férmula con los
indicadores AM o PM y dos digitos para los segundos; por ejemplo,
10:00:00 AM. Las horas introducidas en gl formato de 24 horas
aparecerén en la barra de Férmula en formato de 12 horas — 13:50 en
una celda aparecerd como 1:50:00 PM en la barra de Formula.

Las series que usen horas s¢ incrementardn en horas. Sin
embargo, la manera en que AutoFill incrementa una seric de fechas
depende del formato que se ase. Si se empiezan tos datos con el formato
Sept-92, por ejemplo, la serie se incrementara por mes. Otros formatos
de fecha se incrementaran por dia.

Para introducir la fecha en curso en 1a celda activa, oprima Ctr+:
(punto y coma). Para introducir lahora actual, oprima Ctrl+Shift+:(dos
puntos}.

Si se despeja una celda que conlenga una fecha, use 1a opcién All
de la caja de dislogo Clear. De otra manera el siguiente elemento
introducido a la celda automdticamente quedard formateado como und
fecha. Por ejemplo, suponga que usara la opcidn preseleccionada que €3
Férmula para despejaruna celdaque contiene Ja fecha 1/1/94. Sidespués
teclearaelnimero25 enlacelda, Excel mostraria 1/25/00 porque lacelda
contiene formato de fecha. El nimero 25 seffa interpretado com®
veinticinco dias después de enevo | del afio 1900, que es €l punto de
refetencia usado por Excel para ejecutar operaciones coi fecha.

//

Como Usar ef

Comando Data
Qorips

Sino[ienemouse,osi deseacrearuna serieespccia!,u'scelcomando Data
Series (Series de Datos). Teclee €l primer elemento de la serie ¥
seleccione suficienies celdas para completaria usando las 1écnicas qQue
aprendio en la Leccién 10. Luego seleccione Data » Series pard

LECCION 11

d ‘. 0y ) a "1 H
esplegar la caja de didlogo mostrada en la Figura 11.3. Para llenar
3 una

serie simple, seleccione AutoFill y luego OK.

L ; iones : .
o Sdri&::ss ollr;iérc')[;cmms de la caja de didlogo permiten crear otros tipos
. La Tabla 11.1 explica las opciones de la cajz} de diftogo P

Type

Date Unit

Step Value

Stop Value

Trend

'?a-'-l m- T'p-.~~~~u~u-< | Data Uit~
P flows @ Linoox & Day
L Cokmns: . Growth  Weekday :: '
[ Trand T Dala C Murih
i | b | [ Yo
Step Value: Iﬁﬁ Sige Value: |

W_

S el o 1
(Series en) 1lena una serie en hileras o en columnas

(Tipo in: i
(L!Em)“l_)sctf’.rmlna cémo incrementar la serie. Una seric.Linear
el (t‘Z‘llnLTEl?lcnlil por el valor de paso; cada celda de una serie
o (F( -;,:,( tmlen{o) se multiplica por el valor de paso; una ;;erie
imremee(l, d) permite seleccionar una unidad de fech:; para ser
ntada por el valor de paso; i i
e rementada paso; AutoFill detecia ks serie auto-
Unid: 2 ina si
‘(ﬁas ddd Ide.fecha) Determina si una serie se incremenia por dias
e la s '
&nicame:[ semar;a. lmest:.s o afios. Estas opriones estdn activas
e cuando la celda seleccion: i
s ionada contiene una fecha o una
Valo s0) Fij
l(wguﬁr"rds: pm.tn) Fija el tamafio del incremento — use un valor
o paridecreinentar laserie. Es i
" ie.Estag i
en series Auioliill, Peinnosepuedecambiar
(Valor Fin:
{Var "eFP::aI) Es el valor final de una serie, Excel llena una serie
raeste valor o al fipal del i
rango
o e s eveds primete go seleccionado de celdas.
({Tendencia i i
(T l-:‘:!)Cre:a unprondsticode crecimiento lineal o exponencial
os elementos de las celdas seleccionadas. Los valore:;

existentes en las celdas cambiardn

FIGURA 11.3:
La caja de diflogo
Dhata Serices

TABLA 11.1:
Opciones de Data
Series
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Como designar

rangos

La herramienta
AutoSum

Funciones de Excel

Calculos
Rapidos Usando

Funciones

nafunciénes uncomando especial que ejecuta

una operacién sobre un valor (ocifra)oseriede

valores, e inserta Jos resultados a una celda.La
funcién SUM, por ejemplo, calculael total de
los cantidades de una hilera o una columna, €

inserta el resultado en la celda seleccionada.

Excel ofrece més de cien funciones que ejecutan célculos de
ingenieria, financieros, estadisticos y otros. El dominio deestas funciones
requiere no solamente CONocer bien a Excel sino también los principios
matematicos. Sin embargo, no es probable que utilice todas estas
funciones de Excel. Probablemente aprenderd aespecializarse enalgunas

de ellas que llenen sus necesidades.
En esta leccion aprenderd como usar algunas funciones

fundamentales que pueden agilizar las operaciones matematicas de las
hojas de trabajo. . :

L
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Como Designar
Rangos

Muf:hﬂs funciones operan dentro de un rango (grupo de c;:ldas). Sedebe
designar el rango al insertar la funcion en la barra de Férmula. Un rango
de celdas adyacentes, por ejemplo las de una hilera, una columna, o un
rectdngulo, se designa como sigue: ‘

(Primera Celda:Ultima Celda)

Por ejemplo, se referiria a un rango de celdas de una columna desde la
celda A hasta la celda A10 : ' isti
: . A la celda como (A1:A10). Si el rango consistiera en
as primeras diez hileras de las columnas A y B se designaria (A'I :B10}
usando.corpo coordenadas las celdas de la esquina superior iiqlllierda y
la esquina inferior derecha del rango. ! ‘ .
S.cparc con comas celdas no adyacentes. Por ejemplo, (‘A'l.. CI3
D15)incluye tresceldasenel rango, mientrasque (A1:B10,C1 B)Iincluye
el grupo desde Iz Al hasta la B10 més la celda individual cial
‘ Para referir una hilera o una columna completas, use el nimero de
la hilera o la letra de la columna en ambas posiciones: .
_ESTE BANGO:
(B:B)

(5:5)

REFIERE ;

La columna B

La hilera 5 i
{1:5) Las hileras 1 a 5
(A:B)

(A:1V) 0 (1:16384)

Lascolumnas Ay B !

La hoja de trabajo entera

Gomo Usar fa
Herramienta
AutoSum

;’a que t.otahzar hileras y columnas es una funcién que se usa mucho

xc.e] laincluye en la barra de Herramienta, AutoSum le permit‘c i‘nsenal‘-

rapidamente el total de series de nimeros. ‘

G Usemos ahora la herramienta para calcular los valores del] Total de
astos y del Total de Ingresos que son hileras de la hoja de Ilrabajo
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QUARTERS. | .
1. Arranque Excel y abra Ia hoja de trabajo QUARTERS.

7 Seleccione la celda C13, luego dé click en e] boton Autn:?SurnE
. de la barra de Herramienta — es el bollén con la letra griega £,
bajo la opcidn de menti Data — u oprima Cirl+=.
Excel coloca una linca puntcada que parpadea .alrcdedfor dt‘as rtas;
celdas que estin directamente encima de C13 y despliega la funci

=SUM(C7:C12)

en la barra de Férmula. (Ver la Figura 12.1). La funcigt;;ngilcg q:;:(li:
S delrango CTaCl2. ElsIg
elda contendrd la suma de los valores :
(i:gual le indicaa Excel que la palabra SUM esuna funcidn, nouna palabra
de 1exio.

FIGURA 12.1:

—@_ﬁ La funcion SUM fue
Sle gdit Foymula Formal Data Qptions MAcrs Window _lelp insertada con la

= E’ @m EDE“_’: @E herramienta AutoSum

1=
- A € C D € F G H [
g Fiacai 1933
; 151 Citr 2nit QU g O Ath
3 eSS ' 7EI54E6 976R497

5 FIEE TG, 72400 76 7HI64 a7
: ?ia‘:lsls :caspal SPISE7 597625 GBRACE
: Lea:;s boyge  1EXG 1935 15363
10 oo e b oymsel 1500 as00 1S
W st D et 10975 1NMDEZ 129676

nteres » 2
12 S
13 |Total lncgme [.h\,?LLiI
o E 1733 117867

vop WBRITI  NTEEE R

Salanes 0642 56 473 i
‘12 C;m:'m;slons 7i652 PR 7B2ES 9?:':532
V7 |Fenets 4500 4500 4500 w
Tojomes 13425 10420 1A :ng e _
T8 |Supphes ~gg55  I5d0SE_ 13637 73307 .
s T T T

Point
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Cuando se usa AutoSum, Excel adivina el rango adecuado. Ignora
todas las celdas vacias entre la celda activa y el primer valor encima de
elta, luego incluye todas las celdas desde ese punto hasta la primera en
blanco o no numérica. $i no hay valores numéricos arriba de la celda,
AutoSum usa los valores de celdas que queden hacia su izquierda.

Si el rango seleccionado por AutoSum es incorrecta, use el mouse
para trazar una linea punteada alrededor de las celdas correctas o teclee
el rango correcto en la barra de Férmula. También se pueden oprimir las
teclas de flecha para seleccionar la primera celda del rango, luego teclear

un punto y coma, y en seguida usar las teclas de flecha para seleccionar
la ditima celda del rango.

3. Dé click en lacaja Enter u oprima .J. Para cancelar la opera-
cién, dé click en la caja Cancel, u oprima Esc.

Note que ahora la celda contiene el niimero 97533.15 — el total de
las celdas de arriba — pero Ja barra de Férmula atn muestra la funcidn.
Para Excel el contenido real de la celda es la funci6n, aun cuando su
resultado sea lo que se muestra en la ventana de la hoja de trabajo.

Si se cambia un niimero en una de las celdas dentro del rango, la
sumacambiard reflejando el total nuevo. Este proceso, llamado recdlculo,
acurre automndticamente y es una de las functones mas poderosas de las
hojas de cdlculo. Pruébela.

1. Seleccione la celda C8 y teclee 6000,

2. Dé click en la caja Enter u oprima 1. Note que el nimero en la

celda C13 ha cambiado de 97533.15 a 97682.25,

Seleccione Edit » Undo{Cirl+Z) para cancelar el cambio. Lo

introducido en la celda C8 y el total en la celda C13 regresan a
sus valores anterjores.

Gracias al recélcuto, puede editarse una hoja de trabajo sin tener que
cambiar manualmente ninguna de las funciones que se hayan insertado.
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Como Copiar
Funciones

Necesitamos una funcidn similar a la de 1a celda C13 par:ii c;:](C:;LI:: {g:
totales de las celdas de las columnas D, E y F. En vez de te $
funciones individualmente, usemos AutoFill, l
®  Arrastre €] asa Fill de la celda C13 hasta la celda F13, luego
suelle el botén del mouse. - .
Gracias a que la celda acliva contiene una funcu?n, e?(;:omc(r:::)(i)uciz
i irse a serie. Si la funcién se
a celda se copia en vez de convertirse T e
L‘;;clamenlc. apareceria el mismo nimerc comototalen las c;lda:C lue
D13, E13yF13,en vez del verdadero total de cada columna. Pues (;qdc
CRIO‘ scr;’a incorrecto, Excel copia la funcidon usando un rang
rencia relativa, _ |
e Cuando Exce! copia o mueve funciones o formulas de un? cel(‘i:.'_naz
. . . ;
¢ sa referencias relativas o una referen
rango a otra celda o rango, u ‘ M o ve o e
i : del mismo modo ya s
absolutas. Las referencias trabajan _ x
;:))lbi(;uen a funciones o a férmulas. Aprenderd acerca de referencias
: ¢ ta Leccion 13,
absolutas y acerca de férmulas en a | .
: Un)z; referencia relativa modifica el rango'dc la func.ién %ara::ie
contenga las celdas apropiadas a la nueva yblcacu‘m de la'tugcil3 nc.on.w.
en nuestro ejemplo 1a funcién fue copiada a la celda
= E7.E12) . ' ' o
SUll\j‘a\( mejor manera de comprender esto es interpretando l; fluncnég
H - " g o I ng
significado “totalhiza los valores del ra
SUM en la celda C13 cenel sign s valor o
de celdas que aparecen hacia arriba en esta columna.” El rango de es
lumna es CT:Ci2. ) N
colu Cuando 1a funcién se copiaalasceldas D13, E13y i 3.es z::[;;u.[;::)i
el mismo significade. En lacelda D13, el rango se conv1c'm‘ clr:1 F.l ) ;l
en la celda E13, el rango se convierte en ET:E12, y en lacelda F13,
ango se convierte en F7:F12. o
e Para copiar celdas de manera que Excel no tenga que Cd'?blgm
debe hacer refercncias absolutas. Aprenderd cémo en la Leccion 13,

LECCION 12 @

Funcion pe MovEr vs FUuNcioN pE Copiag

Ahora necesitamas totalizar las celdas que contiencn gastos. Podriamos
aplicar la herramienia AuloSum en la celda C21 pero mejor Iveamos
COmo copiar una funcién usando arrastrar y soltr, .
Siscmueve la funcién de lu celdy €[ 3 usandaacrastrar y soltar, serg
copiada exactamente, y no modificada usando una referencia relativa,
Ello se debe a que Excel supone que se desea colocar los resulthdos de
la funcién en otra ubicacian sin cambiar si valor, |
"Sin embirgo si se copia la funcion, Excel cainbiarg sus referencias
£omo comespande — suponiendo que se desea usar la misma funcién
€omo base de cdlculo en orrag celdas,
Como ejemplo copiemos la funcién p
hilera 21, para el 1] de gustos.

I
|-
E

|

ara llenar los valores de la
1. Seleccione 1 celda C13,

2. Copie la celda 4 la C21 — apunte marco de la celda €13,
oprima la tecla Cir|, amasire el sefizlador a la celdg C21.| suelte
el botén del mouse, y luego suehe 1a 1ecla Ctrl.

Note en {a barra de Férmula que la funcién ha sido copiada
usando una referenciy relativa, La celda €21 ahora incluye Ia
suma de las celdas C15 4 [a €20, gue es el rango de celdas
ubicadas arriba de 1a celda seleccionada,

3. Arrastre ] agy Fill de la ¢

elda C2t ala celda F3y para llenar 1a
hilera.

4. Imprima la hoja de trab

2j0 — dé click en ol botén de imprimir
de 1a barra de Herramic

Ma o seleccione File » Pring » QK

Si mueve una funcién llevando consi
dentro de sy rango, las referencias de celda en el rango cambidrén, Por
ejempio, si mueve solamente a la celda €13 hacia abajo una hile:ra ala
celda C14, 1a funcisn Permaneeerd siendo =SUMICT:C12), Sin em-
bargo, si seleccions lus dog celdas, la Cl2 Y1laClI3, y lus nmcvc;‘hacia
abujo una hilera (de manera que ta funcion este ahora en Ja celda C14),
la funcién cambiarg 4 =SUM(CT:C13), '

80 al menos una de lay celdas
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Como Teclear
Funciones

Para poder usar otras funciones ademds de AutoSum, se les debe teclear
en la celda. Para teclear una funcidn, teclec el signo de igual { = ), el
nombre de la funcién y luego el rango de celdas sobre lus cuules desea
que actde ia funcion.

Una funcién puedeincluirndmeros al igual que referencias de celda,
Porejemplo, pedriacalcular la sumade nidrmeros determinadosiecleando
=SUM(1827,4655,1627) o combinarun rango y unndmero, porgjemplo
=SUM(A:AS, 100,

. Tecleemos una funcién para calcular Tos promedios de cantidades
trimestrales, comao las que muestra la Figura [2.2.

1. Seleccione la celda HS y teclee Average.

2. Seleccione la celda H7 y 1eclee =Average(CT:FT).

)
File  Edit Fopmula

Formal [ats  Dplions Maco  Window  Help

FIGURA 12.2:
La hoja de trabajo

S~ LA RO TG QUARTERS. con
R B

Ha1 - AVERAGE(C2] F2i) totales y promedios
A 5 [ D € f TS T I
4 )
5 11O InaGr MdOu am O Average |
5 e h
| 7_|Saies 7IEE175 I2430 76 7B25465 3765497 { 8049353 »
1 8 (Renlols 58509 5IELT  R4TE 25 5G64 26 5856 77
4 ltasses 18325 15325 9535 15335 15325}
10 {Paysines 1500 1500 1500 1500 1500
11 Jierest 12055 V29756 T3IG52 19676 1302 586!
¥ '
13 [Tatat Income 9753315 4623499 1020664 121741 104483 8!
11 .
15 |Snlenes 054256 WSEA73 JUFESE I2IIBET 31262 631
16 |Commissions 73652 12437 18255 87655 804 9575
17 [Fensls 4500 1500 4500 500 4500;
18 [Udtes 13425 133427 140705 1412087 45646731
18 [Supphes 29855 254086 213667 23M76 7446 423!
20 :
21 {TomaiEapenses 4016783 972393 4058607 54106 85 [+%70 sal *
L4 hd
Select destnnbon and prass ENTER a1 chaase Paste Bt I I 1T

LECCION 12

‘primu . El promedio de tag

o F7 es calculado Y aparece ¢n
Si usa AutoFil) para copiar ¢

aparecera el mensaje de error

#DIV/01

en !as celdas de hiler

ha intentado dividir

malemaitica no vélida,

s1a funcién hacia ahajo en la columng

as en blanco, Ese mensaje
un mimero enire ce
De manera

Al \ queeny
AutoFill Ia cOpiaremos al clipboard yla
esI4n en blanco.

significa que Ja funcidn
ro, lo cual es upy operacién
¢z de copiar la funcian usando
Pegaremos a las hileryg que no

[ Asggdrese de tener seleccionady |
Edit » Copy(Cirl+C) para insert

2. Seleccione fug siguie

dcelda M7, luego seleccione
ar la funcidn a) clipboard,

nees celdas, manteniendo opriridy la

tecla Ctel mientrasg selecciona:
HE . H6
Ha H17
HIio Hig
H1 Hi19
HI3 H2)
Hl5

3. Seleccione Edit » Paste(Ctrl-V)

lipbon 4 pont frara copiar la funcion de)

las celdas seleccionadas,

4, D_é click en el hotdn de Guardar de Iy ba
bien seieecione File »
!gego salga de Excel
siguiente leccidn.

i de Herramiena (
y LI e 0
Save) Para grabur ty hoja de tribajo;

Por cierto, si g; i
St da doble click g upa ¢elda que contiene uny funcién
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, LECC T 0N

las celdas de su rango de referencia automdlicamente quedardn

seleccionadas como grupo. Entonces se pueden slimentar datos al rango 1

de celdas o editar celdas especificas, y ver el efecto en el resultado que

la funcidn calcula. ’ ’ ' PRESENTACION DE
' Algunas funciones bdsicas adicionales se des’cribt:.n en la Tabla Como crear
12.1. El nombre de un pardmetro aparece entre paréniesis i la derecha térmulas)

del nombre de la funcién. El pardmetro indica si la funcidn aciia sobre |

el contenido de una celda, de un rango de celdas, de un ndmero Referenglqs
determinado, v otro tipo de referencia. Porejemplo, donde dice COUNT absolufae.l
{rango) significa que la funcién COUNT (ORDINALY) debe teclearse Coémo usar fechas
seguida de una referencia especifica a celdas de una rango al cual habra en las fOrmulas.

de refererirse, Con StrUCCién :
y Uso de Formulas

na férmula, al igual que una func10n ejeculd
I

|

TABLA 12.1: oneraci
Funcioncs bisicas de P ones matematicas sobre celdas o

ABS(celda) Inserta el valor absoluto de un ndmero — el nlimero sin Excel numero

signo. s. Peroadiferencia de una funcién se le
AVERAGE(rango) ! Calcula el promedio de los valores conlenidos en el rango. ' debe exp[icar expresamente a FXCé] qllé
COUNT{rango) | Insena namero ordinal a los elementos del rango. )
MAX(rango) ! Insenia el valor més alto del rango. - OpCrElClOﬂes C_]t‘,CU[ar Las formulas pueden

| R
MEDIAN(rungo) Inserta el valor promedie ded rango. mclulr o crado
res matema

MIN(rango) Insenta el valor mds bajo del rango. p UCOS re ferencms a
RANK(celda, Insenala jerarqula de la celda comparada con las otras del Celdas, numeros, Y aun func iOI’lCS, COlmO Io
rango) rango, como si estuvieran ordenadas numéricamente €n . |

orden descendente. muestra la Tabla | 3.1. :
SQRT(celdn) Calcula la rafz cuadrada del valor de la celda.
SUM({rango) Calcula la suma de los valores del rango. )
NETWORKDAYS | Calcula el nimero de dias laborables entre fechas de dos \ ) ‘
(celda fecha iniciel, | celdas. : f
celda fecha final) | : '
DAYS360 \ Calculael mimerode dias entre dos fechas usando calendario
(celda fecha inicial, ; de 360 dias, con 12 meses de 30 dias. i
celda fecha final) '




: r LECCION 13
m CONSTRUCCION Y US0 DE FORMULAS .

ignoigual (=) y observar Estaférmuladael resulladocorrecto—?4-—porquc Ly sumadeniro
el O;gz:az:a:‘f'g;n‘r;:z:‘ezir;c::;l;c;f:;n;l zlaglzﬁlfr rcg“ﬁd(’s' Los del paréntesis se calcula primero y el resultado se divide entre 3,
elementos dentro de un paréntesis s¢ calcglan primcrp. luego. Ia:s -
funciones y los rangos, seguidos de porcentajes y potencias, multipli- ' | | |
cacién y divisidn, y finalmente suma y resta. . Comﬂ lnseﬁar Usemos férmulas ahora para llena_r.las celdas de L hoja. w lm‘?zuo
Por ejemplo, suponga que se desea calcular el promedio de tres : l QUARTERS. ln§cnarcmos las utilidades netas en la hilera 2,y
cifras. De teclear ! Fﬂrmu as calcularese la variacién de utilidages entre trimestres,

—

' - Arrangue Excel y abra la hoja de trabajo QUARTERS.
65+75+82/3

2. Seleccione ia celda €23, y teclee =C13-C21,
resultaria 167.333, lo cual es obviamente incorrecto. Se debe aque Excel l

3. Déclick en la caja Enter u oprima .. El resultado de 1a
s ; ividi espués sumé
ejecutdladivisibnen pnrng;lug?alsr. dividiendoB2entre 3, y desp formula, que es 57426.07, se inserta en 1a celda.
ese resultado a las cifras 65y 75.
La manera correcta de ingresar la férmula es 4. Arrastre el asa Fill de la celda C23 a la celda H23, ¥ luego

suelte el botén del mouse.
Note que la cetda G23 contiene l1a férmula =G13-G21 y el
valor 0 porgue no hay valores en la columna,

(65+75+82)/3

1345 5. Seleccione la ceida G23 y oprima Curl+Del para borrar 1a
TABLA 13.1: férmula de 1a celda dejandola en blanco.

CPERADOR SIGNIFICA  EJEMPLO CALCULA” Ejemplos de frmulas

" | p— =Al+BI+10 ! La suma de los valores de las 6. Mueva el texto de ta celda A24 hacia abajo una hilera para

lcetdas Al y Bl y el valor 10 hacer lugar al cambio porcentual — apunte al marco de Ia
E resta =SUM(AI:A4)—5(m{ Lasumade los vatoresdel rango celda A24 y arrastre el sefialudor a la celda A25.
= | | Al a A4, menos 5000

|

I
|

7. Seleccione la celda A24 y tecice Percent Change.

1
i =SUM(AI:C3)/4 | lasumadelosvaloresdelrango i i : . - .
] divisi6n il A1 203, dividido aee 4 8. Seleccione la celda D24 y reclce DZJ{(,ZJ.
. multiplicacién | =C4*10 { El valor de la celda CA 9. Amastre el asa Fill de Ia celda D24 a Ia celda F24,
 multiplicado por 10 . . . - .
i X ) Ahora 1a hoja de trabajo muestra ué utilidad se generd en cada
| i : =A% | 6 por ciento del valor que estd . ; ) g £
% ; porcentye = lenlaceida Al trimestre y también la relacién entre trumestres. (Ver la Figura £3.1)
A l i ,L =G 12elevadoalapotencia6
| F ! b
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Eile Edit_Fopmula

Furmay Dats  Options Macie Window  Help

Pees 1@ (=) 1AL (EIBI 1 ol para

FIGURA 13.1:

Hoja de trabajo con

wtilidud neta y el

F24 ~FEIED
= T porcentaje de
Al B c 3] . E F G H ! variacion
7 ISales 7365175 7243676 7825465 9765497 8049353
[0 [Renols 58509 573567 597625 BG4 26 5656 77
1 9 |Lenses 35325 15325 15325 45025 15325 _
| 10 [Roysites 1500 1500 1500 1500 1500 i1
11 {Interast 12055 129756 TN052 139676 1302586
{11
i3
H‘I_@_ﬂntal Income 9753315 9629499 1023664 12174 1044839
14
(16 |Selaries 054256 3055473 317656 3217867 26289
| 1B | Commissions 73652 72437 78255 97655 8049975
| 17 [Rentals 4500 4500 4500 4500 4500
| 18 {Unites 13426 139427 140105 1412087 4564673 -
% Supplas 23855 254056 213687 233076 2498 423
ETm:ﬂExpanses 4010708 3972193 4058607 5410685 4363098
‘4
L—ﬁ Met Revenues §742607 5657106 178036 6763414 BUAGZ.31
24 {Percant Change 09851111 03z084[ 1 094752) 3
> - S - - Y -

?
8

s -
A bl e

I [ [

Referencias
Absofutas

Algunas veces serd conveniente copiar una férmula (o una funcién) sin
crear una referencia relativa. Porejemplo, puede ser necesario referirun
célculoaunaceldaenespecial oaun grupode celdas, independientemenie
de la ubicaci6n en 1a hoja de trabajo de la férmula o funcin. Para hacer
esto, se necesita establecer una referencia absoluta,

Para crear una referencia absoluta, ponga el signo de pesos
antecediendo a la letra de 1a columna o al ndmere de la hilera, o a ambos
{$). Coloque el signo de pesos en frente de la coordenada gue se desea
hacer absoluta. Por ejemplo, suponga que usa la referencia A5 en una
férmula o funcién, y luego copiard la referencia a otra celda. A
continuacidn se explica cémo cambia la férmula al ser movida segiin de

LECCION 13 &

como se introduzea la referencia de celda:

BEFERENCIADECELON: AL SER COPIADA;

AS Cambian ranto 1a columna como la hilera

$A$s La celda AS siempre serd referidy

5AS La columan A siempre sers n:t'érilda pcr(;
cambiarg la hilera,

AS5 La hilera 5 siempre serd referida pero

cambiari la columna,

Pﬂ a4 o .o - 4
come ra ver como S¢ usan las referenciag absolutas, determinemos
oo segompamla utiltdad neta de cada trimestre con el pmmcdi'o anual
nmero ingresaremos la férmula usando referencias relativils para ver
¢l efecto. - N
1. Seleccione la celda A28 yteclee Percent of Average,
2. Seleccione la celda C28 y teclee =C23/H23

3. Arrastre el asa Fill de 1a celda C28 a 1a celda F28,
EKL‘:G] ajustd ambas referencias en 1a formul

re f‘crlﬁrznc taulasceldas de utilidad nety trimestralse ajusts apropiadamenie
—alasceldas D23, E23y F23, Sin embargo, lareferenciaata celda H23

también se ajusté— a las celdas en bl .
! ancol23 J23y K23 —:
resultado los mensajes de error #DIV/0! 73 —dundocomo

Ahora se utizaran referenciag absolutas,
para corregir 1a situacion,

‘
ade manera rélativy, La
|

y ¢l comando Reference
I Seleccione la celda €28,

2. Eneltexto que aparece en la barra de Férmula

selece)
caracteres H23. celoeos
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3. Seleccione Formula » Reference(F4). Las courdenadas de la

celda cambian a $H$23.

Cadavez que seleccione Formula» Reference(F4), las coordenadas

seleccionadas rotan entre las opciones posib

les para esta secuencia:

$H$23, H$23, $H23 y H23. Por gjemplo, si selecciona Formula »

Reference(F4) por segundavez, lare
el comando cuatro veces para regresar

original.
4. Dé click en la caja Enter u oprima 1.

ferenciacambiarda H$23. Seleccione
las coordenadas a su condicién

5. Arrastre el asa Fill de la celda C28 ala celda F28. Se calculan

los valores correctos y se insertan a 1as celdas, com

la Figura 13.2.

o muestra

Formula Formel Data QOptions  Mscro Window Help

E Edi

A L4 B
N g YA B - e BT o) R P TN SR RSN SRTH ki Q] M e R Y
|11 {interest 12055 129756 111052 139676 1302585
[ 12}
_JLToluj Income 9763315 9629499 1023664 121744 1044839

14

[ 15 {Selan 3054256 3066473 317656 3217867 31262 89

[ 18| Commissions 73652 72437  7B2EG 97655 8049975 j
17 |Rentals 4500 4500 4500 4500 4500 -
| 19 [Uuives 17425 139427 140106 141 2067 4564 673

119 |Supplies 29855 264056 213687 233078 2498 423

.30 )

| B | Totel Expenses 4010708 3972393 40566 07 54106 85 4363089

Ed ‘ '
| 23 [NetRevenues 5742607 56571 06 F17B035 6763414 6085291

| 24 {Percert Change 0985111 +092084 1094752

[ 7% |Alligures are subjectto audit

76

1 27 |

# |Peicental Avetage 8943687 1929636 sz IAXERY | [

3. P N T EEEENIT T — O Y
[ I [

TP S Vo et
Ay | T Ginrh, Ailati T W e

FIGURA 13.2:

La hoja de trabajo
QUARTERS usando
referencias absolutas
ala celda H23

LECCION 13 85

6. Dé click en el botdn de Guardar {o seteccione File » Save)
para grabar la hoja de trabajo; luego salga de Excel si no estd
listo para continuar con la siguiente leccion,

Como Usar REFERENCIAS ABSOLUTAS PARA HACER
PryoOSsTICOS

Use una referencia absoluta cuando desee que una celda en especial sea
la hase de cdlculo de varias formulas. Si posteriormente cambia el valor
dentro de la celda, Excel autométicamente recalcula todas las funciones
y férmulas que se refieren a ella.

Porejemplo, la Figura 13.3 muestra una hoja de trabajo que calcula
el pago aempleados portiemporegular, iempoextray tiempo doble. Las
férmulas de la columna B multiplican el nimero de horas de trabajo (en
la columna A) por el sueldo horario (en la celda B3). Las férmulasen [a
columna C multiplican por 1.51os resultados (en facolumna B), mientras
que las férmulas en la columna D multiplican por 2 los result:;.dos de l;l
columna. '

FIGURA 13.3:

Uso de referencias

7 -
n Hourly Rale Table absolutas para
[ |Ree o ™l pronosticar
L4 ] *
|5 [Hours  Regular Overtime Double
|-& ] 1 §25 12778 165
| 7 | 2 165 2475 13
|8 ] 1 241 I 495
|8 | ] 33 4495 66
1.0 | 5 4125 §187§ 825
RiN & 495 7428 49
_:Z_ 7 5775 86625 155
_I!_ [] 86 99 132
_% 9 7425 11135 1485
1] 10 825 12375 165
17 |
Gl
L]
Ll
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Paracrear la hoja de trabajo, la férmula =$B$3* A6 fue introducida
alacelda Bé; asi mismo, =$B$3*%1.5* A6 fue ingresada a lacelda C6, y
=$B$3*2*A6 ata celda D6. Las tres celdas fueron luego seleccionadas
y copiadas abajo en la hilera 15 usando AutoFill.

La referencia ala celda B3 fue hecha absoluta (8B $3) de modo que
wodas las férmulas usaran ¢l mismo valor en el célculo. Sila referencia
hubiera sido hecha relativa, séio B3, entonces el ndmero de hilera
hubiera cambisdo cada vez que la férmula era copiada. Por ejemplo, en
la celda B7 la térmula aparcceria como =B4* A7 aun cuando la celda B3
contiene el ndmere necesario para multiplicar por la celda A7.

Si quisicra predecir los resultados de una tarifa salarial incrementada,
s6lo se cambiarfa el nimero en la celda B3.

Formulas con
Fechas

Las férmulas y funciones se pueden usar para ejecutar diversasoperaciones
matemdticas sobre fechas al igual que sobre nimeros. Por ejemplo, para
calcular el nimero de dias enire dos fechas, reste 1as celdas que contienen
las techas. Silacelda A contiene 2/15/93 y la celda A2 contiene 2/25/93,
la férmula =A2-A1 resulta en el ndimero 10. También se pueden teclear
directamente las fechas en la férmula, por cjemplo

="2/25/93"-"2/15/93"

Note que las fechas debe ir entre comillas, en caso contrario, Excel
interpretard las didgonales (/) como operadores de division.

Consgjos para
Calcular con
Funciones y
Formulas

Las funciones y formulas pueden ejecutar ¢l grueso de las operaciones

matemiticas requeridas en las hojas de trabajo. Funcionan de maneras

muy similares. A continuacion mostramos algunos consejos uliles para

cuando se esié trabajando con funciones o con férmulas:

=  Mueva y copie férmulas igual que aprendié como mover y

copiar funciones en la Leccion 12, Mover una {érmula o
funcidn no cambia sus referencias de celda. Copiar una
formula o funcidn si.

s

A

LECCION 13 @ | !

|

®  Los resultados que calculan las funciones y tas formulas se
almacenan en la computadora internamente con una p'rccis'i(m
de 15 digitos. independientemente de cémo S¢ Myestren .
(Recuerde que los valores numéricos que son dcmusia’d(;
largos para caber en una celda son convertidos
automdlicamente s notacion exponencial.) ’

8 Para l!eyar a cabo un cilculo con porceniajes, use ¢l sfmibulo
d'c porciento (%) para hacer Iy (érmula més legible. Por
ejemplo la forma B1%6% puede ser mas significativa para el
lector que la forma decimal B 1*.06. Excel conviene |
uylomélicamenle el valor 6% a su equivalente decimal cuando
cjecuta las operaciones. .

m S una‘férmula o funcién presenta resultados incorrectos o un
mensaje de error, revise si falty Is indicacion dos puntos en los
rangos. celdas referidas que contengan texto o fechas I(:n ver

de nimeros o referencias a celdas equivocadas.

~ ® Cuando se est4 construyendo una hoja de trabajo grimde el
recdlculo puede retardar la respuesta de Excel a los lcélc“ot; Si
se presenta la respuesta demasiado lenta, apague rccélcull(; -
Pura .hacerlo seleccione Options » Calculation para desy h; ar
la caja de didlogo yue muestra 1a Figura 13,4, i

Para apagar ¢l cdlculo seleccione Manual en la scccildn

Caulculation de 1a caja de didlogo, ¥ luego OK. Cuando 57 se
dt‘:sca recalcular oprima FHCirl+ =)} 0 rearese a la cuja' dk,
didlogo (?ulcululion Options (Opeiones Jc Cileulo) y éné:icnda
Automatic Calculation (Caiculo automatico).

MaAs Opciones pe CALcuro |

Las opcione a secci : i

" pu‘om,s en la seccién Culeulation de 1a caju de didlogo determinan
clandosecaleulan las funciones v | 16 as: i omdti

¢ : sy las mmlds.Aummaiw(Aummdnco)
recalcula siempre que un valor cambie: ic It '
s S r cambie; Awromaric Except for Tubles
la [r t;;am.n Excepto para Tablas) recalcula ia hoja de trabajo excepto

§ tablas de datos especiales; Manual calcula solamente cuando se

|
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M axitaisen Hgiations: (10D
Maximum Change: Il] Li113]

FIGURA 13.4:

-~ Cafculstion Optivns . .
¢ siculali La caja de didlogo
o
& Automatic ch_'.iﬂ_“ﬂj oK Calculation Options
€ Automatic Except Tables ICalc Dgclml Cancel
 Manuat
Shaet Uptions
T Iteration X Update Reowote Aoferencas

[ Piacision as Displaped

[ 1964 Data Spriem .
[ Sove Extemnal Link Valuos ;
™ ARemate Egproizon Evalustion!
T Alloroste FormnEnty |

instruye especificamente a Excel de hacerlo. 8i se selecciona Manual, se
puede ordenar en lacaja de palomeo si lahoja de cdleulo serd recalculada
antes de guardarla,

Las opcidnes de iteracién de 1a caja de didlogo controlan la manera
en que Excel maneja referencias circulares. Una referencia circular
ocurre cuando dos o més celdas contienen férmulas o funciones que
hacen referencia una de otra. Por ejemplo, si la celda Al contiene una

. férmula que hace referencia a la celda B1, y la celda Bl contiene una

férmula que hace referencia a la celda Al, se tiene una referencia
circular. Si se crea una referencia asf, Excel mostraré la advertencia

Cannot resolve clrcular references

{No se pueden resolver reterenclas circulares}

indicando que Excel no puede determinar cud! férmulacalcular primere.

Normalmente, se¢ deben evitar las referencias circulares. Sin em-
bargo, si se desea que Excel calcule férmulas o funciones que incluyan
unareferenciacircular, seleccione lacajade palomeo lteration {hieracién).
Las funciones o férmulas serdn recalculadas tantas veces como se
especifiqueen lacajade texto Maximum lterations {[teraciones Méximas)
ohasta que ¢l valorde cadacelda alcance lo que se especifique en la caja
de texto Maximum Change (Méaximo Cambio).

La opcidn Calec Now (Calcular Ahora) de la caja de didlogo.
recalcula 1o hoja de trabajo asi como todas las tablas de datos y graficas
que refieran sus datos. La opeidn Cale Document(Calcular Documento}

LECCION 13

recalcula ﬁn.icamcntc la hoja de trabajo ¥ sus gréficas retacionadas
I:.a sec.ménl Sheet Options (Opciones de la Hoja)delacaja de diél;)
permite fijar c1ena§ funciones relativas al recdlculo. Update Rcmc;sl:
il:t(::tl"ﬁreer:lc;:sf (Acn.jal‘lzar Referencias Remotas) calcula f6rmulas que
(Prec)iisjénei erc;ucnlaa aolrosprogramas; laopcién Precision as Displayed
e | gualalo desp.lc.gado) almacena internamente ¢ valor de una
con la misma precisién con lg que aparece en la celda; la opcién
1904 DaFe System (Sistema de Fechas 1904y cambia 'la osgién
g:ﬁ;l:ﬁClor;ada de fechas que empiezan desde enero | de 1900 por la
o Valot:;c; : :(‘;2 l‘l)(:v'o la opcién Save External Link Values (Conservar
s va ‘ slabones Ext_emos) alrrllacena valores referidos desde
€nlos extemos en la hoja de trabajo activa; Alternate Expression
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Como insertar hileras
y columnas nuevas

C6mo borrar hlleras
y columnas

Insercion y
Borrado de
Hileras, Columnas

y Celdas

na vez que se empieza una hoja de trabajo, se

Como ingerlar y
borrar celdas

puede dar cuenta que necesita mads hileras y
columnas de las que habfa pensado. Agregal
hileras o columnas al final de la hoja de trabajo
no es problema. Pero quiza necesite insertar
una nueva hilera o columna en una hoja de
trabajo que ya contiene datos.

. s e hacid
Si hay espacio, puede mover hileras hacia abajoo Commndb'hzcdc
up lado para hacer lugar a columnas o hileras nuevas. Pero c0t1‘h012r10 e
i el
trabajo grande, esto requeriria seleccionar y arrastrar un gdrarl\ nurrtn T
' r ; 4s 5 ¢ ede inserta
ileras de arrastrar celdas selectas, pu
hileras o columnas. En vez . F ‘ -
i : ¢ camente gqueo
; a columna, haciendo automats :
elemento ounahileraoun mdl ' e
hileras se muevan hacia abajo, o bien, columnas hacia la derecha para de}

i as para cerrdl
lugar. De manera similar se pueden borrar hileras o columnas para

ESTHICIOS.
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i

También pueden insertarse y borrar celdas individuales o rangos de
celdas, Explicaremos los efectos de estas acciones en la hoja de trabajo
al final de esta leccién. |

Se puede insertar y borrar usando el mend Edit o el atajo de mend
que se despliega al apretar ¢l botén derecho del mouse. Una vez que
aprenda ambas téenicas, como lo hard en esia leecion, use|la que
encuentre més comoda. .

Hay algunas reglas gencrales acerca de la manera en gue las
inscreiones y los borrados afectan a lus referencias de cc!d;as; sin
embargo, revise siempre su trabajo cuidadosamente después de insertar
o borrar hileras, columnas o celdas. Examine 1a haji de rabajo para
ascgurarse de que las referencias de celdas en las funciones y en las
férmulas permanecen cormectas.

Ahora veamos c6mo insertar hileras y columnas, y se cxp]ica:r:in los
efeclos que estas acciones tienen en las funciones y las férmula.;;.

(Siestiusandoelteclado en vez del mouse, ejecute ls instrucciones
que se dan seleccionando las hileras o columnas especificadas, )} luego
seleccionando Ta opeidn Insert (Insertar) o Delete (Borrar) del mendi
Edit.)

Gomo Insertar
Hileras y
Columnas

Cuando se insertauna hilera, se agregauna hileranuevaen hlunt:o!arriba
de la celda activa. Por ejemplo, si se selecciona 1a hilera 5, o una celda
de b hilera 5, y luego se inserta una nueva hilcra, ios contenidos de 1a
hilera 5 pasardn a hilera 6. Y se tendrd una nueva hilera 5 en b]a‘nco.

Una razén para insertar hileras es espaciar la hoja de trubajlo. Las
hileras en blanco entre encabezados, subtotales o otales, por gjemplo,
hacen que una hoja de trabajo sea més facil de leer. Tambign puede ser
necesario insertar uny hilera para agregar informacion entre hileras ya
existentes. Por ejemplo, insertemos una nueva hilera 25 en la hé)ja de
trabajo QUARTERS para poder reacomodar las hileras,

1. Arranque Excel y abra la hoja de trabajo QUARTERS.

2. Apunie al nimero de hilera 25, a lo largo de 1a orilla izquicr-

da de ia hoja de trabajo (asegurandose de que el scﬁulador:

tiene la forma de un signe més (+), de tamafo grande). D(Ie

click con el botén derecho del mouse para depiegar ¢l mend de
|




atajo, y luego selecciene Insert.

Los datos en todas las hileras empezando con la 25 se pasan hacia
ubajo una hilera. Note que los valores de 1as celdas de Percentof Average
no cambian. Gracias a que la insercién no afecté a ninguna de las celdas
4 que se hace ref srencia en las férmulas, las férmulas—y sus valores—
no cambiaron.

Cuando se sefiala un ndmero de hilera, ¢l meni de atajo contendrd
la opcidn adicional Row Height (Allura de Hileras). Aprenderd acerca
de esta opeion en la Leccién 17.

3. Ahora hay una hilera en blanco; mucva los datos de la hilera
29, que ahora contienen las celdas de Porcenaje del Promedio,
u la nueva hilera en blanco 25.

Para insertar una columna, apunte a la letra de la columna que se
desea pasarhacialaderecha, y luego seleccione Insert (Ensertar) del atajo
o del meni Edit. (Cuando se apunta a una letra de columna, el ment de
atajo contiene la opci6n adicional Column Width (Ancho de Columna),
sobre la cual aprenderd en la Leccidn 17.)

Se puede insertar més de unahilera o columnaala vez seleccionando
varias hileras o columnas. Cuando se selecciona Insert del atajo o dei
_ mend Edit, Excel inserta un nimero de hileras o de columnas igual al

niimero seleccionado. Por ejemplo, para insertar tres hileras, seleccione
tres hileras, empezando en Ia primera que desca que avance hacia abajo.

COMO INSERTAR DESDE CELDAS SELECCIONADAS

Cuando seleccione Insert mientras apunta a un ndmero de hilera, Excel
supone que desea insertar una nueva. De igual modo Excel supone que
desea insertar una columna si el sefialador del mouse est4 sobre una letra
de columna.

Sin embargo, si se selecciona Insert mientras el sefialador estd en
otraparte de lahojade trabajo, tendré que indicar a Excel sidesea insertar
una hilera, una columna o una celda individual.

Si el sefialador estd en una celda cuando se selecciona Insert del
mend de atajo o del mend de Edit, Excel despliega la caja de didlogo
mostrada en Ia Figura 14.1. Las opciones Shift Cells Right y Shift Cells
Down(Mever CeldasalaDerechay Mover Celdas Hacia Abajo) insertan

celdasindividualesalahojade trabajo. Explicaremos €stas posteriormente.

rgz : INSERCION Y BORRADO DE HILERAS, COLUMNAS Y CELDAS
— 1
. . LECCION 14

FIGURA 14.1;
L1 caja de didlogo

Intent 1 "
nse.

T Shitt Celis figh
o Shit Cells Down

C Entire flow
 Entie Lolumn

Seleccione Entire Row (Hilera Completa) para insertar una hilera o

Em:re.Column {Columna Completa) para insertar una coelumna; luego
seleccione QK.

Como Borrar

Bprrar una hilera o una columna elimina todos los datos de sus celdas
$1 eslp sucede por accidente, seleccione Edit » Ura«lu((‘,‘trl+2i
inmediatamente — antes de gjecutar ninguna otra funcién de Excel.
Cuando se borra una hilera completz, las hileras abajo de ella se
mueven hacia arriba y las referencias de celdas en funciones y férmulas
se ajustan gutomdticamente. Cuando se borra una columna, las de su

df:recha se mueven hacia la izquierds, y las referencias de celdas se
ajustan automaticamente también.,

1. Apunte al niimero de hilera 12, dé click con el botén derecho
del mouse, y luego seleccione Delete (Borrar).

Las hileras debajo de Ia hilera 12 se mueven hacia arriba. Note que
los valores calculados en las celdas no cambiaron, porque las funciones
y férmulazs de ias hileras de abajo se ajustaron aulomdticamente a las
nuevas reterencias de celdas. Por ejemplo, las referencias de celdag e;l
la columna C se ajustaron como se muestra: ‘

-ANTESDE BORRAR  DEPUES DE BORRAR

Total Income =SUM(C7:C12) =SUM(C7:.CI1)
Tolal Expenses =SUM(CI35:C20) =SUM(C14:C19}
Net Revenues =C13-C21t =C12-C20
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2. Apunte al ndmero de hilera 19, luego seleccione Delete del opciones son Shift Cells Left (Correr Celdas ala Izquierda) y Shiﬁ Cells

meni Edit o del mend de atajo para eliminar la hilera extra en Up (Correr Celdas hacia Arriba). Seleccione Entire Row' o Entire
blanco. Column (Hilera Completa o Columna Completa), y luego OK,

3. Apunte ala tetra de la columa G, luego seleccione Delete del
atajo o del menu Edit. La columna G se borra, y los datos de

la columna H se pasan hacia la izquicrda para tomar su lugar. Efectos en |aS Insertar o borrar una hilera o columna dentro del rango de una furicién
. ) ) \ o formula, ajusta automdticamente el rango de modo yue 1as nucvas
4. D¢ click en el botdn de Guardar (o seleccione File » Save) HEfEfEﬂCI&S d celdas quedan incluidasen lareferencia. Insertar o borrar unahilera o una
para grabar la hoja de trabajo. La Figura 14.2 muestra Ia hoja Cel columna arriba o abajo del rango no afecta el blogue real de| celdas
de trabajo editada. € das referidas, pero puede cambiar el rango de coordenadas. :
Borre varias hileras o columnas a la vez selecciondndolas primero. Experimenlemos un poco para ver cé6mo funciony esto, |
Si en vez de apuntar a un nimero de hilera o letra de columna, se 1. Seleccione la celda C12, 1a cual estd referida en el ruﬁgo
apunta a una celda de la hoja de trabajo y se selecciona Delete del atajo (CT:Cil). .

o del mend Edit, aparecerd la caja de didlogoe Delete. Sus opciones son

similares a las de la caja de didlogo Insert, exceplo que las primeras 2. Seleccione Insert de los memis Edit o de atajo, luego Entire

Row, después OK.

_ s FIGURA 14.2: 3: Seleccione la celda C13 y note que el rango no cambid —— agin
File Edil_Formola  Formal Uain  Qpiions - Macro Window {1elp La hoja de trabajo refiere las mismas celdas (C7:CL1). Los valores que s¢
@ R@ M=md ][] (=] (o] 7] AT <] (ee[w []ER (O (A]) 20 QUARTERS con alimenten en la hilera 12 serdn ahora automaticamente
Gz [ ] hiteras y columnas Ny acumulados en el resultado calculado por a funcién SUM.
- QLEA -[-]| inseriadas y borradas '
- A B L D E £ G H t e 4. Apunte al nimero de hilera 7, y lucgo seleccione Insen del
|7 Isales 735175 7243676 7826466 0765457 6049951 menu Edit o del mend de atajo.
L !l
[ B jFemals SBS09 573567 597625 S86426 595677 "
9 [Lesses 16326 15325 15325 18325 15125 . , . o .
[ 10 [Royaies 1500 1500 1500 150 1500 3 Se]ccuonle la celda C14 y note en la barra de Férmula que el
1 Jinerest 12055 1297.56 131052 139676 1302585 rango en la funcién ha sido cambiada ; {12 ‘[ 1
[12 | Totot Incame 753315 9629493 1023864 121741 1045619 ang ) * ambiada a (CS'C.I 2). Este rango,
i sin embargo, representa al mismo bloque de cinco hileras
14 |Seleres 3064256 3056473 31756 3217867 3126289 s Fard ) . N
(15 |Commissions FIES2 12437 78255 97655 04947 prclvmmt.me referido en (C7:C11). Los datos que se ingresen
(18 |Reniais 4500 4500 4500 4500 4500 en la nueva hilera en blanco que es lu 7, se sum: ahorh :
(17 Jusites 13475 139427 140105 1412087 4564673 los totales q » S¢ sumardn ahora a
(18 [Supphes 29855 254056 213607 233076 249843 03 lotales,
| 19 |Totol Expenses 4010708 3972393 4058607 5410665 4163098
2 i A seloced " . .
z:‘NeIRevenues 5747607 5657106 176075 6763114 6OBSZSI 6. Ap.ume ala hllera namero 9, y seleccione Insert de los meniis
[22 |Percen Changs 0485111 1092084 1034752 Edit o de atajo.
23 |Percenl ol Average 0943687 0923636 1015241 1.1 1437] ] 3 A
) . L - .
= —— 7. Seleccione I funcién en ta celda C15. El rango ha sido
ady { i ajustado a (CR:C13) para incluir los datos que pueden :

introducirse en la nueva hilera que es 1a 9.
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Como Insertar y
Borrar Celdas

Cuando se inserta o se borra una hilera complela, todas las celdas en las
hileras adyacentes son afectadas. Lo mismo se aplica a insertar o borrar
una columnaentera. Insertar o borrarceldas individuales, afectasolamente
a)a hilera 0 a la columna en la cual est4n ubicadas esas celdas.
Veamos como afecta a la hoja de trabajo insertar y borrar celdas

1. Seleccione la celda C5 y luego seleccione Insert de los menis
Edit o de atajo para abrir la caja de didlogo Insert.

2. Asegirese que esté seleccionado Shift Cells Down y luego
seleccione OK. Unicamente las celdas de la columna C se
mueven hacia abajo una hilera; ninguna otra celda de la hilera
cs afectada (ver Figura 14.3).

3. Seleccione Delete del menu Edit, y luego OK para aceptar la
opcién preseleccionada Shift Cells Up.

FIGURA 14.3:
El efecto de mover

Duie_gptigns_Macro_Wadow _Hclp

() Tl At T iy (Ol TR R INT. coldas hacia abajo
» k4 B3
S5 ] Sl ed o B WG Rk [ R 2 A R B O R PR
%ﬁ_Wutinn ani Sons, Inc ‘; -
3] Fiscal 1393 4
1 :
BER ¢ Q. rd Q. 4h Q. Avarage b
0B TSt O, g
B =
E Sales 7243676 7625465 9765497 8278213 Py
EE 1365175 %
%g_ Fentals 573567 6597625 586426 5850 727 ‘3
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. La opcién Shift Cells Right de la caja de didlogo Insert y la opcién
Shift Cells Left de la caja de diflogo Delete afectan tnicamente a las
celdas de una hilera en particular.

4. Cierre cuidadosamente la hoja de trabajo o salga de Excel sin
guardar la hoja de trabajo editada. Seleccione No en la caja de
didlogo que muestra el mensaje

Save changes In QUARTERS. XLS?

{¢Guardar camblos en QUARTERS.XLS7}

Insertar y borrar celdas afectan las referencias en las funciones yen
las férmulas de la misma manera que el insertar y borrar hileras y
columnas completas. '

También pueden moverse o copiarse ¢ insertarse celdas en un solo
Paso. Seleccione las celdas que se desea insertar entre otras, ¥ luego
seleccione Cut o Copy del atajo o del menii de persiana Edit. Seleccione
lacelda de destino, y luego Insert Paste (Pegar Insertando) del mend Edit
odelmeni de atajo. Sila insercién habra de afectar otras celdas, verd una
caja de didlogo con las opciones Shift Cells Right y Shift Cells Down.
Seleccione la opeidn deseada, y luego OK.
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Formateo de Hojas de Trati)ajo

Una hoja de trabajo efectiva capta la atencidn de[! lector.

Es ficil de leer y esté diseftada para aumentar, y no distraer, la
comprension del lector de su contenido. Gracias a que Excel es
una aplicacién de Windows, puede ajustarse el formato de la
hoja de trabajo a la pantalla, probar varias combinaciones de
tipografia, estilos y distribucidn, hasta que se esté sz;li:sfecho
con su apariencia. Luego, después de estar seguro que el
formato estd como uno lo desea, se imprime la hoja de trabajo
_terminada.
Las lecciones de la Parte 3 muestran como formatear 1a

hoja de trabajo para obtener un maximo impacto.
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Cdamc centrar los
datos en las columnas

Alineamiento derecho,
lzqulerdo y central

Orlentaclén y
colocaclén del texto

Barras de herramlenta
especlales

Alineacion de

Datos en las Celdas

ener los datos correctos en la hoja de trabajo
puede no ser suficiente para asegurar que sea
leiday apreciada. Lamaneraenque se presenta
una hoja de trabajo es frecuentemente un fac-
tor fundamental del impacto que haga en el

lector.

En esta leccién, aprenderd como alinear los datos dentro de las
celdas y en la hoja de trabajo. También aprenderd como desplegar la barra
de herramienta de formateo, que es una de varias barras de herramientas
especiales de Excel.

ceccion1s | ()

Alineacion
Horizontal
Rapida desde la
Barra de
Herramienta

~

Todos los formatos se pueden aplicar a una celdaen blanco o aunacelda

* con datos. Cuando posteriormente se agrega informacion a una celda

formateada, el contenido aparece autométicamente en el formato
previamente especificado. Se puede despejar la celda de su contenido,
dejando el formato intacto, o despejar s6lo el formato, en cuyo caso el
formato de ta celda regresa al preseleccionado.

Empecemos por centrar el nombre de la compafiia en la ho;a de
trabajo QUARTERS y el titulo sobre las columnas de datos.

1. Aranque Excel y abra la hoja de trabajo QUARTERS.
2. Seleccione la celdas de la Al hasta la G1. '

3. Dé click en la herramienta de centrado sobre columnas de 1a
barra de herramienta. Es el botdn con la letra a flangueada por
puntas de flecha, localizado bajo la opcién Window de la barra
de mend.

El texto de lacelda Al se centra en la hoja de trabajo (Figura 15.1).
Este formato centra el contenido de una celda dentro del rango de celdas
en blanco que se haya seleccionade a su derecha. El centrado se detendrd
al fin de la seleccién o en la primera celda que contiene datos. Si se dd
click enlaherramienta de centrado sobre columnas sin primero seleccionar
varias celdas, ¢l contenido de lacelda activa se centrard dentro de lacelda
misma.

Lasceldas B 1 aG2noaparecen; sinembargo, permanecenen la hoja
de trabajo. El texto que se despliega adn estd considerado de la celda Al
y se realineard si se ingresa informacién a cualquiera de las celdas en
blanco. Nete gue el boién de centrado sobre columnas se muestra
oprimido. Los botones oprimidos indican el formato de la celda activa,
por lo tanto cuando pase a una celda mire la barra de herramienta para
ver cudles formatos se aplican a ella. Para cancelar un formato, dé click
en el botdn oprimido,
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4. Seleccione las celdas C3 a la G3, y dé click en la barra de
centrado sobre columnas para centrar el tilulo.

5. Seleccione las celdas A24 hasta la G24, y dé click en la burra
de centrado sobre columnas.

Ahora centremas el encabezado de Ja columna dentro de sus celdas.

6. Seleccione las celdas C5 ala G5, y dé click en el botdn de
alingacion central, que es el décimo desde Ya derecha de la
barra de herramicnta, ubicado entre las opciones Mucro y
Window de la barra de menii. Cada uno de los encabezados de
columna estd centrado dentro de su celda. El botén de
alineacion central se muestra oprimido, asi que se puede
cancelar el formato dando click en el botén por segunda vez,

7. Dé click en el botén de salvar (Shift+F12) para salvar Ia hoja
de trabajo.

L
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l
La Figura 15.2 muesira la hoja de trabajo después de! que tos
contenidos de las celdas han sido centrados.

La herrumienta de alineacion izquierda alinea el conllenido de
las celdas hacia la izquierda, y la de alineacién derecha hacia la derecha.
Para opciones adicionales de alincamicnto, use la caja de| didlogo
Alignment (Alincamiento).

-
fite Edit Formuls

Format Data

eS| .|

FIGURA 15.2:
L hoja de trabajo
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D|Seﬁ0 con |a Lacajade didlogo Alignment, mostrada en la Figura 15.3, incliye varias
\ » opciones de alineamiento ademds de Jas cuatro horizontales di:laponibles
Ca]a de Dlalogo de la barra de herramienta. La Tabla 15.1 describe estas opeiones.
All nment - Muestre la caja de didlogo seleccionando Alignment yu sea del
- - . 1
g mend de atajo (dando click al botén derecho det mouse en la celda

seleccionada) o del meni Format.

'

—
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OPCION DESCRIPCION

ined haaizquierda, el
i ! i i nirola como se alinea, de derec
Horizontal | (llonz?nldﬂCO
' contenido de una celda. y
. . N n
General " Es la opcién preestablecida de alineamiento; el contenido e

; general alineado a la izquierda y los nimeros a la derec-ha.
Lefi, Center, | (lzquierda, centrado, derecha) Cada uno alinea el contenido de

i i a segiin la opcién seleccionada.
Right i la celda segin
Fill | (Rellenar) Repite el contenido de la celda.a tedo el ancho dﬁ‘la
‘ | celda o através de celdas en blanco seleccionadas a la devecha.
Justify (Alinearatodeloancho) Distribuye el contenido uniformemente

1 entre las fronteras derecha € izquierda de la celda.
i i i nter
Center Across, (Centrar lo seleccionado) Hace 1o m1sn:|o que la og::gn Ce
Selection i Across Columns en la barra de herramientas su?.n d. 1
Vertical l Alinea texto en la parte superior, central o inferior de las
! fronteras de celdas, -
Wrap Text - (Cambia texto de rengién) Divide renglones largos en vario
| renglones. s
Orientation | (Orientacién) Gira el contenido de la celdaparaque apar;,_ N
{ 10 ancho o hacia abajo de una celda. No se puede cam m;:r."
crientacion si la celda estd formateada con las opciones Fill,

[ ¢ Justify o Center Across Selection.
| '

FIGURA 15.3:

La caja de didlogo
Alighment

TABLA 15.1;°
Opciones de la caja de
didlogo Alignment
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Experimeniemos con algunos otros pardmetros. Haremos algupgg
cambios a la hoja de trabajo, pero no los guardaremos,

1. Seleccione las celdas C521aGs.

2. Seleccione Alignment del meny de atajo o del menuy Forma,

Mire las cuatrg opciones para Orientation {Orientacion). El formateg
preseleccionado mostrado en video inverso, imprime el contenido dela
celda a lo ancho de la misma, Las otras tres opciones imprimen hacia
abajo, ajustando autométicamente la altura de ta hilera seglin el niimero
de caracteres. Las opciones a la derecha y al centro imprimen el
contenido de la celda rotandolo dando el frente hacia la izquierda o hacia
la derecha. La opcidn a 1a izquierda no
imprime uno bajo el otro,

Nose puede cambiar |a orientacion de uny celda formateadasi se usé
cualquicra de las opeiones Horizontal Fill (Relleno Horizontal), Justify
(Justificar) o Center Across Selection (columns) (Centrado sobre Ia
seleccion) (de columnas). Sin embargo, puede cambiarse la orientacion

rota los caracteres pero s log

3. Seleccione el botén de orientacién — que es ¢l que tiene la
palabra Text viendo hacia la derecha — y luego OK.

El contenido de las celdas seleccionadas gira para dar la cara hacia
laderecha (Figura 15.4), Note que la alturade la hilera se ajustd para dar
lugar a la orientacién de los caracteres. El contenido est4 aiin centrado
en las celdas porque reticnen el formato de centrado horizontal,

4. Con las celdas agn seleccionadas, dé click en e] botén de
alineaci6n derecha de la barra de herramienta, luego en el
botén de alineacién izquierda. Note que el texto cambia de
centrado hacia la derecha, y luego hacia la izquierda al
seleccionar las herramienias de alineamiento,

3. Seleccione Alignment del mend de alajo o del men Fornr;
seleccione luego la orientacién preseleccionada, OK.
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Ready

Eltexto vuelve a la orientacién preseleccionada :eqllio de 12: é;:;g:z
i lonormal, Parareducirla, es
rolaalturade hileranoregresaa .
icerlo manualmente, como aprenderd en la Leccién 17. l
+6. Seleccione Alignment del menu .de atajo 0 del mccl:mi lz:)rma
‘ luego Top (Superior) (en la seccién Vertical), y depu o
seleccione OK. El texto ahora aparece en la parte super
las celdas.

7. Seleccione la celda Ad y teclee el signo $.
8. Seleccione las celdas Ad a G4.

. - at,
9. Seleccione Alignment del meni d.c atajo o del menglforma
- seleccione Fill (en la seccién Horizontal), y luego OK.

LECCION 15 [ |

|
Fill repite ¢l comenido de una celda para Henyr la celda entern o
todas fas celdas seleccionadus en blaney hacia lu derechy, asique el signo
de pesos se repite en ody la hoja de trabajo hujo ¢l (o, ’

CoMo DespEsar Formaros

Excelirmtaalose

ontenidos de celdasy asus form
separadas. Se puede despefar ¢
alineamiento preselece 1om

dtoscomodos entidades
I formato para regresar uy celdas al
adv sin despejar el contenido de T celda, De
mancra andloga se puede despejar el conienido Pero dejar el I'ulrm:llo en
subugar, Incluso se 1 puede dar formate y ung cetdaen blanco e ingresar
su contenido posteriormente, .

Experimentemos ahora en despejar celdas ML ver como afecta el
formuto de ta hoja e trabajo.

L Seleccione [a celda A | y oprima Crrl+Del. que son Jiis teclas
para despejar el contenido de una celdy, Bl texqo s¢ borry y
Tedparecen las celdas en blanco AlaGl.

b

Teclee Morgun and Company,
Enter. Bl texto automdticamente
trabajo, porgue se despejo ¢l con
su tormato.

¥ luego O click en th Cija
Ne centra sobre ty hoja Idc
tenido de las celdyg pero no

3. Seleccione Iy celdy C3y dé click en o boton de
las columnas en Ia barra de herramienta, 2
formato y regresa la celda a alineamiente

Cuntrudj) en
Sto cancela elf
preseleccionado,
4. Seleccione la celda A4, oprima Del, seleccione Formag q|c la

caja de didlogo Clear Que aparece, y despuds sclcccim}e OK.
La hilera de signos de pesos desaparece, porgue despe i el
formato cancely el comando Fijl, :

3. Con cuidado cierre 1 hoja de trabajo sin guardarly,
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Facilidad de
Disefio Adicional
con las Barras de
Herramienta
Especiales

Aparte de labarrade herramienta standard, Excel ofrece varias barras de
herramienta especiales para llevar a cabo una variedad de tareas, Todas
1as barras de herramienta trabajan del mismo modo y se usan las mismas
1écnicas para mostrarlas. A continuacién se mucstran algunos consejos
pura trabajar con barras de herramientas:
B Antes de desplegar una barra de herramienta, asegirese de
estar en 1a modalidad Ready. No se puede desplegar una barra
de herramienta en modalidad Edit ni Enter.

B D& click en el botén derecho del mouse &n cualquier parte de la
barra de herramienta para desplegarel meni de atajo de barras de
herramienta, mostrado en la Figura 15.5. El mend de atajo
enumeralasbarrasde herramientaespecialesque Excelsu ministra,
ast como dos apciones adicionales. La opecion Toothars... desplicga
la caja de didlogo Toolbars. La opcién Customize... permite
agregar y borrar herramientas de cualguiera de las barras de
herramienta para crear barras al gusto.

B La primera vez que se abre una barra de herramiema especial,
aparece en una ventana superpuesta encima de 1a hoja de rabajo.
Cambie el tamafio de una barra de herramienta arrastrando
cualquiera de sus linderos {no se puede arrastrar una esquina).

B Mueva una barra de herramienta arrastrando su barra de tfwlo.
$i coloca 1a barra de herramienta encima 0 abajo de la hoja de
trabajo, la barra de heframienta autométicaniente se expandird
para lenar el ancho de la panialla.

FIGURA 15.5:
v Slandar El meni de atajo de
formatling
Toolbars

Utility
Chart
Drawing

Microsoft Excel 3.0
Macro

Toolbars...
Custlamize.,,
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Para cerrar una barra de herramienta especial, dé click en la caja
de control de sumend, ¢ use la cajade didlogo Toolbars. (No hay
mend de contrel disponible realmente, la caja sirve sélo para
cerrar la barra de herramienta.) Siarrastrd la barra de herramicnta
mds arriba 0 més abajo de la ventana de la hoja de trubajo
arrdstrela de regreso hacia adentro de la hoja de trabajo paru'
redesplegar la caja de control del menu.

L-a lsigmcnle vez que despliegue una barra de herramienta espe-
cial, aparece del tamaiio y en la posicidn en yue estaba la dltima
vez yue la cemrd,

Encienda y apague 1a barra de herramienta standard oprimiendo
Cirl+7. También se puede arrastrar la barra de herramienta
standard hacia el espacio de trabajo para desplegarla en una
ventana con su propio mend de cajade control. (En algunos casos
puede resultar que la mejor posicion de la barra de herr.'uuicnl;l
no sea arriba de la hoju de trabajo.)

Tanybién puededespleparse unabarrade herramienta selecionando
Opll.ons » Toolbar para desplegar la cajade didlogo mostrada en
la Figura 15.6, Seleccione la barra de herramienta que quiera
desplegar. El botdn Hide (Ocultar) se transformard en Show
(Mostrar). Seleecione Show para salir de la caja de didlogo y
desplegar 1a barra de herramienta que haya seleccionade. La
Tabla 15.2 explica las otras opciones de esta caja de didlogo.

FIGURA 15.6:
L caju de didlogo

Toolbars

' Toatbars

']
Miciosoft Excel 3 0
Macio
Stop Recording
Macio Paured

Tookar Nome:
JSIandaid

(
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TABLA 15.2;
Opciones de Ya caja de
didlogo Toolbar

DESCRIPCION

Show Toolbars (Muestra barras de herramienta) Envmers las barras de
herramienta disponibles — seleccione Ja yue quiera mostrar.

Toolbar Name (Nombre de barrade herram’enta) Muestra el nombre de labarra
. de herramienta seleccionada. Seleccione la caju detexto y dé un
nuevo nombre paracrear una barrade herramientapersonalizada.
Hide (Esconder) Quita la barca de herramienta seleccionada.
(Mastrary Muestrs la barra de hermramienta seleccionada. Este
i botdn aparece sélo cuando la barra de herranmienta seleccionadi: |
no estd ya desplegada en la pantalla.
Close " (Cerrar) Cierra bu caja de didlogo.
‘(Sobre diseno} Muestra una caja de didlogo para agregar y
,eliminar botones de las barras de herramienty o crear barras de
herramienta propias.
Reset (Restablecer) Elimina botones opcionales agregados a 1a barra
,de hertamienta seleccionada, regresdndola a su configuracion

Show

Customire ...

“original.

B Labamradeherramiznaespecial que hayadesplegado permanecerd
en la pantalla cuando cierre la hoja de trabajo y aparceerd
autométicamente la siguiente vez gue arranque Excel, Asique, a
menos gue planee usar la barra de herramicnia otra vez, cidrrela
antes de salir del programa,

CoMOMOSTRAR La BARRA DE HERRAMIENTA DE FORMATEAR

Una de las barras de herramienta especiales que se usamds frecuentemente
es la de Formatear. Otvece muchas mis opciones — y mds variadas —
gue la barra de herramienta stahdard para el tormateo de celdas.
Mostremos 1a barra de herramienta de Formatear como un ejemplo
de la manera en que se despliegan 1as barras de herramienta especiales.
1. Asegarese de que estd en la modalidad Ready (Listo)
{recuerde, no se puede desplegar una barra de herramienta
especial en las imodalidades Edit o Enter)..
Cologue ¢l sefialador del mouse en cualquier 1ado de la barra
de herramienta standard y dé click en el botdn derecho del
mouse para mostrar el mend de atajo. .o

ta

BOTON

1"5 Sans Smid .
1

i

o] |

Lecoonts {1 ‘

|

3. Seleccione Formanin
: g (Formatear) para desplegar la barre
herramienta mostrada en la Figura 15.7. Pee ?‘Td *

LaTabl: e b T .
, her;nar:il‘:::tl 5';3 describe lus tareas quegjecutan los botones clc:i labarra
a Formatting. En la Leccion 16 aprenders como
Je herr 14 Formatin . prenderd comio usar los
b ::)dnzs qhue lorrpdledn numeros. Para aplicar otros formatos desde esta
a de herramientas, seleccione lns celdas :
. . 4s que dese :
click en el botén apropiado. ) # fomiae ’ “
I

4 i . .
CI.CITC fa barra de herramienta Formatting dando cliclk enla
caja de control de su menu. I

5. é i no est4 | {
Salga de Excel si no estd listo para continuar con la Leccién 16

FIGURA 15/7:

£ Ot attiry
(e Sumsew ]3] Lo buma e
E] an ? herramienta
Formatting
!
NOMBRE TABLA 15.3;

"PROPOSITO

Botones de lal'burra
de herramiénta
Formating ['

|

Caj i
aja de estilo Muestra formatas para nimero que

hay en la caja del mismo nombre dela
barra de herramienta standard,

I
I
|'
i
i
Caja de nombre ‘

P + Muestra los tipos disponibles que son

| parte del ambiente Windows.,

Caja de puntaje | Muestra los tamailos, en puntos

disponibles para el tipo seleccionado.

Negri ji
gritas Convierte.a negritas el contenido de

| celdas,
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ksl

lialicas

Subrayar

Tachar

Justificar

Estilo monetario

Estilo por ciento

Estilo coma

Aumentar decimales

Disminuir decimales

Hace itdlicas o cursivas el contenido
de celdas,

Subraya ¢l contenido de celdas.

Traza una recta horizontal sobre el
contenido de celdas.

Aplica el formato justificado.

Formatea numeros insenéndoles el
signo de pesos, separador de miles, y
dos cifras decimales. El aspectode la
herramienta cambia segunelpais fijado
en el tablero de control de Windows,

Muestra valores decimales como
porcentajes.

Formatea nuimeros insertdandoles
separadores de miles y dos cifras
decimales.
Seagregaunacifradecimal al valorde
1a celda seleccionada cada vez que se
dé click a este botén.

Se quita una cifra decimal al valor de
Ia celda seleccionada cada vez que se
d4 click a este botdn.

TABLA 15.3:

Bowenes de la barra
de herramienta
Formatting
(comtinuacion)

LECCION 15 1‘13

NOMBRE PROPOSITO

Sombre; i .
eado claro Agrega un patrin £nis claro de fondo

a la celda seleccionada,

AutoFormat

: Aplica el dlimo fenmato usado e Ia
. holadelmbujoaungmposcleCCionadu

, de celdas, Qprlma Shifty dé click a)
i botén AutoFormatpara iry venirentre

. los formatos disponibles.

TABLA 15.3;

Baotones de 1 barra
de herramienia
Formulling
(continuacion)
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PRESENTACION DE

Cémo cambilar los
formatos de numeros,
de la fecha
y de la hora

Cémo usar la barra
de herramienta
Formatting

Formateo
de Numeros

T: xcel ofrece formatos preseleccionados para
m’Jméros, fechas y horas. Si desea cambiar las
— opciones preseleccionadas, se puede escoger
de entre otros formatos interconstruidos o
2 incluso modificarlos al gusto.

En el formato prescleccionado, los ndmeros se alinean hac_ia la
derecha en la columna, sin importar cuéntos decimales tengan. Es cierto
que los nidmeros gue estén alineados segdn el punto degimal son més
faciles de leer e interpretar. Aplicando formatos numéricos, se puede
hacer que Excel agregue ceros, comas 0 separe miles, y que agregue el
signo de pesos.

weccons |11

|

De manera similur, se pueden formatear nimeros deciules para
que apareecan como fracciones o porcentaics, y puwde cumhlielrsc la
formien que se muestren la fecha y lahora, Abigual que con los formuatos
de alincamiento, pueden tenerse Tormatos numdricos en una celda en
blancao, ¢ ingresar tos datos posteriormiente,

Cambiar [s manera de mostrar el conienido de una celda, no altera
su valor real. Se pueden redondear nimeros y desplegarlos con menos
decimales-sin reducir la exactitud de las operaciones nitemdticas,

En estaleccién, aprenderd como lormaltear niimeros usandoa harra
de herramienta standard, la barra de formateo y lacajade aliﬁln'gu Format
Number (Formateo de nimeros), [

Cémo
Formatear
NUmeros con la
Barra de
Herramienta
Standard

La cuja Style de la barra de herramienta standard conticne seis formatos
interconstruidos — patrones preestablecidos — paracambiar rapidamenie
el aspecto de los ndmeras, Siga estos pasos para formatear nimeros en
{a hoja de trabajo QUARTERS usando la barra de hcrrmnicnlésl:undardt

1. Arranque Excel y abra la hoja de trabajo QUARTERS. |

1
2. Seleccione las celdas de 1la C22 a la F23, las cuales conticnen
ndmeros decimales representando porcentajes,

3. Déclick en fa flecha hacia sbajo yue estd a ks derecha d%: la
caja de lista Estilo de la barra de Herramiema para mostrar los
siguientes formatos interconstruidos:

Comma (coma)

Comma (0) (coma {0))

Currency {moneda)

Currency (0} (moneda (0))

Normal

Percent (Porciento) ' 1

Para aclivar la caja de lista Style con el eelade, oprirﬁa Ciri+8
y tuepo las teclas T o | para desplepar el estilo que se desca
seleecionar (hay formatos intercostruidos adicionales
disponibles en la caja de didlogo Format Number (Formatear
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nimero), que se explica posteriormente en esta leccion),

4. Seleccione Percent.

Los valoresdecimales sesustituyen po'rsus porcenlajes cyuivalentes
(Figura 16.1}. Note que Excel redondet los nimeros decimales. Por
ejemplo, el valor 985111 fue redondeado a dos decimales y aparece
como 99%. Excel almacena el contenido de lacelda en su valor decimal
original para que pueda ser usado en operaciones matemdlicas.

5. Seleccione lus celdas C7 ala G21.

6. Abra la caja de lista Style y seleccione Comma.

Elle Edi Formula

FIGURA 16.1:

Valores decimales
formalteados como

porcentajes
- A [~
A - B i~ D E F G H i o

3 [Leases 15325 15325 15325 16328 15325

10 |Royales 1500 1500 1500 1500 V0o

11 |interest 12085 129756 131052 139676 1302 565

| 12 {Totai Income 9753315 9629499 1023664 121741 1044834

13

14 |Salaries 1054256 3056473 JI7656 3217867 1126289 j
‘1% |Cammissions 73652 72437 78255 97655 BO4997%

16 |Renials 4500 4500 4500 4500 4500

17 |Unies 13425 139427 140105 1412097 4564673

18 [Supplies 20055 254656 213667 233076 2498423

| 19 [Total Expenses 40107 08 3372393 4058507 5410605 4363048

20

| 21 |Net Revenues 5742507 E763414 50857 9%

22 lPercent Change e

23 |Percent ot Aversga [

(24

E

28 +
Al 2
Racdy Tt T
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En la pantalla, los nimeros en las celdas ahora tienen dos cifras
decimales, y los miles estdn separados con una coma. El estilo Comma
(0) muestra los niimeros sin decimales.

Note que el contenido de las celdas E12, F12 y G 12 estd constituido
por el signo numérice tnicamente (#). Eslo indica que, a pesar de gue
Excel haconservado los valoresen memoria, los nimeros son demasiado
largos para caber en la celda. Aprenderd cémo ampliar Jas celdas en la
Leccion 17.

7. Ahora abra la caja de lista Style y seleccione Currency.

El estilo Currency es ¢l mismo que ¢l estilo Comma, pero todos los
mimeros van precedidos por un signo de pesos (Figura 16.2). Cur-
rency{0) es lo mismo exceptoque no tiene decimales. Note que ahora hay
muchos nimeros mas gue no se muestran por ser demasiado largos.

FIGURA 16.2;
= Microsatt Excel |3 . 3
fite Edit Formula  Format Daln  Options MWacre  Window Help Niimeros mostrados
Fones ) (6] =) (BL TAT ] (o [ 313 (0 (i) en ¢l estilo Currency
T f7es7s
= - i A -l a
A a [ D E F [+] H ]
5 1stQr 2nd Oy JioQw,  #h Cu.  Average
5
_7_|Seles PRELIREELRREERRRE FRERERRE SRVEERER $HDIELRY ':I
Lﬂanlals $5 85090 $573567 $59762% $5B86426 $5B856 /7
9 [Leases FARRRPEF BEEFEIIR FRRQREEE FRREIIRE 1RELEIRE
10 |Royaltes $1.50000 $150000 3350000 $1.50000 4150000
11 [Interest $1.20650 $1.29756 8131052 $1.396 76 $1.3025%
12 [Totalincame FRRERREE FEELRREE FRERRRRE FEVERERD BRVVRERE
13
-1 14 {Salanes FRRRREET RERVRERE LRRRREEX HISRRIRE HRIVDIRE
15 |Commissions T73657  $72437 478555 497655 480500
_!i Fiertals $4500 00 $450000 $450000 $450000 $450060
17 |uuines $1,34250 $1.39427 940105 #ékfreey $456407
18 |Supphes 4298550 $254056 $2136647 3233076 $2.498 2
18 |Tol E.penses FRARLRES FACERVRE PRRRFREE BNERENEE FRV¥ESRER
20
21 {Ne! Revenues FEXETREE BREETRRE SEXEPERE FRERQNLD REIRRNEY |
22 [Percert Change 99%; 105% 109% _4
L bd
Fead, === o

i
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Cuando activa una celda, ¢l nombre de su formato aparecerd en la
cajade lista Toolbar's Style {Estilo de o barra de herramienta). Reficrase
ula c'uj,u die Tista si no estd segure de cial formato es ci que se aplico o los
datos. N

Ahorasupongaque desea cambiareltipoo algunaofra caracieristics
del formato de una celda que extd en estilo Normal. Si selecciona la celda
y luego Normnal de la caja de lista Style, Excel desplegard una caja de
diglogo con el mensaje

Redefine "Normal" based on selected cells?

{¢ Redefinir "Normal” basado en las celdas seleccionadas?)
con lus opciones Yes, No, Cancel y Help (51, No, Cancelar y Ayudi).
Sclecciong No.

5 se selecciona Yes, el estilo Normal serd cambiuado, y cada celda
de T hoja de trabajo que esud formateada con el estilo Normal cambiard
inmediatumente para iguzdar el estilo de lu celda activa.

Para retovnar ung celda al formato preseleccionado de Excel,
seleccione Edit » Undo Style (Cii+Z) inmedistamente después de
formatearla, o seleccione Format de la caja de didlogo Clear.

Como Cambiar el
Nimero de
Decimales con a
Barra de
Herramienta
Formatting

La harra de herramienta Formatting contiene més opciones para cambiar
formatos de nimeros gue 1a barra de herramienta standard. Siga estos
pasos para cambiar ¢l namero de cifras decimales de los ndmeros.

i. Desplicgue la burra de herramienta Formatting — dé click en
el botén dereche del mouse de 1y barra de herramienta stand-
ard y luego seleccione Formatting del mend de aLujo.

[o%]

Aseguérese de que las celdas que fueron formateadas usando
el estilo Currency — celdas C7 a G21— siguen seleccionadas;
luego Jé click en la herramienta de reducir decimales. Es el
tercer botén de 1a devecha de la hilera inferior. La cifra que
aparece en cada celda seleccionada se reduce una cifre decimal
y s redonden si es necesaiio — a pesar de que su valor exaclo
alian se almacena,

Y sin

3. 3¢ chick en el botén de reducir decimaies una ver s
dechmates iodos fos nimeros weanzan 2 desplegarse en Lapiimalla,

i

'

v
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4. Dé click en 1a herramienta Comma para aplicur ese forniio.
El formato Comma regresa las cifras a dos decimales,
tomando prioridad subre el cambio que acaba de hacer el
formato Currency. Su nombre aparece en las cajas de Estilo
tanto de T barra de herramienta Formatting come de 1o
standard, pero los botones de formateo de las barras de
herramienta, 010 S¢ muestran oprimidos.

5. Abra la caja de lista Style y seleccione el estito Comma (0.

[£]

6. D¢ click en el botén de guardar (Shitt+1712) en la barra d
herramientas standard.

Reducir el nimero de decimales mostrados, o aplicar otro formato,
no altera el valor numérico de las citras, como se puede ver en 14 barra
Formula. Pero puesioque el vilor real se usa para operaciones num_:|11|:'\lic:1.~;,
la hoja de trabajo impresa puede parecer que tiene errores pequefios de
aproximacion de los cdlculos. St molesta esta inconsistencia, admenteel
nimero de decimales, usando el botdn de aumentar decinales, para gue
¢l nimero mostrado iguale el valor real. !

Los botones de la barta de herramienta Formaiting que usé en esta
seccion, no siguieron "oprimidos” al dur el click. Esto significa gue los
botones no sirven para encender y apagar, asi que no se pucde cancelar
el formatco dando click por segunda vez al mismo boton. Para cancelar
el formato, seleccione Format de ta caja de didlogo Clear, selecrione el
estilo Normal de la caja de lista Style, o aplique una de Jas otras opeiones
de formato.

7. Cierre la barra de herramienta Formatiitg — dé click ¢n I!a

caja de control de su ment. :
!

8. SalgadeExcelsinoestd listo paracontinuarcon lasiguiente leccion.

]

Como Usar la
Caja de Didlogo
Format Numbey

i
La barra de herramienta Formatting es Gil; sin embargo. s6lo suministra
algunas cuantas opeciones de formato de ndmeros, y ninguna para hioras
y fechas. Para tener una gama mds amplia de formatos, y pare| crear
formatos especiales, use la caju de didlogo Formart Number, mostrada en
la Figura 16.3.

|
|
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Code [General

Somplo:

FIGURA 16.:
La caja de didlogo
Format Number

R

Number Format

808 8R0)
#.800_) [Red)t, 20}
0 880700_).(0. ¢80 00)

FORMATO"

Normal

Comma

Time (hhmm)
Date (dd-mmm-yy)
Currency

Percent

Scientific

Puara abrir la caja de didlogo, seleccione las celdas que se desea
formatear, y luego Number, del mend de atajo o del mend Format.-

En la caja de lista Category, seleccione el tipo de formato
interconstruido que se desea aplicar. La Tabla 16.1 cnumera tecleos de
atajo para aplicar los formatos interconstruidos de uso mis trecuente.

Las descripciones de los formatos disponibles para la calegoria
seleccionada aparecen en la caja de hista Format Codes (Codigos de
formato), y el contenido de la celda activa debidamente formatcada
aparecerd a continuacién de la palabra Sample (Muestra). Cuando esté
satisfecho con el formato, seleccione OK, Para que alguna celda vuelva
al formato preestablecido en el programa, seleccione All (Todos) en la
caja Category y seleccione General en la caja de lista Format Codes.

TABLA 16.1:
-
TECLEO Tecleos para utilizar
Crrl + Shift + ~ formatos
‘ Curl + Shift +1 interconstruidos

Crrl + Shift + @
Curl + Shift + #
Cirl + Shift + $
. Cirl + Shift + %
Crrl + Shift + #
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Los cédigos que van después de un punto y coma, en los formatos
de nimeros, indican cémo aparecerdn los nimeros negativos. Si no hay
ningiin cédigo, los niimeros negativos serdn precedidos por el signo
menos (- ).

Para crear un formato especial, construya una serie de codigos en la
caja de texto Code (Codigo), y luego seleccione OK. La Tabla 16.2
muestra los codigos que pueden ser utilizados, Co

Para borrar un cédigo especial, seleccisnelo en la caja de lista
Format Codes y seleccione Delete, No se puede borrar un formato
interconstruido— el botén Delete aparece oscurecidacuando se selecciona
un formato interconstruido.

En la Leccién 28 aprendera c6mo evitar que sc desplieguen valores
cero y cdmo hacer otros ajustes en la manera de presentar ¢ imprimir la
hoja de trabajo.

YyyYy
hh

mm

AM/PM

1
|
|

i ceros finales 4 la derecha de! punto decimal

! separador coma

+ abreviatura del nombre del mes

I
1
|
!
|
b
I

segundos
i indicador de AM o PM

TABLA 16.2;

Cadigos para crear
formatos sobre disefio

REPRESENTA

namero del Q u19

signa de pesos
nimero de mes

nimero del dia

nimero del afio, con dos digitos
nimero del ado, con cuatro digitos
hora

minutos
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PRESENTACICN DE

Caémo ensanchar
columnas e hlleras

Como ocultar
columnas e hilerasg

Cambio de Ancho
de Columnas y
Altura de Hileras

xcel muestra completo lo que se ingresa a una
ccl.da apesar de que seamds largoque el ancho
preestablecido para las celdas, que es de ocho

caracteres, mostrandolas sobre celdas adya-

centes en blanco. Pero no ensancha automati-
camente columnas si las celdas adyacentes
contienen datos, ni si un elemento numéricoes
de més de ocho caracteres, y tampoco un valor

calculado tiene mas de ocho cifras.

Se pueden desplegar mis de ocho caracteres en und ce!(?a
usando tipo més pequefio, como aprenderd en la Lt?cgién 18. Sin
embargo, para desplegar cada cardcter de un elemento, sin importar gue
tan largo sea, se debe ensanchar la columna, '

En esta leccién aprenders c6mo ampliar y reducir el 'Tmch(.) d.c
columnas. Hacer las columnas mé4s angostas puede permitir imprimif
mds columnas en la pagina. También aprenderd como ajustar ta altura d¢
hileras,

LECCION 17 L—23_| ‘

Como Cambiar
el Ancho de
Columnas

Para cambiar ¢l ancho de una columna con el mouse, se arrastra 1a linea
que separa letras de columna hacia ki derecha de lacolumna qué se desea
modificar, Searrastrala tinea hacia i doicehe para ensanchar lacolumna
y hacia la kzquierda para hacerla niis ungosta.

Ensanchemos columnas en la hoja de trabajo QUARTERS para dar
cabidu a elementos de 1ex1o anchos,

- 1. Arrangue Excel y abra fa hoja de trubajo QUARTERS.
Algunos de los letreros de la columna A se cxlicm]cp
ocupando la B, Ensancharemos la columnia A para que la
columna B no sea atectada,

[ £

Recorra la hoja de trabajo para poder ver el fetrere mds largo
de la columna A que es Percent of Average (Porciento del
promedio} en la hilera 23.

3. Cologue el seiialador del mouse en la Yinea que separa las
letras de las columnas A y B. El seiialador se Iransforma y
aparecen como un signe mids con llechas hacia izquierda y
derecha en el plano horizontal.

4. Oprima y mantenga oprimido el botén izquicrdo del mousc.
Notar que apurece una linea punteada vertical en [a hoja de
trabajo.

5. Arrastre el sefialador u la derecha husta que La linea pur?lcuda
esié justamente a la derecha del 1exto Percem ol Average;
luego suelte el botén del mouse (Figura 17.1).
Ahora que la columna A estd suficicniemente ancha para yue
quepan todos los letreros, borre la columna I3 que estaba en blanco.

6. Seleccione la columna B, y luego Delete del mend de atajo o
del mend Edit. '

‘

COLUMNAS DE MEJIOR AJUSTE

En vez de arrastrar la columing, se e puede formatear af ancho Best Fit
{(Mejor Ajuste). Una columna Best Fit es a que tiene ¢l ancho justo para
que quepael letrero mids large de todas sus celdas. Para crearunacolumna
i

W O
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Edit formula

Formal

FIGURA 17.1:

La columna A

Microsof Excel -]

Data  Qplivns Macro  Window Help

7 |Sawes 71652 0437 7B 97655 80500
|78 |Fenmis 585  S7¥ 5976 5BE4 5857
"9 |Lesses 15106 155 1535 15325 15305
110 |Foyoties 100 156G 1506 1600 1500 .
11 |mreres: 1206 1298 13H 1387 1303
(12 |Tawl ncome 37633 G525 102366 121741 104434
13
T4 [Salanes 30543 30564 31 7EE 32179 31263
15 [Commissions 137 724 78] 977 805
16 |Renals 4509 4500 4500 4500 4500
A7 | Miities 1,343 1,394 LA 14 4565
78 |Snpphes 298k ) 237 21 z.499
|79 [TataiE-penses w0107 F774 4B5E6 54107 436N
70
[ 21 [ten Ruvanues STACR SESP1 RBIEN 67634 60853
(27 |Feorcant Chengs REE 104% 109%
123 |Feccenl ol Sveroge 94t 43, 192% 1m%
24 Al hqurés ars subjettio sud *
1| .
Ready [P

Best Fit, coloque el sefialador del mouse en la linea que separa letras de
columna y dé doble click.

Si posteriormente edita la columna, creando una celda que requiera
aiin mayor longitud de fetrero, o reduciendo el tamafio de la celda méas
larga, necesitard repetir la operacién de formateo Best Fit.

Primerocambie el formato de niimeros a Currency y luegoensanche
la columna a Best Fit.

1. Seleccione las celdas B7 a F21, y Currency de la caja Estilo de
la barra de Herramienta.

2. Coloyue el senalador del mouse en la linea que separa letras
de coiumna entre la B y la C, y dé doble click al botén
izquierdo del mouse.

La columna se ajusta para que quepan las cifras completas,
formateadas en el estilo Currency. Ahora ensanche el resto de las
columnas.

click en cada una.

punio.

cntera antes de desplegar la caja de didlogo.
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3. Cologue el senalador del mouse en las lincas que separan las
letras de columna Cy D. Dy E.E y F. F y G, dando doble

4. Dé click en el botdn de Salvar (Shift+112) en la barra de
Herramienta, La Figura 17.2 muestra 1o hoja de trabajo en este

Como Usar LA Cata pE D1ALoco CoLumn WiDTH

Para tener mds control del tamano de 1as columnas. use tacaja de didlogo
Column Width (Ancho de Columna), mostrada en la Figura 17,3,
Seleccione las columnas que desee cambiar, luego despliegue la caja de
didlogo seleccionando Column Width del meni de atajo Column (dé
click al botén derecho del mouse cuando esté seftatando la letra de 1a
columna} o desde el mend Format. Para cambiar el ancho de todas las
columnas de la hoja de trabajo, seleccionar la hoja entera o una hilera

File Ldit Formula  Format  Dats  Options Macio  Window  Help

E@m@@m@@@@@
G7

.
“*

.v|i

- A — BA
A i) C D E F G )

| 7 1Sales $7I051 75 §T2A3676  $IB2S4E5 397465497 €8O 4L |

| B_[Fentals $5B5090 3573567 597625 4586426 4585A 77

| 9 [Lesses HLAIS00 41552500 91530500 $15 32000 §1R 10500
ﬂdﬁnyulues 4150000 §1.50000 §151000  §1,50000 41 50000 :J
1 11 hnterest SI L0550 3129756 FLIIGST §108070 4330099
1 12 | Total Income 97003315 $96 29499 $102.35E 47 $121 79099 3104 4RI

13

14 |Salsnes FI0UGAT 0L Fi0%RA73 $30L7R5 B0 #3Z17BE7 43 20D HY
| 16 |Commizsions 173602 $724%7 $782 65 LR B $60% 00
| 16_|Reritals $450000  $450000  $950000  $450000 g3 50000
|17 | imes 11 2260 {3 39427 $1400 05 112067 FALETIHT
|18 |Supphes L24A550  $254056  $203687 $230C oA
|19 | Tawl Erpenses 4046708 $3972393 440458607 $540605 42163098

20

21 it Revenues £57 20 07 ASESIUE $6L7BO3S BB/ E3A12 FEOBLTYL
| 22 |Fercent Chags EE S % 019%,
.23 JFerceni of Averoge 943 93% 102% 1115

24 Sl hgaras are subigcl g audi +
| A [+
Ready

FIGURA 17.2:
Hoju de trubajo
QUARTERS con las
columnas
ensanchadas
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FIGURA 17.3:
Lit caja de didtogo
Column Width

Cohoon Width:  (FENIEN
[ Usa Standard Width

Wide | [ Unhida | [ BestF |
Standard Widih [8.43

La caja de texto Column Width muestra el ancho prescleccionado
en caracteres, Teclee el nuevo ancho de columna en caracteres, desde 0
hasta 255.

Seleccione Use Standard Width (Use Ancho Estindar) para regresar
la columna al ancho preseleccionado. Para cambiar ¢l ancho
preseleccionade de todas las columnas de 4 hoja de trabajo, tectee ¢l
ancho deseado en la caja de texto Standard Width.

Seleccione Hide (Ocultary para que una columna no aparezea, La
columna no aparecerd en la pantalla ni &l ser impresa, pero sus celdas
pueden adn ser referidas en funciones y férmulas, Una linga gruesa
aparecerd entre dos letras de columna, indicando la posicion de la
columna oculta, También se puede ocultar una columna arrastrando 1a
lineadivisoria de letras de columna de laderecha hacia laizquierda sobre
fa linea de la izquierda, u oprimiendo Ctrl+0 (cero).

Para redesplegar una columna oculia, cologue ¢l seflatador del
mouse justo a la derecha de la linea gruesa entre letras de columna, El
sefialador se transforma en un signo de més con un doble trazo vertical.
Oprima y mantenga oprimido el botén izquierdo del mouse y arrastre el
sefialador hacia la derecha. También puede desocultar una columni
oculta oprimiendo Cirl+8hift+), o seleccionando las celdas hacia la
izquierda y hacia la derecha de la linca gruesa y luego seleccionando
Unhide {Desocultar) de 1a caja de didlogo.

Se puede crear una columna Best Fitusando el bo16n de este nombre
de la caja de didlogo.

Ingresar un nuevo ancho standard afectari a todas las columnas de
las hojas de trabajo, excepto las que ya han sido cambiadas. Seleccionar
Hide, Unhide, o Best Fit toma prioridad sobre la opcidn U+ Standard
Width y sobre lo que s¢ haya tijado en Standard Width.
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¢omo Cambiar

|a Altura de
Hileras

_aproximadamente 72 puntos en una pulgada.

Se cambia la altura de hileras de manera muy similar a como selcambia
el ancho de columnas, excepto que se arrastra la linea bajo el nimero de
hilera cuando el seialador tiene 1a forma de un signo més con flechas
apuntando hacia arriba y hacia abajo en ¢l plano vertical. |
También se puede usar la caja de didlogo Row Height (Altura de
Hileras) mostrada en la Figura 17.4. Despliegue la caja de |diélogo
seleccionando Row Height del atajo Row o del meni Format. En la caja
de texto Row Height teclee una nueva altura en puntos — hay

FIGURA 17.4:

La caja de dilogo
Row Height

Bow Heiow: [FN | us_ ]
X Use Standacd Hogt | Concel |

Hida l HM” Hdpi

Seleccione Use Standard Height (Usar altura standard) paralajuslar
automdaticamente la altura de hileras al tipo m4s grande usadoen lahilera
—esencialmente, es un valor de Best Fit. Para fijar laalira standard con
el mouse, cologue el sefialador en la linea que est4 debajo del nimero de
hilera y dé doble click.

Para ocultar una hilera, puede arrastrar la linea que estd bajo su
niimero de hilera hacia arriba sobre la hilera de arriba, seleccionar la

hilera y oprimir Ctri+9, o bien, seleccionar Height de la caja de didlogo

" Row Height. '

Para redesplegar una hilera, coloque el sefialador del mouse
. . . . N |
justamente abajo de lalinea gruesaentre hileras (el sefialador se _mtljstraré
como un signo mis con un doble trazo horizontal), y arréslrEIcT hacia
abajo. También se pueden seleccionar hileras arriba y abajo dé_: lla linea
gruesa, y luego oprimir Cirl+Shift+(, o seleccionar Unhide de la caja de
didlogo Row Height. '

Veri los efectos de los tiposen las alturas de hileraen |a Leccion 18,
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TABLA 18.1:

FORMATO TECLEC

V) Ro i Tecleos para
PHESENTAC'ON pE l Negritus Cul+B formutear caracteres

Cémo usar caracteres ltdlicas o cursivas ! Corl + 1

en negritas, Tachado i Crl + 5
subrayados e Subrayado LGl + U .

italicos Normal L Ctel + 1

Cémao seleccionar
tipos

Como cambiar el
Cambio de Ti O tamafio de los Como Formatear  La barra de herramienta estdndar es cl método mids convenicnte de

p caracteres formatear caracteres, porgue es parte de la ventuna preseleccionada de
Cafactefes ¢on Excel. Lausaremos ahora para formatear kahojade trabajo QUARTERS.

y Formato de Caractere S la Barra de 1. Arranque Excel y abra la hoju de trabajo QUARTERS.

Herramienta 2. Seleccione fa celda Al
Slan daf d Puede parecer extrafio seleccionar la celda Al para formatear ¢l
texto que aparece en las colurmnas B, Cy D de 1a pantalta. Pero recuerde
que el texto de a hilera i csid realmente conlenido en Ta celda Al. Se
los caracteres, se pueden crear hojas de trabajo muestra sobre las otras columnas gracias al formato Center Across
' Columns. Aplicar formateo a las celdas B1, Cly DI no afectariaeliexto
— por lo tanto es necesario formatearlo en la celda Al

plicandoestilos de tipo— por ejemplo, negritas

e itdlicas — y cambiando el tipo y tamafio de

y presentaciones de aspecto profesional.

3. D¢ click en el botén de negritas en 1a barra de Herramienta —

La barra de herramienta standard ofrece botones para modificar los que es el qu‘c l!enc la letra B. El botdn d'e letras nc.gnlus
caracteres haciéndolos negritas, itdlicas y mds grandes o més pequefios aparece oprimido y lf)s caracteres can.mmn a negritas. Se
en puntaje. La barra de herramienta Formatting incluye funciones puede cancelar este formato dando click en el botén por
adicionales — por ejemplo, subrayar y tachar, — ademds, opciones para segunda vez.
modificar el estilo de tipo y su puntaje. La caja de didlogo Font ofrece 4
control completo sobre los formatos de caracteres incluyendo colores.

En esta lecci6n aprenderd como usar todas estas funciones de Excel.
Si no tiene mouse, deberd formatear los caracteres usando la caja de
didlogo Font o las teclas segin muestra la Tabla 18.1.

. Dé click dos veces en la herramienia Increase Front Size
{Aumentar Tamafio de Tipo) — que es ¢l botén con una letra
A grande. Cada vez que se dé click en et botén, el 1amuiio de
los caractercs aumenta y la altura de la hilera se ajusta
respectivamente (Figura 18.1).




1% CAMBLO DETIFO Y FORMATO GECARACTERES

_ FIGURA 18.1:

Eile Edh Formula Formai Datsa  Qptions Macte Window Help Caruacteres
m [(a[] Al «|[=[=[m]H] formateados en
Al [ [ wetsonond Sans, Inc negritas y
- o OUA =T~ aumentados dos
At B LG ‘0 E [ G4 puntos de 1amafio
1, Waltson and Sons, Inc. .
I 8
3. Fiscal 1993
‘4
-5 et Qw, 2nd Cnr. 3rd Qu 4th Qtr, Average
[ ]
7-|Sales $7365175 $7243676  $7B25465 $97.6R497 48043953
‘B -{Renlnls $5.65090 $5.73567 $5.976 25 $5.864 26 $5.856 77 s
8 |Leoses $1532500 $1532500 41532500 $1532500 $15.32500
18 [Royanes $1.50000 $150000 %1.50000 $150000  $1.50080
11iInterest $1.20550 $1.297.56 $1.31052 $1.196.76 $1.302 58 f
12} Tolsi Income $97.53315 $9679499 $102 366 42 $121.74099 $104 46389 .
13 .
14 [Salaries 33054256 43056473 $3.76560 $3217867 3126289
15 {Commissions $23652  §724%) 1782 55 $976 55 $805 00
18 |Rentals $450000 $450000 $4500 00 $4 50000 $4.50000
17 lUtktes $1,04250  $1.38427  $140005 31417067 84564867 r
e — A Bl A A e A AL ai B ad e
RIS LR T, ey ' 1 T &l # bz s [ 2

Si escuchaun"bip" uotrosonidoal darclick en este bot6n, es porque
Hegé al tamafio mds grande disponible en ese tipo.
5. Seleccione 1a celda B3, que es 1a que contiene el letrero Fiscal
1993,

6. D¢ click en la herramienta Negritas y luego en la herramienta
Itdlicas — que es el botén con la letra [ — para aplicar ambos
formatos. Los dos botones aparecerdn oprimidos en la barra de
Herramienta.

7. Selecciane las celdas B5 a 7’5, luego dé click en la herramienta
de itdlicas.

8. Seleccione la celda A24, luego dé click en la herramienta de
itdlicas. ’

9. Dé click dos veces en la herramienta de reducir el tamario de
1ipo — que es el botén con una letra A mayiscula pequea.
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Escuchard un "bip” cuando haya alcanzado ¢l 1amafio ms
pequedio disponible en el tipo seleccionado, ‘

La variedad de puniajes que ofiecen las herramientas Aumenyar el
Tamano de Tipos y Disminuir ¢ Tamaio de Tipos depende el lipo
seleccionudo. E

En Ta barra de herramients suandird los botones de negritus y de
itdlicas se muestran oprimidos cuande jos respectivos formitos cts::in
aplicados a una celda activa, pero no los botones de aummentar tamadio de
1ipo y dereducir tamafio de 1ipo. Para ver el puntaje de un tipo y! aplicar
otrus formatos de caracteres, usc la barra de herramienta Fonnltlling o
lu caja de didlogo Font. l

Como Usar la

Barra de

Herramienta

Formatting

|
Se puede cambiar el tipo y el formato de los caraclenes suhray;inldotos”y
tachdndolos usando la barra de herramienta Formatting. (Al i:l&hﬂrlos
aparece una linea horizontal cruzando los caructeres por la 'mﬁud. El
tachado se usa generalmente cuando se trabaja en un borrador de hoju de
trabajo y se desea indicar secciones gue se planca borrar, ) |
Siga estos pasos: i
1. Desplicgue la barra de herramicnta Formatting ~— seleccione
Formatting de los menis de alajo de fas burras de Herr‘urhienlu
0 de la caja de didlogo Toolbars, o

[

Seleccione I hoja de trabajo entera — dé click en e botdn
que estd a la izquierda de las letras de columna u oprima!
Al+Shifi+Barra Espaciadora, '

‘ |

3. Abra la caja de lista Font Name (Nombre de Tipo) (al Iu(‘jo
derecho de la barra de herramienta Formutting) para dcsﬁlcgar
los nombres de los tipos disponibles en el sistema, La lisla
cambia dependiendo de 1a impresora instalada y de la version
de Windows que se esié usando. |

4. Scleccione Times New Roman si tiene Windows 3.1, De otro
maodo seleccione MS Serit, Los caracteres cambian
inniediztamente al seleccionar ¢l tipo.

5. Seleccione la celda A24 y luepo dé click en el botén de 1
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Subrayar de la barra de herramienta Formatiing. Puesto que la
celda ya estaba formateada en itdlicas, ambos formatos se
aplican ahora.

Abra la caja de lista Font Name y seleccione Small Fonts
(Tipos Pequefios). Si Small Fonts no es una opcién en su caja
de didlogo, seleccione Terminal.

Abra la caja de lista Fom Size (Tamafio de Tipo) para ver los
puntajes (tamafios de tipos) disponibles para ese lipo.

Seleccione 6 puntos. La Figura 18.2 muestra lu hoja de trabajo

en este punto,

Dé click en el botén de Salvar (Shift+F12) para guardar la
hoja de trabajo.

La resolucién de algunos tipos o puntajes puede no ser satisfactoria
en la pantalla o al imprimirse. Si esto sucede, seleccione otro tipo o un
puntaje mayor ¢ imprima la hoja de trabajo de nuevo.

Eite Edit Formula

Formnat

Dota Qptions Macro  Window  Help

FIGURA 18.2:
zle) Hoju de trabajo
formateada

RIS Fome 18 (=] (] 7 AT+ e[ [l (0 (] (el (1
A24 i

[ All hgures are subject to oudst

- A |
T At [ c D £ F G |1

1 Watson and Sons, Inc. -
2

: Fiscal 199)

] dar O Ind Orr Ird Orr ith O Average

3

7 {Sules $I631 75 $TR436TE SIS 9163497 13049953

B [Rentus $385090  $5,73567 15516 2% $h86d 2 §383677

8 Jicases $1532500  §1532300  §1532500 $1532500 1532500

10 |Royalties §1,50000 3150000 $1,50000 L0000 §130000

11 Jintesest SL0550 31975 B2 8ETe 302

12 [Totalincome $97.53315 9629490 0264z M2L,74099 $lod443e

13 ‘

14 iSalanes $30342% $I036473  B3T63e0  $I2ITEET 33126229

15 [Commssions §736 53 §72437 78205 §976 53 380500

16 |Rentals 1450000 34,50000 $450000 3450000 4450000

17 |Unbues 3NN 937 $140100  S1412087 4. fnd 07 e
""—;. N b . " M S
Raady [T T =1 7T
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. . sanch: ol as . ~ros largos A6 qr
Como Camb|af el Ensanchande columnas para que gquepan letreros largos en las celdas,

Tamano de Tipo
para Afectar el
Ancho de
Columnasy la
Altura de Hileras

puede llegarse & hacer ta hojade trabajo demasiado ancha para que quepa
en uni hoja de papel. Una alternativa ex imprimir la hoja en orientacién
horizonlal (a lo largo de la dimensién mayor de la pigina), como
aprenderd en la Leccidn 28. Sin embargo, si desea imprimir en orienta-
cion vertical (la orientacién normal, utravesada en la pagina) podré hacer
que lahojade trabajo quepa reduciendo el puntaje de las letras que se usan
en lus columnas anchas.

Veamos qué efecto tiene el tamafio del tipo en el ancho de la
columna y en la altura de la hilera

1. Seleccione las celdas B7 a la F23 — debe necesitar arrastrar la
barra de herramienta Formatting para gue no estorbe.

2. Abra la caja Font Size de la barra de herramienta Formatting,
recorra la Hsta si es necesario y seleccione el tipo mas pequeno
disponible.

3. Dé doble click en la linca que estd entre las letras B y C para
aplicar el formato Best Fit. Con un tipo mds pequerio, la
columna es mds angosta.

4. Aplique el formato Best Fit también a las demds columnas.

5. Arrastre la linea que estd bajo el ndmero | de hilera hacia
arriba hasta la mitad de la hilera. Parte del texto de 1a hilera se
recorta porque la altura quedé demasiado pequefia para que
cupiera el tamano de tipo.

6. D¢ doble click en la linea bajo la hilera 1 para devolver la
hilera a su altura estdndar. Recuerde altura estdndar se refiere
a la aliura necesaria para mostrar entero ¢l tipo mds grande
que haya en la hilera.

7. Cierre la barra de herramienta Formatting.

8. Salga de Excel sin guardar la hoja de trabajo.
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Como Controlar  Para tener un control completo sobre ¢l formateo de caracteres, o para

formatear carzcteres si no se tiene mouse, use la caja de didlogo Fom

|05 FOfmatOS de mostradaen la Figura 18.3. Los valores de la caja de didlogo re ﬂl..].il] los

tormalos ya aplicados a la celda activa.

Cafactefes con ‘a Despliegue la caja de didlogo seleccionando Fomt del atajo o del
Caia de Dla'logo ment Format. También puede oprimir Ctrl+F para desplegar la caju de

Font

didlogoe teniendo seleccionada la lista Font, u oprima Cul+P para
desplegarla si tiene seleccionada ba lista Size. Oprima las teclas de anajo
dos veces st fa barru de herramienta Formatting esm mostrada en la
pamtalia.

- Seleccione el tipo, elestilo y el puntaje que se desean para las celdas

seleccionadas y luego seleccione OK. Los nombres de los tipos precedidos
porun simbolodoble T son tipos TrucType disponibles en Windows 3.1,
El icono de una pequena impresora indica que los fipos estdn
interconstruides en la impresora. Note que Subrayar y Tachar son
opciones en la seccion rotulada Effects. Aparceerd un cjemplo de fa
forma de mostrar los caracieres en la caja Sample.

Seleccione Normal Font {Tipo Normal) para regresar al estilo
normal definide actualmente. Seleccione un color de lacajade listaColor
si Se tiene impresora gue puede imprimir en colores.

FIGURA 18.3:
= L caja de didlogo
font: Font Style; Fom

MS Sans Serif
MS Senil
Roman

Sciipt
Small Fonts

EHects - - - . .
[ Suigeout . X Mormal Fart

[ Undetine
Codon:

Ml Auvtomatic : ]

This iz & screen font. The closest maiching prioter font will be
vied fou printing.

LaBh'ryZe
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Personalizacion

de

y Patrones

| 0 N

PHESENTACIN OF

Como quitar las lineas
de la cuadricula

Cémo agreg'arI lineas
y 1indero|s
Como rellenariceldas
patrones y colores

Lineas ; J

as cuadriculas preseleccionadas (las lfnéas quc
separan las celdas) que aparecen en la pa|ntalla
se imprimen en la hoja de trabajo. Se puede
modificar al gusto el grueso de lineas \ y atn

quitarlas del todo para crear hojas de ll‘dbaJO

visualmente atractivas, asi mismo presen-

taciones y formas.
1

En esta leccién, aprenders cémo ajustar las lineas de 1a (,uaam.ul.i
y cémo agrepar patrones y colores a las celdas.

Al formatear la hoja de rrabajo, no exagere el uso de tipos, estilos,
lineas y sombreado. Una hoja de trabajo congestionada con dentasiados
elementos de diseio puede distraer al lector del contenido, y aun hacer]
ininteligible segin las normas de otros. e
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Como Quitar las
Lineas de
Cuadricula

Se puede cambiar el grueso de cualquier linea de cuadricula de la hoja
de trabajo. Sin embargo para nuestra hoja QUARTERS, sdlo se desea
que aparezcan algunas lineas modificadas, para que no sed obvio que el
documento fue creado usando un programa de hojas de célculo.
Empezaremos por quitar todas 1as lineas de cuadricula preseleccionadas
de la hoja de trabajo. (Sin embargo, no se deben quitar las lineas de
cuadricula antes de incorporar las lineas y patrones modificados). La
Figura 19,1 muestra como la hoja de trabajo QUARTERS aparece si se
imprime después de esta leccién. Refiérase a la figura al seguir estos
pasos.

1. Arrangue Excely abra la hoja de trabajo QUARTERS.

2. Seleccione Qptions » Display para ver la caja de didlogo
mostrada en 1a Figura 19.2. Las opciones de esta caja de
didlogo le permiten controtar la manera en que aparecerd la
hoja de trabajo en la pantalla y al imprimirse. Explicaremos
esta caja de didlogo con mds detalle en la Leccion 29.

3. Dé click en la caja de palomeo Gridlines (Cuadricula), lucgo

FIGURA 19.1:

Watson and Sons, Inc. I La hoja de trabajo

QUARTERS
formateada con lineas
y patrones

Fiscal 1993

It Otr. Ind (hr. Jrd Qrr. Ath Oir Average

ales
Rentals
I.eases
Ruyalues
[aterest

$73.651.75 $72.436 74 $78.254 65 $97.654 57 $80,499 5

45,850 90 §3.731567 35926 25 35864 26 $5.836 77
1532500 515,325 00 11532500 $15,32500 115,325 00
$1,500 00 41,500 (1) $1.500 00 $1,500 00 $3 500 00
§1,205 50 51,297 56 3131052 11,396 76 31,102 59

[Towl tnoome ¥ 205,

Salaries $30.532 56 $310564 73 §31,765 60 $32,178 67 331,262 89
Commussins $736 52 £724.37 $782 55 $976 35 §805 00
Rentals $4,500 00 §4,500 00 £4.500 00 14,500 00 34,500.00
Unhties 31,342 50 5139427 11,400 05 114,120 87 $4,564 67
Supplies 32,585 50 $2.540 56 4211687 12,330 76 31,498 12

> $OT,533:1 54155 506,294 59 1514 $10T ISELT 591Uk S

| SACAUTCE 330 TH FIAT L S SEE0T - SSHIIGG 85 ey A SA TN

109%

¥,
| R TR AT R T TR T T O
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FIGURA 19.2:
La caja de dislogo
Display Options

seleccione OK. Desaparecerdn las lineas que rodean las celdas
en la hoja de trabajo.

Cdmo Agregar
Lineasy
Linderos

Ya sin la cuadricula preestablecida, modifiquemos la hioja de trabajo
agregando lineas y linderos al gusto. Empezaremos usando el botén

Lindero Perimetral de la barra de Herramienta,

l. Seleccione las celdas de la A1 ala F1.

2. Seleccione la herramienta Lindero Perimetral — que es el
sexto botén de la derecha en la barra de herramienta standard
— woprima Cirl+Shift+&. Un lindero delgado aparece
alrededor de las celdas seleccionadas,

3. Dé click con el mouse para deseleccionar las celdas.

Para quitar el lindere, seleccione las celdas, luego Formatsde lacaja
dedidlogoClear, u oprima Ctri+Shift+ . Paraquitar lag lineas individuales,
selecciénelas en la caja de didlogo Border, descrita en el siguiente
procedimicnto. '

Ahora se desea agregar un lindero més grueso alrededor del cuerpo
de la hoja de trabajo. Para hacerlo usaremos la opcidn Border que esi4
tanto en el ment Format, como en ef de atajo.

Recuerde, el sefialador del mouse debe estar en las celdas seleccio-
nadas antes de oprimir el bot6n derecho para desplegar el mend de atajo.
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4. Seleccione las celdas de la A3 ala F23.

5 Seleccione Border del atajo 0 del menti Format para desplegar
la caja de didlogo mostrada en 1a Figura 19.3.

Las opciones de Border determinan la ubicacién de las lineas
alrededor de las celdas seleccionadas. Ademds de QOutline, se puede
seleccionar cualquier otra ¢ cualguier combinacién de los lados —
izquierdo, derecho, superior o inferior. :

6. Seleccione Outline.

Las opcienes Style determinan el tipo de linea. De izquierda a
derecha, empezando en la hilera superior, las apciones son extrafina,
delgada, mediana, gruesa, doble, punteada, discontinua y sin linea. El
estilo prescleccionado de linea es delgada.

7. Seleccione la linea mediana — la tercera de la hilera superior.

Las opciones de la caja Color determinan ¢l color de la linea. Use
colores si desea que la hoja de trabajo aparezca en coloren la pantaliao
para imprimirla en una impresora de color. Seleccione Automatic
{Automdtico) para aplicar el color y estilo preseleccionados. La opcidn
Shade (Sombra) agrega © quita sombreado de 1as celdas seleccionadas.
Fije el grado de sombreoen la caja de dilogo Pattems (Patrones), como
se describird més adelante en esta leccion.

8. Seleccione OK para salir de la caja de didlogo Border y
regresar a la hoja de trabajo, luego dé click con el mouse para

FIGURA 19.3:
Lacajade didlogo
Border
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deseleccionar las celdas. Un lindero semi grueso aparece
atrededor del cuerpo de la hoja de trabajo.

9. Seleccione las celdas de 1a A3 ala A23 y luego Border del
ment Format o del atajo. Aparece la caja de didlogo Border.

; Las opciones de Border muestran taubicacion de fas lineas aplicadas
al grupo s;lcccmnudo de celdas. Los patrones de gris en las cajas
mostradas junto a las opciones indican que las celdas seleccionadas no
:enerll todas el mismo estilo de linea en sus linderos superior e inferior.
ordgcmplo, mientras que la celda A3 tiene un lindero superior, dé linea
m as i i
Su:c@na.gl resto de las celdas del grupo seleccionado no tiene lindero
superior. De manera similar, 1a celda A23 1 i inferio,
) 3 tiene un lindero infer
no las otras. e
El estilo de linea mediana ya estd seleccionado.

10. Seleccione el lindero Ri
ght (Derecho) y luego OK par: ic:
el estilo de linea mediana. . ¢ i ird‘ ephear

11. Seleccione las celdas de la AS a la F5 y luego Border del
menid Format o de atajo.

12. Se]e'.:cionc el lindero Bottom (Inferior), el estilo de linga
mediano y luego OK.

13. Seleccione las celdas de la Allala Fll.

14. Dé clicF( en la herramienta de lindero inferior en la barra dé
herramienta standard — ¢! quinto boi6én desde la derecha!
' I

15. Sele(fcione las celdas de la Al2alaFl2y Iuc'go Borde‘r dlel
menid Format o del de atajo.

16. Seleccione el lindero Boitom (Inferior), el estilo de linea doble
y luego OK.

17. Sclecci_cme las celdas de la AL8 a la FI8 y dé click en la
herram1enladclmdeminferiorcn]abarradehcrrumicmust':mdurd.

I8. Seleccione las celdas A19 a la F19 y luego seleccione Border
de! mend de Formal o del de atajo. :
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19. Seleccione el lindero Bottom (Inferior), del estilo doble liney
y luego OK. .

La Figura 19.4 muestra como aparecerd en la pantalla la seccién
superior de la hoja de trabajo.

FIGURA 14.9:

=

B
File Edit Formuls Formal Data  Options Macre Window Help La hoja de ”“‘bajo
Gl (=l AL el =afs @ EE @I EIK] QUARTERS con
ar, i i
Fag T linderos y lineas
- 0 A i w] a
A 8 C ] E F G__J3]
1 Watson and Sons, Inc. ] -
F
kN Fiscal 1991
|4 |
: ist{m ed D Jrd in $th (ar Average
7 _|Sales 136507 §TrATE tre.zsa6s 785497 520,459 33
B |Reatals §5.8:0%0 $5,73507 $2.976 25 1550426 $58%617
9 [Leases $1232:00  $1532500 11332500 11532200 $15,32500
10 {Royatues $1,50000 150000 1150000 $1.50000 31,5000
11 |Interest §1,205 50 31,267 50 $1.310 52 §1,3%6 70 31,3025
12 |Tola Income 397,333 10 96520309 §1023p642  $1217000  pl104433 59
13 . .
14 [Salanes 330,542 20 30,5473 $31,765 00 $312.173 07 $3126259
159 (Tommussions 1736 52 121437 478255 97 55 336300
1B |Rentals $4,500 00 $4,500 00 $4,306 00 34,500 00 $4,500 00
17 |Untities $1,34250 313837 L2010 03 $1312087 $4.204 67 5
* - -
Ready I

Como Agregar Ademds de modificar al gusto Ias lineas alrededor de las celdas, se
P [ C | pueden rellenar celdas con patrones. Los patrones estdn formados por
dlrones y QIO arreglosde puntosenla pantalta o enla pagina impresa. Entre més puntos
haya serd més ascuro el patron. Si se desea mostrar la hoja de trabajo en
un monitor de color 0 imprimirlo en una impresora de color, los patrones
pueden combinar diferentes colores del plano principal y del posterior.
Empecemos por agregar el patrén higero preseleccionado usando la

barra de herramienta Formatting.

1. Desplicgue la barra de herramienta Formatting —
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seleccionando Formatting de! mend de atajo.

Seleccione las celdas de 1a A12 a ta F12 y luego d€ click en la
herramicnta de sombreado ligero — que ¢s el botén pendkimo
en la barra de herramienta Formaiting. El patrdn’da el efecto
de imprimir sobre un plano posterior gris.

[

3. Seleccione las celdas de la A19 ala F19 y luepo dé click en la
herramienta de sombreado ligero.

4. Scleccione las celdas A23 a la F23; después dé click en la
herramienta de sombreado ligero.

ComMo MoDIFICAR PATRONES

Se puede modificar el patrén y seleccionar colores usando la caja de
diilogo Patterns. Siga estos pasos pard completar la hoja de trabajo
formateando la hilera Net Revenues (Utilidades netus} para que s¢
imprima en inverso, esto s, letras blancas en un campo negro liso.

1. Scleccione las celdas de la A21 ala F21,

2. Seleccione Patterns del mend Format o del de atajo para
desplegar 1a caju de didlogo mostrada en la Figura 19.5. Las
opciones pueden variar dependiendo del objeto seleccionado
en la pantalla.

La opci6n Pattern fija el disefio o sombra usada para rellenar las
celdas seleccionadas. El color del patr6n queda determinadao por lo que
se fije en las cajas Foreground (Plano anterior} y Background (Plano
posterior). Aparecerd un ejemplo de su eleccién en la caja Sampie

FIGURA 19.5:
Lt caja de didlogo
Patterns

Coll Shading

| Bater: l [ Corcet |
|
i

i Foteground: | Automalc m

! HBackground: | Automatic : |
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(Muestra). Veremos estas opciones con més detalle depués de terminar de trabajo.

1a hoja de trabajo. . . .
a hoja de frabajo _ 9. Cierre la hoja de trabajo QUARTERS.
3. Abra la caja de Foreground y dé click en el color de muestra

. . A imen C i
Negro, que es el primero de la lista. hora experimentemos un pecocon patrones paracrear unaseccion

tridimensional de 1a hoja de trabajo.

4. Seleccione OK. 1. Dé click en la herramienta New de la bamra de herramienta
Con colornegro liso y untiponegronose podrd verel contenido standard para dar inicio a una hoja de trabajo nueva.
de la celda. Cambielo seleccionando color blanco para €l tipo. .
P po 2. Seleccione lacelda D11 y teclee Important.

5. Seleccione Font del atajo o del menii Format. .
3. Seleccione las celdas de la C10 a la E12 y luego seleccione la

6. Abra la caja de lista Color, recorra hasta la parte superior de la herramienta de sombreado ligero de a barra de hhrramienta
lista y seleccione Blanco. Formatting. .

7. Seleccione OK y luego dé click en el mouse para . 4, Seleccione la celda D11 y fuego Border del mend de atajo o
deseleccionar las celdas. Las celdas aparecen ahora en inverso del mend Format. .

{Figura 19.6). :
5. Seleccione tos linderos inferior y derecho para aplicarles el

8. Dé click en el bot6n de satvar (Shift+F12) para guardar la hoja estilo de linea preseleccionado.
FIGURA 19.6: 6. Seleccione el lindere izquierdo.
File dit Formuta Formay Data  Qplions Macro  Window Hel i . . . . 3
b = LB g Hilera formateada . 7. Abra la caja de lista Color y seleccione White. Eljlindero

(sobre fondo negrd) izquierdo se convierte en una linea blanca.

T — T N e T -G 8. Seleccione el lindero superior para aplicarle linea'blanca y
[ 9 '[Leases S53500  $L332500  $LS31500  SI532500  $153B00 . : luego seleccione OK. |
[ 10 [Royalties $1,50000  $1,50000 3150000 30000 _ $L50000 . “
11 [interest $120550  §1. . . .
12 Totdiooms’ | 8797013 | [Porcem (2] {Twes Now floman) (2] 1 9. Dé click con el mouse para deselecionar la celda. La
13| - iiee. - - . . -
A Suues . A=z E@ﬁ"!ﬁ’:: ‘- el compmafn(m de sompreadq ligero y linderos da a‘la celdala
(1% {commasions R TR T ] - B “ apariencia de ser tridimensional (Figura 19.7}.
18 |Rentets $430000 34 z o i
[ 17 Juntsies $1,34250 3139927 SLAI05  MAIDET 6467 . Ahora veamos las combinaciones de patrones.
1§ [Supphes $2985 50 $2,540 36 3213687 $2330.76 $2,493 42 .
19 [Toaiopenger | SMT0I08 90,7393 | 07 - DA DgRs T
E
H ) ' :
22 [Percent Change Lo e 0 FIGURA 18.7:
93 [Peerent of Average . |- 2 T T e L T Celda formateada con
24 Altwres s rybrect to sol H .
s B : - " aspectp tridimen-
o p .. . . N BT ST .ot e e 3T, M L Slonal

Pandy, j - S I T wvbeal. of -1 A ) .
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10. Seleccione las celda de la Cl4 ala E16 y luego Patterns dei

\ IGURA 19.8:
ment Format o del de atajo. — FIGU 9.8

Forma creada usando
. . ‘

linderns y cuadricula
de referencia

Please Sign In
Nama Company Address Phone

11. Abra la caja de lista Pattern y recorra las opciones para ver
como se ven los patrones usando los coleres preseleccionados
para plano frontal y posterior.

12. Dé click en uno de los patrones para ver una muesira en la caja
Sample.

13. Abra la caja de lista Foreground y seleccione un color o una
sombra que preferirfa usar en ¢l plano anterior. Note como el
color cambia el aspecto del patrén en la caja Sample.

14. Abra la caja de lista Background y seleccione ur color o una
sombra para el plano posterior.

nar las celdas y captar como se ven con el patrén escogido.

15. Seleccione OK, luego dé click con el mouse para deseleccio- l

16. Cierre la barra de herramienta Formatting.

17. Salga de Excel sin guardar la hoja de trabajo.

Se pueden usar linderos y cuadriculas para crear formasde todotipo,
La Figura 19.8, por ejemplo, muestra una forma bdsica de letrero. S¢
teclearon los encabezados de columna, y luego se ensancharon fus
columnas para darle suficiente espacio. El titulo se agrandd y se centré
entre las columnas (lo cual también quité las lineas de cuadricula de 1a
primera hilera). Se seleccioné la pigina entera, se le agreg6 un marco,
y luego se agreg6 una linea gruesa en la parte inferior de la hilera uno.

Colocéndole un marco a la pgina entera se imprimen todas las
celdas en blanco y su cuadricula. Sin embargo si s6lo se ingresa un tilule
y encabezado de columna y luego se imprime a hoja de trabajo, sélo se
imprimirdn las hileras con texto. Para imprimir la cuadricula alrededor
de las celdas en blanco sin ponerles primero un marco, seleccione todas
las celdas que desee imprimir y acontinuacion seteccione Opiions » Set
Print Area (Fijar el 4rea de impresion). Cuando imprima la hoju de
trabajo, se imprimirdn todas las lineas de cuadricula del drea seleccionada.

En la Leccién 28 aprenderd cémo ajustar la forma y el lugar en que

la hoja de trabajo se imprima en el papel.
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cémo formatear la

hoja de trabajo en un
solo paso

Disenos
Instantaneos Mediante
Formatos Automaticos

n vez de formatear la hoja de trabajo
manualmente, se puede aplicar cualquiera de
los catorce disefos interconstruidos usando el
comando AutoFormat, Cada disefio incluye
nimero, lindero, tipo, patrén, alineamiento,
ancho de columnas y altura de hileras queé
pueden aplicarse instantdneamente a toda Ia

hoja de trabajo o a una parte de ella.

En esta leccion aprenders cémo aplicar formatos aytom4ticos
usando la caja de dislogo AutoFormat y las barras de herramienta.

LECCION 20

14/

Como Aplicar
Disefios de Hoja
de Trabajo Desde
la Caja de
Didlogo
AutoFormat

La caja de didlopo AutoFormat permite aplicar un disefio completo de
hoja de trabajo seleccionando ¢l nombre del disefio de una lista. Siga
estos pasos para aplicarlo a la hoja de trabajo QUARTERS.

1. Arrangue Excel y abra 1a hoja de trabajo QUARTERS.

2. Seleccione las celdas de la A3 ala F23 y luego seleccione
Fermat » AutoFormat para desplegar la caja de didlogo
mostrada en la Figura 20.1.

Los nombres de 1os disefios que pueden aplicarse aparecenen lacaja
de lista Table Format (Formato de tabla) — recorra la cuja para desplegar
tres nombres de disefio adicionales. En lacaja Sample seliene un ¢jemplo
del aspecto del disefio seleccionado, el cual ahora muestra el formato
Classic 1.

3, Seleccione Classic 2 y note el cambio en la caja Sample.

4, Seleccione cada uno de los disefios restantes para observar
como se ve la muestra.

Clasaic 2
Clagsic 3
Financial 1
Financial 2
Financial J
Coloilul 1
|Coloitul 2
JCotortul 3
Lest ¥

List 2

FIGURA 20.1:
La caja de didlogo
AutoFormat

Jan Feb AMar Tatal
Enst 7 7 5 19
West 13 4 ? 17
South 8 7 9 24
Tolal 2118 21 )
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5. Seleccione un disefio que prefiera y luego OK para regresar a
la hoja de trabajo.

6. D¢ click con el mouse para deseleccionar las celdas. Todos los
elementos de formato en el disefio se aplican a las celdas
seleccionadas, tomando prioridad sobre las que se asignaron
manualmente en lecciones anteriores. La Figura 20.2 muestra
]a hoja de trabajo seleccionada formateada con el disefio 3D
Effects 2 (Efectos tridimensionales 2).

7. Seleccione Edit » UndoAutoFormat (Ctrl+Z) para restaurar la
haja de trabajo a su disefio original.

Sisélounaceldaes seleccionadacuando usa el comando AutoFormat,
Excel intentard adivinar el rango de celdas que se desea formatear.
Buscard una zona rectangular de celdas adyacentes que contenga datos,
y le aplicard el formato a ¢se grupo. Sitodas las celdas adyacentes estén
en blance, Excel muestra una caja de diglogo diciéndole que seleccione

File

Edit Fogmula

FIGURA 20.2:

La hoja de 1rabajo
QUARTERS
formateada en estilo

Format Data  Optiens  Macre Yindow Help

3D Effects 2

=3 A B - D . ES L F ¢

1L B

L% DR R .-
.—;‘r.l'sipw.',ﬂ",zmou. irdOn. O, WE

[Sale:

Loases

| 10 {Roynhiss t 150600 4150000  $150000  $150000  §1,60000

| 11 [intarost T920550  $129756 9131052 9133676 91,30258 |

| 12 ] Totel income $97.63115 996,29433  #102.366 47 “$121,74099 $104483.69

13 |

|14 ] i [T¥3054256 3056473 93176560 $ILNIBE7 431,262 83

|16 [Commissions 73652 $724 37 370255 4976 55 4805 00

18§ |Rentals [ 345000 94,500.00 $4.500.00 $450000  $450000

| 17 iUtisias $1.342.50 .34 27 9140105 $1412087 3456467

| 10 |Supphes 9299550 3254056 3213687 1273076 9748042

| 19 [Total Expensas 4010700 93972393 $4050607 95410885 $4363094 | |
2 4]
] ]

) . $73661.767 2!72.435‘7.5 97025465 9765497  #B0.49953

" §5A5080 " " $573557 5.976.25 15 864.26 4505677
G 8152500 -91532500° $1532500  #15325.00 $1632500

¥
&

[T Tt 1 1T
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un rango de celdas. Seleccione OK en la caja de didlogo, scI_L'C(I"ione las

celdas, y luego use el comando AutoFormat de nuevo.

Como SELECCIONAR ELEMENTOS DE DISERO

Se pueden aplicar todas las selecciones de formateo automdtico que

incluye un disefio o seleccionar porciones del disefio que se desee omitir.
: . !

Porejempio, pucde ser deseable mantencer el tipo y el ancho de columnas

que se hayan fijado manualmente, pero aplicar los demds aspectos del
disefio. Se hace esto usando el boton Options de la caja de|didlogo

AutoFormat.

1. Seleccione las celdas de 1a A3 ala F23 y luego seleccione

Format » AutoFormal.

&)

- Figura 20.3.

Seleccione Options para expandir la caja, como muestra

i

a

Cada una de las opciones bajo Format To Apply (Formatos a
aplicar}quedan seleccionadas, indicando que estos ¢lementos del diseiio
interconstruido se aplicardn a la hoja de trabajo. Para conservar to fijado
manualmente, dé click en las opciones que no se desea aplicar. Por
ejemplo, sise da click en la caja de patomeo Font para apagar esa opeién,
el tipo fijado en el disefio no se aplicard. El ejemplo de la caja ‘Samplc

Somcle
l t Concel I
Jan Feh Mar Talal i
East 7 7 5 18 | [Qptions
West 8 4 7 17 i 2 =
South a 7 9 24 I
Total | 21 182 B |
g
| Fovmatz to Apply -——
| % Bumber I Font X Aignment ’
| X Boder ¥ Pattorns I Width/Haight I

FIGURA 20.;3:

L caja de didlogo
AutoFormat
eapandida |
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cambia al de seleccionar y seleccionar opciones.
3, Recorra la caja de lista Table Format y seleccione List 3 (Lista
3). La caja Sample muestra que los encabezados de columna
estdn en color pero no en itdlicas.

4. Dé click en Font en 1a secci6n Formats to Apply y luego
seleccione OK.

5. Dé click con el mouse para deseleccionar las celdas. Debido a
que fue apagado el tipo del formato interconstruido, los
encabezados de columnas aparecen en <olor nNegro, que es la
opcién preseleccionada (per omisién — default), y en itdlicas,
tal como se formated manualmente para la hoja de trabajo.

6. Dé doble click en la caja de control de la ventana de Excel
{Alt+F4). Aparecers una caja de didlogo preguntando si desea
guardar los cambios gue se han hecho a la hoja de trabajo.

7. Seleccione No para salir de Excel sin guardar los cambios.

Una vez que ha aplicado el formato automético, puede no tener
ningin efecto seleccionarlo jpuevamente y cambiar opciones. Porejemplo,
suponga que estd formateando una hoja de trabajo bajo el estito Classic
2 (Clésico 2). St luego selecciona por segunda vez Classic 2 de lacajade
dislogo AutoFormal y cambia algunas opciones de las de Formats 10
Apply, loscambios notienen efectoal seleccionar OK parasalirdelacaja
de didlogo.

Para cambiar un formato después de haberlo aplicado, primero
aplique un formato totalmente diferente de lacajade didlogo AwtoFormat.
Para usarel mismoejemplo, aplique un estilo que no sed Classic 2. Luego
despliegue la caja de didlogo AutoFormat de nuevo, seleccione Classic
2,y haga los cambios que desee en la seccién Formats to Apply. Cuande
salga de la caja de didlogo ahora, se aplicaran los cambios a la hoja de
trabajo como se desea.

receionzo | 151

Cémo Apficar
AutoFormat con
|a Barra de
Herramienta

- Paraaplicarripidamente el formatointerconstruido que fue seleccionado

por (ilima vez, ya sea en la sesién de Excel en curso o en otra previa, dé
click en la herramienta AutoFormat ya sea en la barra de herramienta
standard o en la barra de herramienta Formatting. En la barra de
herramienta standard, es el sépimo botdn desde la derecha— que tiene
el aspecto de unahoja de trabajo en blanco con una barraoscuraa to largo
dela parte superior. El mismo botén aparece en dltimo lugarde la derecha
de la barra de herramienta Formaiting,

Excel guarda el estilo més reciente de AutoFormat que se haya
usado, en un archivo llamado EXCELA.INL. Cuando se d4 click en la
herramienta AutoFormat, Excel aplicael estiloque contengaese archivo.
Asi se puede aplicar ficilmente un estilo de AutoFormat que se emplee
frecuentemente sin lener que seleccionarlo de la caja de didlogo.

) Para recorrer todos los formatos interconstruidos, que son catorce,
oprima la tecla Shift mientras da click en la herramienta en cualquiera
de las barras de herramienta.
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Creacion !de
. -
llustraciones y Graflc}:as

Los puntos importantes con frecuencia son dificiles de

encontrar, o aun pueden perderse, cuando se presentan en una

serie de hileras y columnas numéricas. Cuando se desela que la

. . . . . |
hoja de trabajo tenga impacto inmediato, trate de presentarla

grificamente. Una grédfica puede contar una historia

inmediatamente, aun cuando el lector no se pueda tomar el

tiempo para estudiar y analizar los nmimeros reales.

. - . Lol
En las lecciones que siguen aprenderd los principios

basicos de la creacién de gréficas, ilustraciones, diagramas y

dibujos.

1
|
b
1




LECC!ION

Como usar
ChartWizard

Gréficas inslantaneas

Creacion
de Graficas

uando se desea que los datos tengan el maximo
impacto, trate de presentar la informacion en
una ilustracién o en una gréfica. Excel ofrece
varias maneras de desarrollar graficas, pero el
método mas sencilloes usar ChartWizard. Este
medio lo guiard a través del proceso de
desarrollar una grafica mediante una serie de
cajas de dilogo. Si desde el principio $¢
selecciona el rango de celdas que contiene la
informacién que se desea graficar, ChaﬂWizard
incluso llenard automdaticamente muchas de

fas opciones de las cajas de dialogo.

I\
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En esta leccion creard una grifica algo sofisticada con sélo unos
cuantos clicks del mouse,

Explicacidn de
los Elementos de
una Grafica

La grifica que crearemos, mostrada con sus partes rotuladasen la Figura
21.1, usatres series de datos -— ingresos, gastos y ulilidad neta alolargo
de cuatro trimesires. Una serie de datos es un conjunto de nimeros que
representan diferentes valores del mismo componente. Por ejempio la
serie Net Revenues (Utilidad Neta) consiste de cuatro diferentes valores
— uno para cada trimestre — pero cada uno de los valores representa el
mismo componente — utilidad neta.

Una grafica debe contener al menos una serie de datos. Sin embargo
usando mds de una serie, se puede comparar la relacién entre los
componentes, asi come los patranes de los componentes individualmente.
Cuando se tiene maés de una serie, se necesita una leyenda que explique
lo que representa cada serie.

La grdfica también necesita rétulos para los ejes x, y. Los rétulos de
eje x explican loque representa cada juego de niimeros. En este casocada

//
Rétuie del Eye ¥

FIGURA 21.1:
Eje ¥ Titulo da In Grafica

Cirdfica con sus paries
£

/ identificadas
Watson and Sons. Inc.. 1993

T

B Total Income

Serles de Datos
$140.000 00

$320.000 00
$100.000 08
$80.000 00

$60.000 00

$40.00000

$20.000 00

$000

[ Toiol Expenses || Layenda

Dollars

B NetRevenves

Ep X

110t

Rétulos del Eje X

5 &
T £
g &

2nd Ctr,

Quarters

Valores del Eje ¥ Catogoria da Eje X




CREACLON DI GRAFICAS
-

juego muestra el valor de cada perigdo irimestral. Los rétulos de ¢je y
muestran el importe de los valores que se representan.

/ﬁ

C()mo Usar Ahorautilicemos ChartWizard paracrearla grafica. RefiérasealaFigura
. 21.1 al trabajar en las cajas de didlogo de ChartWizard. Las figuras de
Chﬂfthzafd esta leccion muestran la graficay las cajas de didlogo de ChartWizarden

blanco y negro, aungue en la pantalla aparecerdn realmente ¢n color si
se tiene un monitor de color.

El uso de ChartWizard involucra tres pasos bésicos. Primero s¢
seleccionan las celdas gue se deseausar como rétulos deeje x, laleyenda,
y las series de datos. Luego se arranca ChartWizard y se designa dénde
s¢ desea que aparezca la gréifica de la hoja de trabajo. Finalmente se
llenan las cajas de didlogo de ChartWizard para crear 12 grafica.

Siga eslos pasos!

1. Arranque Excely abrala hoja de irabajo QUARTERS.

7. Seleccione las celdas de 1a AS a la E5. Excel usara los datos
de estas celdas como rétulos para gje X,

A fin de poder seleccionar otras celdas que usaren la préfica, debe
mantener oprimida la tecla Ciri al arrastrar el mouse. Esto asegura que
las celdas previamente seleccionadas no se deseleccionen. Por supueslo,
se podria seleccionar una seccién contigua de una hoja de trabajo para
lagréificasin mantener oprimidalatecla Ctrl. Peroeneste caso los rangos
no estan en un drea rectanguiar.

3. Oprima y mantenga oprimida 1a tecla Curl, y seleccione 1as
celdas de la A12 ala E12. Elexto del elemento de 1a primera
columna serd usado como leyenda. Los nameros de la hilera
serdn tratados COMO Primera serie de datos.

4, Oprima y mantenga oprimida la tecla Cirl, y seleccione las
celdas de 1a A19 ala E19 como segunda leyenda y segunda

serie de datos.

5. Oprima y mantenga oprimida la tecla Cirl, y seleccione las
celdas A21 a E21 para que sean 1a tercera leyenda y tercera
serie de datos. ) .

o
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6. Dé click en la herramienta Grafica — que es el segundojbotén
desde la derecha de la barra de herramienta, Excel desplegard
el mensaje |

Drag in document to create a char
(Arrastre en el documento para crear una grafica)

en Ia'barra de Es'tado. Este mensaje significa que hay que seleccionar la
gormén de la hoja de trabajo en donde se desea que aparezca la glrzifica.
(.,'|t, puede c.olocz.ir en cualguier lugar, aun sobrepuesta en datos de la
hoja dfﬂ trabajo. Si se hace demasiado pequefia ¢l drea para la gl,rfll'ica
posteriormente se le puede expandir para gue aparezcan todoes los datos.
7. Recorra la hoja de trabajo para poder ver la hilera nimero 26.
] |
8. Coloque el sefialador del mouse en la orilla izquicrda dejla

_ ventana de la hoja de trabajo, junto al nimero de hilera 26.
9. Oprima y mantenga oprimide ¢l botdn det mouse, arrusllc el
seﬁalador horizontalmenie hasta que ¢sté empurejado a t

orilla derecha de la hoja de trabajo, y luego arrdstrelo hacia
abajo hasta |a hilera 48. Al arrastrarlo aparece una linea
punteada, indicando la caja dentro de 1a cual serd colocada la
grafica. ‘

10. SU}:IIE el l?otén del mouse. Excel desplegard la primera de las
cajas de didlogo de ChartWizard (Figura 21.2). |

y La caja de didlogo le pedira confirmar el rango de celdas a usar en
cldesarrollode la grifica. Siel rangoes incorrecto, arrastre el mouse para

seleccionar las celdas que quiere incluir realmente.
1

FIGURA 21" 2

La cuja de dié]t:Jgo

ChartWizard - Step 1 of §

11 the selected colla do ot contai % H
10 chart, ssloct a new lml‘l:‘u- data you msh Clluernzardl p.}rﬂ

inciude the colls contpining row and column labets & designar rangos de

you wanl thosa labols to appoas on tha chart.
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CREACILON DE GRAFICAS

Use los botones de comandos para trabajar con ChantWizard.

Seleccione Cancel (Cancelar) para detener el proceso sin crear ninguna
grafica; use << para arrancar ChartWizard desde el principio; use Back
(Retroceso) para volveralacajade didlogoanterior; use Next{Siguiente)
para pasar ala siguiente caja de didlogo, y use >> para omitir el resto de
las cajas de dislogo e insertar la grafica en la hoja de trabajo.

11. Seleccione Next para desplegar Ia segunda caja de didlogo de
ChartWizard (Figura 21.3). Enesta caja de didlogo se
selecciona el tipo de gréfica a producir. Usaremos 1a tipe
columna, que es la preseleccionada.

12. Seleccione Next para desplegar la tercera caja de didlogo de
ChartWizard (Figura 2] .4). En ésta se selecciona el formato
de 1a griifica del tipo seleccionado, Las opciones cambian
dependiendo del tipo de gréfica.

13. Seleccione Next para desplegar la cuarta caja de didlogo de
ChartWizard (Figura 21.5). Esta caja de diflogo muestra un
ejemplo de como se verd la gréfica.

Las opciones en la porcién derecha de la caja de didlogo se fijan
basadasdependiendodelrango de celdas seleccionadas y de su contenido.

FIGURA 21.3:
La caja de didlogo
ChartWizard para
seleccionar tipo de
grafica
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FIGURA 21.4:

-='-“ ‘ CharWizard - Step 3 al & La caja de diél
Seloct 8 formol los the Column chart: Wisard pars
. : . ChartWizard para
5 seleccionar un
0 lwdl || B
grafica
8 9 10
[ Hep |{Cancol J{ ks J<Bock [Meats | 22 ]
FIGURA 21.5:

- — i ChartWizard - Step 40l & T L i de d
Sampla Chart a caja de didlogo
ChantWis ar:
$140.000 00 Data Series in: ) v izard para
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000
:Emug Bl Use fast row lor:
$40,000 00 Erperses @ Catopary (X] Axis Labots
$20,000 20 B Net Bevenues €' Eirst Data Seriss
3400
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En este caso, selcl:ccioné celdas en hileras, asi que Excel supone que los
datos de cada serie estdn en su propia hilera. Puesioque la primerahilera
del rango conliene elementos de texto, no nimeros, Excel supone
éstos deben ser usados como leyendas de eje x, también s'u‘ one (ﬂml:
texto en la primera columna debe ser usado pa‘ru Ieycnd;; pone e

14. Se]ecci(?ne chl_ para desplegar la quinta caja de didlogo de
ChartWizard (Figura 21.6). Usela para encender y apagar la

leyenda, para n‘uroducir un titulo gque aparezca encima de Ia
grafica, o para insertar titulos a los gjes.
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~

FIGURA 21.6:
: : La caja de didlogo
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15. Seleccione la caja de texto Chart Title y téclec Watson and
Sons, Inc., 1993,

16. Seleccione la caja de texto Category (Categoria) y teclee
Quarters. Cuando se selecciona esta caja de texto, Ja grifica
muesira queda actualizada incluyendo el titulo de gréfica
correspondiente.

17. Seleccione la caja de texto Value (Valor) y teciee Dollars. El
titulo de la categoria aparece en la gréafica de muesira.

18. Seleccione OX para regresar a la hoja de trabajo. La gréafica
aparece en el recuadro que se especificé para elia en la hoja de
trabajo (Figura 21.7).

Las cajas pequeiias alrededor de los linderos de la grifica se llaman
asas. Se pueden usar para cambiar el tamafio de la grafica, e indican que
la grafica estd seleccionada. Sise d4 click fuera del drea de la grafica, 1as
asas desaparecen, y 1a grafica ya noestd seleccionada. Dé click dentro de
la gréfica una vez més para seleccionaria y mostrar las asas,

Note que la barra de herramienta Chart {Gréfica) ahora aparece en
la pantaila. Excel muestra esta barra de herramienta para ofrecer und
forma cémoda de editar o cambiar la gréfica. Aprenderd c6mo usar 12
barra de herramienta Chart en la Leccién 22.

|
LECCION 21 16‘] i

FIGURA 21.7:
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Daouble-click chart 1o open

19. Dé click en ¢l botén de salvar (Shif ‘
i +F12) para guardar ta hoj
de trabajo y 1a gréfica. para g : a hoja

—) PN TN N . . . ..

20. Dé L|‘I(.|( en ¢l botén de imprimir para imprimir la hoja de
.[]'dhﬂ_lo y la gréfica en una misma pdgina. Sino ticne
impresora de color, Excel convertirg los colores de la gréfica
en lonos de gris,

21. Salga de Excel.

ChantWizard crea una grificaincrustada. Una grifica t'm'r:;smda es
aquella que forma parte del documento hoja de l;ahujo. La grizh’ca sc-:
guardar;’?, se imprimirdy se abrir junio con ia hoja de trabajo misma. Si
se (.:umbla cualquicr informacion en una ceida usada como pa'ﬁc de-s‘u
senie de datos, la grifica cambiars también automaticamente U;\a
gréﬁ_cu incrustu@a que se crea con ChanWizard aparcce cc)!m;) una
ipn(zlr:rl)ir:l:i:z:cllmja de trabajo, pero se le puede desplegar en sufventang

1



CREACION DE GRAFICAS

Para borrar la grafica, seleccifnela, asegurindose de que aparecen
las asas, y luego oprima Del. En {a Lecci6n 22 aprenderd c6mo cambiar
el tamafio y aspecto de las gréficas.

Gomo Crear

Graficas

Instantaneas

Sepuede crear una gréficasinacudir alascajasde didlogode Chant Wizard.
Seleccione las celdas que se¢ desea graficar, luego oprima Fll, o
seleccione File » New » Chart » OK. Excel hace una grifica de
columnas simple con los datos de las celdas seleccionadas y 1a muestra
en una ventana separada traslapdndose con la hoja de trabajo (Figura
21.8).

Note que la barra de menii ha cambiado. Esto se debe a que ahora
hay una ventana de grifica activa en lugar de la ventana de hoja de
trabajo. Las opciones de meni y las herramientas de guardar € imprimir

File

FIGURA 21.8:

Misinsutt Excel =¥ Gréfica mostrada en

Edit Gallery Chart Format Macro Window Help
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operardn sobre la grafica, no sobre la hoja de trabajo. Por ejemplo,
cuando una ventana de gréfica estd activa, dar click en el botdn de
imprimir, imprime Gnicamente 1a grifica, no lahoja de trabajo. Aprendera
mds acerca de opciones de meni en la Leccion 22,

Una grafica creada oprimiendo F11 no estd incrustada ni es parte de
la hoju de trabajo. No se'imprime ni se guarda al imprimir y guardar la
hojade trabajo. Sinembargo, la grafica permanece eslabonada a los datos
de 1 hoja de trabajo. Si se cambian datos que son parte de una serie de
datos, la grifica se actualizard.

Si desea imprimir o guardar la gréfica y Ia hoja de trabgjo juntas,
necesila incrustar la grafica en la hoju de trabajo. Seleccione Chiart »
Select Chart, y luego seleccione Edit » Copy. Déclick encualquier parte
de la ventana de la hoja de trabajo, seleccione la celda donde.desea
posicionar la esquina superior izquierdu de la grafica y luego seleccione
Edit » Paste. La grifica aparecerd sin linderos ni leyendas. Aprender
mds acerca del uso de varias ventanas en la Lecci6n 26.

Cuando salga de Excel, se le preguntard si desea guardar la grifica.
Toda grifica recibe la extension XLC al ser grabada. Las gréficas se
abren igual que las hojas de trabajo.
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PRESENTAC!ON DE

Coémo cambiar el tipo
de grafica

Camo borrar
la leyenda

Como cambiar &l
tamanio y posicién de
graficas

Trabajo con
Graficas

espués de crear una grifica, se puede cambiar
su estilo y modificar cualquiera de sus
elementos. En esta leccion, aprenderd como
cambiar el tipo de una grafica, ajustar sus
linderos y su fondo, asi como cambiar el

tamafio y posicién de la misma.

Utilizar4 la barra de herramienta Chart para ejecutar muchas de las
tareas de esta leccion. Refiérase a la Tabla 22,1 para ver una lista de
iconos de esta barra de herramienta. (Las herramientas Flecha y Caja de
lexto existen también en la barra de herramienta Drawing, asi que 18
explicaremos en la Leccion 23),

R . TABLA 22.‘I| T
BOTON  NOBAEo | Botones de fa b

ERBiFeEEBBEREEE M E

Grafica de drea

t Grdtica de barras
1
i
' Grdfica de columnas
1

| Grafica de columnas apiladas

1 Gréfica de fineas

i
|

I Gréfica de sectores
1
:

i
{ Grafica de dispersion XY

"1 Grifica de drea 3-D

| Gréfica de barras 3-D

i
'
1 Grifica de columnas 3-D

Gréfica en perspectiva 3-D

! Gréfica de lineas 3-D
|

i Griifica de sectores 3-D
1

Grdfica de superficie 3-D

Grafica de radar

.

E
i! Combinacidn de gréaficas de lineas y de columnas
i

. !
LECCION 22 .

de herrumienta
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TRABAIO CONGRAFICAS

BOTCN

|

L EDE BE

NOMBRE

! Grafica bursétil

. Grﬁﬁcapreferidu(insenuunagréﬁcaincrustadausandoceldas
seleccionadas de una hoja de trabajo)

ChartWizard (inicia el programa ChantWizard)
" Lineas horizontales de referencia.
Leyendus

‘: Flecha

|
. Caja de texto .

TABLA 22.1:

Botones de ka barra
de herramienta Chan
(continuacién)

Como Cambiar
¢l Tipode una -
Gréfica

Los primeros tres juegos de botones, desde 1a izquierda de la barra de
herramienta Chart sirven para cambiar el tipode grafica. El primer juego
formatea graficas simples, el segundo, gréficas iridimensionales (3-D).
y el tercer juego crea combinaciones de graficas. Para cambiar el tipode
grafica, solo dé click en ]a herramicenta det estilo deseado.

Estas herramientas se pueden usar ya sea que s& haya creado 1a
grafica con ChartWizard o bien oprimiendo F11. Siga estos pasos pard
aprender como trabajar con 1a barra de herramienta:

1. Arranque Excel y abra el documento QUARTERS. La barra
de herramienta Chart debe aparecer en la pantaila poique
aparecia cuando se guard6 la hoja de trabajo QUARTERS en
Ja Lecci6n 21. Si la barra de herramienta no aparece, dé click
con ¢l botén derecho en la barra de herramienta standard para
que aparezca ¢l menii de atajo Toolbars, y luego seleccione
Chart para que aparezca dicha barra de herramienta.

2. Sila grafica noesid seleccionada, déle click para ver sus asas.

»

————
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Dé click en el primer bot6n de la izquierda de la barra de
herramienta Chart. Excel convierte la gréafica de columnas en
grafica de 4rea (Figura 22.1).

. D¢ click en el segundo botén para crear una gréfica de barras.

. Dé click en cada uno de los botones restantes de los primeros

tres juegos para ver su efecto en la gréfica. Obtendrd un
mensaje de error cuando dé click en el Wltimo botén — que
pide una combinacién de gréficas financieras — porque
requiere de cuatro series de datos.

Dé click en la herramienta de gréfica de columnas simple —
que es el tercero desde la izquierda — para regresar al estilo
de gréifica preestablecido.

Dé click en la herramienta de cuadricula — que es el cuarto
botén desde la derecha. Aparecerdn lineas de referencia
horizontales marcando los incrementos a lo largo del eje y.

File Edit Fopmula Formal [Data Options Macro YWindow Heip

RN IEEELIA-EEs AR

FIGURA 22.1:
La grifica conventida
D4 tipo Area

3
watson and Sons. Inc.. 1993 i
N
$250.000 00 -
$200.000 0 :I
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Total Incume 5

$50.000 00
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Ahora veamos como encender y apagar las leyendas.
8. D¢ click en la herramienta de Leyenda — que es el tercer
botén desde la derecha. La leyenda se ctimina de la grafica y
ésta se expande ocupando el drea donde estaba la leyenda.

9. Dé click por segunda vez en la herramienta de leyenda para
restaurar ésta.
§i cambia una grafica, debe guardarla de nuevo pari quc el cambio
quede repistrado en el disco, adn si no hizo Olros cambios a la hoja de

trabajo.

Cémo Cambiar
los Marcos y !
Plano de Fondo
de una Gréfica

Una manera de personalizar el aspecto de una gréifica es cambiando el
marco que larodea o agregando un patrén de relleno a su plano de fondo.
Siga estos pasos cuando desee personalizar sus grificas:
1. Apunte a cualquier parie de 1a grafica y oprima el botén
derecho para ver el mend de atajo Chart (Figura 22.2).

1 Seleccione Patierns... (Patrones) para mostrar la caja de
diflogo de la Figura 22.3.

3. Seleccione Opciones a su gusto para el marco y ¢! relleno, Las
opciones bajo Border (Lindero) determinan ¢l color, el estilo de
linea y el grueso del lindero gue rodea la grafica. También hay
opciones para crear una caja sombreada y para usar esquinas

FIGURA 22.2:
E! meni de atajo pard
Curi+C
Copy ' graficas
Clear Del
E ¢it Object
Patierns...

Being to Front
Send to Back

Dbject Properties...

Assign Macro to Object...
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FIGURA 22.3:
La caja de didlogo
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Patterns

i
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redondeadas en vez de cuadradas. Lasopciones bajo Fill (Relieno)
controlan el patrén y el color que hade servircomo plano dé fondo
a las praficas — vea la caja Sample (Muestra) para confitmarel

aspeclo gue tendrin sus selecciones.

4. Seleccione OK, La Figura 22.4 muestra como se_ ve una
gréfica con esquinas redondeadas dentro de una caja
sombreada y con un patrén de relleno.

5. Seleccione Edit » Undo Pat
ci ermns para regresar | icaas
condicidn original. P gresar a grifican e

6. Salga de Excel ahora sin guardar la grafica modificada, o trate
algu.nas de las otras técnicas descritas en ¢l resto de esta |
leccidn, y luego salga sin guardar 1a gréfica.

Como mprimir
una Grafica
Incrustada sin
Imprimir la Hoja
de Trabajo

Si dt?sca |rlnpr|m|r un ejemplar de la gréfica pero no su hoja de trabajo
asociada, nlcnc que desplegar la grificaen ventana separada. Parahdcerlo
dé d(fble click en la gréfica, o seleccione Edit Object (Editar objclcl)) de!l
ment de atajo para grificas.

Dé gllick en la herramienta de imprimir o sclecione File > Print
(Cirl+Shift+F12). D¢ doble click en ta caja de control de la vcmar'm de
la gréfica para cerrar dicha ventana. .
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FIGURA 22.4:
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Para cambiar el tamafo de una grafica, apunte a una de las asas de |

Como Cambiar-  Paraca
. TIMSME

¢} Tamario de .

una Grafica .

Apunte a un asa de lindero superior para cambiar la altura.

Apunte a un asa de la derecha o la izquierda para cambiar el
ancho.

m Apunle a un asa de esquina para cambiar tanto el ancho como
la aliura a la vez. ,

El senalador del mouse se transforina en flecha de dos pl{l\lﬂlz
Oprima y manienga oprimido ¢l botdén izquierdo del mouse y arrsire g
vertical, horizontal o diagonalmente — verd moverse. junto (‘:onl °
sefalador, una linea fantasma que corresponde al lindero © a_la cag:h N
que se estd moviendo. Arrastre con el mouse hasta que la graficaest
tumafio descado y luego suelte el boton.
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Como Mover
una Grafica

Para mover una gréfica, cologue el sefialador del mouse dentro de la
grifica de modo que adopie 1a forma de una flecha grande. Oprima y
mantenga oprimido el botén izquierdo, y arrastre el mouse, Al irlo
arrastrando se mueve junto con €] una linea que indica el perimetro de
la grifica. Ubiquela donde desee que aparezea la grifica y luego suelte
¢l hotdén del mouse. ’

Coémo Editar

Graficas

0PCION

File
Edit
Gallery
Chan

Format

Macro

Excel ofrece un poderoso juego de comandos para modificar el aspecto
de las gréficas. Debido a que hay tantos menus y cajas de didlogo que se
pueden usar, estos comandos quedan fuera del propésito de esie libro de
ABC. Sin embargo, una vez que domine et manejo de los conceplos
basicos del desarrollo de grificus, puede descar practicar con eslos
comandos por cuentd propia.

Para edilar una grifica incrustada, dé doble click o seleccione Edit
Object del mend de atajo, para desplegar la grifica en su ventana propia.

TABLA 22.2:

Las opciones de la
barra de menis pary
editar grificas

" DESCRIPCICN

(Archivo) Mistnas opciones que en el meni standard

(Editar) Cortar, copiar y pegar partes seleccionadas de la grifica
1 (Galeria) Para cambiar el tipo y estito de grafica
l (Girdfica) Para agregarelementos a la grifica, agregar texto a titulos

!y ejes, seleccionar dreus, calcular en la hoja de trabajo y verificar
ortografia

(Formato) Para cambiar tipo, colores, patrones y otros formatos de
la grifica o elementos seleccionados de ella

Pura grabar y correr macros

Window | (Ventana)Paraacomodar. oculiar. desocultar y seleccionar ventanas
Help . (Ayuda) Opciones standard del mend Help
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Puede usar entonces las opciones de la barra de mends (ver Tabla 22.2)
para cambiar cualquicra de las opciones de la gréfica.

Por ejemplo, para crear o editar el titulo de una gréfica, scleccione
Charl » Atiach Text {Anexartexto} paradesplegar lacajade didlogoque
muestra la Tigura 22.5. Seleccione Chart Title (Titulo de gréfica), y
luego OK. Teclee el titulo en la bara Formula u oprima F2 y edite un
titulo existente; luego seleccione la caja Enler.

En vez de usar la barta de mends para cambiar opciones de las
gréficas, se puede dar doble click en la parte de la grifica que se desea
editar para desplegar una cajade didlogo con ocpiones. Las opciones que
tenga la caja dependerdn del lugar de la gréfica donde se dé click.

También se puede dar click al botén derecho del mouse mientras
estd apuntando a un drea en especial de la gréfica para desplegar el mend
deatajo. Unavezmés las selecciones de este menti cambiardn dependiendo

de donde se dé click.

. FIGURA 22.5:
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Creacion de
Elementos Gréficos y
Cajas de Texto

0

N

Cémo crear logos

Cémo dibujar flechas

Cajas de texto

e pueden agregar toques persbnales auna hoja
de trabajo para aumentar su impacto visual
usando la barra de herramienta Drawing,
mostradaenlaFigura23.1. Se usan las primeras
11 herramientas para trazar lineas, contornos y
cajas de texto. Los contornos sin relleno son
lransparentes — esto es que no cubren objetos
ya existentes en la pantalla. Las cajas rel‘lenas
son opacas y pueden aparecer enfrente de
(cubriendo) o detrds de (cubiertas pors otros

objetos. Las herramientas restantes mzm!ipulan

objetos seleccionados. Vedse en la Tabla -|23.l

el nombre de las herramientas.

\
—— S ——




ETEXTO
174 CREACLON DE F.LE.MENTOSGRAF'ICOSYCA]ASD

FIGURA 23.1:

Barra de herramienta
Drawing

TABLA 23.1:
Botones de la barra
de herramiena
Drawing

Flecha

A mano libre

Rectangulo

Qvalo

Arco

Poligono a mana libre
Rectdngulo relleno
Ovalo relleno

Arco relleno

EEeEER IEEEBER

Pol[.gnno a mano libre relleno

LECCION 23

BOTON

. NOMBRE

I
E Caja de texto

Seleccion

Cambiar forma
Agrupar

Desagrupar
Pasar a plano anterior
Pasar a plano posterior

Color

e EER DR

Sombra tridimensional
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TABLA 23.1:

Botones de la barra
de herramienta
Drawing
(continuacién)

Ademds de dibujar objetos, se les puede editar y modificariguatmente.
Puede cambiarse 1a forma, ancho, estilo y color de los objetos, ¥ aun

combinar objetos individuales formando grupos.

En esta leccion agregars un logotipo, flechas y una caja de texto a

la hoja de trabajo QUARTERS.

Gomo Dibujar
Siluetas

Refi€rase a la figura conforme va siguiendo los pasos.

Empezaremos por dibujar un logo — el escudo de armas de Walson —
al 4rea rectangular que consiste de las celdas A3, A4y AS. El logo,
mostrado en la Figura 23.2 se compone de dos Gvalos y dos flechas.

-]




176 CREACIONDE ELEMENTOS GRAFILCOS Y CalAS DETEXTU

FIGURA 23.2:
C D 3 Tl & Logo creado usando

Watson and Sons, Inc.

J las herramientus de

1 dibujo

Ist Ofr,

Fircal I993

2nd O Jrd Otr dth AT, Average Y

R

Arranque Excel y abra la hoja de trabajo QUARTERS.
Recorra la hoja de trabajo hasta mostrar la celda A3.

Abra 1a barra de herramienta Drawing — dé click al botén
derecho del mouse en la barra de herramienta standard y luego
seleccione Drawing del ment de atajo.

Seleccione la herramienta Ovalo sin relleno — que s la
quinta desde fa izquierda. El sefialador del mouse se
transforma tomando el aspecto de una mirilla con dos lineas

finas en cruz.

Cologue la mirilla en cruz en la esquina superior izquierda del
recténgulo que forman las celdas A3 a A5. Coloque ¢l
sefialador tan arriba y tan a la izquierda como sea posible, pero
asegurindose de que no pierde su forma de mirilla en cruz.

6. Oprima y manienga oprimido el bot6n izquierdo det mouse y

arrastre la mirilla en cruz hasta la esquina inferior derecha del
rect4ngulo mencionado. Al arrastrar el sefialador se ve un
contomno de forma oval en su trayectoria.

7. Suelte el botén del mouse. El Gvalo se muestra Con asas

indicando que estd seleccionado ese objeto (Figura 23.3).
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|
= FIGURA 23.3:
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Cuando un objeto — por ejemplo una linea que se dibuja, un évalo,
un recuadro u otra forma — se selecciona, se le puede mover o borrar y

manipularla de varias formas:

Ahora terminemos el escudo de armas,

8.
9.

Para mover un objeto seleccionado, arrdstrelo por una de sus
asas.

Para borrar un objeto seleccionado, oprima Del.

Pgra seleccionar un objeto, apunte a una de sus fineas y dé
click al botén izquierdo del mouse.

gar: deseleccionar un objeto, dé click en cualquier partelfuera
e €l

Seleccione la herramienta de évalo relleno.

Refiérase a la Figura 23.2 y coloque la mirilla de cruz :cn
donde se desee que aparezca la orilla superior izquierda del
6valo relleno.




178 CREACION DE ELEMENTOS GRAFICOS ¥ CAJAS DE TEXTO

10. Arrastre el sehalador a la orilla inferior derecha del évalo, y
luego suelte el bot6in del mouse.

11. Siel 6valo no estd donde se desea, arrdstrelo por una de sus
asas. Para borrar el 6valo y empezar de nuevo, oprima Del e
intente de nuevo,

12. Teniendo atin seleccionado el 6valo relleno, dé click dos veces
en la herramienta de color — que es la que tiene el icono de
una paleta de pintor, ¢l penaltimo bot6n de la barra de
herramienta Drawing.

Cada vez que se d4 click en la herramienta Color, el objeto
seleccionado se rellena de otro color u otro patrén. Dar click
una vez rellena el 6valo con blanco, pero dar click una
segunda vez lo rellena con negro.

13. Dé click en la herramienta de flecha —es el bot6n con el
icono de una flecha diagonal; €l segundo hotén de la izquierda
de 1a barra de herramienta Drawing,

14. Coloque el sefialador en la esquina inferior derecha del
rectangulo, arrastre el mouse a la esquina superior izquierda, ¥
luego suelte el boton, La flecha aparecc con asas en ambos
extremos, denotando que estd seleccionada. Note que la
cabeza de 1a flecha aparece ¢n €l extremo opuesto dela
posicion de partida.

15. Seleccione la herramienta Flecha una vez més,

16. Coloque el sefialador en la esquina inferior izquierda del
rectdngulo, arrastre ¢l mouse hasta ]2 esquina superior
derecha, y luego suelte el botdn para completar la segunda
flecha.

$i un elemento del logotipo se ve incorrecto, bérelo y dibujeto de
nuevo.
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Como Agregar
Cajas de Texto

Cualndo se desee agregar notas o mensajes a una hoja de trabajo
cnmém.zlas en una caja de texto. Se crea una caja de texto con I.';
herramienta Text Box — que es el primer botén de la segunda hilera de
la barra de herramienta Drawing y el dltimo botén de ta barra de
herramienta Chart.

El texto que se ingrese en lacaja hard cambio de renglén automdtico
al Ilegar al lindero derecho y se recorrerd automdticamente, para que en
una caja dfz texto pequeiia pueda caber cualquier cantidad de texto.
Cuando se imprime la hoja de trabajo, sin embargo, inicamente el texto
que aparece en la pantalla deniro de la caja serd €] que se imprima.

Uscmos_ unacajadetextoahorapararesaltar losexcelentes resultados
det cuarto trimestre de Watson and Sons. La caja de texto completo se
muestra en la Figura 23.4 — dsela de referencia al trabajar.

1. Recorra {a pantalla hasta que pueda ver ¢l final de la hoja de
trabajo y el principio de la grifica,

2. Seleccione 1a herramienta Text Box.

3. Coloque el sefialador del mouse bajo 1a palabra subject que
estd al final de la hoja de trabajo.

4, Oprin?a y mantenga oprimido el botén del mouse y arrdstrelo
aproximadamente dos pulgadas hacia la derecha y media
pulgada hacia abajo.

FIGURA 23.4:

0% 100% 0% Caja de texto llena en
i) $3% 102% 1% la hoja de trabajo

T ’ QUARTERS

Our Best Quarer Everl /

Thenks 10 everyonel

Watson and Sons, Inc., 1993
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FIGURA 23.5:
Recuadro de texto

agregado a la hoja de
trabajo QUARTERS
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5. Cuando aparezca la caja aproximadamente del tamafio y forma
que muestra la Figura 23.5, suelte el botén de'l mouse. (Para
dibujar una caja cuadrada, oprima la tecla Shift al arrastrar el
sefialador). :

El punio de insercidn parpadeante que aparece de.nlro de la caja de
texto, indicaque lacajaestiactiva, osealista pararecibirtexto. Alteclear
el texto hard cambio automético de renglén al llegar al lindero derecho
y se ird recorriendo hacia arriba.

6. Teclee Our Best Quarter Ever!, y oprima ..
7. Teclee Tharks to everyone!.

8. Déclick en la herramienta de Flecha y dibuie una flecha que
apunta desde dentro de la caja a la cifra 111% en la celda E23.

9. D¢ click dentro de la caja de texio para que aparezcan sus
asas,

i
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10. D€ click en fa heramienta Drop Shadow (Sombra
tridimensional) — que es el iiltimo botdn en Ia barra de
herramienta Drawing. Aparecers un lindero més OSCUro en la
parte inferior y en 1a parte derecha de la caja, dandeo aspecto
tridimensional,

I1. Dé click en ¢l botén de imprimir para que se imprima laI hoja
de trabajo terminada y la grafica, La Figura 23.6 muestra

€omo aparecerd la impresion.

12, D click en la herramienta Guardar (Shift+F12) para grabar la
hoja de trabajo.

13. Salga de Excel. 1

Para personalizar adn més un objeto dibujado, dé doble cli(fk encl
objeto para que se desplicgue una caja de diflogo con opciones. Las
opciones en esta caja cambian dependiendo del tipo de objeto. También
sc puede dar click en el objeto con el botén derecho del mouse, :'( luego
hacer selecciones del mend de aajo que aparcce.”

Excel ofrece demasiadas opeiones para disenio y personalizacién de
dibujos que no pueden describirse en una obra deintroduccién como ésta.
Perouna vezque domine lashabilidades de ha aprendido aqui, expmlimenu:
porsu cuenta con losolros botones y comandos i 1a barrd de herramienta,
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PRESENTACION CE

Como reemplazar con
y sin confirmacién

Como localizar
referencias

Busqueda y
Reemplazo de Texto

ran parte del tiempo que pasa editando una
hoja de trabajo es para recorrerla a fin de
encontrar algiin elemento o referencia en par-
ticular, Con frecuencia se requiere reemplazar
un valor con otro, ya sea porgue los nimeros
han cambiado o porque se desea experimentar
con los resultados de un cambio potencial
sobre funciones calculadas y férmulas. En vez
de recorrer hileras y columnas para localizar el
elemento que se desea cambiar, se puede hacer
el cambio automdticamente mediante el

comando Replace (Reemplazar) de Excel.

LECCION- 24 1 85

En esta leccion, aprenders c6mo buscar y ¢6mo rcemplazar lexto
automdticamente. También aprenderd como usar ¢l comando Find para
pasar rdpido a una referencia especifica.

Como
Reemplazar
Caracteres

El comando Replace permite cambiar nlimeros, coordenadas de c;ldas
en las férmulas y funciones, y eltexto de titulos o encabezados de hileras
ocolumnas. Sise deseareemplazarcaracteresen la hojade trubajo entera,
seleccione una sola celda en cualquier parte de la hoju de trabajo, -Para
recmplazar elementos dnicamente en un drea determinada, seleccione el
rango de celdas primero. '

No se puede reemplazar caracteres st estin seleccionados | una
grificauotroelemento gréfico— laopeién Replace aparecerd som breada
en ¢l mend Formula, Seleccionar cualquier celda de la hoja de trabajo
volverd a dejar disponible la opeidn Replace.

Veamos codmo reemplazar caracteres cambiando los valores en la
hilera 10¢n la hojade trabajo QUARTERS haciéndole que sea $1,800.00.
Siga estos pasos:

I. Arranque Excel y abra la hoja de trabajo QUARTERS.,

2. Seleccione Formula » Replace para desplegar 1a caja de

didlogo que muestra la Figura 24.1. El punto de insercidn ya
estd dentro de la caja de texto Find What (Encontrar qué),

FIGURA 24.1:
L1 caju de didlogo

Fedwha: [ [Baplecept] | Repluce

Replace
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1. Teclee 1500, que son los caracteres gue se d§sea SUSllllu‘l.!‘. No
se deben teclear signos de puntuacién; por e’Jempr),; signo
de pesos ni comas, porque éstos ya de por i quedaran
insertados gracias al formato de la celda.

4. Seleccione la caja de texto Replace With (Reemplazar‘ czn) y
. luego teclee 1800, que son los caracteres nuevos que se desea

insertar.

5. Seleccione Whole (Entero) en la seccién Look At (Mirar a).
nada Part {Parte), Excelhard elreemplazo
de otro elemento mis largo. Por ejemplo
000.00 a $18,000.00. Seleccionando
4n alterados por error.

Conlaopci6n preseleccio
aun si los caracteres son parte
Excel cambiarfa el ndmero $15,
Whole, se asegura gue 108 nimeros no ser

6. Seleccione Replace All (Reemplazar todos). Exc.el rcerf\!:)!::;a
cada aparicion de $1 ,500.00 con $1,800.00 y quita la caja
didlogo. o -

Excel no sustituird ninguna funci6n ni férmula-SI se mg‘reseu? sdli;
resultados en la caja de texio Find What, Por C_]E:I‘np:O, ‘:r;:::lo .
reemplazo, la celda F10 mostraba $1,500.00 porque m]Z res ado e

AVERAGE (B10:E10). Después del reemplazo, la celda €O o
misma funcién. El nimero $1,800.00 se muestra ahora' porque ;ido
nuevo resuliado, no porque los caracleres de la celda hayan
Cambsl?gg fi'esea reemplazarunaf uncién ouna férmula, se debe m:rodurc;
en 1a caja de texto Find What, como lo harfa en l.a barra FdC)tTnu ra; E:ndo
sola. También puede reemplazarse una referencia de celda :jng o
sus coordenadas en la caja de 1exto qu What y luf cfnor e;\a
reemplazo en la caja de texto Replace.Wuh (Reer?lpluz.lr con). .
Si seintroducen caracteresenlacaja detexto Emd Whatquen
en la hoja de trabajo, Excel desplegard el mensaje

1d not find matching data o replace
?I?: se encontraron datos coincldentes que reemplazar)

stén

3 i ara
Seleccione OK para cancelar ¢l reemplazo, o seleccione Help p
obtener informacién acerca del comando Replace.

L
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Seleccione Match Case (Igualar maydsculas/mindsculas)en la caja
de didlogo Replace cuando se desea reemplazar caracteres dnicamente
st coincide la combinacién exacta de maytsculas y mindsculas que
contenga ta caja de texto Find What. Use esto cuando reemplace
encabezados de hilera o de columna.

Seleccione Rows (Hileras) (horizontales) o Columns (Columnas)
(verticales) en la seccién Look By (Buscar por) para indicar a Excel la
direccion en que desea que efectiie la bisqueda. Esto es més dtil cuando
se estd ejecutando un reemplazo confirmado y se desea sustituir texto en
un cierto orden.

Como Hacer REEMPLAZOS CONFIRMADOS

En vintud de que 1a opcién Replace All cambia automdlicamente la hoja
de trabajo, se podrian alterar algunos elementos accidentalmente. Por
ejemplo, suponga que $1,500.00 era un elemento en otra parte de lahoja
de trabajo QUARTERS que no se deseaba reemplazar con $1,800.00,

Podria primero seleccionarel rango de celdas en las que quisieraque
Excel buscara los reemplazos — Excel harfa los cambios dnicamente
dentro de ese rango. Como altemativa, se podria llevar a cabo un
reemplazo confirmado. Un reemplazo confirmado es aquel en el cual se
debe seleccionar el botén Replace cada vez que se va a hacer un cambio
especifico en la hoja de trabajo.

Supongamos gue se desea cambiar los valores del primer trimestre,
segundo trimestre y tercer trimestre de la hilera Rentals.

1. Seleccione Formula » Replace. Note qgue la caja de didlogo
contiene el texto que se introdujo vy las selecciones que se
cfectuaron en los pasos anteriores.

2. Teclee 45006 en la caja de texto Find Whai.
3. Seleccione la caja de texto Replace With y teclee en ella 4250.

4. Seleccione Find Next (Encontrar siguiente). Excel pasa ala
primera celda que contiene 4500 en |a hoja de trabajo. Si no
puede ver la celda activa, arrastre la caja de didlogo Replace a
otro lugar de la pantalla. Para mover la caja sujéiela de la
barra de titulo.
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Seleccione Replace. Excel lleva a cabo ¢l reemplazo, y luego
localiza la siguiente aparicién.

n

6. Seleccione Replace para cambiar el elemento y localizar la
siguiente aparicion.

7. Scleccione Replace una vez més. Esta vez, Excel se detiene en
la celda E16, que es un elemento que no se quiere cambiar.

8. Scleccione Find Next. Excel no efectia el reemplazo y ¢n
cambio pasa a buscar la siguiente aparicién del mismo texto.
Puesto que ya no hay otra aparicién, Excel despliega una caja
de didlogo con el mensaje

Could not find matching data
{No se encontraron datos coincidentes)

Cuando se desea localizar la aparicién anterior de lo que
contiene la caja de texto Find What, se oprime y se manticne
oprimida la tecla Shift al seleccionar Find Next.

9. Seleccione OK para salir de fa caja de didlogo y regresar a la
hoja de trabajo.

10. Cuidadosamente salga de Excel ahora sin guardar la hoja de
trabajo editada, o practique usar el comando Find, descrito en
la siguiente seccién, y luego salga de Excel sin guardar los
cambios.

Gomo Encontrar
Caracteres
Rapidamente

Cuando se esté trabajando con una hoja de trabajo grande, puede resultar
tardado recorrer hileras o columnas hasta hallar determinada referencia
en particular. Porejemplo, supongaque lahojade trabajo contiene varias
formulas que hacen referencia a una celda especifica. Desea revisar cada
una de estas referencias para asegurarse que estdn correctas. A fin de
localizar cada una rdpidamente, use el comando Find.

Elcomando Find localiza unaceldaperonoreemplaza su contenido.
A continuacion se explica como trabaja:

1. Seleccione Formula » Find (Shifi+F5), para desplegar la caja

[
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de didlogo que muestra |y Figura 24.2. La caja contendri e
texto y las opciones seleccionadas duranie la Gltima Ope'racién
de bisqueda o de reemplazo de la presente sesion de Excel.

En la caja de tex1o Find Wha, teclee tos caracteres que desea

localizar.

En la seccién Look In (Buscar en), seleccione Formulas)
Values o Notes'(Férmulas, valores o notas) para cspccit‘i’czlr en
donde se desen que Excel ejecute la bisqueda.

Seleccione Whole (Entery) o Pant (.Pariu) en la seccion Look
Al :

s |, 1 e AN LA T H 7 '
Sglwcmne Rows si se desea que Excel ejecute la hdasqueda por
hileras o Columns si se quiere gue la ejecute por columnas en

la seccién Look By.

Selccctqne la caja de palomeo Match Case si se desea localizar
la combinacion exacta de caracteres en maytscula y
minuscula.

Seleccione OK para encontrar [a primera aparicién de los
carucleres,

Seleccione Edit » Repeat Find (Repetir 1a biisqueda) (F7)
para buscar la siguiente aparicion, Oprima Shifi+F7 para |
encontrar Iy aparicién anterior. '

FIGURA 24.2:
La caja de didlogo
Find What: (4500 Find

Look in Look by

® Formulas ® Aows

_r Yalios  Columng

 Moles
?Finok "i n !.u‘:h Caze !
C Pat Piezs F7 to Find Nemt
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PRESENTACION DE

Coémo colocar hileras
en orden

La barra de
herramienta Utility

eras y Columnas

1 orden en el cual se ingresan datos a la hoja de
trabajo depender4 con frecuencia de la fuente

de informacidén. Se puede crear una hoja de

trabajo de un presupuesto en el mismo orden
que las paginas del libro mayor. Un maestro
puede introducir nombres a una hoja de trabajo
de un grupo de alumnos en el orden en que 1os

nombres de los estudiantes aparecenen la lista.

Sin embargo, una vez que se haterminado la hoja de trabajo, puede
resultar que seria ms \til otro orden de hileras o columnas. El maestro.

porejemplo, puede desear tener a losestudiantes enumerados de acuerdo

con sus calificaciones promedio. Un analista podria preferir enumerdr
los departamentos de una compatiia de acuerdo con sus utilidades 02 los
empleados de acuerdo con su historial de seguridad.

En esta leccién aprenderd como ordenar las hileras y las columnas
de una hoja de trabajo.

4
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LECCION 25

C6mo Ordenar
Hojas de Trabajo
por una sola
Clave

Se ordena una serie de hileras o columnas determinando un criterio de
ordenamiento, llamado clave. Cuando se estd ordenando una serie de
hileras, la clave es cualquier celda de la columna que contenga el
elemento que se desea reacomodar. Por ejemplo, suponga que desea
colocar en orden alfabético las categorias de ingreso de la hoja de trabajo
QUARTERS. Puede servir como clave cualquiera de los rétulos de
ingreso de la columna A.

Como ejemplo de ordenamiento, empecemos por disponer las
categorias de gastos en orden alfabético.

1. Arranque Excel y abra la hoja de trabajo QUARTERS.

2. Seleccione las celdasde la A7alaFl1.

3. Seleccione Data » Sort (Ordenar) para desplegar la caja de
didlogo mostrada en la Figura 25.1.

Excel supone que la celda activa — la primera que scleccioné del
grupo—es laclave. Excel rodea lacelda clave con unacajaque parpadea
y coloca sus coordenadas ($A$7) en la caja de texto Ist Key (Primer
tecla). Un ordenamiento ascendente desde el valor mas bajo hastael mas
alto, es la opcion preseleccionada.

4. Seleccione OK para ejecutar el ordenamiento.

5. Dé click con el mouse para deseleccionar las celdas.

)

FIGURA 25.1:

Sort




ORDENAMIENTO DFE HILERAS Y COLUMNAS

nadas se ordenan alfabéticamente de
Note que el lindero que estaba
Interest — se movid junto con

Las hileras de celdas seleccio
acuerdo con sus rétulos de la columna A.
asociado a 1a hilera 11 original — que es
los datos.

6. Scleccione Edi
(Ctrl+Z) para hacer que as cel
original. El rango aparece seleccionado,

Ahorasupongaque desea determinar rapidamente cudles categorias
producen mayor ingreso. Para hacerlo debe ordenar las hileras de
acuerdo con los valores de 1a columna Average en orden descendente.

Las celdas A7 a F11 deben seguir seleccionadas. Si no es asi,
selecciénelas ahora y luego siga los siguientes pasos:

1. Seleccione Data » Sort. La celda activa, que es AT, estd

atn dentro de la caja de texto 1st Key.

t » Undo Sort (Deshacer el ordenamiento)
das regresen a su ordenamiento

a F17 en la columna Average. Aparecerd

Seleccione la celd
¢ la celda y las coordenadas

una caja parpadeando alrededor d
$F$7 aparecerdn en la caja de texto 1st Key. Sino se ve la
celda para seleccionarla, cambie de lugar la caja de didlogo
Sort para que no estorbe, arrastrdndola por la barra de Titulo,

Seleccione Descending (Descendente) bajo 1a caja de texto Ist
Key.
4. Seleccione OK.

El importe de los in
descendente, de acuerdo con los va
virtud de que 1a hilera Interest es atin 1a Gitima de su categori

de los linderos no cambia.
Ahora ordene el rubro Expense en 1a columna Average.

1. Scleccione las celdas de la Aldala F18.

gresos estd ahora acomodado en orden

lores de la columna Average. En
a, el arreglo

Seleccione Data » Sort.

Seleccione la celda Fi4 en la columna Average.

aowo®

Seleccione Descending abajo de 1a caja de 1ex10 151 Key.

LECCION 25
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5. Seleccione OK.

6. D(:: C!le con el mouse para deseleccionar lus celdas. Ellindero
inferior bajo las celdas de Supplies ya no estd en la posicién
correcta.

7. Seleccione las celdas de lu Al7 ata F17 y dé click en 1a
herramienta Lindero Inferior de la barra de herramienta
standard para eliminar la linea. '

8. Scleccnpne las celdas de la A18 ala F18 y.dé elick en Ta
herramienta Lindero Inferior para agregar la linea.

9. D¢ C|.IC|( en la herramienta de Guardar (Shift+F12) para salvar
la hoja dt_: trabajo. La Figura 25.2 muestra [a hoja de lrapbajo
con las hileras ordenadas.

—E"E — Microsolt Excel FIGURA 25-12:
n]mula Farmat Data  QOplions Macre  ‘Window Help La hoja de trabajo
et ﬂﬁﬁ (=[w]u]] QUARTERSI
A8 | |Commsswons __________ _ _—— ordenadaporla
- £ A Y !

n I 1.3 columnu Average

- B c D E F G -
g L2l
> a1 O 2nd Ot ird . ah O Average :]
7 |Seles $734851 75 $7243%676

. , 17825465 197,634 97 380,499 53
: ]]insu 11532300 31532300 113,325 00 31332300 115-32503
2 Reras 53809 $TBE 45ges  $eas 8%l
s cyalties $1,500 00 $1,500 00 41,500 00 11,500 00 u'jmm
3 ;n::;l $1,205 30 31,297 36 3131652 $|‘306 76 11-302 59

tod 2 : ;
i3 Mgn 13 Mﬂ ‘IM L !IIII'MJ.W 51%433.39
4 ;s
. E::::: 330,542 56 §30,56473 $31,765 60 132178 67 $31,262389
L - $1,342 50 $1,39427 $1.401 05 412087 3450467
16 ol $450000 5450000 3450000 3450000 340000
1 Supphes_ SEES N LMIN  RIKET 2307 28
13 rﬁ““’om $73¢ 52 $r1a 3t 378235 1974 53 S.Bﬂi 0g
1 s r TOI008  SHTBI)  SMIBEIT 3410685 HOAWE
Z Ld
L d
Raedy
[r= [ [




ORDIENAMII’.NTO DE HILERAS Y COLUMMNAS

CoMO ORDENAR POR COLUMNAS

La opcitn Columns (Columna
las columnas ¢n vez de las hile
columnas aparezcan en cierto or

Para ordenar esta hoja
seleccione las celdas B3 a E16, use como clave cua

hilera 3 que contenga un nombre, y selecci

den especial, como en

s) de la caja de didlogo Sort reacomodard
ras. Use esta opcion cuando desee que las

ja Figura 25.3.

de trabajo por los nombres de la hilera 3,
lquier celda de la

one Columns en ia seccibn

Sort By (O}denar por).
) FIGURA 25.3:

- ]~ Hoi
1 MNgie] Bl € 3 E F G H ol
y

3 JCresin Walsh  Goldsmih Kautman

4
6 _|Jonuary G9000 874615 53120 187450
[ § |Fenmary 42500 541835 683845 735450

[ 7.-{march cia107 341876 987931 452570

9 |Apr w2000 J1eEse 142987 40Tt

B |May wiz20 512497 757000 376500

14 | June 1123500 672130 661258 761D

1|ty 2197245 942000 154091 890500

13| August 1276129 ESEY97  326B40 V76143

13 [September gEpalp 505010 1083450 398124

44 |October aobis2  276ia0 762190 81262

15 {November 64197 567620 49150 350500

18 |December grp111 872180 531000 BT2124

1

[-] ¥

e

Se pueden ordenar hileras o columnas jerdrq

Como Ordenar !
;. claves. Se usa una segunda clave cuando se repi
Jefaqulcameme celda, con la primera clave; esto €5 cuando se usa en

Utilice una terceraclave cuand

la segunda clave.
LaFigura25.4 muestrauna hojade trabajo orden

Laprimeraciave ordena Ja hoia de trabajo por los nom
A. En virtud de que cada nombre apareceenm

de la columna B fue designada como
ciudades dentro de cada grupo de nombres.

Mediante Claves
Mittiples

a de trabajo para

ordenacidn por
columnas

uicamente usando hastatres
te el valor o texto d

ela
mas de una celda.

o se repite el valorotextode lacelda,con

ada portres claves-

bresdela columnd

4sde una hilera,und celdd
segunda clave para 487 upsf
Una terceta clave s€ emple?

LECCION 25 195

A TTTRrpoRTxLs FIGURA 25.4:
: A — — - Hoja de trabaj
KN eal Estate Monthly Report | ordenad 230
m ada mediante
3 |Agem i
e oy Type orce tres llaves
3 {cnes: Margate  Condo $125.500
-2 Ches!n Maigate  Conda $1 10000
& Jcresi Margete  Condo  $150.250
=3 Ches!n Margate Single $215.500
e sif Margare Singte $325.600
e esin Ventnar Condo !152-000
10 Chesin Vemnor  Condo 398,000
'_fi-‘ ghesin Veninor Duplex SJIS'DUU
th:;sm Ventnor Singte %E?BiBDD
Hatw Ise Veninor Singie $146.900
"f?w;s: Maigae Condo QBH‘DUH
13 we]sh Margale Single $325.500
I wm:h Ventnat Condo $67.900
: JVeror  Duplex  $185500
*
Ll
para grdenar el tipo de venta dentro de cada ciudad
araorde ach :
o Cajasrger:ar E)orz m(;’x-;( deunaclave,tecleelascoordenadasdelacelda
exto 2nd Key (segunda cl
. ave) y 3rd Key (tercerac
! ‘ aclave
y seleccione ya sea Ascendente o Descendente para cada clave >
Como Evitar Si no se tiene cuidad
Pmbl l comcaciones ado, ordenar un rango de celdas podria resultar en
nes inesperadas. Por ¢ i ‘
8Mmas con & 8. jemplo al ordenar hil 5 i
compl . ileras, seleccione
O d ) e af; celdas en las hileras clave, no inicamente las de una colu
r enamlemo eamos lo gue sucederfa. e

1. Seleccione las celdas de la A7 ala All.

2. Seleccione Data » Sort, y luego OK.

Dado (ini
WICCCionague uémcamcnlc los rétulos de la columna A fueron
b 0s, €stos se ordenan i
. sin reacomodar s i
o e ‘ sus valores
o pf)ndlenlesenelresmdclas columnas, Los valores de lascolumnas
ya no representan las categorias de la columna A
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3 SClCCCIOIlC Ed“ ] ( )
.I
. pl , contiene dh Tra

ordenamiento. - .
‘ ESUM(BZ.Bé). Puesto que las celdas B2 a B6 no conticnen vallférmma
4 Seleccione las celdas de 1a A7 alaF18,y luego xcel pueda usar para hacer cdlculos, el resultado de la férmula Pr;?)quc
. . ulacs
Data » Sort. 8. Seleccione Edit » Undo Sort(Cirl+Z) 0.
5. Seleccione la celda F7 como la clave. . 9. Salga de Excel sin guardar Ja hoja de trabajo editad
' djo editada.

6. Seleccione Descending gue aparece bajo 12 caja de texto Ist
Key, y luego seleccione OK.

Com . .
0 Ofdenaf La barra de herramienta Utility de Excel, mostrada en ta Figura 25.6

I l [ I | y
| B onhiene IaS he amientas S()l[ Debce"dl“g (Odend] descclldle“d()

es e a a Ia 50[[ Abcend“'g (Ordendl dbccndlcndo). Se]et(,l(]nc Cl rango dc‘ Celd)d\

5 | v

7. Dé click con el mouse para deseleccionar las ceidas.

Estudiando la Figura 25.5, s¢ puede ver que la hilera que contiene

los valores para Total Income (Ingreso total) fue ordenada junto con las de Herramjema que se desea ordenar, luego dé click en 1a herrami
celdas paracl ingreso individual y los conceptos de gastos. Ahoraaparece " sccuendia de ordenami amienta que representa la
S . rdenamiento deseada. Si . 1
al principio de 12 lista y cada uno de sus valores es $0.00. UTF|IIy ‘ herramienta mientras se tiene oprim"'j SI' se d click con el motise en la
- . - 1aa ] - oo b .
Esto sucedid debido a que cuando se llevo acabo ¢l ordenamiento, de la herramienta a la que se estd d c(tj atecla Shift, seinvierte el orden
. . b o an 1y
el valor més grande de la seleccion estabaen lacelda F172 en lu hileradel La Tabla 25.1 enuncia los propd 0 click.
. . . . . ) M 5 - .
Ingreso Total. Sin embargo, después del ardenamiento la hoja de trabajo herramienta Utilify propdsitos de los botones de lu barra de
fue recatculada. Las férimulas pard Ingreso Total, hasadas en las referencias
relalwas. y uhora.localrfzadas en la pnlera 7, fu_cron ajustadas para hacer FIGURA 25/6:
referencia a 1as cinco hileras supernores a la hilera de Ingreso Total. Por : CEEE i La barra de
. Yy fﬂi g ; -
[I @@ herramienta Utility
FIGURA 25.5: R IEEEREE
- auaR R B . .
I y B o D 3 3 ol o 1.a hoja df: trabajo
4 ) QUARTERS
: f o ts nd (i 3rd 4th Average ordenada
7 [romintons W 500 1000 5000 00 incorrectamente BOTON - o
(8 [sees Tiel T FRAWTs  STEIMES TTeaul 4509 33 NOMERE DESCRIPCION TABLA 25.1:
_LSuluies 10,542 %0 $30,56473 $31, 70564 43217367 331,202 89 ' Boto
10 [Leaces fiemson SIS0 WM Az $12,32500 oL nes de la barra
11 |Rentals aom  pomel  Bgn 3360 138% 77 L de herramienta Unilit
12 {Gubuies Shnn W  waues  wapI e & Deshacer Ejecuta el ; d
13 [Rentals Vo000 $4%000  $asi0 25000 $4,500 0 el comando Edit » Undo
14 |Supples 3258530 P00 12,136 87 T 8233076 12,458 4
15 [Royalues $1,500 00 $1,500 00 3150000 11,200 00 41,500 00 @ R i
interes s $LKRTe a0z mvete W29 | Repelie Repi PR ,
Ve s: viadl 1782 5% 197635 30500 ! pite ta tltima accidn ejecutada i
|
w4l 52 0018 $3,736 94 3¢, 0407 $4,106 01 -
. '
—r * Copiar C(_ina los dutos seleccionados al
clipboard
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NOMBRE

Pegar valores

Pegar formatos

Amplificar

Reducir
Ordenar ascendente

Orcdenar descendente

Bloguear celda

Promover

Degradar

Mostrar simbolos
de perimetro

Iw ORDENAMIENTO DE HILERAS Y COLUMNAS

DESCRIPCION

Inserta valores de celdas copiadas o
cortadas al clipboard, sin pegar el
formato

Pegalés formatos que contengaelclip-
board a las celdas seleccionadas

Aumenta el tamafio de lo desplegado

Reduce el tamao de lo desplegado

Ordenahiteras de celdas seleccionadas
en secuencia ascendente

Ordenahileras de celdas seleccionadas
en secuencia descendenie

Evita que el contenido de una celda
pueda ser cambiado

Asigna las celdas seleccionadas al
siguiente nivel superior, cuando se
emplea la funcion de perimetro

Asigna las ceidas seleccionadas al
siguiente nivel inferior, cuando se
emplea la funcién de perimetro

Oculta o muestra simbolos de perime-
tro, o permite Crear un perimetro

~

TABLA 25.1;
Botones de la barra
de herramienta Ulility
{continua)

BOTON

* NOMBRE

LECCION 25

DESCRIPCION

El

E

i
Seleccionar celdas |
visibles

Botdn

Caja de texto

Ciémara

Verificar ortografia

Fijar drea de
impresioén

Calcular ahora

Selecciona dnicamente celdas visibles,
no hileras ni columnas ocultas

[nserta un botén paraejecutar unmacro

Agrega una caju de texto

Hace wna copia del 4rea seleccionada
de la hoja de trabajo

Inicia el proceso de verificacién
ortogrifica
Designa fas celdas seleccionadas como

drea para ser impresa

Recaicula la hoja de trabajo

19

TABLA 25.1:

Botanes de ka barra
de herramienta Unility
{continda)
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PEESENTACION D

Comeo abrir ventanas
muitiples

Como mover y copiar
texto entre hojas de
trabajo

Trabajo con
Muiltiples Hojas

de Trabajo en
Ventanas Respectivas

-on Excel, se puede abrir mds de una ventana de
hoja de trabajo o de gréficas alavez. El nimero
de ventanas queda limitado dnicamente por la

memoria de la computadora.

Imaginese que estd construyendo una hoja de trabajo y tiene que
hacer referencia a una hoja anterior creada la semana pasada. En vez de
buscarunaimpresi6n dela vieja, puedeabrir su propia ventana y referirse
a ella mientras trabaja. Incluso puede copiar 0 mover informacién desde
la hoja de trabajo vieja a la nueva tan ficilmente como trasladarse de un
lugar a otro dentro de una misma hoja de trabajo.

'

- Leccmulza @

En esta leccidn aprenderd cémo copiar informacién entre hojas de
trabajo y cémo desplegar varias ventanasen lapantallaala vez. Ta:mbién
aprenderd como desplegar ventanas de grificas y de hoja de trabajo al
mismo tiempo, para poder ver los efectos en la grafica del cambio de

datos en la hoja de trabajo.

Como tsar
Multiples Hojas
de Trabajo

Suponga que desea crear una hoja de trabajo que contenga a misma
informacién respecto de los rubros de ingresos que 1a hoja de llrubajo
QUARTERS. En vez de teclear las mismas lineas de nuevo, se les puede

copiar a otra hoja de trabajo. Siga es1os pasos:

1. Arranque Excel.
2. Sin cerrar Sheet, abra la hoja de trahajo QUARTERS.

3. Seleccione las celdas de 1a A7 a la Fi |, luego Edit » Copy
(Ctri+C) para insertar el contenido de las celdas al clipboard.

. . . . !
4. Seleccione Window para mostrar ¢l ment de persiana que
aparece en la Fipura 26.1.

Lalista numerada que estd en la parte inferior del memi mues Ira tos
nombres de las hojas de trabajo y grificas que estdn actualmente abiertas,
Para pasar a otra ventana abierta, seleccione su nombre en esta lista, La

FIGURA 26.1:

Window gALZJ El meni de ersliana
New Window o P

Arrange... Window

Hide

View...

. split
Freeze Panes
Zoom...

+1 QUARTERS.XLS
2 Sheeti




@ TRADAIO CON MU[,"I‘|Pl.I=.5: ul().luAs DE TRAUBAJO EN VENTANAS RESFECTIVAY * LECCION 26 ma
Tabla 26.1 hace un repaso de 1as opciones de menu. OPCION OESCRIPCION [T:Bo":::ﬂ .l ;
5. Seleccione Sheetl. La hoja de trabajo de este nombre aparece View ... . {Vista...)Permite almacenar parimetros especificos de pantalla r;éndein;z\:rL
en la pantalla. La hoja de trabajo QUARTERS no estd borrada ’ * eimpresion, attura de hileras y ancha de columnas, un rango de
_— su ventana simplemente pasé a plano posternor y se i celdas seleccionado, y tamaiio de ventana, en una vista con
encuentra inactiva. | S;T:rl:m:)nj;p::; ;;C]Pﬁl::de mostrar rdpidamente la vista
6. Asegirese de que la celda Al estd activa, y‘luego scl‘t:CCmnc Split ' (Seccionar) Divide una ventana en dos 0 cuatro paneles para
Edit Paste (Cirl+V) para insertar el contenido del clipboard a | mosirar simult:incamcnle. diferentes 4reas de una hoju de
i ‘4 de trabajo. | trabajo. (Fuando se seleccnf)na esla opeiom, cambia a Remove
la nueva hoja ) . | Split {Eliminar seccionamienta).
7. Dé click al mouse para deseleccionar las celdas. Freeze Pancs + (Congelar paneles) Evita que los paneles superior, izquierdo o
i ambos, tengan un recerrimiento, Cuando se selecciona esta
8. Oprima Cirl+F6 para cambiar de ventanas ().lra vez __ | opcidn, cambia a Unfreeze Panes (Descongelar paneles).
reaparece la hoja de trabujo QUARTERS, sin Can_]h“?b' Zoom | Cambia la amplificacién mostrada.
Oprimiende Ctrl+F6 se rota entre las ventanas ubiertas. 1,2,3....9 | Enumera los nombres de las ventanas abiertas, $i hay mds de
. . ¢ Mueve ventanas abiertas, el menu contendrd s opeién More
9. D¢ click con el mouse para dcselcc(:loni}l: lus celdas; luc{go 4 ' Windows {Mds ventanas). ‘Al seleccionarla se muestran los
oprima Esc para quitar ka caja de seleccion que parpadea de L I nombres de las demds ventanas,
rango de celdas.
También puede cambiarse de ventanas de fincumemo abricpdo cl
menit de control de la hoja de trabajo y seleccionando Next Wmdou:
(Siguiemte Ventuna). DE click en la caja de control u oprima A“t— (TB Coma Abrir Acaba de aprender algunas de las ventijas de tener maltiples hojas de
carfcter desubrayar) paramostrar las opciones paramover, redimensionar . trabujo abiertas 4 la vez. Siestd trabajando en varias hojas de trabajo
y cambiar de ventanas. MUlleleS complejas, mover y copiar texto entre ellas puede ser mds eficiente si no
) Vemanas s6lo cﬁtén abiertas sino también visibles sumull.z’lncznmcmc en la pantalla.
TABLA 26.1: Sigu estos pasos para hacer que las hojas de rabajo Sheet 1y
DESCRIPCION Las opciones del QUARTERS scan visibles al mismo tiempo:
New Window (Ventuna nueva) Abre olra VELna que contiene la hoja de | - mend Window 1. Seleccione Window » Arrange para desplegar lu caja de
. trabajo en la ventana activa. o o en I didlogo mestrada en la Figura 26.2.

Arrange ... (Acomodar _..) DC[L‘l’?T‘IiH‘d _la u.tncauén .dc lvemande.‘ en d e las onc) e L 1es o lar varias
pantalla y establece sincronizacién de recorrido de ventanas Use as opeiones de esl‘f caja de d!alogn para acomodar varias
que contiene la misma hoja de trabajo. ventanas ahicrtus en el espacio de trabajo. Las opeiones de Arvange

Hide (Ocultar) Retira una ventana de la visia sin cerrarta. {Acomodu) determinan la colocacion de las ventanas en la pantalla de

Unhide (Desocultar) Redespliega una ventana escondida. manera gue no se encimen: Tiled (En mosaico) huce atodas las ventanas

abiertas lo suficientemente pequeias para caber en la pantalla — ¢l
acomodo depende del ndimero de ventanas abiertas: Horizontal muestra

P S




TRABAJO CON MULTIPLES HolAS DETRABAJOEN VENTANAS RESPECTIVAS
. .
LECCION 26 ms '

FIGURA 26.2;
Arrange Windows La caja de didlogo g
Anange Arange Windows = 7T R - : S
Edit Formula  Fermat Data  Qptions Macro  Window Help = Ventanas acomodadas

@ fded i RO
Hoimat (=)=l <JAl .Imm@@@@ horiontalmente

 Hgrzontal |
Sales

¢ Vedtical |
€ None = e
A B [ e
- i OCLIROnL - 3
e s ak FR -
Yt Honruntat Sl > dsrge nd
I Sene Vel s Q — o -
. : le:s | s7363175  s7243676 3782045 $96M9T 8040
g anes L3300 142500 BI500 HI3S06 SN
Renul BE0M  $513867 855702 SiBedds  13aTT
!ny es $1,500 00 $1,500 00 $1,30000 5150000 1l>‘mm
£31 06 IO 421 a0, VTN LY 4l_l.' L II.'F\‘ s

las ventanas de ancho entero pere reconadas verticalmente para poderlas -
apilar en la pantalla: Vertical muestra 1as ventanas de altura completa '

0 lus reduce horizontalmente colocéindolas lado a lado; None permite Sheent ;
pero las reduce horizontalme . ; perm AT B s T 5 1" ¢ = < =
én para sincronizar manualmente el recorrido 5= 65175 37243076 §782540) 1976397 1RO 13 |

dejar las ventanas comoest :
Leases 1532500 11532500 §1532500 §1532500 31522500
Rentis | 4582090 273067 BIII615 4546376 458367

1
2]
de las ventanas mostradas. Aprenderd acerca de sincronizar ventanas y _:_
R <
}T oyalies | L0000 §150000 3150000 $L30000 41,0060
KR
17
8

acerca de lu opcidn Windows of Active Document (Ventanas del ltest ] W05 LTI MIDS 1L396T6 4
. . S alb 032 11,3976 41,3029
Documento Activo) mds delante €n esta leccion.

2. Seleccione Horizontal y luego OK. Las dos ventanas se
reacomodan para mostrarse al mismo tiempo (Figura 26.3). Ready I

Unicamente una de las ventanas desplegadas puede estar activa a la )
vez. Se puede identificar la que estd activa (seleccionada) porque 4. Cierre la vemana Sheet 1 dando doble click en T i
su caja de

contiene 1a barra de titulo en video inversoy tiene barras de recorrido. control, y lego seleccione No cuando Excel .
. + - Y M\ : .
Las acciones con botones de barra de herramienta y con el meni que se guardarla. La hoja de trabajo QUARTERS |:n.gume s1 desea

. . .. L. . ermanece en le
lieven a cabo, por gjemplo imprimir y guardar, afectardn unicamente a mitad del espacio de trabajo P hece en la

la ventana acliva. )
Para activar otra ventana, dé click en cualquier parte de elia, ¥ 3. Seleccione Window » Arrange, y cualquiera de las opciones
oprima Ctri+F6 para pasar de una a otra. Cuando se activa una ventana, de acomodo excepto None; luego seleccione OK. Se cxpa'nde
<u barra de titulo cambia a video inverso y sus barras de rvecorrido llenando toda la pantalla, o espacio de trabajo, la (nica
reaparecen. veniana de hoja de trabajo que queda.
Una vez que s¢ lienen desplegadas varias ventanas, se puede editir. Si se seleccionara None en la caja de didlogo Armmange, ¢}
copiar o mover texto entre cllas con facilidad. acomado de ventanas no cambiaria. ’
1 Seleccione la ventana Sheet 1 — dé click en cualquier parte d¢ . Se puede fﬁ’Pidﬂmcme agrandar la ventana de hoja de trabajo dando
ella u oprima Ctrl+F6. C|{Ck en su botén de maximizar, Esto amptifica la hoja de trahaJl'o de
Manera que yi no aparezea en una ventana individual sino contbinada

con la ventana de aplicacion de Excel.
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Ademis de abrir més de unahojade trabajoalavez, puede mustzarfsg
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simulténeamente en la pantalla una hoja de trabajo y una El,rl ica
;:omeniduen ella. De estamanera se puede vercomo los cambios alahoja

de trabajo afectan la grifica. Se hace como sigue:

1. Dé doble click en la grafica de la hoja de lrat')ajo QUARTERS.
. La grafica se abre en su propia ventana, subtitulada Chart .

7 Sejeccione Window » Arrange » Vertical para desplegarll
. tanto la hoja de trabajo como ia gréfica en ventanas lado a lado.

3. Seleccione la ventana QUARTERS que contiene 1a hoja de
_ trabajo y recorra hasta poder ver la celda B7.

4. Seleccione la celda B7 ¢ ingrese la cifra 10,000. La gréﬁ;::-a .
a cambia autométicamente de acuerdo con ¢l nuevo dato (Figura

26.4).

5. Salga de Excel sin guardar la hoja de trabajo editada.

a
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FIGURA 26.4:
Grifica ajustada
cuando cambian los
datos de la hoja de
trabajo se
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Maostrando la hoja de irabajo y 1a gréfica al mismo ticmpo, s¢ puede
obtener una imagen de ¢c6mo los cambios en la hoja de trabajo afectan
la relacién general de los datos.

Como DESPLEGAR MULTIPLES VISTAS DE UNA Hola DE
TraBajO

Editar hojas de trabujo que son demasiudo grandes para caber en la
pantalla puede ser laborioso. Quizd tenga que recorrer de extremo a
extremo la hoju de trabajo para mover o copiar celdas de un lugar a otro
osimplemente para referir celdas de una parte de la hoji de trabajo a otra.

Envezderecorrer, use la opcién New Window en el ment Window

para abrir una segunda ventana que contenga ka misma hioja de trabajo
que estd en fa ventana activa. Entonces podrd seleccionar y recorrer cada
ventana independientemente para mostrar diferentes vistas de la misma
haja de trabajo y cortar o copiar entre ventanas sin recorrer,

Sidesea desplegar la misma seccién de Ia hoja de trabajo en ambas
ventanas, seleccione Windows of Active Documenten lacajade didlogo
Amange. Luego seleccione una o ambas de Sync Horizontal o Sync
Vertical (Sincronizacién Horizontal o Sincronizacion Vertical) para
determinar ¢6mo desea que se cfectie el recorrido sincronizado. Si
setecciona Sync Vertical, par ejemplo, la ventana inactiva se recorrera
hacia arriba o hacia abajo al recorrer la ventana activa, pero no se
recorrerd horizontalmente.

Seleccionar Windows of Active Document autométicamente ocultard
cualquier ventana que no contengael documento activo. Para cambiarlas
opciones de sincronizacion sin ocultar otras ventanas, seleccione None
en la caja de didlogo Arrange. ’

Laopci6n Split (Seccionar) en el memii de persiana Window permite
mostrar miltiples vistas de la misma hoja de trabajo pero en una sola
ventana. Lo hace dividiendo la hoja de trabajo en dos o cuatro paneles
(secciones). Si selecciona una hilera o una columng y luego Window »
Split, la hoja de trabajo se divide en dos paneles a o largo de la hilera o
columna seleccionada. Si selecciona Window » Split cuando estd en
seleccién una celda, la hoja de trabajo se divide en coatro paneles.

A diferencia del uso de maltiples ventanas, los paneles siempre se
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recorren sincrénicamente en una direccion al menoes. Los paneles ladoa
ladoest4n sincronizados verticaimente, mientras que los paneles apilados
lo estdn horizontalmente.

Para eliminar el seccionamiento, seleccione Windows » Remove

Split (Eliminar Seccionamiento).

COMO SALIR DE VENTANAS MULTIPLES

Cuando se tienen dos o mas hojas de trabajo editadas abiertas, se les debe
guardar individualmente, Guardar la hoja de trabajoola graficaque estd
en la ventana activa no afectard unahojade trabajoeditadaen una ventana
inactiva. Sin embargo guardar una hoja de trabajo también guardar la
grifica incrustada, aun si ésta aparece desplegadua en ventana separada,

Si no ha cambiado ninguna de ias hojas de trabajo desplegadas,
puede cerrar cada unade las ventanas de documento por separado y luego
salir de Excel, o simplemente salir de Excel — ambas hojas de trabajo
sin cambios se cerrardn autométicamente.

Para informacién adicional acercadel trabajo con ventanas, refiérase
al Apendice B. Ahf aprendera c6mo maximizar, minimizar y cambiar el
tamano de las ventanas.

ComO ' adicionales para proteger su documento de miradas no autorizadas. Al
Salvaguardaf estar trabajando, seleccione [aherramientaNew (File » New}y abra una
sU Trabaio ventanaen blanco. Seleccione su ventanade lahojade trabajoy conllim'le

trabajando. Si alguien que no debe enterarse de su trabajo se aproxima.

Si estd trabajando con material confidencial, pucde usar ventanas

oprima Ctrl+F6 para desplegar 1a ventana en blanco. Luego cuando esd
persona se vaya, puede regresar rapidamente al documento oprimiendo
Cirl+F6 de nuevo,

4
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Verificacion
Ortografica

Un verificador ortogrifico, lo cual se ha vuelto

PRESENTACION DE
|

o
Como corregir errores

de ortografia

Como crear

- N L

diccionarios
especializadc'as

una funcién estindar en los programas de
procesamiento de palabras, puede parecer una
adicion frivola para un programa de hojas de

calculo que tiene que ver principalmente con

cifras. Pero debido a que la mayor parte de las
hojas de trabajo tienen titulos, encabezados
para las hileras y para las columnas de algin
tipo, un verificador ortogrifico es |una

herramienta valiosa.

' El verificador ortogréfico compara cada elemento del texto de una
hoja de trabajo o gréfica contra una lista de palabras de su dicciohario
Las paiabras que no puede encontrar en ¢l diccionario s0n rcpor‘ludas.
como posibles errores. Muchos nombres propios y palabrastécnicas, por
e;chmpIo, scrﬁn reportadas; sinembargo, estin deletreadas corrcclam‘e‘nle.
Si usa con frecuencia palabras que no estin en ¢l diccionario, las plucde
agregar aundiccionario suplementario para que yanosigar apareciendo
COMO eTrores.
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VERIFICACION ORTOGRAFICA

Debe verificar la ortografia de las hojas de trabajo y graficas antes
de imprimir y distribuir las copias finales.

Como Correr
el Verificador
Ortogréfico

Como ejemplo del use del verificador onpgrafico, credremos una
pequeda hoja de trabajo con algunos errores obvios. De esta manera,
podr4 ver coémo Excel maneja diferentes tipos de errores.

1. Arrangue Excel.

2. Teclee la hoja de célculo mostrada en la Figura 27.1,
incluyendo los errores de ortografia y otros que son obvios.

3. Seleccione la celda Al.

Puede dar inicio al proceso desde cualquicr celda de la hoja de
trabajo. Excel iniciard la verificacion en la celda activa y procederd de
ahi hasta el fin de 1a hoji de trabajo.

4. Seleccione Options » Spelling. También puede arrancar la
verificacién ortografica dando click en el boton de
respectivode la barra de herramienta Utility
— que es 1a tercera desde el final y muestra una marca de

FIGURA 27.1:
Shert) Haoja de trabajo con
¥ SRR R St I : | - . P
T ST ERTI | erfores ortograficos
|::T|pe QUanuty
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|8 |ABC's 10000
% |Mnstaring 15250
.7 _|Up Up and Running 24250
|8 [Encyciopedia 1500
"% Underslanding 5500
.40 | Tesch Yoursefl 12300
| 11_{Hendbook 6000
| #2 JAdvanced Techriques 11000
.93 instar Reterence 16000
iL]
18 1Contact Sybexior sddivonal informanan
18 |
n
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paloma bajo las letrus ABC,

Excel inicia 1a verificacién ortografica y se detiche en la palabra
Sybex, mostrando la caja de didlogo de 1a Figura 27.2, f nombre Sybex
no cs.l:i en el diccionario de Excel, asi que aparece en seguida del letrero
Not in F)ictionary (No estd en ¢l diccionario). En la caja de lista
Suggestions (Sugerencias) aparecen palabras correctus con deletreo
parecido, 1a primera de las cuales también se muestra dentro de la caja
de texto Change To (Cambiar A). Si lo que scfiala la caja de texto no es
la palabra correcta, seleccidnela de entre bas mostradas en la cija
Suggestions, -

3. Seleccione Ignore All (Tgnorar todas), puesto gue la palabra
estd deletreada correctamente y aparece de nuevo en lu Hoja de
trabajo. Excel no la reportard como error otra vez durante la
sesion de verificacion ortografica actual,

. Excel continda verificando el documente hasta que encuentra ka
siguiente palabra desconocida, Tipe. La ortografia correcta de la palabra

-— Type — aparcce mostrada en la caja de lista Suggestions.

6. Scleccione Type en la caja de lista, y lucgo Change (Cambiar)
para que yuede insertada la palabra correcta en la hoja de
trabajo.

- El siguiente error encontrado es QUantiry, debido a que ticne
ncarrectas las maytsculas. En vez del letrero Not in Dictionary aparece
otro que dice Capitalization (Mayisculus).

Mot in Dictionary: Sybex
Change 1o (TR | |

Sugguations:

Add Words To:  [CUSTOM.DIC  [2] T lonote Words in

Col Value: Sybwex Book List

FIGURA 27.2:

La caja de didlogo

Spelling muestra una

e ] [ 1omoe A palabri que nc estd
Lhange [ Change Al I en el diccionario de

[ Add _i r Cancel J Excel

e § [ pew |

§

UPPERCASE
B Always Suggest

]
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7. Seleccione Change para aceptar la sugerencia dc la palabra
Quantity mostrada en la caja de texto Change To. La siguiente
parada de Excel es en ABC's.

8. Seleccione Add (Agregar).

La palabra se insertard en el archivo CUSTOM.DIC. Este es un
archivo de un diccionario suptementario donde se pueden almacenar
palabras que se desea que Excel aceple como correcias.

Excel a continuacién detecta la repeticion de la palabra Up. El
leirero Repeated Word (Palabra Repetida) aparece en vez de Capitaliza-
tion, y el bot6én Delete (Borrar) aparece en lugar del botén Change.

9. Seteccione Delete,
Puesto que el documento entero ha sido verificade, aparecerd una
caja de didlogo con el siguiente mensaje

Finished spell checking entire sheel.
(Verlficacién ortografica terminada para la hoja entera).

10. Seleccione QK para terminar el proceso.

11. Cierre la hoja de trabajo sin guardarla.

Hay otras opciones en la caja de didlogo que no usamos en este
ejemplo. Se puede seleccionar Ignore para indicar que la palabra estd
deletreada como se desea en este dnico caso. El programa reportard la
palabra como mal deletreada la siguiente vez que aparezca en lahojade
trabajo. Change All cambia cada aparicién de la palabra en la hoja QC
trabajo a lo que dice la caja de texto Change To. Si se desea cerrar lacaja
de didlogo y detener la verificacién onogréfica, seleccione Cancel u
oprima Esc.

Algunas veces ninguna de las opciones que propone Excel son la
palabra correcta. Para hacer que Excel busque otras posibilidades.
seleccione Change To y luego teclee la palabra mal deletreada. A
continuacidn seleccione Suggest. ;

Seleccione Ignore Words in UPPERCASE (ignorar patabras en
maydscula) si se desea que Excel omita la verificacién de palabras
escritas con maytsculas. Use esta opeion si hay nombres inventados 0
érminos técnicos utilizados para titulos o encabezados con solo
maytisculas. )

pe—
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Laopcion Always Supgest (Sugerir siempre) estd preseleccionada
{por omisién — default). Buscar palabras sugeridas en ¢l diccilonario
toma tiempo y puede frenar a Excel. Si se sabe que hay muchas palabras
yue no aparecerdn en el diccionario, apague esta opeion, Cuando desee

encontrar una alternativa del deletreo, seleccione ¢l bolén Suggest.

Como Verificar
Porciones de
una Hoja de
Trabajo

Excel comienza el proceso ortografico en la celda activa. Situl celduno
es la A1 al momento de iniciar el proceso, cuando Excel llega al final de
la hoja de trabajo, verd una caja de didlogo con ¢l mensaje
Continue checking at beginning of sheet?
(¢ Continuar la verificacién al principio de la hoja?)

Scleccione Yes para regresar al principio del documento para con pletar
la verificacién ortogréfica, o seleccione No paru detenerla, |
Si selecciona celdas antes de iniciar la verificacidn ortogrifica,
Excel la llevard a cabo dnicamente sobre lus palabras de lo seleccionado.
Cuando la verificacidn ortogrifica de las celdas seleccionadas estd
terminada, aparece una caja de didlogo con el mensaje
Finished spell checking selected ceils.

(Verificacidn ontografica terminada para las celdas
seleccionadas).

Seleccione OK.

Para hacer verificacion ortograficade una sola palabra, seleccidnela
en la barra de férmula, y luego Options » Spelling.

Excel hard la verificacion de las palabras en ta hoja de trubajo yen
sus graficas incrustadas. Siestd activa una ventana de grificas, se bucdc
hacer verificacién ortogrifica solamente de la grifica, scleccionando
Chart » Spelling.

Como Crear
Diccionarios
Especiales

Cuando s¢ selecciona Add, ta palabra se incluye en el archivo
CUSTOM.DIC. También puede requerirse la creucién de dicctonarios
espectales o sobre temas especializados para almacenariérminos técnicos,
nombres o palabras de idiomas gue no sean el inglés y gue se|usan
frecuentemente.
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~

Para crear o usar otro diccionario, seleccione Add Word To
(Apregar Palabra A) y un nuevo nombre de diccionario de la lista de
persiana; o bien, teclee un nombre en la caja de texto. Si el diccionario
no existe aon, Excel preguntard si desea crearlo. Luego al salir del
programa preguntard sidesea guardar el nuevodiccionario. Siselecciona
Yes, la siguicnte vez que se desee agregrund palabra en €1, se le deberd

seleccionar en la caja de lista.

Como Vertficar la
Hoja de Trabajo
QUARTERS

alice la verificacién ortografica de la hoja de trabajo QUAR-

Ahorare
alaverificacion ortogrifica.

TERS. Abrilahoja y, porcuenta propia, corr
Las palabras Watson y Qtrse sefialardn como posibles errores. Seleccione

fgnore para omitirlos. Guarde la'hoja de trabajo si hubiera cambios.

L ECC

Configuracion
de la Pagina
Impresa

| 0 N

PRESENTACION DE

Cémo cambiar los
margenes de pagina

Coémo centrar hojas de
trabajo y gréficas

Cédmo estilizar los
encabezados y
notas de pie

Como escalizar la hoja
de trabajo impresa

Cémo insertar
cambios de pagina

justando la configuracién de pagina (Page
Setup), se puede convertir una hoja de trabajo
cuidadosamente diseiiada y formateada o una
grafica de imagen en la pantalla, una
presentacion de aspecto profesional. Después
de todo, ain en esta era del correo electronico,
lamayor parte de los negocios lodavia depende

de la pdgina impresa.

En esta leccidn, aprenderd como adecuar ladistribucién de la pdgina
y ¢l tamanio de la hoja de trabajo impresa o de una grifica. También
aprenderd cémo usar a Excel para que imprima rétulos decorativos y
bunderolas.
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Cémo Cambiar
la Configuracion
de Pagina

Imprimamos la hoja de trabajo QUARTERS —sin la grafica —centrada
en la pagina, 25% mads grande de lo que aparece en la pantafla, y en
orientacién horizontal. (Recuerde, la orientacién preseleccionada ey
vertical, Damada de retraro, imprimiéndose 1a hoja de trabajo alo ancho
de 1a pagina. A la pigina se le supone de mayor longitud que ancho. En
contraste, la orientacién horizontal, llamada de paisaje, supone que la
pégina es mis ancha que larga, La hoja de trabajo se gira para que se
imprima segan la direceién longitudinal de 1a pagina, haciendo en efecto
que el ancho de la hoja de trabajo sea mayor.)
Siga estos pasos:
i. Arrangue Excel y abra la hoja de trabajo QUARTERS.

[

Seleccione las celdas de la Al ala F23.

3. Seleccione Qptions » Set Print Area (Definir drea de
impresién} para imprimir solamenie ka hoja de trabajo sin la
gréfica ni la caja de texto.

4. Seleccione File » Page Setup para desplegar la caja de
didlogo que muestra la Figura 28.1.
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5. Seleccione Landscape (Paisaje) para que tal sea la nuwld
orientacién. El icono de la pdgina ¢n la seccidn Omnmnon se
transformard mostrando una pdgina que tiene mds ancho que
allura.

6. Scleccione Horizontally para centrar 1a hoja de trabajo entre
los extremos derecho e 1zquierdo de la pdgina.

7. Scleccione Vertically (Verticalmente) para centrar la hoja de
trabajo entre Jos extremos superior ¢ inferior de la pdagina.

8. Teclee 125 cn la caja de texto Reduce/Enlarge (Reducir/
amplificar) para imprimir la hoja de trabajo al 125% delsn
tamaio en la pantafla.

Se puede escalizarun ejemplarimpresodesde el 1% hasta ¢1400%.
Losnitmeros menores que 100 reducen laimagen, y los miyores yue 100,
la umplifican.

(omo Editar
Encabezados y
Notas de Pie

Los encabezados son renglones standard de texto que se imprimenen la
parte superior de cada pagina; los pies s¢ imprimen en la parte inferior.
El encabezado preseleccionado es el nombre del archivo, y|el pie
preseleccionado es ¢l ndmero de pagina.

Se pueden borrar los encabezados y pies, o editarlos para incluair
texto adicional, la fecha, 1a hora y el mimero total de pidginas. C(}mo un
ejemplo, borremos el nombre del archivo del encabezado y agreguemos
ta fecha y hora para referencia.

1. Seleccione Header de la caja de didlogo Page Setup para
desplegar la caja de didlogo mostradu en la Figura 28.2.

Los encabezados y los pies constan de tres secciones — 17qu1erda
central yderecha. Enlaseccidn central existe unelemento precxtahlec;do
que es una clave para mostrar ¢l nombre del archivo (&F). ‘

Se puede teclear texio en cualquiera de las secciones o seleccionar
de entre los botones de opciones de la caja de didlogo. Seleccionar el
primer botén, que es el que tiene una letra A, desplicga la cajadedidlogo
Font. Usclo para cambiar el tipo o lwmafio de los caraclercs del
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FIGURA 28.2:

}:—nm*lﬂ.m:ﬂl—_ position tha cursas in the edil bex.

mﬂ-oﬂ-“ poaition the cussor in the text box: then press AR+Enter.

(2l €6 @l @

ot Lester Saction: Fight Sectioe: *
t iF 2]

ileader

0K
Cancel
RN

encabezado o del pie. Los otros botones insertan c6digos que imprimen

informacion especifica. Ellos son:

PARA IMPRIMIR UTILICE
Page Number ~ Nimero de pigina &P
Total Pages Niamero de paginas &N
Date Fecha &D
Time : Hora ‘ &T
Filename Nombre de archivo &F

El punto de insercion ya estd dentro de la caja Left Section (Seccion

izquierda), por lo tanto tecleemos el texto para esa seccién.

2. Teclee Printed On, y luego oprima la barra espaciadora. -

3. Dé click en el botén de la fecha. El texto de la seccién se verd

L.a caja de didlogo

LECCICN 28 219

Time: &T
(Hora: &T)

6. Seleccione OK para aceptar et encabezado y regrese a la caja
de didlogo Puge Setup.

7. Seleccione Fooler. E pie preestablecido consiste en 1a palabra
Page sepuida por el c6digo del nimero de pigina.

8. Scleccione la caja Center Section (Seccién Central) y cologue
el punto de insercién después del 1exto.

9. Edite ¢l texto para que diga

Page &P of &N
(Pagina &P de &N)
El pie impreso aparecerd como
Page 1of 1
(Pagina 1 de 1)
10. Seleccione OK,

I'l. Seleccione Print para mostrar la caja de didlogo de ese
nombre.

12, Seieccione OK para imprimir la hoja de trabajo.
13. Salga de Excel sin guardar la hoja de trabajo.

Cuando se guarda una hoja de trabajo, ta configuracién de pigina
s¢ graba junto con ella. Si no se guarda la hoja de trabajo editada, se
aplicara la configuracion preestablecida la siguiente vez que se abra la
hoja de trabajo.

LaTabla28.1 describe las opciones de lacajade didlogo Page Setup,

comeo sigue:
Printed on &D
{impreso en &D} , .
4. Seleccione la caja Center Section (Seccién central) y borre ¢l Como |mpf|m|r
c6digo &F. | Hojas de Trabajo

5. Seleccione la caja Right Section (Secci6n derecha), teclee
Time:, oprima la barra espaciador, y luego dé click en el
botdn de la hora. El resultado aparecerd como

;;i

4

Grandes

Cuando se imprime una hoja de trabajo que tiene més de una pdgina de
ancho o de largo (o ue estd escalizada a un tamafio mayor gque el de la
pigina), Excel la imprime en secciones, como ilustra la Figura 28.3.
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QOPCION DESCRIFCION

Current Printer | (fmpresora actual) Indica la impresora actual de Windows.
Puri cambiar de impresora, seleccione el bot6a Printer Setup
aqui o ea cl mend File.

(Oriemtacién) Especifica las orientaciones Portrait {Vertical)o
Landscape (Horizontal). Portrait imprime lo horizonal a lo
I ancho de la hoja y lo vertical a lo farge de la hoja; l.andscape
, gira la impresién para quedar alineada horizontalmente en la
! direccignlongitudinal del papel y verticalmente en ladireccién
transversal del papel.

Paper {Papel) Indica el tamaiio del papel. Las opciones dependerdn

i de la impresora seleccionada.

Orientalion

Margins ; (Miirgenes) Permite indicar los mirgenes deseados entre lus
orillus del papel y la hoja o grafica impresa, e imprimir la haja

{ de trabajo o grifica centrada horizontal o verticalmente en la
! hoja. Algunas impresoras laser tienen requisitos para los
| mdrgenes minimos, '

Row & Column! (Encabezados de Filas y Columnas) Imprime las coordenadas

Headings i de celdas que comtienen notas, cuando se imprimen estas.

Cell Gridlines  (Reticulas de celdas) Apaga y enciende las reticulas paru el

. documento impreso.

! (Celdas negroy blanco) [mprime en negroy blanco el contenido

| de celdas y cajas de texto gue aparecen encolor en fa pantalla.

Black &
White Cells
Start Page
No.'s At
Page Order

" (Empezar a numerar paginas con) Indica ¢l mimero de pagina
_que se imprimird en la primera pigina.
! (Secuencia de las paginas) Cambia el orden de las pdginas.

Scaling } (Escalizacién) Reduce o aumenta el tamafio de la hoja o
X grifica.
FitTo . (Acomodar en) Escaliza una hoja de trabajo para que ocupe un

| ndmero especifico de pdginas.

Options ... ! {Opciones) Muestra una caja de didlogo con opciones
. adicionales. Las opciones dependen del tipo de impresora.
Header ... . (Encabezado) Muestra una caja de didloga en la que se puede
- indicar un encabezado que se imprimird en todas las piginas.
footer ... . {Pie de pdgina) Muestra una caja de didlogo en laque se puede
, indicar un pie de pagina que se imprimird en lodas las paginas.
Print ... - (Imprime} Mugstra la caja de didlogo Print.

(Configuracién de impresora) Muestra la caja de didlogo
Printer Setup para poder cambiar de impresera o de
configuracién. '

Printer Sctup ...

TABLA 28.1:

COpciones de la caja de

didlogo Page Setup

LECCION 28

FIGURA 28.3:
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Por opci6n preestablecida, Excel imprime cada pdginacnorientacion
vertical, imprimiendo tantas columnas como quepan en ¢l ancha de la
pdginay tantas hileras como quepan a lo largo de la pagina. Si hay h:ilcras
que nocaben en la pAgina, Excel imprime después otra pdgina adicional
de hileras para las mismas columnas, y 1antas pdginas como resulte
necesarias hasta que todas las hileras y todas las columnas hayarjl sido
nnpresas. Siquedaran columnas sin imprimir, Excel regresa u la primera
hilera e imprime otro juego de paginas hasta que todas las hileras qlljcdcn
impresas. Repite este patrén tantas veces como $ea Necesano| pard
imprimir la hoja de trabajo completa, Esto es lo que ordena la opeién
Down thenOver (Hacia abajo y luego pasar) que aparece bajo Page Order
{Orden de Piginas) en 1a caja de didlogo Page Sctup.

Si se selecciona Over then Down en la caja de didlogo Page Setwp,
Excel imprime en una segunda pdgina todas las columnas qufc no
cupicron en la primera pagina, Al final de la segunda, si hay hi;lcras
adicionales que no cupieron hacia abajo en el primer juego de péginas,
Excel regresa al extremo izquierdo para imprimir todas las hileras
adicionales ¢n otro juego de paginas siguiente.




CONFIGURACION DE LA PAGINAIMPRESA .

Seleccione el método que mejor convenga de acuerdo con el plan
que tenga para presentar la hojade trabajo o paraencarpetariaen un libro,

CamBIOS DE PAGINA

Excel inserta cambios de pagina para dividir una hoja de trabajo grande
en varias paginas. Si no le conviene donde Excel marca un fin de pagina
y principio de otra, se pueden agregar manualmente cambios de pdgina.

Para insertar un cambio de pigina, seleccione la celda donde desea
que empiece la nueva pagina, y luego seleccione Options » Set Page
Break (Fijar cambio de pdgina). No se puede incrementar la cantidad de
texto de una pagina insertando un cambio de pigina. Los cambios de
pagina manuales siempre se insertan paraobligar que una pdgina lermine
antes de gue Excel ki termine autométicamente.

Para borrar un cambio de pagina manual, seleccione la celda
siguiente hacia abajo o hacia la derecha de la linca de cambio de pagina;
luego seleccione Options » Remove Page Break (Eliminar cambio de
pégina).

Para verificar los cambios de pdgina antes de imprimir, use el
comando Print Preview (Vista Preliminar de Impresion), que se explica
en la Leccién 29.

Como Imprimir
Graficas

Para imprimir una gréfica incrustada sin imprimir la hoja de trabajo, dé
doble click sobre la gréfica para desplegarla en una ventana individual.

Si se selecciona Page Setup desde una ventana de prafica, muchas
de las opciones no estaran disponibles. Sin embargo, la caja de didlogo
contendr4 tres opciones adicionales que se refieren exclusivamente &
graficas, Size On Screen {Tamafio en Pantallay imprime la gréfica del
mismo tamafio que aparece en la pantalla. Scale Fit To Page (Escalizar
para gue quepa en la pgina) imprime la grafica tan prande como sea
posible pero en las mismas proporciones que tiene la pantalla. Full Page
{(Hoja Llena) escaliza la grdfica para llenar la pdgina, cambiando sus
proporciones si es necesario — pero posiblemente distorsionande 12
grafica.

g

LECCI] 0N

PRESENTACION Ds
Vista preliminar de
impresion

Coémo dar zoom hacla
dentro y hacia afuera

Coémo fijar opciones
de lo que se muestra

Cambio de Vista
de la Hoja de Trabajo

¢ puede cambiar la manera en que se muestra
la hoja de trubajo en la pantalla para hacerla
mas facil de leer o de editar. También puede
tenerse seguridad de que el documento impreso

S¢ vera exactamente de la manera planeada.

!En esta leccién, aparenderd ¢6mo reducir y amplificar la hoja de
trabajo mostradaen la pantalla, y ¢6mo cambiar el modo de que algunos
elementos especificos aparezcan en la pantalla y sean impresos
Empezaremos usando el comando Print Preview. '




CAMBIODE VISTADE LA HOJA DE TRABAIO

Vista Preliminar
de la Pagina
Impresa

Antes de imprimir la hoja de trabajo o grificas, se puede veren pantalla
un facsimil de 1a manera como se verdn impresos. Asi que se puede estar
seguro de que las paginas terminan en donde deben y se puede verificar
Ja distribucién general y aspectode la pagina. Esto es especialmente Gtil
con las hojas de trabajo grandes, o cuando se esté tratande de ajustar la
configuraci6n de pagina para oblener un méximo impacto o0 mayor
utilizacién del papel.

Usemos la hoja de trabajo QUARTERS para aprendercdmoobtener
una vista preliminar de las pdginas antes de imprimirlas.

1. Arranque Excel y abra la hoja de trabajo QUARTERS.

2 Seleccione File » Print Preview (Vista Preliminar de
Impresién) (u oprima la tecla Shift manteniéndola oprimida y
dé click en la herramienta de Impresi6n de la barra de
Herramienta).

Excel abre la pantalla de Vista Preliminar, la cual muestra un
facsimil de la pAgina entera impresa (Figura 29.1 }. La barra de menus de
Ja pantalla Preview contiene las siguientes opciones:

OPCION  PROPOSITO
Next (Siguicnte) Despliega la siguiente pgina, si existe

Previous  (Previa) Despliega la pagina anterior, si cxiste

Zoom Cambia de pantalla estdndar a pantalla amplificada,
y viceversa

Print (Imprimir) Despliega la caja de didlogo Imprimir

Setp  (Confirguracion) Despliega la caja de didlogo Page
Setup

Margins  (Mdrgenes) Permitc usar el mouse para cambiar

margenes y ancho de columna

Close (Cerrar) Sale de Print Preview

__ A

R
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Pruview. Paga 1 of 1

FIGURA 29.1:
La hoja de lr!abujo
g QUARTERS en vista

Lo |
prcllmmur para

impresion

Cuando el sefialador del mouse estd en la pagina, tendrd la forma de
una lente de aumento. Para dar zoom hacia adentro (ampli[‘icah a4 uni
seccitn de la pdgina, coloque ¢l sefiulador en ta parte que se desea
amplificar y dé-click al botén izquicrdo del mouse. También se puede
seleccionar Zoom de la barra de Mend u oprimir .J. Cada uno de estos
métados actila como vaivén, cambiando entre la vista prccsluhllecida y
la vista amplificada cada vez que se le usa. Veamos cémo funciona.

3. Cologue el senalador del mouse sobre 1a caja de texto en la
hoja de trabajo y dé click al botén izquierdo. El drea de la
pégina bajo el sefiakador se amplia (Figura 29.2).

Cuando la imagen est amplificada, use las barras de recorrido o las
teclus de flecha para pasar a diferentes porciones de la hoja de lr;‘xb:lju a




FIGURA 29.2:
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de 1a grafica poniéndolas a la vista. En la modalidad preestablecida, use
las barras de recorrido para pasar de una pigina a otra dentro de una hoja
de trabajo grande.
4. DE click en el boton izquierdo del mouse otra vez, U oprima !
para regresar la pantalla 4 la amplificacion preseleccionada.

5. Seleccione Close para regresar a la ventana de hoja de trabajo-

Viendo la pantalla de la vista Preliminar puede saberse qué tanto de
la hoja de trabajo se imprimirden cada pagina. Ademds se pulcden verllc_is
lineas de cambio de pagina insertadas en la ventana delahojade trzlibdjo
tal como si 6sta estuviera impresa. Use la vista Preliminar para \fenﬁci"
el tamafio y distribucion de la hoja de trabajo antes de imprimirla.

LEGCION 29 Q?

Cémo Cambiar
- la Amplificacién
de Pantalla

La vista Preliminar, en su condicién prescleccionada, muestra la pagina
entera, yencllalaimagen puede no verse con suficiente claridad para leer
el contenido de las celdas. Y aun cuando la opcidn Zoom en vista
Preliminar muestra una vista amplificada de la hoja de trabajo, no se
puede editar en la modalidad de Vista Preliminar.

Si se desea trabajar con las celdas o con la grifica en vista reducida
o ampliada, use el comando Zoom del menid Window. Por ejemplo,
suponga que desea ver la hoja de rabajo QUARTERS enlera en la
pantalla, mientras cambia ef contenido de varias celdas. O quizd necesite
amplificar la imagen para hacer m4s ticil la lectura con ejos cansados.

Pruebe el comando Zoom ahora.

1. Seleccione Window » Zoom para mostrar [a caja de didlogo
de la Figura 29.3.

Enestacajade didlogo, seleccione laamplificacidn descada o teclee
una amplificacion especial entre 10% y 400%. La opcidn Fit Selection
(Alojar lo Seleccionado) escaliza las celdas seleccionadas para que
guepan en la pantalla completa — aparecerd un mensaje de alerta si la
seleccion entera no cabe para ser desplegada.

Las amplificaciones menores que 100% reducen el tamaiio de la |

imagen para poder mostrar mds celdas en la pantalia que lo normal. Por
ejemplo, cambiemos la amplificacién para poder ver todas las hileras y
columnas numéricas de la hoja de trabajo QUARTERS.

FIGURA 29.3:
L] - o de didlogo
-
C 5% .
€ sox
C 8%
C [# Selection |
O Qustom: {100 x




28 CAMBIODE VISTA DE LAI;OIADETRABAJO . LECCION 28 %

2. Seleccione 75%. y luego OK. Excel escaliza la imagen Tanto en la vista reducida como amplificada se puede editarceldas, :

desplegada reduciéndola a 75% de su tamano normal en ingresar datos y ejecutar cualquier otra operacién de Excel. La ;
. . F e + . - . ! . ’
pantalla (Figura 29.4). Use las barras de recorrido, si es amplificacion vigente no afecta el tamanio de la hoja de 1r:1|hajo al
necesario, para recorrer lu imagen a fin de que el drea imprimirse. Para ajustar el tamaiio de impresién, fije lescala en lacaja
completa, desde Al hasta F23, se muestre en la ventanu de la de didlogo Puge Setup.
hoja de trabajo. 5. Seleccione Window » Zoom.
Use una amplificacién mayor que 100% para incrementar el tamario ) _

eu p yord P 6. Scleccione 100% y fuego OK para regresar a la vista

dc Ia imagen en pantalla. Por ejemplo, podria tener problemas para leer

— . reseleccionada.
un tipo de letra muy pequefio 0 para trazar und linea u otra cosa en una P C

posicion exacta. Amplifiguemos la imagen a tres veces su tamafio 7. Salga de Excel.
normal. La barra de herramienta Utility contiene las herramientas Zoom In
3. Seleccione Window » Zoom. y Zoom Qut para cambiar la amplificacion de la pantatha sin usar la caju

» 14 L
4. Seleccione Custom, teclee 300 y luego OK. La imagen de didlogo Zoom.

aumenta haciendo que la hoja de trabajo sea fécil de leer, aun
desde lejos.

Cémﬂ Fijar En la Leccién 19, aprendid como eliminar las cuadriculas de referencia
.. . “ . [
FIGURA 29.4: . de la pantalla usando ta caja de didlogo Display. Relicrase a la Figura
L4 . - .. . L E
L hota de traba OpCIoneS de 19.2). Las otras opciones de esta caja de didlogo tumbién afectan g
“ - . B .4 hoja de trabyjo a . . . |
File Edit Formula Forma) [lata  Options Macre Window Help e |.1J e 75(; J Pama“a manera en gue la hoja de trabajo se muestre en pantalla y se imprima. Las
g scals o : . . \
(8 (=) (=2 1AT~] GO E]]EE opeiones de Display aparecen en la Tabla 29.1. |
AZ5 |
- . i LUARTER O hd b
1= n . o - 3 r a H \ P 0°PC|ON DESCHIPCION : TABLA 29.1; %
1 Watsan and Sons, Inr. ! LY. - . Opeiones de li'cuja de '
2] Fireat 1997 Formulas Alterna entre desplegar formulas y los valores caleulados por didlogo Display
+g path-2d CT R P 1 o) Airrag I ellas.
+sa—; S7766175 37243676 $TEZSAET  $UETIT  4004IIDI Gridlines i (Cuadricuta) Muestra o elimina la cuadricula de celdas,
[0 Jueases (EI500 $WAZS00  $EIIS00  RNSM  $ENAX . e - :
2 {Fientas 1590 870667 ISINX 1SEAZE  158M W Row & Column ¢ (Hileray columna) Muesiraoelimina encabezados de hileras
| |Aoydies 150000  PAB00 3150009 3150000 llﬂ;:;: y columnas N
N _lwrnest 4120550 3129776 $LI0 52 11.0% 7€ 1. 5.
] TR TH 214055 SN ASI6S Ton ; X ) L
%lﬂ_‘m_M—!——-—i——;—-— Zero Values (Ceros) Muestra ceros enceldas cuyo valorcaleuladoes cero.
"% | Salane X Hh $321T867 A N262EY . . - AR e " . A
Ca. Mo Twmer oo s s -  Apagando esta apci6n tales celdas aparecen en blanco.
500 a0 4 * 2 N . .
8 s cpiborotelibatcepe Rl o Cuttine Symbols! (Simbolos de contorno) Muestra o elimina fos simbolos
T P T YA WL XAAT TR T ' usados para creur contomos.
—-1 . t 23 . .. P ' +
] Automatic Page | (Cambio sutomiticode pigina) Muestraocliminalos cambios
22 | Fercama Change s =0 o y Breuks I autonuiticos de pdgina insertados al imprimir o al presentar
s : ' vista preliminar de la hoja de trabajo.
Roady i ! ' i
;




m‘ CAMBIO DE VISTADE LA HOJA DETRAEAIO

OPCION

Show Al

Show
Placeholders

Hide Al

Giridling &
Heading Color

(Mostrar 1odo) Muestra todas las graficas, objelos dibujados,
cajas de texto y otros elementos grificos.

TABLA 29.1:
Opciones de la caja de
didlogo Display
{continuacidny

DESCRIPCION 0

(Mostrar temporales) Muesira rectdngulos grises en vez de
tas gréficas y los recuadros de texto seleccionados.
(Esconder todos) Elimina de la panialla todas las grificas,
objetos dibujados y cajas de testo.

(Color de cuadricula y encabezados) Especifica el color de
1a cuadricula de los encabezados de hileras y columnas.

Use 14 opcion Formulas para crear una copia dura de respaldo. Por
ejemplo, si accidentalmente borra la hoja de trabajo del disco, una copia
impresa de 1a hoja puede no ser suficiente ayuda para reconstruirla, A
pesar de que la hojaimpresa si muestre los titulos, encabezados y valores
numéricos de las celdas, no mostrara las férmulas utilizadas para Hegar
a los resultados.

Sin embargo, si selecciona Formulas de 1a caja de didlogo, Excel
desplegard las férmulas que hay en las celdas en vez de los resultados
calculados porlas férmulas. (También duplicael anchode las columnas.)
Asi €8s que para tener un resplado, despliegue las férmulas y luego
imprima una copia adicional de la hoja de trabajo. (La Figura29.5 sefiala
como aparecen las férmulas en la hoja de trabajo QUARTERS con un
50% de amplificacion.) Si accidentalmente se borra el archivo del disco,
puede usir el respaldo impreso para obiener las férmulas de nuevo.

Como atajo, puede pasarse de férmulas a resultados oprimiendo
Cirl+™ {acento grave), que es la misma tecla que de en la mayor parte de
los teclados estdndar).

Onciones Acerca
de! Espacio de
Trabajo

Igual que la caja de didlogo Display, la caja de dislogo Workspace
Options (Opciones del espacio de trabajo) incluye aliernativas que
afectan a la hoja de trabajo desplegada (Figura 29.6). Pero ademds,
permite alterar algunas de las maneras fundamentales en que opera
Excel.

LECCION 29' @
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FIGURA 29.5:
Hoja de trabajo
QUARTERS que
muestra las férmulas

=, Workspace Options
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FIGURA 29.6:
La caja de didlogo
Workspace Options




CAMBIDDE VISTA DE LA HOIA DETRABAIO

Por ejemplo, seleccione Fixed Decimal (Decimal fijo) y teclee un
nimero para hacer que Excel automdticamente inserte un punto decimal.
Si se teclea el ndmero 2, por ejemplo, Excel desplegurd 1.23 al weclear
123 en una celda. Si se teclea un ndmero negativo, Excel agregard ceros
al final de los ndmeros. Teniendo —3 en la caja de 1exto Places, Excel
desplegard 123000 al haber tecleado 123. Use estas opciones si se desea
teclear nimeros decimales sin tener que oprimir ef punto decimal, o para
mostrar todos los valores en miles sin teclear los ceros finales.

LuTabla29.2 describe lasopciones de la cajudedidlogo Workspace

GRCION
Fixed Decimal
Places
RICI

Stawus Bar
Info Window

Scroll Bars

Formula Bar

Note Indicator

Alternale Menu
or Help Key

L

Options,

DESCRIRCION

{Necimal fijo) Inserta un punto decimal automiticamente.
(Cifras decimales) Determina 13 posicién del punto decimal.

© Muestra Jos encabezados de columna numiéricamente en vez

de con letras para poder referirse a celdas por nimero de
hilera y columna. La celda Al, por ejemplo, seria referida

- como RIC), Las referencias existentes en térmulas se

converlirin.

{Barra de estado) Apaga y prende la harra de estado.
(Ventana de informacitn} Abre una veniana gue Mmuestra
informacién acerca de la celda activa. Use Window »
Arrange para mostrartantola hoja de trabajo coma a ventana
de informacién.

(Buarras de recorrido) Apaga y prende tas barras de recorrido,
(Barra de férmula) Apaga y prende la barra de férmula. Para
edinar una Tormula cuando la barra estd apagada, active la
celda, oprima F2 y luego cualquier tecla de flecha para
mostrar la férmula en vez del resultado.

" (Indicador de nota) Muestra un punio pequeno en la esquina

superior derecha de las celdas que contienen anotaciones en
texto. .

{Menii altemo o tecla de ayuda) Designa una tecla allerna
para activar Jabarra de mend o para mostrar tacajudedidlogo
ielp de Lots 1-2-3. Seleccione los mends de Microseft
Excel o el boton Help de Lotus 1-2-3.

TABLA 29.2:
Opciones de la caja de
didlogo Options

LECCION 29 m

OPCION DESCRIPCION

Alternulle (Aliernos) Activiun juegode tecleos altemos para operaciones
Navigation Keys| frecuentes de Excel.
Ignore Remote

(Ignorar solicitudes remotas) Ignora solicitudes gue hagan
Requests

otras aplicaciones de Windows a Microsoft Excel.
(Mover seleccién al oprimir Enter) Automédticamente
selecciona la celda en la nueva hilera cuando se oprime -J.

Maove Selection
after Enter

Cell Drag and (Arrastrar y seltar cetda) Enciende y apaga la funcién de

Drop arrastrar y soltar para movimiento y copiado de celdas.

TABLA 29.2:
Opciones de la ¢
didilogo Options
(continuacion}
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LECC 1 ON

Cémo |nsenar Se anexa una nota de texto a una celda individual, aungue la nota puede
referirse a la hoju de trabajo entera o incluse a un tema no relacionado

NOIHS de Texto con la hoja de trabajo en si. La celda es simplemente la estructura
utilizada para almacenar el contenido de la nota.

A diferencia de una caja de texio, una nota de tex16 no aparece en
la pantalla ni se imprime automdticamente con la hoja de trabajo. Sin
embargo se le puede desplegar y pueden imprimirse notas, como
aprenderd en esta leccién.

Veamos como trabajan 1as notas de texto apgregando varias a la hoja
de trabajo QUARTERS.

1. Arrangue Excel y abra la hoja de trabajo QUARTERS.

PRESENTACION DE !

Texto y notas de
sonido

2. Seleccione la celda A1, que es ba que se desea marcar con una

Insercion de
NOtaS a 1as Celdas 3. L:Z::;:cionc Formula » Note (Shift+F2) para desplegar la c.uja

' ., ) de didlogo Cell Note (Nota de celda) que muestra la Figura
omo aprendlo en la Leccion 23, se pUCdcn usar : 300 1. Las coordenadas de la celda seleccionada aparecen en la
caja de texto Cell.

cajas de texlo para agregar comentarios a la
4. El punto de insercion ya estd dentro de la caja de texio Text

:, T . ar Ty nen
h()jd de [l‘db;lj(). Los comentarios aparece Note (Nota de texto), asi es que teclee el texto de la nota:

pantalla y se imprimen junio con la hoja Check these figures with the accounting department,
ionada (Confirme estascifras con el departamento de contabilidad).
- FIGURA 30.1:
L caa e didlogo
Lett jar Lot ot < Cell Note
Pero podria necesitar tambicn insertar unanota o recordatorio paru Hates in Shoot:
usted mismo que no conviene que nadie mds lea. Lanota podriaexplicar
cémo llegd a una férmula compleja, o podria ser un mensaje per:-;(mal a =
otra persony gue le estd ayudando a desarrollar la hoja de trabajo.
En esta leccion, aprenderd como agregar nolas de texio y notas QC -m
sonido a las celdas. Una nota de sonidoes un efecio sonoro o un mensaje Sound Nota
grabado guc puecde ser reproducido en la bocina o altavor de su (s 3 [ ] [tmeeris]
computadora.
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El texto autométicamente hace cambio de renglon en el exiremo
derecho. Oprima Ctri+J si desea insertar un punto y apane.

Para insertar una nota en otra celda sin cerrar la caja de didlogo,
seleccione Add (Agregar), y luego seleccione la celda o teclee sus
coordenadas en la caja de texto Cell. Teclee el texio de la nueva nola en
la caja Text Note.

5. Seleccione OK,

Aparece un peguefio cuadro en Ja esquina superior derecha de la
celda, indicando que hay una nota anexa. Para ocultar o mostrar los
indicadores de notas, seleccione Options » Workspace » NoteIndicator.

6. Seleccione la celda B22, y luego seleccione Formula » Note
(Shifi+F2) para mostrar la caja de didlogo Cell Note.

Las coordenadas de las celdas que contienen notas, y varios de los
primeros caracteres de cada nola, se enumeran en la caja Notes in Sheet
{Notas en !a Hoja).

7. Teclee el texto de la nota para la celda B22:
This cell is intentionally blank because the worksheet

covers only Fiscat 1993,
(Esta celda esta intencionalmente en blance porque la
hoja de trabajo cubre solamente el ano fiscal 1993).

8. Seleccione OK,

9. Dé click en el botén de salvar (Shift+F12) para guardar Ja hoja
de trabajo junto con sus notas. '

Como DQSp‘Egar Para leer el contenido de una nota, dé doble click en la celda que la
l N : contiene, o seleccione Formula » Note(Shift+F2) para desplegar lacajd
ds Otas de didlogo Cell Note. Pruebe esto ahora.

LECCICON 30 %7

l Dé doble click en la cetda B22 pura desplegar la caja de
didlogo Cell Note. La nota en la celda activa aparece en la caja
Text Note (Figura 30.2).

Dar doble click en una celda que no contiene nota no tendra ningdn
efecto.

2. Seleccione la celda Al en la caja de lista Notes in Sheet.
Aparece la nota que hay en esa celda en la caja Text Note.
3. Seleccione Close para cerrar la cuja de didlogo.

La nota de la celda también aparecerd en la ventana Info Window,
que se despliega seleccionando Opiions ™ Workspace » Info Window.

Como Editar
las Notas

. ‘ . i
Para cditar unanota, dé doble click en la celda que contiene una nota para

desplegar la caja de dislogo Cell Note. Seleccione la celda que!desea
editar en la caja de lista Notes in Sheet, y luego edite la nota dentro de

la caju Text Note. Seleccione OK para regresar a la hoja de lrabaj(l).

o FIGURA 30.2:
-— & ote
Cuja de didlogo Cell
Lat- oxl Note: :
r——— 1 Nole gue muestra

This cell is intentionally
blank becauie the
worksheet covers only
Fiscal 1993

todas las notas de la
hoja de trabajo

Notes n §heot:

Al Check thexe ligl +
B22: Thiz cellis inl¢
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Para borrar una nota, seleccione laceldaen lacajade lisla. N()lcs in
Sheet, y luego Delete. Excel desplegard una cuja de didlogo pidiéndole
que confirme el borrado — seleccione OK.

Gomo Imprimir
las Notas

Para imprimir las notas de una hoja de trabajo, sclec;ionc‘Nf)les 0 Bolh
de 1a caja de didlogo Print. Imprimamos las notas ahora sin imprimir la
hoja. _

1. Seleccione File » Page Setup.

9 Seleccione Row & Column Headings (Encabezados de Hileras
y Columnas) para encender esta opcion, y luego OK.

Esta opcion debe estar seleccionada si se desea que la impresion
identifigue las coordenadas de las celdas de cada nota.

1. Seleccione File » Print » Notes, luego seleccione OK.

Las notas se imprimirdn, precedidas por las coordenadas de sus
celdas, usando el encabezado y pie agregados a la hoja de trabajo. Si
seleccione Both de la caja de didlogo Print, l1a hoja de trabajo se
imprimir, seguida por las notas en una hoja de papel scparada.

4. Salga de Excel sin guardar la hoja de trabajo. Su seleccién de
Row & Column Headings en la caja de didlogo Paste Setup 00
queda guardada. ‘

Como Usar
las Notas de
Sonido

Se puede agregar sonide auna celda y reproducir el sonido dzfndo doblcl
click en 1a celda. El sonido puede ser uno pregrabado, por ejemplo de
archivo Wave suministrado con Windows 3.1, 0un sonido.que haya
grabado usted mismo si tiene el equipo y programas necesarios. y
Para agregar y reproducir notas de sonido, debe tener Windows J-
o las extensiones Multimedia con Windows 3.0. También debe tenef
equipo especial de audio o una rutina controladora de Windows Cl“:
produce sonido através de la bocina interconstruida de la compuladﬂfde-
Consulte su manual de Windows para informacién adicional acerca
c6mo producir sonido, en multimedia, y que rutinacontroladora (driver)

de sonido utilizar.

——
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Para agregar un sonido pregrabado, seleccione Import... de'la caja
de didlogo Cell Note. Aparecerd otra caja de didlogo de la cual se
scleccionuel archivode sonido. Poropei6n preseleccionada, tosarchivos
enumerados son archivos Wave con la extension WAV. Son archivos
especialmente formateados que contienen informacidn Je sonido com-
patible con los comandos multimedia de Windows. Scleccione el
archivo, y luego OK, para regresar u la caja de didloge Cell Note.
Seleccione lacelda donde desea agregar lanota, y luego seleccione Add.
Una vez gue la celda conticne una nota de sonido, ¢} botén Record
(Grabar) cambia a Erase (Borrar).

Si tiene equipo para grabacidn de sonido y la programacion
respectiva, puede grabar sonidos; por ¢jemplo, un mensaje personal en
calidad de nota senora. Seleccione Record de la caja de didlogo Cell Note
para desplegar una caja de didlogo con los hotones Record (Grabar),
Pause (Pausa), Stop (Parar) y OK junto a una escala que representa la
longitud de la grabacidn, Seleccione Record y luepo grube el sonido; a
continuacion seleccione Stop. Marque OK para regresar a la caja de
didlogo Cell Note y luego seleccione Add para insertar ¢l sonido.

Para reproducir un somido, dé doble click en la ceida que contiene
la nota sonora. Si la celda contiene tanto una nota de sonido come una
de texto, la caja de didlogo Cell Note uparecerd al mismo tiempo que el
sonido que reproduce. También puede seleccionarse la celda en la caja

de lista Notes in Sheet, y luego Play. Las celdas que contienen una nota
de sonido se identificardn con un asterisco en la caja de lista.

Para borrar una nota sonora, seleccione la celda en la caja de lista
Notes in Sheet y luego Erase.
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PRESENTACION DE

Cémo automatizar
operaciones

Cémo grabar tecleos

Como Generar
y Correr Macros

abiendo cientos de diferentes operaciones que
se pueden ejecutar con Excel, puede suceder
que requiera usar de las mismas una y otra vez.
También puede requerir utilizar un mismo
juegode encabezados de hileras y columnasen
muchas hojas de trabajo. En vez de repetir las
acciones de mouse o tecleos cada vez, puede

grabarlas en macros.

Un macroes un comando especial que se crea para ejecutar unasenc
de tecleos u operaciones de mouse. Luego cuando se desec repelir esas
acciones, simplemente se reproduce o se corre el macro.

(4l

teccion |24

Los macros ofrecen un poderos medio de automatizar operaciones
de Excel, disenar aplicaciones especificas y adn cambiar la interfaz de
Excel agregando botones y cajas de didlogo personales. A pesar de que
es10s temas escapan al enfoque de un libro de tipo ABC, aprenderi cémo
grabar y correr algunos macros bdsicos en esta leccidn. ‘

Como Grabar
Macros Globales

A pesar de que todos los macros estdn creados y operan esencialmente
de la misma manera, hay algunas diferencias basadas en Limanera tomo
se les almacena. Los macros se almacenan en uno odos tipos de archivos,
Si se almacena un macro en un archivo llamado macro-sheet (hoja‘ para
macro}, se debe abrir la hoja de macro al arrancar Excel antes de que se
puedan correr. Como alternativa se pueden guardar los macros en 12 hoja
Global de Macros, que es GLOBAL . X1.M — que es un urchive uplcciul
que automdticamente se abre al arrancar Excel. Primero, dpr(,ndui,mos
¢Oomo crear y almacenar macros en la hoja Global de Mdch Luego
procederemos, més ilelante en esta leccion, u crear y almacenar macros
especiales.

A diferencia de ta mayor parte de las ventanas, ti de la hoja de
Macros Globales es oculta; no aparece automdticamente cn puma]la: y no
estd enumerada en el mend de persiana de Windows. Mds adelanie
aprenderd cémo "desocultarla™;

Excel graba macros "vivos" — que son tecleos u operaciones que
se ejecutan y que serdn realmente agregadas o afectardn lza hoja de trabajo
en la pantalla, al misme tiempo que sus instrucciones estdn siendo
almacenadas en la hoja de macro. Por ejemplo, si graba un macm‘puru
desplegar un membrete de carta teniendo luhoja de trabajo QUARTERS
activa, el papel membretado en s quedard insertado en la hoja de trabajo.
Si no desea que la hoja de trabajo en pantalla se afecte, regisire el macro
cuando lenga activa en pantalla una hoja de trabajo en blanco. Luego,
mientras termina de grabar el macro, puede cerrar la hoja de trabajo en
blanco sin guardarla. El macro quedard almacenado en la hoja de macro
apropiada.

Puede dar nombre a sus macros asi como asignarles tecleos de atajo.
Los nembres de macro deben ser de una sola palabra y empezar con una
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letra. Por opcién preseleccionada, Excel da a su primer macro el nombre
de Record] ¢ incrementa el niimero conforme se graban nuevos macros,
Sin embargo, debe dar a sus macros nombres més descriptivos como
ayuda para identificarlos posteriormente.

Los tecleos de atajo incluyen latecla Cirl més una letra que se puede
oprimir para correr un macro después de haberlo grabado, La letry es
sensible a maytisculas y miniisculas, o sea gue oprimir Ctrl+a corre un
marco diferente, que oprimir Cirl+A, ]

Excel ofrece una letra por preseleccion, empezando con la letra
minisculaa. Luegoincrementa la letraconcada macro que se grabe, pero
excluye las combinaciones interconstruidas de Excel, tales como Ctrl+h
(negritas) y Ctrol+i (it4licas). El orden s

geghjklmnogtwy

seguidas por las letras maydsculasde la A ala Z.

Se puede tener més de un macro asignado a la misma combinacion
de teclas. Sin embargo, ¢l que se haya definido primero se corrers en
primer lugar al oprimir esas teclas. Aun cuando sicmpre podrd correr ¢l
segundo macro usando cajas de didlogo, es mejor evitar laasignacién del
mismo tecleo a mas de un macro.

Se pueden crear macros usando el mend Macro. Las opciones de este
menid se enumeran en la Tabla 31.1, aunque no todas las opciones estdn
disponibles en todo momento. '

Grabemos varios macros ahora.

1. Arranque Excel. La hoja de trabajo Sheet | aparece en pantall.

2. Scleccione Macro » Record para desplegar la caja de dislogo
Record Macro (Grabar Macro) (Figura 31.1).

3. Teclee LoadQuarters como nombre para ese macro, en
sustitucién de Record!.

4. Seleccione Key. (Tecla) y teclee q en la caja de texto,
reemplazando a lefra a.

5. Seleccione Global Macro Sheet {Hoja Global de Macro).

ORCION .

Run

Record

Stant Recorder

Stop Recorder

Set Recorder

Relative Record

Assign to Object

Resume

LECCION 31 @'

TABLA 31.1:
Menid de opeiones
Puri ALaCros

DESCRIPCION

(Correr) Ejecuna los tecleas y comandos del macro.

(Girabar) Inicia el grabado de tecleos.

(Arrancar grabadora) Inicia la grabacidn de los 1ecleos,
agregdndolos a un macro existente.

(Purar grabadora) Deja de agregar tecleos & un macro.
{Preparar grabadora) Designa la celda activa de ks hoja de
macros en la cual almacenar las instrucciones de macros.
{Grabacién relativa) Graba operaciones de seleccidn de
celdas con referencias relativas, demanera que el macro corra
a una distancia determinada de la celda activa. Cuando se
selecciona, cumbia a Absalute Record (Grabacion absoluta)
que s la opcisn preseleccionadi.

{Asignar a objeto) Permite eslabonar up macro con un objeto
del espacio de trabajo, por ejemplo, una grifica 0 un dibujo.
Lar click en el objeto hace correr el macro.

(Continda) Reanuda un macro que estd en pausa.

FIGURA 31.1:

= Record Macro La caju de diflogo
Name: Record Macro

Koy Cub [a

Store Macio In—— e ey

C: Global Macio Sheet |
@ Mecio Shost o

To odit the global macio sheat, choots Linhide hom the Window menu.

PR —

'
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-

6. Seleccione OK. Regresard a la hoja de trabajo Sheet 1. La
barra de Estado ahora muestra la palabra Recording
(Grabando).

A continuacién grabe las acciones que abren la hoja de trabajo
QUARTERS. :

7. Abra la hoja de trabajo QUARTERS sin primero cerrar la
ventana Sheet 1. Puede abrir el mend File y selcccionar
QUARTERS de la lista, si aparece ahi; use €l comandq Open
del mend File o el botén de abrir de la barra de herramienta.

8. Seleccione Macro » Siop Recorder {Detener Grabadora) para
" detener la grabaci6n de sus acciones y terminar e! macro. Ain
verd en la pantalla la hoja de trabajo QUARTERS.

Ademds de almacenar comandos de Excel en los macros, también
puede grabar acciones de mouse que seleccionen celdas, y tecleos que
alimenten ¢l contenido de celdas. Como ejemplo, crearemos un macro
para agregar automdlicamente encabezados de hileras y columnas.

1. Cicrre la hoja de trabajo QUARTERS para que la Sheet 1 se
active.

2 Seleccione Macro para abrir el menti de ese nombre.

Ahora estén disponibles en el meni las opciones Start Recorder
(Arrancar Grabadora) y Relative Record (Grabacién Relativa). Se
selecciona Start Recorder para agregar més operaciones al dltimo macro
grabado en la hoja Global de Macro. .

3. Seleccione Relative Record. El nombre de la opcién cambia 2
Absolute Record (Grabacién Absoluta).

Por opcitn preseleccionada, los comandos de seleccidn d_c celdas
estdn grabados como absolutos. Esto significa que si se selecciona uﬂ?-‘l
celda al grabar un macro, €sa misma celda se seleccionard elal corrcrff
macro posteriormente. Porejemplo, silacelda Alestd seleccwnqda yse
graba un macro que selecciona lacelda B3, entonces lacelda B3 siempre

.4

!
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se seleccionard al correr el macro — sin importar cual celda estaba
seleccionada antes de correr el macro. ‘

Por otra parte, la opcién Relative Record graba los comandos de
seleccidn de celda en relacién con la celda gue estd activa al momento
de correr el macro. Por lo tanto, en nuestro ejemplo, cuando selcorrael
macro, Excel seleccionard una celda que esté una columna mds adelante
y dos hileras més abajo desde la celda cualquiera que sea que esté activa
en la hoja de trabajo.

4. Seleccione Macro » Record para desplegar la caja de didlogo.
Note que el nombre sugerido para el macro ¢s ahora Record2,
la tecla ha sido incrementada a Cirl+e, ¥ la opeion Global
Macro Sheet sigue seleccionada.

Teclee Calendar como nombre para el macro.
Seleccione Key y teclee e en la caja de texto.
Seleccione, OK para regresar a Sheet 1.

En la celda B1 teclec Sunday.

AR

Arrastre el asa Fill de la celda B1 a la celda H1 para que se
llenen los nombres de dia de la semana.

10. Scleccione la celda A3 y teclee 8:00 AM, -

11. Arrastre el asa Fill de la celda A3 a la celda A13 para que se
llene la serie de horas, como muestra la Figura 31.2,

12. Seleccione Macro » Stop Recorder.

13. Cierre la hoja de trabajo Sheet 1 sin guardarla.

Puesto que los macros estdn almacenados en la hoja Global de
Macros, no se tiene que guardar la hoja de trabujo mostrada para guardﬁr
los macros. Sin embargo, como pronto aprenderd, si hay que g’u::miar la
hoja Global de Macros antes de salir de Excel si se desea el guardado de
los macros. )
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. FIGURA 31.2:
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Se puede correr un macro oprimiendo la tecla de atajo asignada a él. Para
correr un macro asignado a una letra maydscula, oprima Curk+Shift y la
letra. También puede correrse un macro seleccionando su nombre en uai
caja de didlogo. Usaremos ambos métodos aqui.

Puesto que adn qw hemos salido de Excel, los macros de la hoja
Global de Macros siguen disponibles, a pesar de que todavia no hemos
cerrado la hoja de macros.

1. Oprima Ctrl+g para abrir 1a hoja de trabajo QUARTERS.
Ahora corra e] macro Calendar usando ¢l comando Macro »
Run. '

Como Correr
Macros Globales

2. Scleccione la celda A53.

3. Seleccione Mucro » Run para desplegar la caja de didlogo
Run Macro (Correr el Macro) (Figura 31.3),

-
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FIGURA 31.3:
Ea caja de didlogo
Run Mucro

“!

c GLOBAL.XLM!Calendar
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Los macros que acaba de grabar aparecen enumerados en 1a caja
Run. Estdn enunciados en orden altabético sepiin su teeli de atajo. Cada
clemento incluye el nombre de L hoja Global de Macros —
GLOBAL.XLM — y ¢l nombre det macro. (XLM es la extension
preestablecida para todas tas hojas macro de Excel).

Para correr un macro dé un doble click en é1 en la lista, o haga su
scleccion y tuego OK. Cuandoseleccione un macro, sunombre apareceri
cn la caja Relerence (Referencia).

La opcion Step (Paso)-de la caja de didlogo sirve para avanzar por
pasos a fravés de un macro — o sea haciendo una pausy despuds de
gjecutar cada instruccidn del macro. "Ejecutar paso a paso” un macro es
un terma mds avanzado que sale del enfoque de este libro.

4. D¢ doble click en ¢l macro Calendar. El catendario aparece
insertado en la hoja de trabajo QUARTERS, como muesiri la
Figura 31.4, En virtud de que fue grabado usando la tuncidn
Relutive Record, los encabezados de hiferas y columnas del
calendanio aparecen relativamente a la celda activa de la hoja
de trabajo en vez de aparecer en las celdas que fueron
seleccionadas cuando se grabaron los comandos.

Como Borar
Macros Globales

Se puede borrarun macro de la hoja Global de Macros después dehaberlo
grabado. Yeamos comw.

1. Cierre lu boja de trabajo QUARTERS sin guardaria.
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2. Seleccione Window » Unhide (Desocultar) lo cual despliega
la caja de didlogo mostrada en la Figura 31.5. Esla caja de
didlogo enumera las ventanas que estdn ocultas — o sea no
desplegadas en la pantalla ni enumeradas en el meni Window.

3. Seleccione GLOBAL.XLM y luego OK.
La hoja Global de Macros aparece desplegadaen la pantaila (Figura

31.6). Cada macro estd grabado en una columna separada de la hoja de
trabajo, con una instrucci6n en cada hilera. Las instrucciones esténenel
lenguaje de Excel para macros. El nombre de cada macro y su tecla de
atajo se tienen en la hilera 1. Para borrar un macro, borre la columnacen
la cual esté grabado.

Si 1a hoja Global de Macros estd desocultada al salir de Excel,

aparecerd automdticamente la siguiente vez que arranque Excel.

4. Seleccione Window » Hide para eliminar la hoja de macro de
la pantalla.

—
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FIGURA 31.5:
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GU rd sin haberla guardado primero aparecetd una caja de didlogo con el
alargar mensaje
Macros Save changes to Global Macro Sheet?
(¢ Guardar camblos a I8 hola Global de Macros?)
Globales

Seleccione Yes para guardar los macros, o No para borrarlos.

Para guardar lahoja Globalde Mucroscon la ventana GLOBAL.XLM
achiva, seleccione la herramienta de Guardar, o seleccione File » 'Save

(Shift+F12).

R —
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Ahora salga de Excel. Decida si es conveniente guardar la hoja
Global de Macros.

Hojas de Macro
Especiales

Sideseagrabar un macrogue s6lousari ocasionalmente, gudrdeloenuna
hoja de macro que no sealaGLOBAL.XLM. Puede tener tantas hojas de
macro especiales como le quepan al disco, de modo que puede guardar
colecciones de macros en hojas gque traten un tema comin, Por ejemplo
puede guardar un juego de macros que use para trabajar con presupuestos
en una hoja de macros que se llame BUDGET.XLM. Cuando vaya a
trabajar en una hoja que contiene informacién de presupuestos, abra
BUDGET.XLM para tener disponibles esos macros.

Lamayor parte de lasiécnicas que ha aprendido para grabar macros
globales se aplican por igual a los que se almacenen en hojas de macro
especiales. Cuando desee grabar un macro y almacenarlo en una hoja de
macro especial, seleccione Macro » Record para desplegar la caja de
didlogo Record Macro, y luego seleccione Macro Sheet (Hoja de Macro)
en vez de Global Macro Sheet. Déle nombre al macro y asignele una
combinacién de teclas; luego seleccione OK para salir de la caja de
didlogo y empiece a grabar sus acciones, Excel creard una hoja Hlamada
Macro 1 (en ¢l plano posterior, debajo de la hoja de trabajo activa) y
almacene el macro grabado ahi en vez de en GLLOBAL.XLM.

Para desplegar la hoja de macro, pase a ella oprimiendo Ciri+F6 0
selecciénela en el mend Window — no estar oculta. Guarde la hoja de
macro antes de cerrarla o salir de Excel. Si desea cambiarle de nombre
— porejemplo, de MACROL.XLM aBUDGET.XLM —-use el comando
Save As y teclee el nuevo nombre en la caja de didlogo Save As.

Para usar macros en una hoja de macro especiul, dbrala igual que
cualquier hoja de trabajo — recuerde que tiene una extension . XLM.
Excel abrir la hoja de macro y la desplegari en el espacio de trabajo.
Abra 0 pase a la hoja de trabajo que desea crear o editar, y lucgo corra
los macros especiales o globales usando sus teclas asignadas o lacajade
diflogoRun, Silahoja de macroespecial contiene unmacro con lamisma
clave de teclas asignada que un macro global, éste serd el que corre al
oprimir la combinacién de teclas. Corra el macro especial en su lugar
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usando la caja de didlogo Run Macro.

Para agregar un macro a una hoja personal de macros, abra su
ventana, seleccione la primera celda en blanco de la hilera 1, finalmente
seleccione Macro » Set Recorder, y proceda a prabar el nuevo macro.
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Uso de Excel
para Resolver
Problemas de Negocios

PRESENTACION DE

Como resolver
problemas de
¢Qué pasa si ... ?

Coémo usar Goal Seek

sar Excel para producir hojas de trabajo y
graficas apenas toca sus capacidades. Hay
operaciones avanzadas de Excel que hacendel
programa una poderosa herramienta para
solucién de problemas. Sin embargo, no
necesita aprender esas operaciones compli-
cadas para que Excel le ayude a resolver

problemas criticos.

Enestaleccion, aprenderd cémo usar recélculo paratomar decisiones

de negocios. También aprenderdcémo utilizar Goal Seek (Busca Metas), -

que es unode los comandos més dtiles de Excel para resolver problemas.

T
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(6mo Resolver

En las empresas, constantemente hay que decidir acerca de opeiones, o

con seleccionar una aliernativa sobre otras. Al hacer tales dcc'lsionels, se

PfOblemaS de trata de proyectar el impacto qué tendria cada alternativa, y luego
.,Oué pasa Si" seleccionar l.a que es mads rgdiluable, efectiva 0 segura, o ?

Las decisiones de este lipo suelen llamarse problemas de "Qreé pasa

51" (Qué pasa i construimos la planta en el sitio A en vez del sitio B?

Qué pasa si elevamos los precios 10%7 ; Qué pasa si cedemos nuc.%lras
acciones al piblico'en vez de conservarlas como propictarios privaclios'?
En algunos casos un problema de "Qué pasa si ..." puedc expresarse

en una hoja de trabajo, con férmulas gue calculan los efectos dﬁ: las
decisiones. Como gjemplo, usemos la hoja de trabajo mostrada en la
Figura 32.1 para ver como Excel puede ayudar a tomar dccisione}s de
- direccidn de negocios. La hoja de trabajo muestra ¢l costo de producir
una unidad de producto basada en el salario por hora y la cantidad de
unidades producida. -
El primer problema que trataremos de resolver es ";Qué pasa si

aumentamos los salarios?”. Cualguier incremento en kalasa salarial, oen

FIGURA 32.1:
ry B c o 3 F r H 1 : Hoja de rabajo para
1 Wage Rate 825 ]l resolver problemas de
2 . Guanities S ey 0
73] TmeMdon 3000 2000 M0 4000 5000 Qué pasa si...
4
[ 5 _[Matensi 9250 12i25 7365 21557 25617
£ _{Recenng 002 165 330 195 860 825
| 7_|Fabncaucn 15 32375 24750 3NS5 49500 E187S
| 8 [Ponshing 075 61875 12375 IBS62S 24750 30337
ER L 225 185606 37125 GEREIS 74250 928125
[ 10 | Shipping 05 4125 8250 12375 16500  T082S
]
12 [Taw! Cost SOEES 94955 141610 87217 232692
13
| 14 |Costper nem S0665 474775 4720133 4580425 965384
15
18
171
1] D
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el costo de materiales incrementard el costo de produccfén. Esto
incrementaria el precio que hay que cargara los clienlcsf. suponiendoque
se desea mantener constante un margen de utilidad. Sise 'aumcnlan las
salarios demasiado, el precio resultante puede ser dcmaflado alto para
mantener una posicién competitiva en t?l mercado, Asi que antes de
aceplar un aumento salarial, debe <‘Jelermmarse su efecto en el costo por
unidad o costo unitario.
Siga estos pasos:
1. Cree la hoja de trabajo mostrada ¢n la Figura 32.1. Ingrese el
lexto, los encabezados de hileras y columnas, y los valores en
la hilera 5 y en la columna B, como aparecen.

Refiérase ala Figura 32.2 para las férmulas de las celdas restantes.
Las referencias absolutas hacen posible ingresar Jas f6rmulas en lahilera
6 y copiarlas hacia abajo hasta la hilera 10. _ . .

Cuando haya terminado la hoja de trabajo, compare sus rcstjltfldos
con los de la Figura 32.1. Si cualguiera de los mimeros Ies distino,
cuidadosamente verifique sus férmulas y eletmentos numéricos.

Note que el costo de cada unidad varia de un costo alto F!c $50.66
cuando se producen 1000 unidades, 2 un costo bajo de $46.54 si son 5000
unidades. ' e

Ahora suponga que esti considerando un aumento salarial de
centavos. Veamos el efecto en el costo unitario.

2. Seleccione la celda B! y teclee 8.75.

FIGURA 32.3:
G Fémulas para hoja
c D E F d )
e trabajo
2C$715BS1ASRE =D33+5B§145B6 =ES)1*$BSL"SBS =F5)+5851+3B6 =G5i-5B51a5B6 i

=C5IeSn51e5B7
=512 5RS1+5E8
=C31+5B%145B%
0 =€$245mG1-$B10

ey Ry

12 =5UM{C5:C11)

14 =€12/Cy

- *5B7 =E53%SBS1+5SBT  =FS$345BS14SB7 =GS3sSB%L+$R7
-333:353-355 -Ezzczssl-sua =F53145BS145B8 =G$14$RS145ES
=DS3PSBS1*4BY  =E$I45B514589 =F$I1+$BS1+5RY =G535BS1+$BY
=D$3I45B5145B10 =ESI*SBS12$BI0 =F$3+5B51 45810 =G51+5HS1#5B10

=SUM(D5:D11)  =SUM(ES:Fl1)  =SUM(F5:F11)  =SUM(GSiG11)

=D12/D3 =E12/E3 =F12/F3 =G12/G3
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Cada una de las unidades aumenta su costo aproximadamente en
$2.51. Puesto que un costo unitario de aproximadamente $50 requerirfa
un precie de menudeo fuera de competitividad, veamos qué resultados
hay con un incremento salarial de 25 centavos.

3. Teclee 8.5en lacelda BI ¥y note el cambio en ¢l costo por
unidad. Un aumento salaria) de 25 centavos corla a fa mitad el
incremento de costo unitario.

Probandocon diferentes cantidadesen la celda B, podra determinar
qué tasa salarial ofrece un costo unitario aceptable. Ahora veamos otro
problema.

' Unamanerade bajarel costo de produccidnesreducirel tiempoque

toma producir cada unidad. Con un presupuesto limitado para equipo de
capital, puede comprarse ung méquinaque reduzcael ticmpo de acabado
por 10%, o una banda transportadora que corte a la mitad el tiempo de
recepcidn. A primera vista, reducir por mitad una operacidn podria
parecer 1a alternativa mas eficiente. Pero dejemos que Excel ayude a
decidir con seguridad,

1. Seleccione la ¢elda B1 y tecle 8.5 para regresaria a su valor
original.

2. Seleccione la celda B ¥ teclee 2.025, to cual refleja un 10%
de reduccién en el tiempo de acabados, Con esta reduccion el
costo por unidad se reduce en aproximadamente $1.85.

3. Seleccione Edit » Undo Entry (Deshacer 1o Alimentado)
(Crl+Z) para restablecer ¢l valor original de 1a celda B9,

4, Seleccione la celda B6 y teclee 01, que es a mitad del liempo
de recepcion original.

Una reduccion de 50% en ¢l tiempo de recepcion reduce el costo
unitarioen solamente $.08. Es obvioqueeldineroestaria mejorinvertido
reduciendo en un 10% el tiempo de acabados.

3. Seleccione Edit » Undo Entry (Ctri+Z) para restablecer el
valor original de la celda Bé6.

N
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Como Usar el
Buscador de
Metas

Si se ticne en mente un resultado ¢specifico, puede hacerse que Excel ge
modo automdtico encuentre el valor correcto de una variable. Por
ejemplo suponga gue se desea aumentar los salarios de modoque el costo
unitario sea $50 al manufacturar 5000 unidades. En vez de cambiar
manualmente el valoren la celda B1 hasta que sea $50 el resultado en Iy
celdaG14, usecl comando Goal Seek. Automaticamente Goal Seek varfy
el contenido de una celda hasta que el resultado del clculo que aparezca
en otra celda sea igual a un valor dado.
Veamos cémo funciona.

I. Seleccione la celda G14. Esta es la celda que se desea que
contenga un resultado especifico calculado, que es 50.

2. Seleccione Formula » Goal Seek para ver la caja de didlego
que muestra la Figura 32.3. La caja de texto Set Cell (Celda
Fija) contiene las coordenadas de la celda seleccionada usando
una referencia absoluta — $GS$14.

3. Seleccione la caja de texto To Value (Al Valor) y teclee 50,
que es el valor que se desca que contenga G14.

4, Seleccione la caja de 1exto By Changing Cell (Cambio de la
- Celda), y luego la celda B1. Esta es donde se desea que Excel
cambie iterativamente hasta que aparezca en la celda G14 lo
que contiene la caja To Value.

5. Seleccione QK.

Excel cambiard el valor en lacelda B1 hasta que el de lacelda G14

sea 50, y luego desplegari la caja de didlogo mostradaen la Figura 32.4.

FIGURA 32.3:

Goal Seck La caja de didlogo
Goal Seek
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|
FIGURA 32.4|:
La caja de didkogo
Goal Seek Suis

Goal Socking with Cell B6
tound a solution.

Touged Value: 50
Cusrent Value: 50

=

Note que lacelda B1 ahora contiene 8.939562. La caja de didlogo indica

que se encontré una sokucion exacta — esto es un valor de la celda BI

que produce un valorde 50en lacelda G 14, Aparecerd un mensaje enesta

caja de didlogo si no se puede encontrar una solucion exacta.

6. Seleccione Cancel para que ta hoja de trubajo regrese a,su

" contenido original. Si selecciona OK, a hoju de trabajo
retendrd ios nuevos valores calculados.

7. Guarde la hoja de truf)ajo y salga de Excel.

En este libro ha aprendido ¢émo usar Excel para crear hojus de
trabajo y graficas, asi como técnicas para agilizar luintroduccion de datos
y las operaciones, el formateo de hojas de trabajo y la creacidn de
presentaciones de aspecto profesional. En esta leccion apruldlo asi
mismo ¢6mo Excel puede ayudar atomardecisiones y resolver pmhlt_mds

Cada hoja de trabajo que cree reforzari estas habilidades adqumdas
e incrementard sus conocimientos de Excel. Cuando tenga II(_'mp()
experimente con algunas de las funciones mds avanzadas de ['xcel
Guarde sus hojas de trabajo antes de probar nuevas técnicas, a fin db que
recupere rdpidamente la version original en caso de que hiciera cambios
no deseados.

Principatmente no deje que su imaginacién se limite, y aproveche
las posibilidades que ofrece Excel.
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AP ENDICE

Preparacion e
Instalacion de Excel

Antes de empezar a usar Excel, es una muy
convenienle proteger su inversion haciendo
copiasderespaldo. Eneste apéndice aprenderd
como hacer un juego de respaldo de los discos
de Excel para su salvaguarda, cémo instalar
Excel en su sistema, y como asegurarse de que

Windows esté configurado para su impresora.

Como Hacer
Copias de
Respaldo

- T L

Debe hacer un juego extra de discos de Excel para su propio uso. Los
discos sc pueden desgastar y un juego extra es simplemente una
precaucién contra la pérdida de este valioso programa, Para hacer un
juepo de respaldo, necesitard todos los discos de Excel y un nimero igual
de discos en blanco del mismo tamario,

APENDICE A .

Antes de iniciar €] procedimiento de respaldo, proteja los discos
originales contraborradura accidental. La proteceion delos discos de 5%
pulgadas se hace pegandoles una etigueta de proteecion contra cs’crimra
sobre la peguefia muesca que tiene en fa orilla cadivdisco. (Las etiquetas
de proieccién contra escritura son papeles adhesivos pequeiios
rectangulares que van empacados con los disketies en bl.mco) Los
diskettes de 3% pulgadas se protegen poniéndoles cerrojo — lcslo es
empujando una pequefia correderade pldstico ubicady en una esquing de
la parte posterior del disco de modo gque se pueda ver Tuz atr m.u. de un
peyguefio agujero cuadrado. Si el apujero estd 1apado por la wm,ldcra de
modo que no se pueda ver através, el disco estd sin cerrojo y los dl“(.hlVOh
pueden ser borrados. No ponga cerrojo ni proteja contra escritura los
discos en blanco sobre los cuales va a hacer copias. '

Ahora estd listo para respaldar sus discos. I

Recibio un juego de 5% pulgadas o de 3% pulgadas de discos de alta
capacidad con su paquete Excel. La manera de copiarlos dcpu‘nd&, del
ndmero y tipo dé unidades de disco (drives) que tenga su smpmd

Si su sistema tiene una sola unidad, o si tiene dos umdddu, Jque no
son del mismo tamafio o de ta misma capacidad, use el método dubcmo
en la seccion "Una Sola Unidad de Disco”. Aplique ¢sie mém‘do, por
ejemplo, si tiene una unidad de 5% pulgadas y una unidad| de 3%
pulgadas, o dos unidades que sean del mismo 1amano pero de diterente
capacidad.

Si su compumadora tiene dos unidades de disco del mismo lamario
y de la misma capacidad use el método que se explici en la seceion "Dos
Unidades de Diskette Idénticas™,

Uilice ¢l procedimiento descrite para su tipo de computadora,

Una SoLa UnNibab pE Discos

Durante el procese de respaldo, recibird instrucciones de insertar en la
unidad A el disketie fuente o el diskctie de destino. Ef diskelte fuente es
el oniginal Excel que se estard copiando.El diskette de destino esel que
estden blancoysobre el cual se vaahacer lacopia, Nuncainserte un disco
original Excel cuando se ie pide inseriar el de destino porque podria
destruir ¢l programa. Pura tener doble seguridad recuerde proteger
contra escritura o poner cerrojo a sus discos de Excel.

A R G
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Su direciorio de sistema operativo contiene un programa Hamade
Diskcopy, €l cual sirve para hacer un duplicado de sus discos de Excel,

1. Arranque la computadora.

2. Asegiirese de yue ¢l programa DISKCOPY.COM esté en el
directorio actual. Si no lo esté, pase al subdirectorio apropiado
con el comando CD\, por ¢jemplo, CDNDOS. ’

3. Teclee Diskcopy A: Az, y luego oprima . La pantalla
mostrard

Insert SOURCE diskette in drive A:

Press any key to continue...

(Inserte el diskette FUENTE en la unidad A:
Oprima cualquier tecla para continuar...)

4. Cologue uno de los discos de Excel en la unidad A. Este es
uno de los discos originales suministrados con Excel.

5. Oprima cualquier tecla. En poco tiempo verd aparecer el
mensije
Insert TARGET diskette in drive A:
Press any key to continue...

(inserte el diskette de DESTINO en la unidad A:
Oprima cualquier tecla para continuar...}

6. Saque ¢l disco de Excel ¢ inserte un disco en blanco en la
unidad A.

7. Oprima cualquier tecla para iniciar el copiado.

Sele puede pedir varias veces que cambie estos discos hasta que toda
la informacidn del disco de Excel haya quedado copiada en el discoen
blanco. Asegiirese de que el disco original Excel esté en la unidad
Gnicamente cuando la pantalla pida el diskette fuente.

Cuando la copia esté terminada, vera el mensaje

Copy another diskette (Y/N)?
(¢Coplar otro diskette (S/N)?)

8. Saque el disco e inmediatamente etiquete la copia adecuada-
mente. En el case de discos de 5% pulgadas, escriba el nombre

APENDICE A @

del disco en la etiguela antes de pegarla en ¢l disco (se pucde
dafar el disco escribiendo directamente sobre él).

9. Oprima Y, y luego repita este proceso desde ¢l paso 4 para
todos los discos Excel.
Coloque los discos originales Excelen lugar seguro y use las copias
para corrergl programa Setup. ’

Dos UNIDADES DE Discos IDENTICAS

Enelsiguiente procedimiento, nuncacologue unode los discos originales
de Excel en la unidad B. §i lo hace y ¢l disco no esté protegido contra
escritura o con cerrojo, podria destruir Excel. Consuite su manual de
operacion si tiene problemas con el procedimienio.

1. Arrangue la computadora,

2. Asegirese que el programa DISKCOPY.COM esté en ¢l
directorio actual. 5i no lo estd, pase al subdirectorio apropiado
con el comando CD\, por ejemplo, CDNDOS.

3. Teclee Diskeopy A: B, y luego oprima . La panlallu'mostrarﬁ

Insert SOURCE diskette in drive A:

Insert TARGET diskette in drive B:

Press any key to continue...

{inserte el diskette FUENTE en la unidad A:
Inserte el diskette de DESTINO en la unidad B:
Oprima cualquier tecla para continuar... )

4, Cologue uno de los discos de Excel en lu unidad A. Este es
uno de los discos originales suministrados con Excel. Debe
tener pegada en €] una etiquela de proteccidn contra escritura,
© lener cerrojo.

5. Cologue un disco en blanco en la unidad B y oprima cualquier
tecla. El procedimiento de copia correrd por si mismo. Cuando
esté terminado, verd ¢l mensaje

Copy another diskette (Y/N)?
(& Copiar otro diskette {S/N)?)

6. Sagueeldiscodelaunidad Beinmediatamente etiquete la copia

"
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Como Instalar

con el réivlo correspondiente. Con los discos de 5% pulgadas escrihy ¢l
nombre del discoen la etiqueta antes de pegarla al disco (se pueden dadiy,
los discos escribiendo directamente sobre elios).

7. Saque el disco de la unidad A.

8. Oprima Y, luego repita este procedimiento desde el paso 4
hasta que todos los discos de Excel hayan sido copiados.
Recuerde siempre insertar ] disco Excel original en 1a unidad
Ay ¢l disco en blanco en la unidad B.

Guarde losdiscos originales de Excelen lugar seguro. Use las copia,
cuando corra el programa Setup.

Excel

El programa Setup de Excel copialos programas apropiado al disco duro
para que se pueda empezar a usar Excel. Setup es facil de usar. S6lo siga
los mensajes y avisos de ta pantalla,

1. Arranque la compuiadora.

2. Imtroduzca ¢l disco de Excel etiguetado Disco | — Setupen fa
unidad A.

Arrangue Windows.

Abra el meni File y seleccione Run.

wokow

Teclee A:\Setup, luego oprima J. Aparecerd una caja de
didlogo pidiendo que teclee su nombre y el nombre de su
organizacién o compaiiia,

6. Teclee sunombre y luego oprima Tab.

7. Teclee el nombre de su compaiifa y luego seleccione Continue.
Aparecerd una caja de didlogo solicitando gue confirme el
nombre ¢ informacién de la compafia.

8. Seleccione Continue u oprima . Aparecerd una caja de
didlogo pidiéndole que confirme el directorio preseleccionado
(Figura A.1).
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St es la primera vez que ha instalado Excel, verduna cajade di?logo

9. OprimaJpara acéplar eldirectorio preseleccionado, C:\EXLCEL. : ‘

diciéndole que el directorio de Excel atin no existe, Seleccione Ye
crear ¢l directorio y para continuar con el proceso de instalacién

S para

Excel desplegard una caja de didlogo numerando tres niveles de |
instalacién (Figura A.2), La opcion Complete Installation (Instalacién
Completa) requiere al menos 11 MB de espacio del disco duro, pero deja

disponibles todas las funciones de Excel. Si se tienen menos de |

I MB

deespaciode discodisponible, seleccione Custom Installation (Inslu[lucién

FIGURA A_1:
b Microsofl Excel 4.0 Selup Caja de didlogo
Microsoft Welcome 1o Microzolt Eacel Selup confinmar el

Setup will place Miciozoll Excel ilo the {ollowing direcloy,
which it will creale on yow haid dish.

1§ you wani to inslall Mictosclt Excel in a dilterent diectoy
and/oi dnve. lype the name of the duecloly. -

Instafl to: ]

To quit Setup. choote the Exit butlon in the lawer-tight
coinet M any time duling the installation piocess.

[ gontinse | [ EsitSetwp |

directorio Excel

pari

FIGURA A.2: |

= Microsott Excel lor Windows 4.0 Opeiones de
Choose the type of mslalaton by cbcking ane of The buttons

instalacion

Comgplete Installation

Installs of Miciosoll Excel options  This inslallalion tequires a total of
11 MB ot disk. space

Cuslom Instaliation

[ .

= Lets you choase which Microsoll Excel optons to nstal You can
(w] cleale a cusiom Microsolt Excelinsta¥laton and add move oplions
lates by munning S etup agan

Minimum Installation

Installs only the minmum tdes requned ta run Miciosoh Excei This
conliguiation requiles ordy 5 MB of dish. space

s el S
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Especial) para designar cudles partes de E.xcel ’sc' desea msllular, o
seleccione Minimum Installation (Instalacién Minima) para mstalar
Gnicamente las funciones bésicas de Exce!. las c?uales chlul.eren
aproximadamente 5 MB de espaciodel disco. Si pOSlCﬂOl”l‘I‘ICl’I‘l(: E’llsp()nc
de mis espacio libre del disco, puede voiycr acorrer gl programa S'emp
y usar laopcion Custom Installation para instalar funciones adicionales,

10. Si tiene suficiente espacio en el disco, oprima JJpara
seleccionar Complete Installation. De otro modo, seleccione
Minimum Installation.

Aparecers una caja de didlogo preguntindole i desed |nsla_|ar
informacidn acerca de Lotus 1-2-3. Esta funcién facilita a los usuarios
de Lotus 1-2-3 trabajar con Excel. Seleccione Yes o No.

Aparece una caja de didlogo preguntando si desea que Seiup
actualice su archivo AUTOEXEC.BAT.

11. Seleccione Update (Actualizar).

Selup empezard a copiar el programa de Excel al disc? duro. Una:
caja de didlogo en la esquina inferior derec.:ha de la pantalla rc.porta '1:-
nombre del archivo que estd siendo copiado y el Porccnlaje1de. il
instalacion que se lleva de avance. Aparecerdn mensajes en‘la Cbt‘[mf:;
superior izquicrda de 1a pantaila reportando acerca deal gunas f unCl'(;?ro
de Excel y recomendando que mande por corTeo su l‘dl‘](“,‘la de regl ei
En una serie de pasos, s¢ le pedird que imserte los Fhscos de Exc
en la unidad A. Siga los llamados de la pantallz? — inserte el disco
solicitado y seleccione OK u oprima -, para continuar. s
Cuando todos los archives estén copiados, Excel actualizar b
archivos de inicializaci6n en el directorio df’ Windows y luego cre'alrc .
grupo Excel dentrodel Program Manager. Fmalmcn_[e aparecerdunac)
de didlogo reportande que la instalacién estéd terminada. -
Ahora ya instalé Excel en su disco duro. E! programa estd Ilhlw ;)0 o
ser utilizado cuando cree su primera hoja de trabajo. Si ll'ev() aca s
instalacién minima o especial y posteriormente (_1esea 1Ansmlar '(z) "
funciones de Excel, rearrangue el programa Setup y sigalas instruccl
que se dieron aqui.

A
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Como
Configurar
una
Impresora

Excel usa los recursos que estdn disponibles en el ambiente de Windows,
Este incluye la configuracién especifica de su equipo, monitor, adaptador
grafico e impresora. Si Windows estd configurado udecuadamente para
su sistemna, podriusar Excel paracrear e imprimirdn las mas complicadas
hojas de trabajo. )

En virtud de que Excel se apoya totalmente en Windows para sus
saltdas de impresion, asegirese de que Windows estd debidamente
configurado para su impresora. Esto es especialmente critico si se tiene
una impresora laser o si se experimentan problemas al imprimir desde
Exce! o desde otra aplicacién de Windows.

Siga estos pasos para verificar la configuracién de su impresora:

1. Secleccione Control Panel desde la ventana Main de Program.
Manager.

Silaventana Mainnoestd abiertaal arrancar Windows, abrael menii
Window y seleccione Main.

2. Seleccione Printers en la ventana Control Panel. Verd una caja
de didlogo con los nombres de las impresoras que ya tiene
instaladas para Windows, como muestra la Figura A 3.

Si suimpresora no aparece enumerada, seleccione Add >> para ver
una lista de impresoras que reciben soporte. Seleccione su impresora y
luego la opeion Install, la cual aparecerd en la parte inferior de la cajade

[

FIGURA A.3:

I T R . c:ju ic diflogo

Dedault Printer
HP Latewl et Plus on LPTY:

Printers

] Com ]

Inatafled Pravers:
HP LaserJel Plut on LPFT1:

Spt As Delmlt Printes

(<) Uise Puini Manager
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didlogo. Se le pedird que introduzea uno de los discos originales de
Windows en la unidad A. Introduzca el disco y siga lasinstrucciones que
aparezcan en la pantalla hasta que la caja de didlogo Printers vuelva

FIGURA A.S%

Setup: HP Laserdet Wil on LPTT; La caju de didlogo

aparecer. Pape: Size:  TIE RN Printer Selup para
i ) impresoras Laserlet
Una vez que la impresora esté instalada, tendrd que configurarla Paper Souice: [Upper Tray T2}
para trubajar con su sistema. . .
, . . Graphics 350 dots pes inch [2]
3. Resalte el nombre de su impresora en ta caja de lista; luego
seleecione Connect para desplegar la caja de didlogo mostrada Losies: ]
en la Figura A4, Mesory: 3
4. Seleccione el puerto al cual estd conectada su impresora, y Orientation ———————1 Cantridges (7 max] === —"""=

lucgo OK para regresar a la caja de didlogo Printers.

Z: Miciozoft 1A
HP: Bar Codes & More
HP. Yorms, Etc.
HP: Glabal Text

by @ Pogtiait

5. Scieccione Sctup para ver una caja de didlogo con opciones O Landicape
para su impresora. Por ejemplo, 1a caja de didlogo mostrada en
la Figura A.S aparecerd cuando se esi€ instalando una
impresora laser de LaserJet o compatible.

6. Seleccione las opciones que identifican su configuracion. CoMo DESIGNAR La IMPRESORA PRESELECCIONADA
7. Scleccione OK para confirmar lo seleccionado. Contintie Se pucden tener varias impresoras instaladas en Windows y haem se
seleccionando OK de las cajas de didlogo que aparezcan hasta pucde asignarles el mismo puerto. Por ejemplo, pucde lu]Lrlse uni
regresar a lu ventana Control Panel, y luego cierre la ventana impresora laser para usarse con grificas y una impresora de mal\tm de
para regresar a la ventana Main. puntos de carro ancho para ser utilizada con hojas de trabujo anchas.
Ambas pueden estar asignadas al puerto LTP 1 y conectadas al puerto a

FIGURA A.4: través de un conmutador o switch A-B.

”' La caja de didlogo . Puesto yue solamente puede usarse una impresord en el puerto a la

HF Lasedet I Connect pura vez, hay que asignar una de las impresoras como preseleccionada.

Ports: seleccionur un pucne : ren s metn | T BT cTeve Trahaiog de i lei .
S— ? Windows usard esta impresora para todos los trabajos de lmprelmén, a
Hetwork, I
[t

AT resorik : ; :
LPT2.Laval Port ot Present p— para ka imp menos que se cambic la impresora prescleccionada o temporalmente se
: ocal Port Not Present T ' ' . . . ., .
Local Port Mot Present cambien tas impresoras en 1a caja de didlogo Printer Setup.

Local Poit . ' N
Para designar una impresora preseleccionada, resalte sunombre en

Timeouls [seconds) . .. . . . . .

Device Mot Selected:  [15 | . lacajadedidlogo Printers y seleccione Set as Default Printer (l"l]‘d!l’ como

Tiantmiasion Rety: f5 ] Impresora Preseleccionada). Si posteriormente s decide usar oira
Fast Printing Disech to Port : impresora como preseleccionada, repita este proceso usando el nombre

de la nueva impresora.
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Para cambiar impresoras y opciones de impresién desde Excel,
seleccione el botén Printer Setup (Configuracién de Impresora) desde 1a
cajade didlogo Page Setup. Aparecerdunacajade didlogoque le permite
seleccionar otra impresora de su lista, o cambiar alguna de las opciones
dispenibles en la caja de didlogo Setup. Haga los cambios que desee y
luego seleccione OK.

Si encuentra algdn-problema al imprimir, asegirese de gue la
impresora esté encendida y de que esté debidamente conectada a la
computadora. Verifique los pardmetros fijados para el puerto en la caja
de didlogo Connect y las opciones de la caja de didlogo Printer Setup. Si
tiene una impresora en serie, lea en su manual los pardmetros de
comunicacién correclos y aseglirese de que estd utilizando el cable
correcto. Si estd trabajando en una red, hable con su administrador de la
red si tiene dificultades de impresion.

APENDICE

Interaccion con las
Aplicaciones de Windows

En virtud de que Excel es una aplicacién de
Windows, se interactda con ella de manera
muy similar a como serfa con cualquier otro
programa de Windows. Asi es que si estd
familiarizado con Windows, ya sabe la mayor

parte de las técnicas para trabajar con Excel.

Técnicas de
Mouse

Sitiene un mouse, verd un simbolo en la pantalla, llamado sefialador,que
indica la posicion del mouse. La forma que adopta el sefialador depende
de su localizacién en la pantalla. Cuando una instruccion le diga que
apunte aalgoen la pantalla, muevael mouse sobre su escritorio hastaque
¢l sefalador esté sobre el abjeto en la pantalla.
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Una instrucci6n de dar click con el mouse significa oprimir
rapidamente y soltar el bot6n izquierdo del mouse. Si la instruccion dice
"Dé click en la celda” {o en la palabra, el botén, etc.), significa que hay
que colocar el sefialador del mouse en el objeto al que se hizo referencia
y que dar click en el botén izquierdo del mouse. Siempre serd ¢l boidn
izquierdo del mouse €l que se use, a menos que una instruccién
explicitamente indique dar click al bot6n derecho. Por supuesto, invierta
eslas instrucciones, si liene un mouse para zZurdos.

La instruccion de dar doble click, significa ejecutar dos clicks
seguidos ripidamente. La velocidad a 1a cual hay que dar click depende
de la computadora. Si se da doble click siguiendo alguna instruccién y
nada sucede, es porque no se dio click suficientemente rdpido — inién-
telo otra vez,

La instrucci6n de arrastrar significa apuntar a un objeto, oprimir y
mantener oprimido ¢l bot6n izquierdo del meuse, luego mover el mouse
sobre ¢l escritorio, Las instrucciones de arrastrar siempre proporcionardn
un destino, porejemplo "Arrastre el sefialador hasta abajo de la pantalla”.
Al llegar al destino indicado, suelte €l botén del mouse.

Como Trabajar
con Menus

Su primera tarea al dar comandos a Excel generalmente serd seleccionar
una opcion de 1a barra de Meniis. La barra de Menis es un renglén cerca
de la parte superior de la pantalla en 1as aplicaciones de Windows, gue
conliene palabras de comando, tales como File y Edit. Seleccionar un
elemento despliega un mend “de persiana” con elementos adicionales.

Se puede seleccionar una opcién de la barra de Mends, o abrir un
men, de as siguientes maneras:

e Cologue el sefialador del mouse en la opcién que se desea
seleccionar y dé click con ¢l betén izquierdo del mouse.

m Mantenga oprimida la tecla Alt y presione la letra subrayada
del comando; por ejemplo, F para File, Note que la letra
subrayada no siempre es la primera de la palabra, como en el
comando de menid Format.

h_.
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s Oprima F10 para entrar a la barra de Menis; luego oprima la.
letra subrayada, o use las teclas de flecha direccional para
resaltar upa opcidn de menid; a continuacion oprima I para
seleccionarla.

Una vez que abre un mend, tiene que seleccionar un elemento de éL
Por ejemplo una manera de cambiar el tipo de letras es abrir ¢l mend
Format y luego seleccionar la opcidn Font. Se puede seleccionar una
opcidn en un mend de persiana de 14s sigutentes maneras:
m  Coloque el sefialador en la opcion que desee seleccionar y dé
click al botén izquierdo del mouse,

s Oprima 1a letra subrayada del comando.

®  Use las teclas de flecha direccional para resaltar una opeién de
men y luego oprima . para seleccionaria, '
Unacombinacion de teclus aparece aladerecha de algunas ]opcioncs
de los menids, Oprimiendo tal combinacidn, puede ejecutarse la opera-
cion desde el teclado, sin abrir primero el mend.
Al estar desplegado un mend de persiana, no ¢s posible ICCICdr en
Ia hoja de trabajo. Para continuar ingresando texio, dé click en Cudlqmer
parte de la hoja de trabajo u oprima la tecla Esc.
~ Siabre el mend equivecado por error, dé click en otro comando del
mend, arrastre €l sefialador sobre la barra de menis, v oprima lus!; teclas
flecha izquierda o flecha derecha para pasar de un mend a otro.
Enalgunos menis, lus opciones pueden presentarse en un tono mds
claro o pahido que el normal (0 sea opacado). Estas opciones n(I) estan
disponibles; es necesario ejecutar alguna otra operacion antes aé poder
seleccionar una opcion que esta opacada.
Cuando se selecciona una opcién de un mend de persiana que va
seguida por puntes suspensivos (...) Excel desplegard una caja de
didlogo.
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Como Trabajar
con Cajas de

Didlogo

Una caja de didlogo contiene opciones adicionales que se relacionan aj
comando u operacién de Excel que se desea ejecutar. Cuando una caja
de dislogose despliega por primera vez, una de las opciones estardactiva,
Esto significa que es la opcién que se halla lista para ser seleccionada o
actuar sobre ella. Si la opcidn activa requicre o permite gue se tecleen
caracteres que la identifiquen més, contendrd una linea vertical
parpadeandc llamada punto de insercidn, Los caracteres ya existentes
para la opcién aparecerdn resaltados en video inverso. Si la opcién no
permite que se tecleen caracteres, aparecerd resaltada o rodeada por un
recuadro de seleccién punteado.

Si tiene un mouse, simplemente dé click en las opcienes en la caja
de diflogo. Con el teclado, use las siguientes técnicas para seleccionar
opciones: '

m Oprima Tab para moverse hacia adelante en la caja de didlogo
de una opcién a otra, 0 bien oprima Shift+Tab para moverse
hacia atrés.

m  Oprima Alt y la letra subrayada en la opcion.
Las cajas de didlogo pueden contener varios tipos de elementos.

Casas pE TExTO

Una caja de texto es un block donde se puede teclear informacién o
seleccionar opciones. Algunas veces cuando se despliega una caja de
diflogo, las cajas de texio contendrdn algo que se haya ingresando o
alguna instruccién. Cuando unacaja de textoesté resaltada, su contenido
actual se borra al empezar a teclear un elemento nuevo.

Para seleccionar una caja de texto y resaltar su contenido, dé doble
click en la caja o arrastre el sefialador del mouse barriendo su contenido.
Usando el teclado, oprima Tab o Shifi+Tab para llegar a 1a caja de texto.
Si se da click una vez en la caja de texto, el punto de insercién aparecerd
ahi, pero primero se debe borrar el contenido actual antes de introduciv
nueva informacion. (El punto de inserci6n es como un cursor ——muestra
donde aparecersn los caracteres que se tecleen. Use las teclas Del 0
Retroceso para borrar el texto existente.

1
i
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Cuando haya introducido la informacion a la caja de texto, pase a
otro elemento oprimiendo Tab o Shift+Tab, o bien dando click con el
mouse. Nooprima J después de ingresar textoen lacaja de texlo w menos
que yahayaterminado de seleccionar opciones. Oprimir . J cerrard Idc.qa
de dislogo, elimindndola de 1a pantalla.

Casas DE Lista DE PERSIANA

Algunas cajas de lista tienen una ftecha que apunta hacia abajo al final
delacaja. Estoindica que hay opciones adicionales disponibles para esa
opcion en una caja de lista de persiana,

Para ver la lista de opciones adicionales, apunte a la flecha; luego
dé click y mantenga oprimido el botén del mouse. Una vez que la lista
se ha mostrado, arrastre el mouse hacia abajo para seleccionar, o resaltar,
su eleccion. Con el teclado, oprima Ali+ | para desplegar lacaja de lista;
luego oprima lasteclasde T o | para rotar a través de los elementos sin
desplegarlalista. Cadavezque se oprima 1 o |, aparecerdotro ¢lemento
de 1a lista,

Cuando la flecha que apunia hacia abajo es parte de la caja de texto,
nose puede teclearen lacaja-—debe seleccionarse unelementode la lista
de persiana. Si la flecha que apunta hacia abajo estd en una caja
independiente, despegadade lacajade texto, puede seleccionar de lacaja
de lista de persiana o teclear su seleccién en la caja de texto.

Calas pE LisTaA

Algunas cajas de lista estdn ya desplegadas en la pantalla y no necesitan
ser abiertas. Para seleccionar una opcidn de una de ellas, dé click en la
opciénconel mouse. Usandoelieclado, seleccione lacajade listay luego
oprima la 4 o | para seleccionar la opei6n.

CaJas DE PALOMEO

Una caja de palomeo ¢s un cuadro pequefio junto a una opcién, Cuando
se ddclick enunacaja de palomeo aparece una X en el cuadro, indicando
yueelelementoestd seleccionado, oencendido. (Sila funcién representada
por la caja de palomeo no estd disponible en su sistema, no aparecerd
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ninguna X.) Si ya existia una X en la caja, seleccionarla eliminars a I
X apagando el elemento.

Se puede poner X en mds de una caja de palomeo de un grupo. Por
ejemplo, poner X tanto en Bold como en lialic al formatear caracleres
crea un caricter en negritas que a la vez son udlicas.

Con el teclado, seleccione una caja de palomeo pasando a ella
usando Tab o Shift+Tab. Una caja de palomeo estd lista para ser
seleccionada cuando el texto adjunto estd rodeado por una linea pun-
teada de recuadro de seleccién. Ponga o quite 1a X oprimiendo la barra
espaciadora. En algunos casos, una vez que se pasa a unacaja de palomeo
de un grupo, se tienen gue usar las ieclas de flecha para pasar de una caja
a otra dentro del grupo — oprimir Tab puede seleccionar la siguiente
opcion fuera del grupo.

Botongs DE Rapio

Un bot6n de radio es un circulo préximo a un elemento. Cuando se
selecciona un botdn de radio, aparece un punto negro en su centro,
indicando que ese elemento estd encendido.

Los botones de radio vienen en grupos exclusivos. Seleccionar un
botdn de radio de un grupo, apaga automdticamente cualquier otro botén
de ese grupo que estuviera encendido antes.

Botones pe CoMANDO

Los batones de comando ejecutan una accién y afectan a toda la caja de
didlogo. Muchas cajas de didlogo tienen botones de comando rotulados
OK, Close y Cancel. Dar click en OK o en Close u oprimir ., elimina la
caja de didlogo de la pantalla y pone en accién lo gue indique. Dar click
en Cancel u oprimir Esc el:mmd la caja de didlogo sin aceptar sus
cambios.

Como Usar Bamas
de Hemamienta

Muchas aplicaciones de Windows tienen barras de herramienta. Una
harra de herramienta es un grupo de botones sobre los que se puede dar
click para ejecutar operaciones de uso frecuente. Cada botén tiene un

i
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icono (un pequefio dibujo) que representa la operacién o comando que
el botdn ejecuta. Por ejemplo, en Excel el botén al que se le da click para
imprimir una hoja de trabajo tiene el icono de una impresora.

Con las barras de herramienta de Excel, cuando se d4 cllcl\ ¥ se
manticne oprimido el botén del mouse al estar apuntando a un bolén de
la barra de herramienta, la tarea ejecutada por ¢! botén de l1 barra
aparecerd en la barra de Estado en la pante inferior de la panlall?a. Sino
desen ejecutar 1a operacién, mantenga oprimido el botén del mouse y
arrastre ¢l sefialador fuera de 1a barra de herramienta.

Se pueden abrir mends arrastrando el mouse sobre la barra. respec-
tiva, pero arrastrar el mouse sobre la barra de herramienta no st,lcccmnd
cada herramienta gue se vaya tecando. La seleccionada cuando s se e dio
click originalmente al mouse permanecera en scleccion.

Como Obtener
Ayuda

LaLeccidn 3 leda pricticaen el uso del sistema de Ayudade Excel. Aqui
ofreceremos un repaso de la estiructura bdsica de Ayuda que escomiéinen
todas las aplicaciones de Windows. ‘
Las palabras o frases que estdn subrayadus en las ventanas de Ayuda
se lluman hotspots (puntos dlgidos). Al apuntar a un punto dlgido, ¢l
sefiafador del mouse se transforma en una peguefia mano que apunta,
Cuando se da click en un punto dlgide que estd subrayado con linea
continua, Windows muestra una pantalla que contiene inforplacién
acerca de esa palabra o frase. Seleccione un punto dlgido con el teclado
oprimiendo Tabpararesaltareliérmino, y lucgooprima.Jdpara dupl%dr
La informacién acerca de €L
Otros puntos dlgidos estin subrayados con linea punteada. Cuando
se da click en uno de cllos, aparece una definicidn del término. Cuando
haya terminado de leer la delinicion, dé click al mouse otra vez.
Cuando necesite ayuda, bdsquela a través de los mends de Help,
seleccionando puntos dlgidos o buscando temas especiticos.
Las ventanas de Ayuda también incluyen tas opciones y € co mandos
de ment mostrados en 1a Tubla B.1. |

Ty
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OESCRIFGICN »
i (Archivo) Imprime la informacién de ayuda, o sale de Ja
funci6n de ayuda. v
(Editar) Hace una copia de la informacidn de ayuda, para
poderla insertar o pegar en el documento.
{Marcador de libro) Marca el lugar dentro del sistema de
ayuda para poder regresar al mismo punto rdpidamente.
(Ayuda) Muestra informacién acerca del uso de las funciones
de ayuda.
(Contenido) Muestra |a pantalla de indice de ayuda.
{Buscar) Muestra una lista de puntos 4lgidos (hotspots) y
penmite teclear una palabra clave.
(Retroceder) Muestra la pantalla previamente desplegada.
Esle botdn no estd activo al arrancar Help.
{Historia) Muestra unacaja de lista que enumera las pantallas
de ayuda gue se han usado durante la sesién actual de
Windows. Lamdsreciente encabezala lista. Puede regresarse
a una pantalla seleccionando su nombre en la lista.
{Glosario) Presenta una lista alfabética de puntos digidos que
se pueden seleccionar para mostrar informacién.

TABLA B.1:

Opciones y comandos
del meny de ayuda de
Windows

—

- INDICE

BAK, extensidn, 34
BAT, extensitin, 34
COM, exlensién, 34

.EXE, extensién, 34

SYS, extensi6n, 34

XLC, cxtensién, 163
XLM, extensién, 247, 250

XLS. extensi6n, 33, 43-44

1904 Dale System, opcién, 89
3-D chart, herramientas, 165

A

About Microsoft Excel, epcién, 13
abrir
el grupo Excel, 5-6
hojas de trabajo, 17, 42-45
ABS, funcién, 78
Absolute Record, opcidn, 244
acento circunflejo (%), 80
Add, modalidad, 11
Alignmen, caja de didlogo, 103-107
alimentacién (ingreso) de datos, 19-26
en tramos, 57-62
fecha y hora, 67-68
\lenando series, 63-69
alineamiento horizontal, 101-105
alinear datos, 1K)

caja de didlogo Alignment para, 103-107

herramientas para, 17-18

horizontal, 101-105

nimeros, 23, 25, 114

texto, 23, 25
All, tecla, uso con mends, 272
Altemate Expression Evaluation, opcion, 89
Alternate Foermula Entry, opcidn, 89

altura de hileras, 92, 127, 133
AM/PM, claves para crear formatos especiales,
121
amplificar la imagen, 198, 203, 224-225,227-
229
ancho
de columnas, 122-126, 133
de objetos, 175
ancla, posicion, 55
Applications, grupo, 6
Arc, herramienta, 174
Area Chart, herramienta, 165
arrancar
Excel, 2-6
hoja de trabajo nueva, 39
Windows, 3
Armrange Windows, caja de didlogo; 203-204

"Arrange, caja de didloge y opeion, 202-205, 207

arrastrar y ‘soltar, funcién, 50, 233
arrastrar, 272
Arrow, herramienta, 166, 174, 178
asas
de llenar, 63
para gréficas, 160
Assign Lo Object, opcin de macro, 243
asteriscos (*)
con contrasefias, 35,
para multiplicacién, 80 _
atajo, teclas de, para macro, 241.242, 246, 250
Attach Text, caja de didlogo, 172
AUTOEXEC.BAT, modificar archivo de, 266
Autofill, funcisn, 63-65, 68
AutoFormat, caja de didlogo ¥ herramienta, 18,
113
Automatic Except for Tables, opcion de cdleulo,
87
AutoSum, herramienta ¥ comando, 16-17,71-74

. ————
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AVERAGE, funcién, 78
ayuda

de Excel, 13-16

de Windows, 277-278

para gréaficas, 171

para Lows 1-2-3, 13, 232

sensible al contexto, 15-16, 28
ayuda sensible al contexto, 15-16, 18
afos

alimenuar, 68

en formato sobre disefio, 121

B

Back, opcién de ChantWizard, 158
Bar Chart, herramienta, 165
barra de estado, 7-8. 10-11
al alimemar daios, 22
desplegar, 232
barra de herramicnta standard, 16, 129-131
barra de titulo, 7, 9-10, 204
barra espaciadora para seleccion de celdas, 49
barra Formula, 7-8, 10
contenido de 1a celda en, 24
mostrar, 232
pura alirmentar (ingresar) datos, 19-21
barras de herramienta, 7-9, 16
baras de herramienta de propdésito especial, 108-
I .
AutoForman, herramienta encendida, 15
AutoSum, herramients encendida, 71-74
ayuda pura, 15
Chart, 160
de propdsito especial, 108-110
Drawing, 173-176
en Windows, 276-277
Formatting, 110-113, 118-119, 131-132
iconos en, 17-18, 277
imprimir desde, 28 -
para abineamiento horizonal, 101-103

para formatear caracteres, 129-132
para formateo de nidmeros, F15-119
Utility, 197-199

barras de Men( y mends, 7-9, 15
de atajo, 16, 54, 10B-110
en Windows, 272-273
opciones para, 13

seleccionar elementos desde, 11, 272-273

teclas alternativas para, 232
barras de recorrido y recorrido, 8, 25-26
desplegar, 232
en imdgenes amplificadas, 225-226
en ventanas aciivas, 204
en ventanas mdltiples, 204, 207-208
Besi Fits
para columnas, 123-126
para hileras, 127
bloquear discos, 26
Bold, formato, 17, 111, 129
borrar
cambios de pégina, 222
celdas, 96-97
cuadricula de referencia, 136-137
formato. 56, 121
herramientas, 108
hileras y columnas, 93-95
14minas, 162
macros, 247-249
notas, 238-239
palabras repetidas, 212
dreas de impresion, 62
botones de comando, 276
botones de radio, 276
Boutom Border, herramienta, 18
Bring 10 Front, herramienta, 175
buscar
*informacion de Help, 13-14, 278
texto, 188-189
buscar texto, 188-189
Butlon, herramienta, 199

C

cajas de didlogo, 16, 273-276
cajas de lista, 275
cajas de lista de persiana, 275
cajas de palemeo, 275-276
cajas de texto, 179-181, 199, 274 ]
cajas ¥ formas rellenas, 173-174, 178
Calculate Now, herramienta 199
Calculation options, caja de didlogo, 87-88
cambio automitico de renglén, 104
en cajas de texio, 179 ,
para notas, 236
cambios de pagina, 22, 229
cambios de pdgina manuales, 222
Camera, herramienta, 199
Cancel, caja, 21-22
Caps Lock, tecla, 11
caracteres
formatear, 128-134
reemplazar, 47, 184-188
celdas activas, 19-20, 24, 43
celdas bianco y negro, imprimir, 220
celdas seieccionadas
insertar desde, 92-93
movimiento en, 61.62
celdas y grupos no adyacentes, seleccionar, 49
celdas, 10. Ver también grupos, iramos
activas, 19-20, 24, 43
alimentar (ingresar) datos en, 19-26
alineamiento del contenido de, 100-107
borrar fonnatos en, 56, 121
contenidos largos en, 24-25

copiar ¢l contenido de, 18, 48, 50-55, 65-66,

97,
despejar ¢l contenido de, 55-56, 93, 107
editar, 45-56
insertar desde, 92-93
insertar y borrar, 90, 96-97
linderos para, 18, 19, 28, 137-140
mover el conlenido de, 46, 50-55, 97, 203
notas en, 234-239
pasar entre, 58, 61-62
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patrones y colores en, [40-145
reemplazo de caracieres en, 74
rotacién del contenido de, 105-106
seleccionar, 29, 48-49, 55, 199

Cell Note, caja de didlogo, 235-237, 239

Center Across Columns, herramienta y formato,

18,

Center Align, herramienta y opeidn, 18, 102, 104

ceros
division entre, 77
en formatos sobre disefio, 121

finales a la derecha del punto decimal, 24,

121
mostrar, 229

ceros finales a la derecha del punto decimal, 24

cerrar
barras de herramienta, 109-110
ventanas, 38

Chanrt, barra de meniis, 171

Chan, herramienta y opcidn, 157, 160, 164-166,

17

ChantWizard, funcién y cujas de didlogo, 18,

154,

Check Spelling, herramienta, 199, 210-211

claves para formatos sobre disefio, 121
claves para ordenacion, 191-192, 194-195
Clear, caja de didlogo, 55-56, 68, 137
clipboard, 18, 53-55, 197, 202
color

de celdas, 140-145

de cuadricula de referencia y encabezados,

230
de linderos, 138
de objetos, 175
de tipografia, 134
de dvalos, 178
Color, herramienta, 178
Column Chan, herramienta, 165

" Column Width, caja de didlogo, 125-126

columnas, 10
alimentar (ingresar) datos a, 57
ancho de, 122-126, 133
borrar, 93-95
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buscar 1exto por, 187, 189
centrar texto sobre, 18, 101, 104- 105, 107,
129
encabezados para, 220, 229-230
insertar, 90-93, 95
ardenar por, 194
recorrer por, 26
seleccionar, 49
comandos, herramientas para, 16
comas (,}
en formatos sobre diseiio, 121
© 7 en tunciones, 71
en separadores de miles, 112, 116-117
comentarios
en cajus de texto, 179-181
en notas, 234-239
cormillas (")
para fechas, 86
para texto, 25
Combination Line and Column Chan,
herrumienta, 165
Comma, estilo y formato, 112, 119-120
Comptete Installation, 265-266
configurar inpresora, 267-269
confimacion previa, reemplazos de texio con,
18- - f
Connect, caja de didlogo, 268, 270
contenidos largos de celdas, 24-25
conteo total de pdginas en comisas y p ies de pig
" conltrasefias, 35-36, 44-45
Control Panel, para configuracion de impresoras,
3
Control, tecla
para copiar celdas, 59, 52-53
para macros, 242
para mover de celda a celda, 62
para seleccionar celdas, 49, 55
coordenadas de la celda activa, 19
copiar
al clipboard, 18, 197
contenido de celdas, 18, 48, 5-55, 65-66, 97,
197,
de una hoja de trabajo a otra, 203

discos Excel, 260-264
funciones, 74-75
" informacién de Help, 278~

Copies, opcién de impresion, 29
Copy clipboard, opcién, 53-54
Copy, herramienta y opcién, 18, 97, 197
comisas, editar, 217-220
COUNT, funcién, 78
cuadriculas de referencia, 133, 166-167

color de, 230

desplegar, 229

imprimir, 220

para formas, (44

retirar, 136-137
Currency, estilo y formato, 112, 117, 120
Currem Printer, opcién, 220
Custom Installation, 265-266
CUSTOM.DIC, diccionario, 212-213
Cut, opcién del clipboard, 53-54, 97

D

dar click, 16, 272

dar doble click, 272

dar pausa a macros, 247

Data Series, caja de didlogo, 68-64

datos, alimentar. Ver alimentacion {ingreso) de
datos

DAYS360, funcidn, 78

dd, clave de formato sobre disefio, 212

decimales, lugares, 11, 112, 118-119, 232

Decrease Decimal, herramienta y opeién, 112,
118

Decrease Font Size, herramienta, 17, 130-131

definiciones en Help, 277

Del, tecla, 53-55

Delete, caja de didlogo, 94, 97

Demote, herramienta, 198

deseleccionar celdas, 55

despejar

contenido de celdas, 55-56, 93, 107

fechas, 68
formatos, 107
linderos, 137
ventanas, 38
desplegado horizontal de ventana, 203-205
diagonal (/)
para division, 80
para fechas, 86
dibujar, 173-175
cajas de texto, 179-181
formas, 175-§78
dibujos, 173-178
diccionarios para verificador ontogrifico, 209, 21
diccionarios ortoprificos complementarios, 209,
p4l
directorios, 34, 264-265
discos, respaldar, 26-264
MSKCOPY.COM, programa, 262-263
diskettes de destino al copiar, 261-263
diskettes fuente al copiar, 261-263
Display Options, caja de didlogo, 136-137, 229-
230
divisidén entre cero, 77
division, 80
DOS, regresar al Hamador, 37
Down Arrow, herramienta, 17
Down then Over, opcién de impresidn, 221
Drawing, barra de herramienta, 173-176
Drop Shadow, herramienta, 175, 181
duplicar celdas, 65-66

E

Edit Object, opcién, 169, 171

Edit, modalidad, 10, 47

editar
celdas, 46-56
comisas y pies de pdgina, 271-220
Help, informacidn, 278
imdgenes amplificadas, 229
laminas, 171-172

INDICE @

nolas, 237-238
Effects, opcidn, 134
ejes, etiquetas para, 155-156
elementos de mend subrayudos, 272-273
etiminar

cuadriculas de referencia, 136-137

pantallas divididas, 208

dreas de impresion, 62
encabezados de hileras y columnas, 220, 229-230
End, tecla, 20
Enter, caja de, 21-22
Enter, modalidad, 10, 22
Enter, tecla, 62, 233
Entire Column, opciones, 92, 95
Entire Row, opciones, 92, 95
enumerar las ventanas abiertas, 203
Esc, tecla

en alimentacién (o ingreso) de datos, 21

en el sistema de ayuda, 15

en la seleccion de celdas, 20

en modalidad Edit, 47-48
escilar

con Zoom, 227-229

grificas, 222

impresion, 217, 220
estilos

de grilicas, 164

de linderos, 138

de lineas, 139

de nimeros, 112, 115-120

de objetos, 175

desplegar, 17, 111
etiquetar diskettes, 262-263
etiquetas de proteccién contra escritura, 261
Excel, directorio, 34
Excel, grupo 3

abrir, 5-6

crear, 266
Excel, respaldar discos, 260-264
Excel, ventana de aplicacion, 7
EXCELA4.INI, archivo, 15]
exponencial, formato, 24
Extend, modalidad, 11




284

!
extender selecciones de celdas, 55
extensiones de nombres de archivo, 33-34

F

F1, tecla, 15-16
Fast, but no graphics, opcion de impresién, 29
fechas
en cornisas y pies de pdgina, 28
formatos para, 67-68, 120
formulas con, 86
series de, 69
File, oprion de grificas, 171
Fill, asas, 63
Fill, opciones
para alineamiento, 104-105, 107.
para grificas, 168-169
Find, caja de didlogo, 189
Fit Selection, para imagen, 227
Fit To, opci6n de impresara, 220
FI1X, indicador, 11
Fixed Decimal, opcién, 232
flechus triangulares para dimensionar ventanas, 9
Font, caja de didlogo, 128-129, 134
formas sin relleno, 173, 176
formas, crear, 144-145
formas, dibujar, 175-178
Format Codes, caja de didlogo, 120
Format Number, caja de didlogo, 119-120
formateo automdtico, 18, 113, 146-151
formate en itdlicas, 17, 112, 129
formatos interconstruidos, 120
formatos y formatear, 29. Ver también alinear
dato
automaticament, 18, 113, 146-151
borrar, 56, 121 v |
caracteres, 128-134
despejar, 107, 137
fechas y horas, 67-68, 120
graficas, 158-159, 171
hileras y columnas, tamaito, 122127

U b

lineas, 135-140
ntimeros, 24, 114-121
patrones, 140-145
sobre disefio, 121
Formats, opcién, 137
Formatting, barra de herramienta, 110-113
para caracteres, 131-132
para mostrar ¢l punto decimal, 118-119
Freeze Panes, opcién, 203
funciones de ingenieria, 70
funciones de suma, t16-17, 71-74, 78
funciones estadisticas, 70
funciongs financieras, 70
funciones, 70
bdsicas, 78
copiar, 74-75
mover, 75
reemplazar, 186
sugerencias para, 86-89
sumar, 16-17, 71-74, 78
teclear, 76-78
tramos para, 72, 73-75
férmulas, 79-80
con borraduras, 56
con fechas, 86
insertar 81-82
mostrar, 229-230
reemplazar, 186
referencias absolutas en, 82-86
sugerencias para, 36-89

G

Galléry, opeidn de prifica, 171
General, opci6n de alineamiento, 104

GLOBAL.XLM, hoja de macro, 241, 244-245,

247-250
glosario para informacién de Help, 278
Goal Seek, funcién 256-257
Gridline, herramienta, 167
Group, herramienta, 175

Growth, series, 69
grupos, 3, 175. Ver ramhién tramos
abrir, 5-6
imprimir, 62
moverse entre, 61-62
seleccionar, 48-49
grificas
crear, 154-163
desplegar, 206
editar, 171-172
elementos de, 155-156
estilos de, 164
formatos para, 158-159, 171
imprimir, 169-170, 222
incrustadas, 161, 163, 169-170, 208, 222
instanldneas, 162-163
linderos y fondos para, 168-169
maover, 171
opciones para, 158-159
reemplazar texto en, 185
tamano de, 170,222
tipos de, 158, 166-168
titulos para, 159-160, 172
verificacion ortogréfica, 213
graficas de sectores, ayuda sobre, 13-15
graficas incrustadas, 161, 163
guardar, 208
imprimir, 165-170, 222
gréficas instantdneas, 162-163
guardar '
grificas, 163, 208
héjas de trabajo miltiples, 208
hojas de trabajo, 17, 12-36, 45
macros, 249-250
recilculo con, 88
valores externos, 89

H

Header, caja dc didlogo, 218
Help Contents, ventana, 16

Help, comenido de ta informacién, 13, 16, 278

INDICE

Help, definiciones, 277 )
Help, glosario para informacidn de, 278 I
Help, herramienta, 18
herramientas de poligono. 174,
herramientas a mano libre, 174
hh, clave para formatos sobre disefio, 121
Hide A, apcién, 230
Hide, herramienta y opciones
para barras de herramienta, 109-110
para columnas, 126
para hileras, 127
para objetos, 230
para ventanas, 202
hileras, 10
alimentar datos a, 57
altura de, 92, 127, 133
borrar, 93.95
buscar texto por, 187, 189
encabezados de, 220, 229-230
insertar, 90-93, 95
ordenar por, 190-194
recorrer por, 26
seleccionar, 49
historia de las pantallas de Help, 278
hojas de trabajo protegidas, 35-36, 44-45
hojas de trabajo grandes, imprimir, 219-22s, 224
hojas de trabajo, 3
abrir, 17, 42-45
arrancar, 39
formatear. Ver formatos y formatear
grandes, 219-222, 224
guardar, 17,'32-36, 45
imprimir, 17, 27-31, 214-222
moverse en, 19-20
miiltiples, 38, 200-208
nombres para, 9-10, 33
para lectura solamente, 36, 42, 44-45
proteger, 35-36
respaldar, 34-35
seleccionar, 49
ventana para, 7-11
hojas macro, 241, 244-245, 247-251
Home, 1ecla, 20




T

hora
en comisas y pie de pdgina, 218-219
formatos para, 67-68, 120
horas en formatos sobre disefio, 121
Horizontal Gridlines, herramienta, 166
hotspots, en ventana de Help, 277-278

I

ICONOS
de Excel 5-6
en la barra de Herramienta, 16-18, 227
mpresion centrada, 217
MPresoras
actual, 220
configurar, 267-269
preseleccionada, 269-270
seleccionar, 30-31
mprimir, 17, 27-31
configuracidn de pagina para, 215-217
comnisas y pies de pagina, 217-219
grupos, 62 ’
gréficas, 169-170, 222
hojas de trubajo grandes, 29-222
nodas, 238
vista preliminar, 29, 223-226
IlCTe’dStl: l[;ec:inrml. herramienta y opeidn, 112,
Acrease Font Size, herramienta, 17, 129, 131
ndice para el sistema de ayuda, 15, 60, 61
nfo Window, opcién, 232,237
n.fo.rmacién confidencial, ocultar, 208
nicializacién, actualizar archivos de, 266
ns, tecla, 47
nsert Paste, opcion, 97
asert, caja de didlogo, 92-93,97
nsert, modalidad, 47
senar
caracieres, 47
celdas, 96-97
formulas, §1-8§2

hileras y colurfinas, 90-93, 95

nutas, 235-236
instalacidn completa, 265-266
instalacion minima, 265-266
instalacidn especial, 265-266
instalar Excel, 264-266

- Introducing Microsoft E;xcelf'opcién. 13

Iteration, opcién’de célculo, 88

J

Justify, opciones de alineamiento, 1{4- 1035, 112

L

Learning Microsofl Excel, opcién, 13
Left Align, herramienta y opciones, 17, 103-104
Legend, herramienta, 166, 168 )
legibilidad, 87, 91
leyendas de graficas, 155, 166, 168
Light Shading, opcién, 113
linderos : ’
imprimir, 28 .
para celdas, 18, 19, 28, 137-140
para formas, 144
para {dminas, 168-169
Line Chart, herramienta, 165
Line, herramienta, 174,
Linear, opcion de series, 69
List File of Type, caja de lista, 44 '
lenar series, 63-6%
Lock Cell, herramienta, 198
Lotus 1-2-3 :
. dyudas para, 13, 23i I
yonvertir férmulas desde, 89
) instalar informacion para, 266
]{miles de pagina al imprimir, 28
lineas continuas en ventanas de telp, 277
lineas punteadas '
en las ventanas de Help, 277

™

para linderos, 28 .
para dreas seleccionadas, 52, 62
lineas, modificar, 135-140

M

m, cluve para formato sobre disenio, 1214
Macro, opeion para grificas, 171
macros globales
borrar, 247-249
correr, 2‘46—'24".'
guardar, 249-250
registrar, 241-246
macros, 244
borrar, 247-249
correr. 243, 246-247, 251
guardar, 249-250
registrar, 241-246, 250254
sobre diseiio, 250-251
marcadores de zona ocupada, desplegar, 230
marcas de libro para informacion de Help, 278
MAX, funcitn 78
Maximize, boton, 9, 205
Maximum Change, opeitn de cilculo, B8
Maximum lterations, opeion de caleulo, 88
maytisculas con el verificador ortogrifico, 211-
212
mayﬁsculas!mins. en iisquedas, 187, 18y
MEDIAN, funcion, 78
memoria disponible, 13
mensajes en cujas de (exto, 179-181
meni de Control, caja de, 9-10, 15, 38-40, 43
mends de atajo, 6, 54, 108-110
meses en formato sobre disedo, 121
Microplan, opcidn de ayuda. 13
Micrasoft, apoye al cliente, 13
MIN, funcién, 78
Minimize, botén, Y
Minimum Insiatlation, 265-266
minutos en formato sobre disefio, 121
T, ¢lave para formate sobre disefo, 121

.l‘r.li?lICE

MOUSE Pard mane irguierda, 272
mouse, 8, 12,20, 217272+
con mends de atajo, 54

operaciones automdticas con. Ver macros

para selecci6n de mends, 16
para seleceion de celdas, 49

técnica de artastrar y soltar con, 5(-233

mover
barras de hemamientis. 16, 108

contenido de celdas, 46, 50-55, 57, 203

en hojas de Trabajo 19-20
entre celdas, 58, 61-02
funciones, 175
grificas, 171
multiplicacion, %0
mirgenes pird impresion, 220, 224
miktiples celdas, seleccionar, 48-49
makltiples claves de ordenacion, 194-195
maltiples hileras y columnas, borrar, 94
miltiples hojas de trabajo, 38, 200-202
mostrar ventanas pira, 203-207
vistas de, 207-208
multiples ventanas, 8

N

NETWORKDAYS, funcidn, i
New Window, opcién, 202, 207
New Worksheet, herramienta, 17
Nexl, opciones

para gréficas, 158

para visia preliminar, 224
nombres

de barras de herramients, 110

de hojas de trabajo, 9- 10,33

de macras, 241-242, 245-246, 250

de tipos de lewra, 111, 132
nombres de archive

en cornisas, 217-218

extensiones para, 33-34
Noral Font, opciones, 134
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Normal, estilo y formato, 118-120, 129
notas con sonido, 238-239
uotas de texto, 235-238
iotas, 234
editar, 237-238
en cajas de texto,179-181
imprimir, 238
indicador para, 232, 236
insertar, 235-236
sonido, 238-239
ueva hoja de trabajo, 17, 19
‘um Lock, tecla, 11, 57
umero de elementos, funcién, 78
‘imeros
alimentar (o ingresar), 25, 57
alinear, 23, 25, 114
formatear, 24, 114-121]
imeros de pdgina, 217-219
imeros negativos, 1121

ultar informacidn confidencial, 208

acados, elementos de memi, 273

en, herramienta y caja de didlogo, 17, 43-44
craciones matemdticag, 70

craciones automdticas. Ver macros
cradores para [Srmulas, 80

tions, caja de didlogo, 220

lenamientos ascendentes, 191, 197-198
lenamiento descendente, 192, 197-198
lenamientos jerdrquicos, 194-195

lenar

desde la barra de herramienta Utility, 197-198
por columnas, 194

por hileras, 190-194 !
problemas con, 195197

'macién vertical, 133, 216, 220-221

‘miacion horizontal, 133, 216-217, 220
‘ntacién, 133, 216-217, 220-22|

:ntation, opeién de alineamicnto, 104-105

ortografia sugerida, 211-213

Outline Border, herramienta, 18, |37
Oval, herramienta y 6valos, 174, 176-178
Over then Down, opcion de impresién, 221
Ovenype, modalidad, 11, 47-48

P

Page Order, opcitn de impresién, 220-221
Page Setup, caja de didtogo, 29-30, 215-217
para comisas y pies de pagina, 217-219
para hojas de trabajo grandes, 219-222, 224
para la impresora preseleccionada, 269-270
palabras enteras, buscar (exto por, 186, 189
palabras repetidas, verificar, 212
paneles, 203, 207-208
pantaila
amplificar, 198, 203, 334-225, 227-229
Display Opticns, caja de didlogo para, 136-
137,22
Preview, pantalla para, 223-226
Warkspace Options, caja de didlogo para,
230-233
‘pantallas divididas, 203-208
pantallas. Ver también imagen
de Excel, 7-11
recorrer por, 26
para lectura solamente, hojas de trabajo, 36, 42,
paréntesis ( )
para parimetros de funciones, 78
para precedencia de operadores, 80
pardmetros, 78 °
Paso a paso, avance en macros, 247
Password, caja de didlogo, 45
Puste Formats, herramienta, 18, 198
Paste Values, hetramienta, 198
Paste, opcién del Lllpboard 53.55
patrones, 140-145, 168-169

" Paterns, caja de didloge, 141, 168-169

pegar
del clipboard, 18, 53-55, 198
graficas, 163

Percent, estilo y formato, 112, 116, 120
PgUp y PgDn, eclas, 20
Pie Chart, herramienta, 165
pies de pdgina, editar, 217-220
plano frontal, colores y opciones, 140-141
plano posterior
colores y opciones para, 140-141
para ldminas, 168-169
polencias, 8(}
precedencia de operadores, 80
Precision As Displayed, opcién, 89
precisién, 87, 89
Preterred Chan, herramienta, 166
preguntas de negocios, 252
Goal Seek, funcidn para, 256-257
;qué pasa si...?, 253-255
preseleccionada, impresora, 269-270
preseleccienade, formato, 114
Previous, opcion de vista prebliminar, '224
Print Quality, opcién, 29
Print Range, opcion, 29
Print, herramienta y caja de didlogo, 17, 28-30, 1
Printer Setup, caja de didlogo, 30, 220, 268-270
Printers, caja de didlogo, 267-268
Product Support, opcidn, 13
Program Manager, 4, 37, 39
Promote, herramienta, 198
pronosticar, referencias absolutas para, 85-86
puntajes, 133
punto de insercidn, 21, 47, 180, 274
puntos suspensivos (...}, 273
puntos dlgidos (hotspots) en ventana de Help,
277-278

Q

;qué pasa si ... 7, problemas del tipo, 15, 60, 61

R

, referencias femotas, 89, 233

INDICE @

RIC1, opcibn, 232

Radar Chart, herramienta, 1635

RANK, funcién, 78

Read-Only Recommended, opeibn, 36, 45
Ready, modalidad, 10, 22

Record Macro, caja de didlogo, 242-243, 250
Rectangle, herramienta, 174

recdlcuto automdtico, 87

recélculo, 73, B7-B8

recdlculos manuales, 87

redes, impresoras en, 270

Redo Entry, opeion, 48

reemplazar lexto, 47, 184-188

Reference, comando, 83-84

referencias absolutus, 82-86

referencias relativas, 74

referencias circulares, 88
absolutus, 82-86 !
circulares, 88
RICI1, 232
relativas, 74
y cambios, 95, 97
regisirar macros, 241-246, 250-251
Relative Record, opcion, 243-245
Repeat, herramienta, 197
Replace, caja de didlogo, 183-187
Reset, herramienta, 110
Reshape, herramienta, 175
respaldar
fxcel, discos de, 260-264
hojas de trabajo, 34-35 -
resta, 80
Restore, botén, 9
Resume, opcién de macro, 243
Right Align, herramienta y opcién, 18, 103-104
rotar el contenido de celdas, 105-106
rotular ejes, 155-156
Row Hefi,hl opcién y caja de didlogo, 92, I27
Run Macro, caja de didlogo, 243, 246-247, 251
Run, opcién y caju de didlogo, 243, 250




S

salir
de Excel, 4, 37-40
" de ventanas miiltiples, 208
de Windows, 39-40
Sample, caja de
para AutoFormat, 147
para color, 141
Save As, caja de didlogo, 33
Save External Link Values, opcign, 89
Save File as Type, caja de lista, 34
Suve Options, caja de didlogo, 35, 45
Save, herramienta, 17, 33-34
Scientific, formato, 120
SCRL, indicador, 11
Scroll Lock, tecla, 11
Search, caju de didlogo, 13-14
secuencia de operaciones, 80
segundos en formatos sobre diseiio, 121
seleccionar
celdas visibles, 199
celdas, 20, 48-49, 55, 199
elementos de meni, 272-273
grupos, 48-49 7
impresoras, 30-31
jn_'gmos. 57 .
Select All, herramienta, 49
Select Chart, opcidn, 163
Select Visible Cells, herramienta, 199
selection, herramienta, 175
Send to Back, herramienta, 175
icparadores de miles, 116-117
series
crear, 68-69
en préficas, 155
especiales, 66-67
llenar, 63-65
-eries de datos, 68-69, 155
cries especiales, crear, 66-67
uries no consecutivas, 67

csiones de hoja de trabajo, terminar, 37-40

et Page Break, opcidn, 222

Set Print Area, herramienta y opcion, 62, 144,
199
SetRecorder, opcidn, 243
Setup, opcién, 224
Setup, programa, 264-266
sefialador del mouse, 8, 15, 20, 271
Sheet Options, de Ia caja de didlogo Calculation
8]
SHEET1.XLS, archivo, 33
Shift Cells Up, opcidn, 95
Shift Cells Down, opcidn, 92, 97
Shift Cells Left, opcidn, 94-95, 97
Shift Cells Rigiu, opcidn, 92, 97
Shift, tecla
para moverse en celdas, 62
para seleccionar celdas, 48-49, 55
Show All, opcidn de imagen, 230
Show Outline Symbols, herramienta, 198
Show Placeholders, opcién, 230
Show Toolbars, herramienta, |10
Show, herramienta, 109-110
signo de interrogacidn, sefialador del mouse con,
15 - ’
signo de pesos ($)
en estilo monetario, 117
para fqnnulos sobre disefio, 121
para referencias absolutas, §2
signo de porciento (%), 80, 87
signo menos (~—)
para nimeros negativos, 21
para resta, 80
signo més (+), 80
signo numérico (#) en formatos sobre disefio, 121
signo igual (=), para funciones, 72-73, 76
sicronizar recorrido, 204, 207-208
Size on Streen, opcidn, 222
sobre disefio
barras de herramienta, 110
formatos, 121
hojas de macro, 250-251
lineas, 135-140
patrones, 140-145
sombrear, 113, 138

sonidos pregrabados para notas, 238-239
Sort Ascending, herramienty, 197-198

Sort Descending, herramienta, 197-198

Sort, caju de didlogo, 191-192

Spelling, cuja de didlogo, 211

SQRT, tuncidn, 78

55, clave para formutos sobre disefio, 121
Stacked Column Chart, herrintienta, 165
Standard Widih, opcidn, 126

Stant Page No's AL, opcién de impresién, 220
Start Recorder, opuidn, 243-244

Step Vulue. opeidn para series, 69

Step. opcidn de mucro, 247

Stop Recorder, opeidn de macro, 243-245
Stop Value, opcidn para serics, 69

Strikeout, formato y opcidn, 112,129, 131, 134

" Style Box, herramienta y opcién, 17, 111

SUM, funcion, 18
suma, 80
simbolos de contorno, desplegar, 198, 229

T

Tab, tecla
para cajas de didlogo, 274-276
para moverse en celdas, 62
‘Table Format, caju de lista, 147
tamafio
de barras de herramienta, 108
de grificas, 170, 222
de tipos, 17, 111, 129-132
de ventanas, 9
tamaiio de papel, 220
teclado, 12
indicadores de estade para, 10-11
seleccionar celdas con, 49
teclas alternas, 232-233
teclas de funcian, indicador de estado para, 10-11
tectas direccionales, 20, 22, 48
tecleos automilticos. Yer macros
Text Box, herramienta, 66, 175, 179, 199

INDICE %1

1exto
alimentar (0 ingresar), 25
alinear, 23, 25
encontrar, 188-189
reemplazar, 47, 184-188
tipo de datos, 25
tipos de lewra, 131
aplicar, [49-150
cambiar, 128-134
nombres de, 111, 132
tamafo de, 111, t29-132
TruType, 27
Toelbar Name, opeién, 110
Toolbars, caji de didloge, [09-110
trumos. Ver fambién grupos
djustar, Y35
alimeattar (o ingresar) datos a, 58-62
imprimir, 29
ordenar, 195-197
para funciones, 71, 73-75
para grificas, 157
reemplazar texto en, 185
seleccionar, 57
verificacion onografica. 213
Trend, opeicén de series, 69
True Type, tipos, 27
Type, opcién para series, 69
tilos para grificas, 159-160, 172

U

Underline, herramienta y formate, 112, 129, 131,
1
Undo, herramienta y opeiones, 48, 53, §#97
para celdas borradas, 93
para ordenaciones, 192
Unfilled Oval, herramienta, 176
Ungroup, herrumienta, 175
Unhide, opuiones y caja de didlugo
paru colurmnas, £26
para hileras, 127
para ventanas, 202, 248-249
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date Remote References, opcidn, 89
: Standard Width, opcidn, 126

: Standard Height, opcién, 127

lity, barra de herramienta, 197-199

'r absoluto, funcién, 78

T méximo, funcién, 78

r minimo, funcién 78

tana activa, 204

Lanas

acomodar, 202-208, 207

e hoja de trabajo, 7-11

Jespejar, 38

miiltiples, 8, 200-208

para gréficas, 171

umaio de, 9

:unas de aplicacion, 7

tanas en mosaico, 203

ficador ortogréfico, 199, 209-214

tical, opcién de alineamiento, 104

~, opcidn 203 .

« preliminar de la impresién, 29, 223-226
15 para miltiples hojas de trabajo, 207-208
ame/Hi-Lo-Close Chart, herramienta, 166

¢, archivos de sonido para notas, 238-239
dow, mend, 201-203
lows, programa

arrancar, 3

ayuda en, 277-278

barras de herramienta en, 276-277
caja de didlogo en, 273-276
mends en, 272-273

salir de, 39-40

técnicas de mouse con, 271-272

Workspace Options, caja de didlogo, 230-233

Wrap Texl, opcién de alineamiento, 104
Write Reservation, contraseiia, 35, 45

X

XY Scatter Chart, herramienta, 165

-

Y

yyyy, clave para formato ‘s;J.bre disedio, 121

Z

Zoom, herramientas y cajas de didlogo, 198, 203,

224-225, 227-229
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Jomandos de
eleocion

7.
N

-COMANDO
Ciri+End
Ctrl+Home
Cirl+Flecha
Cul+PgUp

Curl+-Shift+End

Curi+Shift+Home
Ctrl+Shift+PgDn
Cirl+Shift+PgUp

* Ctrl+Shifi+Barra

Espacio

Crrl+Barra Espacio
Home

Pglp

PgDn
Shift+Flecha

Shifi+Retroceso,
Shift+H9mc

Shift+PgUp
Shift+PgDn

 Shift+Barra Espacio

Shift+Tab

.« Tab- -

Pasa‘a la ésquina inferior derecha de la hoja de trabajo

Pasa alg pﬂnCIPlO de la hoja de trabajo
Pasa a las csqumas de Ja hoja de trabajo

- ,,”

+» s Pasa una venmna haciala izqu ierda
Ctrl+PgDn . -
_ G +8hift+Flecha

Pasa una ventana hacia la derecha

s

Extiende la se]ecc:én en el sentido de la ﬂocha

Extiende la selccc:dn hasta ef fin de los datos- «" -‘Ef ‘,:. a2

[y
Iy

Emcnde la seleacldn hasta el § pnncnpm dela ho_|a
Exnende_ Ia seleccién una venm.pa hacia la dcrecha
Extiende la seleccidén una venfana_h_acia la iz:iuicnia

Selecciona la hoja de trabajo entera

Selecciona 1a columna entera
Pasa al principio de la hilera
Pasa arriba una ventana
Pasa abajo una ventana

Extiende 1a seleﬁc‘cién una celda en ¢l sentido de la
flecha .°

" Reduci el Area seleccionada a la celda activa

Exticnde ef drea de seleccidn hasta el principio de la
hilera

Extiende la seleccién una ventana hacia arriba
Extiende la selecci6n una ventana hacia abajo '
Sclec::ionq 1a hilera entera

Pasa a Ia celds anterior de la hilera

Pasa a la siguiente celida de 1a hilera

v 1A

e

A L,
Rl

R S

P

o gme pameenn

e T

Comandos de
Formateo

COMANDO

Crrl+0

Crrl+1

Cirl+3

Ctri+7

Cirl+9

Curl+B
Ctrl+F

Crri+l

Cirl+P
Curl+3
Ctrl+Shift+—
Cirl+Shift+!
Ctri+Shift+@
Curl+Shifi+#
Cirl+Shift+$
Cul+Shifi+%
Curl+Shift+#
Curl+Shift+&
Ctrl+Shift+(
Curi+Shift+)
Ctri+Shift+_
. Cirl+U
Ctrl+

~
Aplica el tipo de letra Normal

ACCION

Oculta las columnas seleccionadas

Aplica o elimina el formato wachado
Oculta o muestra la barra de herramienta standard
Oculta las hileras seleccionadas
Aplica o elimina ] formato negritas
Muestra la caja de didlogo Font
Aplica o climina ¢l formato itdlicas
Muestra la caja de didlogo Print
Selecciona la caja de estilo en la barra de herramienta
Aplica el formato Normal

Aplica el formato Comma

Aplica el formato Time

Aplica el fonmato Date

Aplica el formato Currency

Aplica el formato Percent

Aplica el formato Scientific

Aplica un lindero exterior

Desoculia las hileras seleccionadas
Desoculta las columnas seleccionadas

Elimina todos los lindetos

Aplica o elimina subrayado

Alterna entre mostrar férmulas y valores




